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About the Release Notes
The release notes provide information about new major Salesforce features and major enhancements to existing features.

You can choose from PDF and HTML versions. The release notes include:

• Brief, high-level descriptions of the functionality

• Setup information

• Implementation tips to help you get started

• Best practices to ensure your continued success

The release notes also identify all other changes and provide details about how those changes might affect your organization.

Feature Summary and User Impact Tables Are Easier to Use

Easily find out which features are already enabled for users.

Stay Informed about Updates

Use Twitter to get documentation updates.

You Asked for It!

We delivered the features you asked for on IdeaExchange.

Your Feedback Matters

We know how important our documentation is to your company’s success. We want to know what works for you and what
doesn’t.

Links in the Release Notes May Not Work before the Salesforce Release

Some links to the Salesforce Help, implementation guides, tip sheets, and developer guides won’t work until the Salesforce
release itself is available in your sandbox or production organization.

Other Resources

In addition to these release notes, we provide other resources to get you up to speed quickly.

Release Notes Changes

Read about changes to the release notes, with the most recent changes first.

Feature Summary and User Impact Tables Are Easier to Use
Easily find out which features are already enabled for users.

The headings in the Feature Summary and User Impact tables now show more clearly whether features:

• Are enabled for users

• Are enabled for administrators or developers

• Require administrator setup

• Require you to enable them by contacting salesforce.com
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http://docs.releasenotes.salesforce.com


Stay Informed about Updates
Use Twitter to get documentation updates.

When you follow @salesforcedocs on Twitter, you’ll receive notices whenever we publish new documentation or make significant
updates to existing documentation.

You Asked for It!
We delivered the features you asked for on IdeaExchange.

Idea deliveredIdeaExchange

Use Formulas to Track and Validate Activities by Date or by
Date and Time

Activity Due Date and Type Fields Available in Formulas
and Validation Rules: Partially implemented

Add a Simple Version of the Case Feed Email Action to
Salesforce1

Standard "Send an Email" function for Salesforce1 app

Home Page ComponentsVisualforce Home Page Component Type

Attach Larger Files, Up to 25 MB, to ObjectsIncrease case attachment size

Middle Name and Suffix Fields Available for Person Objects
(Beta)

Contact Full Name (Middle Name, Suffix, etc)

Customizable Price Book EntriesCustomize PricebookEntry Object

Create Price Book Entries in Apex TestsAllow Standard Pricebook in 24.0 Apex Test
@isTest(SeeAllData=false) feature

Historical Forecast Comparisons & TrendingHistorical Trending for Forecasts

Pin Reports FoldersKeep Favorite Report Folders In View

Custom Permissions (Developer Preview)Custom Settings Need Permissions

Your Feedback Matters
We know how important our documentation is to your company’s success. We want to know what works for you and what
doesn’t.

• Feedback forms: As you’re working with our documentation—whether it’s in the Salesforce Help, release notes, or developer
guides at Developer Force—look for the feedback form and vote up or down. Add comments if you have them.

• Twitter: Tweet us at @salesforcedocs.
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Links in the Release Notes May Not Work before the
Salesforce Release

Some links to the Salesforce Help, implementation guides, tip sheets, and developer guides won’t work until the Salesforce
release itself is available in your sandbox or production organization.

Other Resources
In addition to these release notes, we provide other resources to get you up to speed quickly.

• Release Readiness community. Join a community of Salesforce experts.

• Release demos. Get quick video overviews of what’s coming this release.

• Training Release Notes. Learn about online and instructor-led training changes and additions. Published every four months,
the training release notes make it easy for you and your customers to keep up with the latest training innovations.

Release Notes Changes
Read about changes to the release notes, with the most recent changes first.

May 28, 2014
Generate Orders (Pilot)

Improved the screen image callouts.

Community Templates for Self-Service (Beta)
Changed from Generally Available to Beta release.

Enable Territory Management 2.0
Updated the topic to state that enabling Territory Management 2.0 (Beta) automatically clears the value (if any) in the
territory field on opportunity records in your organization.

Metadata Types and Fields
Updated the topic to identify the addition of Territory2 as a value for the ReportType Categories field.

Metadata Types and Fields
Added information about the new QuestionPost FeedItemType value for FeedLayout.
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Feature Summary and User Impact
Summer ’14 has features that immediately affect all users after the release. You may want to communicate these changes to
your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit
from the new functionality.

When will you start seeing Summer ’14 changes on your instance? The best way to find out is to check the Major Release
Schedule section of the Salesforce trust site at trust.salesforce.com/trust/maintenance/.

These release notes describe the new and modified features available in this release. For visibility into known salesforce.com
issues, please refer to the Known Issues Site.

This table summarizes the Summer ’14 features and their impact on users. Review the feature details for the applicable Salesforce
editions.

General Enhancements
Mobile
Chatter
Communities
Sales
Work.com
Service
Analytics
Site.com
Force.com Customization
Force.com Development

General Enhancements
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Updates to Browsers

Attach Larger Files, Up to 25 MB, to
Objects

Receive Incoming Emails of up to 25
MB

Salesforce Notification Banner

Improved Previews for Microsoft
PowerPoint® (.pptx) Presentations

Orders Included in Data Storage Limits

Separate Database.com Documentation
Discontinued
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Updates to Translated Terminology

Middle Name and Suffix Fields Available
for Person Objects (Beta)

Increased App Limits with Expansion
Pack and Unlimited Apps Pack

Mobile
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

The Salesforce1 App

Salesforce1 Enhancements

Salesforce1 Differences from the Full
Salesforce Site

Salesforce1 App Development Overview

The SalesforceA App

SalesforceA

Other Changes

End of Support for Chatter Mobile for
BlackBerry and Salesforce Classic for
BlackBerry

Configure Push Notifications for Your
Mobile Connected Apps (Generally
Available)

Package Mobile Connected Apps
(Generally Available)

Chatter
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Files
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Salesforce Files Sync (Generally
Available)

Run File and Content Reports from the
File Detail Page

Other Changes in Files

Topics

See Topics People Know about on User
Profiles

Report on Knowledgeable People in
Your Organization

View Records on Topic Detail Pages

Search Feeds on Topic Detail Pages

Delete Topics Directly in Salesforce

Feeds

Profile-Based Rollout of Chatter
(Generally Available)

Add Action Links to Posts (Pilot)

Ask Questions in the Feed with Chatter
Questions (Beta)

Other Chatter Changes

Mobile User Context Switching from
Emails

New Preview Links

Dismiss Group Announcements

API Enhancements

Chatter REST API

Chatter in Apex (ConnectApi)
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Communities
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Community Engagement Console

Communities Analytics

Dashboards for Community Managers

Communities Reporting Enhancements

Reputation

Guest User Access to Public Chatter
Groups Without Logging In

Share URL Moved To The
Communities Settings Overlay

Communities Now Tracked in Login
History

Task Reminders for Partner Users

Caching Now Available for
Unauthenticated Visualforce Pages

“Create and Manage Communities”
Permission Renamed

Company Community License Renamed

Sales
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

The Salesforce1 App

Manage Sales on the Go!

Opportunities and
Collaborative Forecasting

Complete Customization Available for
Opportunity Splits

Edit Custom Fields on Opportunity
Splits
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Add Custom Split Types for
Opportunity Splits

Create Custom Split Types for
Opportunity Splits

Opportunity Splits Appear in Subtabs

View Opportunity Split Details in
Forecasts

Custom Field Forecasts (Pilot)

Overlay Forecasts (Pilot)

Track Forecasting Changes

Forecasts 1.0 (Classic) is Retired in
Summer ’14

Territory Management

Territory Management 2.0

Salesforce for Outlook

Salesforce Side Panel Available in
Contact Manager and Group Editions

Create More Kinds of Salesforce Records
Directly from the Side Panel

Customize Side Panel Publisher Menus
for Different Users

Users Can Download
Salesforce for Outlook without
Administrative Support

Schedule Logouts for
Salesforce for Outlook with Connected
Apps

Salesforce Console

Salesforce Console Enhancements

Activities

Default Event Action Lets Users Create
Events from Any Publisher

Use Formulas to Track and Validate
Activities by Date or by Date and Time

Report on Sales Reps’ Meetings with
Customers
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Use Additional Activities Fields to Run
More Comprehensive Reports

Related To and Status Fields Make Task
Lists More Useful

Security is Improved in the Multi-User
Calendar View

Custom Reports Based on Activity
Relationships Not Fully Supported
without Shared Activities

Price Books

Customizable Price Book Entries

Orders

Generate Orders (Pilot)

Other Changes in Sales

Territory Field Removed on Accounts
for Organizations Using Territory
Management 2.0 (Beta)

Territory Field Value Cleared on
Opportunity Records for Organizations
Enabling Territory Management 2.0
(Beta)

Custom Formula Fields on Accounts

Users Can Associate Records Related to
Pipeline with Records Related to Sales
in Progress

Work.com
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Skills (Generally Available)

Give Different Types of Rewards

Work.com Goal Enhancements

Added Support for Triggers and
Workflow
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Other Changes in Work.com

Service
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Case Feed

Customize Case Feed Layouts in New
Ways

Associate Contacts with Outgoing Email
in Case Feed in New Ways

Make Quick Text Messages Available to
Agents in More Case Feed Actions

Simple Version of the Case Feed Email
Action Available for Salesforce1

Inline Images Now Appear Correctly in
Email Replies from Case Feed

Add the Attachment Component to
Case Feed

Increase Agent Collaboration and
Productivity with Case Experts (Pilot)

See Feed Items for Attachments Added
from the Case Detail View on page 147

Exclude Email Threads from Drafts in
the Feed

Customize the Appearance of Emails in
the Feed

Case Management

Receive Larger Emails with On-Demand
Email-to-Case

Community Templates for Self-Service

Community Templates for Self-Service
(Beta)

Available within 24 hours of Summer
’14.
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Entitlement Management

Add the Milestone Tracker as a
Salesforce Console Component

Knowledge

Provide Code Samples with the Click of
a Button

Next-Gen Knowledge Search (Pilot)

Search Synonym Groups More Easily

Search Suggested Queries Resource in
REST API (Generally Available)

Live Agent

Transfer Files During a Chat (Generally
Available)

Transfer Chats to a Chat Button Queue

Create and Share Articles Using the
Knowledge One Widget

Limited Support for Right-to-Left
Languages

Chat Workspace Closes When a Chat
Is Transferred to Another Agent

Live Agent Deployment API: New
Methods

Live Agent REST API: New Visitor
Resources

Open CTI

Open CTI: New Directory Numbers
Method

Salesforce Console

Related Lists as Console Components

Add the Topics List and Milestone
Tracker as Salesforce Console
Components

Salesforce Console Integration Toolkit:
New Methods

Saved User Sessions Include
Multi-Components
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Add Call Data to an Interaction Log

Clear Notes from an Interaction Log

Limited Support for Right-to-Left
Languages

App Launcher Removed from the
Navigation Tab

New Look for Lookup Components

Service Communities

Introducing Chatter Questions (Beta)

Social Customer Service

Moderation for Social Customer Service

Quick Text for Social Customer Service

Other changes in Social Customer
Service

Analytics
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Track Forecasting Changes

Keep Favorite Report Folders In View

Site.com
Contact

salesforce.com to
enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Rename Site Assets

Edit Plain Text Files

Pane Names Replaced with Icons
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersEnabled for usersFeature

Make Rich-Text Area Fields Compatible
with Internet Explorer® 11

Force.com Customization
General Administration
Data
Business Logic and Process Automation
Security
Sharing
Globalization
Critical Updates
Other Changes in Customization

General Administration

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Custom Permissions (Developer
Preview)

Description Field Added to Login IP
Ranges

Improvements to Setup Search (Beta)

More Specific Permissions for Managing
Users

Limit Raised for External IDs

Customize Feed-Based Page Layouts in
New Ways

All Custom Objects Classified as Light
or Enterprise Objects

Home Page Components

Monitor Your Organization’s
Usage-based Entitlements (Generally
Available)

Actions
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Publisher Enabled for Chatter Off
Organizations

Global Publisher Layouts and Global
Actions Have New Locations in Setup

Changes to Mobile Smart Actions
Behavior

Default Event Action Lets Users Create
Events from Any Publisher

Default Action Lets Users Ask
Questions in Chatter

Data

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Retain Field History Data (Pilot)

Business Logic and Process Automation

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Critical Updates

Governor Limits Enforced on All Flows

Visual Workflow

Manipulate Multiple Salesforce Fields
and Records at One Time in a Flow
(Generally Available)

Changes to Trigger-Ready Flows

Cross-Object Field References in Flows

Send Email from a Flow

Submit Records for Approval from a
Flow (Pilot)
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Use an Object-Specific or Global Action
in a Flow

Flow Formulas Can Resolve to
Non-Numeric Values

Date/Time Values in the Cloud Flow
Designer Include GMT Offset

Workflow

Workflow Target User Merge Fields for
Email Templates (Beta)

Default Workflow User is Notified
When Email Alerts Approach or Exceed
Limits

Flow Triggers Can Pass Previous Record
Values into SObject Variables (Pilot)

Verify Formula References to Custom
Fields in Workflow Rule Criteria and
Workflow Actions

Increased Limits for Total Rules

Approvals

Expanded Approval History Reports

Submit Records for Approval from
within the Salesforce1 App

Submit Records for Approval from a
Flow (Pilot)

Security

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Password Changes

Additional Password History Options:
Remember Up to 24 Passwords

Longer Minimum Password Length
Option

Uppercase and Lowercase Password
Complexity Option
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Minimum Password Lifetime Option

Authentication

Specify an Authorization Endpoint as a
Request Parameter

Community ID and URL Values
Included in OAuth Responses

Organization ID Allowed as a Salesforce
Identity Provider Custom Attribute

Identity Provider Logout URL
Supported for External Users of a
Community

Get Custom Permissions in the Identity
URL Response

New Conditions for Access To Multiple
Identity URLs With One Access Token

OpenID Connect Discovery Endpoint
Added

Improved Internet Explorer Browser
Compatibility for Login Features

Log in to a Custom Domain Field
Suggestions for Communities

Microsoft Authentication Provider
Support

Identity

App Launcher Available for More
Profiles

10 Identity Connect Licenses for New
Developer Edition Organizations

Administration

Force Logout On Session Timeout

More Session Types Available for User
Session Information

New Fields Available for User Session
Information

Cross-Domain Exchanges Switch to
POST Requests
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Sharing

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

User Sharing Auto-Enabled for All
Organizations

Control Manual Sharing for User
Records

External Organization-Wide Defaults
Auto-Enabled for All Organizations

Asynchronous Parallel Recalculation of
Sharing Rules (Generally Available)

Globalization

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Language Additions and Changes

Additional Globalization Changes

Critical Updates

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Governor Limits Enforced on All Flows

Enhanced Session ID Management for
Visualforce
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Other Changes in Customization

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Link to Success Community Site in
Force.com App Menu

Twitter Component Added by Default
onto Page Layouts

Permission Sets and Enhanced Profile
User Interface: Users Section Added to
System Permissions

Increased Maximum Length for Long
Text and Rich Text Fields (available
within 24 hours after the Summer ’14
release)

Increased Maximum Number of
Relationship Fields (available within 24
hours after the Summer ’14 release)

Increased Validation for Custom Web
Tabs

Support for Compound Address Fields
in the DISTANCE() Formula Function

Support for Compound Address Fields
in Custom Geolocation Indexes
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Force.com Development
Sandboxes
Change Sets and Deployment
Force.com Canvas
Developer Console
Visualforce
Apex Code
API
ISVforce

Sandboxes

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Packaged Connected Apps Copied to
Sandboxes

Match Production Licenses to Sandbox
without a Refresh

Change Sets and Deployment

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Entitlement Types Available in Change
Sets

Territory Account Access Included in
Change Sets

Change Sets Included in the Deployment
Status Page

Force.com Migration Tool Support for
rollbackOnError
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Force.com Canvas

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

entityFields Attribute Added to
<apex:canvasApp>

SDK Object and Field Changes

Orientation Event for Handling
Mobile Device Orientation

Canvas Apps in a Page Layout or a
Mobile Card

Custom Icon Support in the Salesforce1
Navigation Menu

Request a Signed Request On Demand

Signed Request Canvas Apps Can Be
User-Approved

SAML Single Sign-On for Canvas Apps

Custom App Lifecycle

Developer Console

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Search and Edit Files with the Edit
Menu

Find Files By Name

Speed Up Queries with the Query Plan
Tool

View Color-Coded Logging Expiration
Data
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Visualforce

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Visualforce Development

Improvements to Remote Objects
(Developer Preview)

API Versioning for sforce.one
Functions

Deferred Creation of Dynamic
Components

Other Changes in Visualforce

renderStyle Attribute Added to
topics:widget

<apex:lineSeries> markerFill
and fillColor Attributes Default to
strokeColor

Consolidated Inclusion of Salesforce
CSS and JavaScript Resources

Enhanced Session ID Management for
Visualforce

Apex Code

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Describe Limits Removed

Script Statement Limits Methods
Removed

Create Price Book Entries in Apex Tests

Submit More Batch Jobs with Apex Flex
Queue (Pilot)

Run Future Methods with Higher Limits
(Pilot)

New and Changed Apex Classes

Chatter in Apex (ConnectApi)
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API

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Developer Edition Changes

New and Changed Objects

APIs

REST API

SOAP API

Chatter REST API

Bulk API

Tooling API

Metadata API

Salesforce Console API (Integration
Toolkit)

Open CTI API

Analytics Dashboards API

ISVforce

Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

New Partner Community

Simplified Package Installer

Usage Metrics (Generally Available)

Usage Metrics Visualization

License Management App (LMA)
Supports Sandbox Installations

Assign Package Licenses Using the API

Create Partner Organizations in the
Environment Hub
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Contact
salesforce.com to

enable

Requires
administrator

setup

Enabled for
administrators/

developersVisible to usersFeature

Package Mobile Connected Apps
(Generally Available)
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General Enhancements
General enhancements affect many users.

Updates to Browsers

We’ve made some changes to the way Salesforce works with browsers.

Attach Larger Files, Up to 25 MB, to Objects

We’ve increased the size limit for attachments to objects from 5 MB to 25 MB. Collaborate more easily with larger attachments
to cases, accounts, orders, and other objects.

Receive Incoming Emails of up to 25 MB

We’ve increased the size limit for incoming email messages from 10 MB to 25 MB, making it more likely that you’ll receive
even long messages with multiple attachments in their entirety.

Salesforce Notification Banner

The Salesforce Banner is an announcement banner that appears on some pages.

Improved Previews for Microsoft PowerPoint® (.pptx) Presentations

We’ve enhanced the technology used to preview PowerPoint® files inside the browser. Users now enjoy presentations rendered
with noticeably higher quality.

Orders Included in Data Storage Limits

Orders (but not order products) now count against the data storage limits of your organization.

Separate Database.com Documentation Discontinued

The Database.com documentation set has been replaced by the standard Salesforce documentation.

Updates to Translated Terminology

We’ve updated some terminology, including tab and field names for our Dutch, French, Hebrew, Hungarian, Russian,
Spanish, and Turkish language users. For each term, we provide the English version and the corresponding previous and
new translations.

Middle Name and Suffix Fields Available for Person Objects (Beta)

We’ve added the Middle Name and Suffix fields to person objects so that you can better represent the name of a person
who’s associated with a record. Using these fields also helps to avoid confusion when two records have the same first and last
names.

Increased App Limits with Expansion Pack and Unlimited Apps Pack

Get Expansion Pack for Professional Edition or Unlimited Apps Pack for Enterprise Edition to add and use more custom
apps in your organization.

Updates to Browsers
We’ve made some changes to the way Salesforce works with browsers.

While we haven’t made any changes to our browser support for the full Salesforce site, we have made improvements to our
browser and device support for the Salesforce1 mobile browser app.
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Currently Supported Browsers (full Salesforce site)

CommentsBrowser

If you use Internet Explorer, we recommend using the latest version that
Salesforce supports. Apply all Microsoft software updates. Note these
restrictions.

Microsoft® Internet Explorer® versions 7, 8,
9, 10, and 11

• The full Salesforce site is not supported in Internet Explorer on
touch-enabled devices for Windows.

• The HTML solution editor in Internet Explorer 11 is not supported in
Salesforce Knowledge.

• The Compatibility View feature in Internet Explorer isn’t supported.
• The Metro version of Internet Explorer 10 isn’t supported.
• Internet Explorer 6 and 7 aren’t supported for login hints for multiple

accounts.
• Internet Explorer 7 and 8 aren’t supported for the Developer Console or

the Data Import Wizard.
• Internet Explorer 7 isn’t supported for Open CTI.
• Internet Explorer 7 and 11 aren’t supported for Salesforce CRM Call

Center built with CTI Toolkit version 4.0 or higher.
• Internet Explorer 7 isn’t supported for Force.com Canvas.
• Internet Explorer 7 isn’t supported for Salesforce console features that

require more advanced browser performance and recent Web technologies.
The console features not available in Internet Explorer 7 include:

◊ The Most Recent Tabs component
◊ Multiple custom console components on sidebars
◊ Multi-monitor components
◊ The resizable highlights panel
◊ The full-width feed option on feed-based page layouts

• Internet Explorer 7 and 8 aren’t supported for Community Templates for
Self-Service.

• Community Templates for Self-Service supports Internet Explorer 9 and
above for desktop users and Internet Explorer 11 and above for mobile
users.

For configuration recommendations, see “Configuring Internet Explorer” in
the Salesforce Help.

Salesforce.com makes every effort to test and support the most recent version
of Firefox.

Mozilla® Firefox®, most recent stable version

• Mozilla Firefox is supported for desktop users only for Community
Templates for Self-Service.

For configuration recommendations, see “Configuring Firefox” in the
Salesforce Help.

Google Chrome applies updates automatically; salesforce.com makes every
effort to test and support the most recent version. There are no configuration

Google Chrome™, most recent stable version

recommendations for Chrome. Chrome isn’t supported for the Console tab
or the Add Google Doc to Salesforce browser button.

There are no configuration recommendations for Safari. Apple Safari on iOS
isn’t supported for the full Salesforce site.

Apple® Safari® versions 5.x and 6.x on Mac
OS X

• Safari isn’t supported for the Salesforce console.

25

Updates to BrowsersGeneral Enhancements



CommentsBrowser

• Safari isn’t supported for Salesforce CRM Call Center built with CTI
Toolkit versions below 4.0.

For more information about our browser policy, see “Supported Browsers” in the Salesforce Help.

Attach Larger Files, Up to 25 MB, to Objects
We’ve increased the size limit for attachments to objects from 5 MB to 25 MB. Collaborate more easily with larger attachments
to cases, accounts, orders, and other objects.

Attachment limits in Salesforce Knowledge remain unchanged.

Receive Incoming Emails of up to 25 MB
We’ve increased the size limit for incoming email messages from 10 MB to 25 MB, making it more likely that you’ll receive
even long messages with multiple attachments in their entirety.

The 25 MB per message limit applies to the entire message: the headers, the body, all attachments, and the encoding. This
limit increase applies to all incoming email messages, including those that come in through Email to Salesforce, Email to
Chatter, and On-Demand Email-to-Case.

Salesforce Notification Banner
The Salesforce Banner is an announcement banner that appears on some pages.

In Summer ’14, the Salesforce Notification Banner will appear on all pages for accounts, contacts, and dashboards, and in the
setup area for your organization.

Your users can dismiss the banner from all pages by clicking , or you can disable the banner for your entire organization.

Disable the Salesforce Notification Banner

Easily remove the Salesforce Notification Banner for all users in your organization.

Disable the Salesforce Notification Banner
Easily remove the Salesforce Notification Banner for all users in your organization.

Available in: All Editions
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User Permissions Needed

“Customize Application"To disable the Salesforce Notification Banner:

The Salesforce Notification Banner is automatically enabled if your organization accepts auto-enabled features in Summer
’14, unless Salesforce1 is disabled for your entire organization. You can dismiss the banner from all pages for all users in the
organization for the Summer ’14 release.

1. From Setup, click Customize > User Interface.
2. Deselect Enable Salesforce Notification Banner.
3. Click Save.

Improved Previews for Microsoft PowerPoint® (.pptx)
Presentations

We’ve enhanced the technology used to preview PowerPoint® files inside the browser. Users now enjoy presentations rendered
with noticeably higher quality.

Available in: All editions

Figure 1: Before

27

Improved Previews for Microsoft PowerPoint® (.pptx)
Presentations

General Enhancements



Figure 2: After

Orders Included in Data Storage Limits
Orders (but not order products) now count against the data storage limits of your organization.

For data storage, Contact Manager, Group, Professional, Enterprise, Performance, and Unlimited Editions are allocated either
1 GB or a per-user limit, whichever is greater.

Separate Database.com Documentation Discontinued
The Database.com documentation set has been replaced by the standard Salesforce documentation.

Starting in Summer ’14, Database.com refers to the Salesforce documentation, with a list of features that Database.com
supports. You can use this list to identify the subjects in the Salesforce documentation that apply to Database.com. This means
that instead of referring to Database.com-specific documentation, you use the Salesforce online help, release notes, workbooks,
and developer guides for APIs, Apex, SOQL, and SOSL.

The following Database.com developer guides are no longer available. Use the Salesforce equivalent guides along with the
Database.com features list instead.

• Object Reference for Database.com

• Database.com Apex Code Developer’s Guide

• Database.com SOQL and SOSL Reference

• Database.com Bulk API Developer’s Guide

• Database.com Metadata API Developer’s Guide

• Database.com REST API Developer’s Guide

• Database.com Streaming API Developer’s Guide

• Database.com Chatter REST API Developer’s Guide

• SOAP API Developer’s Guide
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This is the list of Database.com features.

Administration

• Audit Trail

• Company Information

• Delegated Administrator and Login As

• Enhanced Profile Management

• Field-Level Security

• Login History

• Mass Transfers

• New Profile UI

• Permission Sets

• Profiles

Apex (Libraries are available only for features supported in Database.com.)

API

• API Clients

• Bulk API

• Data Loader

• Metadata API

• Chatter REST API

• Web Services API Data Replication

• Web Services API Reads

• Web Services API Writes

Application Lifecycle Management

• Change Sets

Chatter

• Ability to stop following records that you own in Chatter

• At Mentions (API only)

• Chatter Activity and Influence

• Customize Chatter settings

• Feed Tracking

• Feeds

• Files (API only)

• Group Layouts

• Group Trigger and Group Member Triggers

• Groups

• Hashtags and Topics

• Publisher Actions

• Rich Link Previews in Feed

• Triggers for Feed Comments and Feed Items

Content

Custom Settings
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Customer Domains

Data

• Ability to mass transfer records of custom objects

• Data Loader

Declarative App Builder and Custom Schema

Custom Objects and Fields

• Customforce

• Formula Fields

• Rich Text Area

• Roll-up Summary Fields

• Validation Rules

Developer Tools

• Force.com IDE

Divisions

Enhanced Profile User Interface

• Enabling

• Field Level Security

• Field/Object Perms

• Object and Tab settings – Objects only

• Search

• System Perms

• Viewing and editing app perms

• Viewing and editing Login Hours

• Viewing and editing Login IP Ranges

• Viewing and editing Service Provider Access

• Viewing Profile Lists

Field Accessibility (for custom objects)

Field Dependency Matrix

Fileforce

Localization and Globalization

• Multi-Currency

• Timezones

My Personal Information

• Change My Password

• Editing personal information

• Granting Login Access (Send Activation Link button)

Offline

• Force.com Flex Desktop applications

• Force.com Flex Web applications
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Permission Sets

• Ability to search permissions

• Viewing, Editing, and Creating

Profile List Views

• Creating

• Editing

Restricting Logins

• Hours and IP Ranges on Profiles

Sandbox

• Developer SandboxSandbox (for an additional fee)

• Full Copy Sandbox (for an additional fee)

• Setup Only Sandbox (for an additional fee)

Search

• Personal Tags

• Public Tags

Security

• Connected Apps (OAuth)

• Encrypted Custom Fields

• General Security

• Identity Feature

• Inbound Single Sign-On

• Password and Login Policies

• Retrieving forgotten passwords

Single Sign-On

Sharing

• Apex Managed Sharing

• Criteria Based Sharing Rules

• High Volume Portal User

• Ownership Based Sharing Rules

• Public Groups

• Queues

• Role Hierarchy

• Sharing Model and Manual Sharing

Topics

• Topic and TopicAssignment Triggers

User Setup

• Creating and editing Personal and Public Groups

• Send Activation Link
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Users

• Expiring Passwords

• Manage Users

• Managing Roles

• Monitoring User Events (logins and training)

• Resetting Passwords

• Role Fields

• Role List page

• Set Up Password Expiration

• Setting Login Restrictions

Viewing the Public Group Related List

Weekly Export

Workflow

• Outbound messages (as both immediate and time-dependent actions)

• Time-Based Workflow (Workflow Queue)

• Workflow Field Updates and Outbound Messages

• Workflow rules

Updates to Translated Terminology
We’ve updated some terminology, including tab and field names for our Dutch, French, Hebrew, Hungarian, Russian, Spanish,
and Turkish language users. For each term, we provide the English version and the corresponding previous and new translations.

You can find the complete list of term changes in knowledge article number 000193875 (URL:
https://help.salesforce.com/apex/HTViewSolution?urlname=Summer-14-Updates-to-Translated-Terminology&language=en_US)
on the salesforce.com Customer Support site.

These terminology changes are available to all organizations. To keep your current tab and field labels, system administrators
can change the name back using our rename tabs and labels functionality. For more information, see “Renaming Tab and
Field Labels” and “Considerations for Renaming Tab and Field Labels” in the Salesforce Help or contact Customer Support.

For more information about supported languages, see “What languages does Salesforce support?” in the Salesforce Help.

Middle Name and Suffix Fields Available for Person Objects
(Beta)

We’ve added the Middle Name and Suffix fields to person objects so that you can better represent the name of a person
who’s associated with a record. Using these fields also helps to avoid confusion when two records have the same first and last
names.

Available in: All Editions

User Permissions Needed

“Customize Application”To show the Middle Name and Suffix fields:
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Note:

This release contains a beta version of the Middle Name and Suffix fields that has known limitations.

The Middle Name and Suffix fields are available for the following person objects: Contact, Lead, Person Account, and
User.

To show these new fields, you need to do a few things.

1. Contact salesforce.com Customer Support to enable the new fields.
2. Click Setup > Customize > User Interface.
3. In the Name Settings section, select Enable Middle Names for Person Names and Enable Name Suffixes

for Person Names.
4. Click Save.

The values of the Middle Name and Suffix fields appear in most places where a person’s full name is displayed with the
following exceptions.

• Activities, including new events, new tasks, and shared activity lookup search results
• Calendar, including meeting invitations and the Scheduled Meetings section on the Home tab
• Campaigns, including Campaign Member lists
• Chatter
• Cloud Scheduler
• Data.com records
• Forecasts, including the Collaborative Forecasting page
• Opportunities, including opportunity stage history, the Opportunity Sharing Detail page, and the Opportunity Split Edit

page
• Price Books, including price book history
• Recycle Bin
• Search results for users

Increased App Limits with Expansion Pack and Unlimited
Apps Pack

Get Expansion Pack for Professional Edition or Unlimited Apps Pack for Enterprise Edition to add and use more custom
apps in your organization.

Available in: Professional and Enterprise Editions

Expansion Pack Available for Professional Edition
You can purchase Expansion Pack units for your Professional Edition organization to increase app, tab, and object limits.
Each Expansion Pack unit corresponds to a user license in your organization.

The following table shows the limits that are upgraded by Expansion Pack.

Professional Edition + Expansion PackProfessional EditionFeature

155Custom Apps

2510Custom Tabs

20050Custom Objects
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Unlimited Apps Pack Available for Enterprise Edition
You can purchase Unlimited Apps Pack units for your Enterprise Edition organization to increase app, tab, and object limits,
as well as the maximum number of API calls and data storage capacity. Each Unlimited Apps Pack unit corresponds to a user
license in your organization.

The following table shows the limits that are upgraded by Unlimited Apps Pack.

Enterprise Edition + Unlimited Apps
Pack

Enterprise EditionFeature

Unlimited (9,999)10Custom Apps

Unlimited (9,999)25Custom Tabs

2,000200Custom Objects

Current limit + 4,000 callsDepends on the license type. See the
Salesforce Help.

API Calls

120 MB per user or 1 GB per
organization, whichever is greater

20 MB per user or 1 GB per
organization, whichever is greater

Data Storage

Adding Pack Units
Expansion and Unlimited Apps Pack units are available for Sales Cloud, Service Cloud, Force.com, and Site.com-Only users.
An organization can be upgraded only once with Expansion Pack or Unlimited Apps Pack. If your organization needs higher
app limits than what the pack provides, we recommend that you upgrade your organization’s edition. To add Expansion Pack
or Unlimited Apps Pack units, contact your salesforce.com representative.

Note:  Custom apps, tabs, and objects that are contained in a managed package that’s publicly posted on the
AppExchange don’t count toward the limits for your Salesforce edition.
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Mobile
Not in the office? No worries! Salesforce mobile apps help you stay productive no matter where you are.

Salesforce1

Users can stay up to date on their most important records, activities, conversations, and dashboards while out of the office.

SalesforceA

Salesforce administrators can manage users and view information for Salesforce organizations from mobile devices.

End of Support for Chatter Mobile for BlackBerry and Salesforce Classic for BlackBerry

In case you missed the announcement last release, the Chatter Mobile for Blackberry and Salesforce Classic for Blackberry
apps are no longer supported effective Summer ’14. This is because the BlackBerry OS platform on which these apps run is
nearing the end of its lifecycle and the new BlackBerry 10 platform doesn’t support these apps. Both of these apps will remain
fully functional until they are officially deprecated.

Configure Push Notifications for Your Salesforce Mobile SDK Connected Apps (Generally Available)

We’ve expanded connected app settings to support mobile push notifications. With these mobile app settings, developers of
Salesforce Mobile SDK connected apps can configure their users’ mobile devices to receive push notifications from Salesforce.

Package Mobile Connected Apps (Generally Available)

Mobile packaging is now available to all customers for free. Mobile packaging solves the app distribution problem for
customers building mobile apps on the Salesforce platform, by providing an easy mechanism for distributing those apps to
employees or partners.

Salesforce1
Users can stay up to date on their most important records, activities, conversations, and dashboards while out of the office.

Available in: All editions except Database.com

Access the Salesforce1 App

There are several options for accessing Salesforce1 on mobile devices.

Salesforce1 Enhancements

Our latest round of new and improved Salesforce1 features further expands the utility of the downloadable and mobile browser
apps, making it even easier to access Salesforce on the go.

Salesforce1 Differences from the Full Salesforce Site

The Salesforce1 app doesn’t have all of the functionality of the full Salesforce site, and in some cases includes features that
aren’t available in the full site.

Salesforce1 App Development Overview

There are several Force.com platform enhancements that support Salesforce1 development.
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Access the Salesforce1 App
There are several options for accessing Salesforce1 on mobile devices.

• Install the Salesforce1 downloadable app on Android ™ and Apple® mobile devices. Users can download the app from the
App Store or Google Play™.

• Access the Salesforce1 mobile browser app from a supported mobile browser on Android, Apple, and BlackBerry Z10
devices. This option doesn’t require anything to be installed.

Salesforce1 Enhancements
Our latest round of new and improved Salesforce1 features further expands the utility of the downloadable and mobile browser
apps, making it even easier to access Salesforce on the go.

Note:  Use of the Salesforce1 app is supported for all editions (except Database.com Edition) without any additional
licenses. The Salesforce data and features that are available in Salesforce1, however, are determined by your
organization’s Salesforce edition and licenses and by a user’s assigned profile and permission sets.

Setup
Menu in
Full Site

Mobile
Browser

App

iOS
Downloadable

App

Android
Downloadable

App
Salesforce1 Enhancement

New Device and Browser Support

The Salesforce1 mobile browser app is now supported in
BlackBerry® Browser on BlackBerry Z10 mobile devices and in the
Good Access™ secure mobile browser.

Available Data and Navigation Enhancements

Access Salesforce Knowledge Articles.

Access Work.com Coaching and Goals.

Access Work.com Skills.

Access the Campaign Members related list.

Access more of your organization’s custom objects from the
Salesforce1 navigation menu and in search results.

Access up to 200 list views for an object.

Sort list views to locate data more easily.

Publisher and Publisher Actions Enhancements

Use the publisher and publisher actions in Salesforce1 even if
Chatter is turned off.

Salesforce Communities Enhancements

Access Flexible Pages in Communities. When viewed in Salesforce1,
these pages show up as tabs in the community.
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Setup
Menu in
Full Site

Mobile
Browser

App

iOS
Downloadable

App

Android
Downloadable

App
Salesforce1 Enhancement

Chatter Enhancements

(As of version
5.1)

(As of version
5.1)

Search for information, such as feed posts, comments, hashtag
topics, mentions, and files, in the main feed.

View and follow feed entries organized by topic.

Tap on hashtags (#) in feed posts to navigate to related topics.

Ask questions and get answers in the feed.

Integrate Salesforce or third-party systems into the feed using action
links (available through a pilot program). An action link is a URL
on a post that links to an API, Web page, or file.

Open Chatter email notification and digest links directly in
Salesforce1 when viewing email on mobile devices.

Edit user profile details.

(As of version
5.1)

Change the user profile picture.

(As of version
5.2)

See a user’s manager, peers, and direct reports.

Quickly identify group announcements in feeds by the new flag
icon. (In the downloadable apps, this icon displays in the group
feed but not the main feed.)

(As of version
5.0)

(As of version
5.0)

Access Salesforce Files from the Salesforce1 mobile browser app.

(As of version
5.0)

(As of version
5.0)

See more details about Salesforce Files directly from Files list views.

(As of version
5.0)

(As of version
5.0)

Share Salesforce Files, content links, and Google docs in the feed.

Approvals Enhancements

Submit records for approval.

37

Salesforce1 EnhancementsMobile



Setup
Menu in
Full Site

Mobile
Browser

App

iOS
Downloadable

App

Android
Downloadable

App
Salesforce1 Enhancement

Activities Enhancements

Access Salesforce events from the Salesforce1 navigation menu.

Navigate task lists more easily and receive better feedback when
delegating or closing tasks.

Today Enhancements

Log mobile calendar events in Salesforce.

Add new contacts to Salesforce from mobile calendar events.

Access related account records directly from mobile calendar events.

Join conference calls more easily with the improved conference call
dialer.

See the day’s weather forecast.

Scan and absorb important details about the day’s schedule more
easily with the streamlined Today interface.

Analytics Enhancements

Drill down to reports from dashboard components.

Drill down to see the record that report data is coming from.

Sort data in reports.

View Visualforce dashboard components in dashboards.

Customer Service Tools Enhancements

Add a simple version of the Case Feed Email action to Salesforce1.

(As of version
5.2)

(As of version
5.3)

Track cases and respond to Twitter Tweets in real time.

Notifications Enhancements

(As of version
5.2)

(As of version
5.2)

Users can now receive notifications if they’re assigned to tasks.

(As of version
5.2)

(As of version
5.2)

Users can decide for themselves which push notification types they
want to receive.

Page Layout Enhancements

Customize the user profile page layout specifically for Salesforce1.
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Full Site

Mobile
Browser

App

iOS
Downloadable

App

Android
Downloadable

App
Salesforce1 Enhancement

The Twitter component is now automatically added to the Mobile
Cards section of the accounts, contacts, and leads page layouts. This
applies to all organizations created after Spring ’14.

Include canvas apps in Salesforce1 by adding them to the Mobile
Cards section on standard or custom object page layouts.

More Browser and Device Support for the Salesforce1 Mobile Browser
App

Giving your users more options for working on the go, we’ve expanded the number of mobile browser/mobile device pairings
in which the Salesforce1 mobile browser app is officially supported.

If the Salesforce1 mobile browser app is enabled for your organization, users are automatically redirected to the mobile browser
app when logging in to Salesforce from these environments:

• BlackBerry® Browser on BlackBerry Z10 devices with BlackBerry OS 10.2 or later. (Salesforce1 isn’t supported on BlackBerry
Q10 devices.)

• Good Access™ secure mobile browser on Android™ phones with Android 4.2 or later and on Apple® mobile devices with
iOS 7 or later.

More Salesforce Data Supported
The Salesforce1 app includes more Salesforce data, including: Campaign Members, Salesforce Knowledge articles, and
Work.com Coaching, Goals, and Skills. Unless otherwise noted, these objects are supported in all versions of the Salesforce1
app.

Campaign Members

This related list is now available on Campaigns.

When viewing campaign members in Salesforce1, only the members’ Status appears. To see more details about members,
tap on a row.

Salesforce Knowledge Articles

This object is supported in the Salesforce1 mobile browser app only.

The Articles item is automatically included in the Recent section of the Salesforce1 navigation menu as part of the Smart
Search Items element. Users may need to tap Show More to see the item. See “Customize the Salesforce1 Navigation
Menu” in the Salesforce Help for information about how the navigation menu is populated.

Users can view recently accessed articles, use search to locate any article, and access articles attached to a case.

When viewing articles, information such as the Chatter feed, the publisher, and related lists is also included.

Work.com Coaching, Goals, and Skills

Coaching is available from the Salesforce1 navigation menu. Users can add new coaching relationships but editing
existing relationships isn’t available in this release.
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Goals is available from the Salesforce1 navigation menu and on user records. Users can view details about existing goals
but can’t add new goals or edit goals.

Skills is supported in the Salesforce1 mobile browser app and the Salesforce1 downloadable app for Android devices.
User profiles have a User Skills card that makes it easy to see all the skills a person has. You can also drill in further to
see endorsements on those skills.

These Work.com objects are automatically included in the Recent section of the Salesforce1 navigation menu as part of
the Smart Search Items element. Users may need to tap Show More to see the item. See “Customize the Salesforce1
Navigation Menu” in the Salesforce Help for information about populating the navigation menu.

Access More Custom Objects
The Salesforce1 app now supports any custom object that has a tab in the full Salesforce site. In previous releases, users could
only access custom objects that were included in a Salesforce app.

As long as a custom object is associated with a user-accessible tab, it’s included in the Salesforce1 navigation menu and in
search results in Salesforce1.

See More List Views
Salesforce1 users can now see up to 200 of their list views for an object, not just their four most recently accessed lists.

When looking at a specific list view, tap  to display up to 200 of the most recently accessed list views that are available for
the object.

Tap a list view name to open that list. Or, tap  to return to the previous list view.

Sort List Views
Locate data in list views faster by controlling how information is sorted and displayed. This option is available in the Salesforce1
mobile browser app only.
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On a list view, tap  to see the sort options. Tap the column name by which to sort. Tap the column name again to alternate
between sorting in an ascending and descending order. Tap Apply to sort the list view.

Access Publisher Actions without Chatter Enabled

Publisher actions available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer
Editions

Salesforce1 users can now take advantage of all the robust functionality that the publisher and publisher actions provide even
if your organization has decided to turn off Chatter. This enhancement is available in the Salesforce1 mobile browser app
only.

For more information, see Actions on page 183.

Search Within a Feed
Now Salesforce1 mobile browser app users can search the main feed to find specific information. This feature has been available
in the downloadable apps as of version 5.1.

Search in the feed locates information within the main feed’s posts, comments, hashtag topics, mentions, and files. The search
box displays at the top of the feed—unlike in the downloadable apps, users don’t need to pull down on the feed to reveal the
search box.
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View Topics
In the Salesforce1 mobile browser app, users can now view feed posts organized by topic.

The Topics item is automatically available from the Recent section of the Salesforce1 navigation menu as part of the Smart
Search Items element. (See “Customize the Salesforce1 Navigation Menu” in the Salesforce Help for information about how
the navigation menu is populated.) Users may need to tap Show More in the navigation menu to see Topics. This item displays
a list of recent topics.

To access the topics assigned to a particular feed post, tap any topic name below the post.

Note:  Topics appear in global search results in Salesforce1 only if the user accesses the Topics item frequently or
pins Topics to search results in the full Salesforce site.

Ask Questions and Get Answers with Chatter Questions (Beta)

Chatter Questions available in: Personal, Group, Professional. Developer, Performance, Enterprise and Unlimited
Editions.
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The Salesforce1 mobile browser app now includes Chatter Questions, so users can ask questions in the feed, in groups, and
in records.

To ask a question in Salesforce1, tap , then select the Question ( ) action.

After a question is asked, the person who asked the question and moderators can select a best answer—which is prominently
displayed in the feed—allowing other users to quickly and easily find the best response to their question.

See Ask Questions in the Feed with Chatter Questions (Beta) on page 82 for more details about Chatter Questions.

Open Chatter Email Notification or Digest Links in Salesforce1
Links in Chatter email notifications or digests have been enhanced so they automatically open in the Salesforce1 app (instead
of the full Salesforce site) when the user is working on a mobile device. Links also include data that Salesforce1 uses to correctly
switch the user to the correct organization or community. These improvements keep users in the interface that’s optimized
for working on the go and eliminate the need to manually switch to the correct Community or internal organization.

Note: Currently, Communities are supported in the Salesforce1 mobile browser app only.

Edit Profile Details
Users can now update their profile details using the Salesforce1 mobile browser app or the Salesforce1 downloadable app for
Android devices. Update profile details such as name, title, and contact information by tapping the Edit button on the detail
page of user records. Users can edit their own profiles. Administrators can edit the profiles of others if they have the proper
permissions.

Users can’t edit their profile details in the Salesforce1 downloadable app for iOS devices. But this version of Salesforce1 allows
users to change their profile photos. When viewing the user record, tap the photo in the highlights area then tap Edit Profile
Photo.
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View Team Members and Managers
Want to quickly see someone’s manager, peers, and direct reports? The new Team related list is now available on user records
when viewed in the Salesforce1 mobile browser app or the Salesforce1 downloadable app for Android devices. The information
in this related list is pulled from manager hierarchy data, so manager fields for users must be populated to see this feature.

Similarly, the Salesforce1 downloadable app for iOS devices displays the new Direct Reports related list on user records. This
related list shows a person’s direct reports only.
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Access Salesforce Files in the Salesforce1 Mobile Browser App

Files available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

Now users can access, share, and collaborate on their in the Salesforce1 mobile browser app, as well as the Salesforce1
downloadable apps.

The Files item is automatically included in the Recent section of the Salesforce1 navigation menu as part of the Smart Search
Items element. Users may need to tap Show More to see the item. See “Customize the Salesforce1 Navigation Menu” in the
Salesforce Help for information about how the navigation menu is populated.

View Information about Salesforce Files

Files available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

When browsing Files list views in the Salesforce1 mobile browser app, users now see key details about each file, including the

file owner, the date the file was created, file size, file type, and a file preview. To see the record details for a file, tap . Tap
the file’s name to open the actual file.
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These details have been available in the Salesforce1 downloadable apps as of version 5.0.

Share Salesforce Files, Content Links, and Google Docs

Files available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

Salesforce1 mobile browser app users can share files from the full Salesforce site, even if the files aren’t stored on their mobile
devices. This option has been available in the downloadable apps since version 5.0.

Post Salesforce Files, content links, and Google Docs to the feed by tapping  then selecting the  File ( ) action. Tap
Select a file from Salesforce then choose an option from the list, including a file from the full site, a content link, or a Google
Doc.
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Submit Records for Approval

Approvals are available in: Enterprise, Performance, Unlimited, and Developer Editions, and for an additional cost in:
Professional Edition

Users can now submit records for approval from the Salesforce1 app. The app displays the Submit for Approval button in
record detail pages for objects with:

• Active approval processes

• Page layouts that include the Submit for Approval button

Note, however, that users can’t manually select approvers in Salesforce1. For approval processes that require manual selection,
the submitter needs to log in to the full Salesforce site to submit a record for approval.

Quickly Access Salesforce Events
Sales reps and sales managers who use Salesforce events to track and log activities can now easily access their events from the
Salesforce1 navigation menu (instead of having to tap through to activities related lists on different objects).

Events are included in the navigation menu by default.  Administrators can customize the location where the Events item
displays in the navigation menu—from Setup, click Mobile Administration > Mobile Navigation.

Selecting Events displays the My Events list, which shows the user’s current and future Salesforce events.  With the exception
of multiday events that haven’t concluded yet, past events aren’t available.

Notes about the My Events list:

• The list displays events that are owned by the user, that the user created for him- or herself, and that the user (or a user’s
groups) are invited to. Events that are available to a user through your organization’s role hierarchy settings aren’t displayed,
nor are proposed events.
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• Initially up to 15 events are displayed in the list; to see more events, pull up at the bottom of the list.

• Events in the list are sorted by start time.  All-day events are displayed at the top of the list.

• Each event in the list shows either the date and time of the event or “All-Day Event,” and up to four information fields.
 These fields are determined by the Event compact layout that’s in effect for the specific event. See the Salesforce Help to
learn more about compact layouts.

• When browsing the list, it doesn’t automatically update to show new, edited, and deleted events. Pull down on the list to
refresh it.

• Users can’t create new events from the list.  However, the New Event publisher action allows users to add new events from
a feed or a record view.  This action is automatically included in the publisher’s global layout for organizations that are
new as of Summer ’14—see Default Event Action Lets Users Create Events from Any Publisher on page 183.

Salesforce events aren’t currently available in the Today app.

Navigate Task Lists More Easily
Now when a user saves a task, the Salesforce1 app displays the last viewed task list instead of the saved task record. Salesforce1
also now provides more confirmation messages about changes that users make. Finally, new and edited tasks appear in lists
immediately after a user saves—a user no longer needs to tap Refresh.

When a user creates a task while looking at a task list and then saves the task, the Salesforce1 app displays the task list again,
with the new task included.

If a task is displayed in a different list as a result of an edit, the Salesforce1 app now displays a message. For example, after a
user closes a task while viewing the My Tasks list, a message now confirms that the task appears in a different list (Closed
tasks).

After a user reassigns a task to a user with different permissions, a message indicates that the user no longer has access to the
task.

Log Mobile Calendar Events in Salesforce Using Today
Today displays events that are scheduled on users’ mobile calendars. Now Today makes it fast and easy to log these events in
Salesforce. This option is especially helpful if your organization requires sales reps to track customer interactions through
Salesforce events.

The option to log a mobile calendar event in Salesforce is now available for every event in the Today event list, allowing users
to record each meeting as soon as it ends while all the details are still fresh.  The process takes just a few seconds because
Today automatically fills in all of the required standard fields with data from the mobile calendar.  No more typing or
cutting-and-pasting required!

From the Today event list, tap the event’s card, then tap Log this Event. This opens the publisher page for the New Event
publisher action.  (If your organization’s global publisher layout includes multiple publisher actions for creating events, Today
uses the first action in the layout.)
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To expedite the process, Today uses data from the mobile calendar event to automatically populate these standard fields in
the new Salesforce event: Assigned To, Subject, Start, End, Location, Description, and the All-Day Event
checkbox (if applicable). The user can add other information of their own, including notes about the meeting.

Note:

If the event that is logged is one of a series of recurring events, “Recurring:” is added to the text in the Subject field.
Only the current event is logged, not the full series of events.

After the event is logged in Salesforce, the user can access the new Salesforce event record directly from the mobile calendar
event in Today.
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If changes are made to a mobile calendar event after it’s been logged in Salesforce, the corresponding Salesforce event is not
automatically updated. The user will need to update the event in Salesforce.

Add Contacts to Salesforce from Today
It’s no secret that using Salesforce to gather information about customers helps sales reps build the insights needed to forge
stronger relationships and win deals. But often the trick is finding the time to sit down and enter new customer data. Today
now makes it easy and fast for sales reps to add new contacts to Salesforce, directly from a meeting’s list of invitees.

When viewing an event in Today, the Invitees list includes avatars so users can tell at a glance which of the meeting’s participants
are already included in Salesforce as contacts, person accounts, or users, and which ones aren’t.  For any invitee showing the

unmatched ( ) avatar, simply tap on the person’s name then tap Create Contact.
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Today automatically fills in the new contact’s email address, as well as their first and last name. The user can add other
information, including the contact’s phone number.

Note:

If the invitee’s name includes more than two words (for example, John Seymour Smith), Today adds the second name
to the Last Name field. The user may need to edit this field to correct the last name (as in our example, to change
“Seymour” to “Smith”).

If the event includes only a first or last name for the invitee, Today doesn’t populate either of the name fields.

See Accounts Related to Events in Today
The CRM data that’s directly accessible from events viewed in Today now includes related accounts, so users can quickly
review important information like account details, pending opportunities, or open cases in advance of a meeting.

Related accounts are listed in the new Accounts card that’s been added to the event record view. (Users must have the “Read”
user permission on accounts to this card.)

51

Salesforce1 EnhancementsMobile



Today uses the Accounts compact layout to determine the account details that are summarized in the Accounts card. (See the
Salesforce Help to learn more about compact layouts.) Tap on an account summary to view the complete account record.

Today determines that an account is related to an event if it’s associated with a contact record that matches one of the meeting
invitees.  Person accounts aren’t included in this card.

If a meeting includes contacts from a variety of different accounts, Today lists up to three accounts, picking those that are
associated with the largest number of contacts.  To see how Today chooses the most relevant related accounts for an event,
consider a meeting that includes 10 invitees who are all contacts in Salesforce, representing five different companies:

• Three contacts from PetEdge.com

• Three contacts from Chewy, Inc.

• Two contacts from Pet Food Express

• One contact from Joe’s Pet Supply

• One contact from Petopia

The Accounts card for this event will list PetEdge.com, Chewy, Inc., and Pet Food Express because PetEdge.com and Chewy,
Inc. have three representatives each and Pet Food Express has two representatives.

Use Today to Join More Types of Conference Calls, More Quickly
The conference call dialer in Today has been improved so it’s quicker and easier to join online meetings. It’s now completely
automatic to join many Citrix® GoToMeeting® online meetings, and joining calls hosted by other conference providers,
including WebEx®, InterCall®, and Microsoft® Lync®, is much simpler. The conference call dialer now functions the same
way on Android and iOS devices.
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As in the previous release, the conference call dialer is available for an event if the mobile device supports making phone calls
and if the event includes a valid conference call dial-in number. But the other information that the dialer needs is much simpler
now. The dialer no longer requires that an event include an access code—if one isn’t present, the dialer proceeds with calling
in to the meeting and allows the user to manually enter the access code.  And Today no longer requires specific labels to detect
possible dial-in phone numbers or access codes.  These are the simplified dialer requirements:

• The conference call invitation details must be included in the Location field or the Notes section of the event.

• The dialer supports local and international phone numbers that contain between 7 and 15 digits. The phone number can
be entered in any format.

• An access code must contain a minimum of seven numbers.

The conference call dialer automates as much of the dial-in process as possible. The level of automation available depends on
the conference call provider and the details included in the event.

• It’s completely automatic to join a GoToMeeting meeting if the event includes a valid GoToMeeting URL and a single
valid dial-in phone number.

It’s also automatic to join an online meeting from any provider if the event includes a dial-in number and an access code
in this format:  <dial-in number>,,,<access code><other>, where <other> can include additional numbers, #
symbols, commas, and asterisks. The numbers must be entered on a single line and there can’t be any spaces after the first
comma.  For example:

1234567890,,,1234567#11#

In both of these cases, the user taps  in the event, then taps Call.  The dialer does everything else to connect to the
meeting.

• It’s slightly less automated to dial in to a GoToMeeting event that includes multiple phone numbers, a GoToMeeting
event that doesn’t include a meeting URL, or an event hosted by a different conference provider. Before initiating the
dial-in process, and depending on the information available in the event, the user may need to choose the dial-in phone
number, the access code, or both, from the “Choose a Phone Number” or “Choose an Access Code” lists.

After the user taps Call to start the dial-in process, Today automatically dials the selected phone number.  When the
conference provider prompts for the access code, the user taps Dial “<number>” on their mobile device and Today
automatically enters the selected code.

Note:  If Today isn’t certain about what the meeting access code is, or if the meeting doesn’t include an access
code at all, the “Choose an Access Code” list includes the Skip this Step option. If the user selects this option,
Today dials the phone number only and the user can manually enter the access code and any other required
information.

Get Weather Information in Today
Today now includes weather information.  This information helps users start the day right, from making wardrobe decisions
to better anticipating commute or travel delays.

Local weather information displays in the highlights area of the Today event list. Users see an icon representing the daytime
or nighttime weather forecast, and the forecast high and low temperature for the current location.
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To display local weather information, Today requires access to location services on the mobile device. New Today users are
prompted to grant location access (along with calendar access) when setting up Today. With Summer ’14, existing iOS users
will also be prompted to grant location access when they next access Today.

Users can control whether they view temperatures in Celsius or Fahrenheit, from the  icon on the Today event list.
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Today User Interface Improvements
The Today interface has been streamlined, making it easier to scan and absorb important details. Improvements include:

• A smaller highlights area at the top of the page so users can see more information about their actual events.

• The meeting organizer and invitees are now shown together in the Invitees card.

• The second page in the record view was removed because it didn’t include any unique information.

Drill Down from a Dashboard to a Report
Users can now drill right to a report from a dashboard. When viewing a dashboard in the Salesforce1 app, just tap a dashboard
component to see the report that’s delivering the data to the dashboard.

Dashboards available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Reports available in: All editions except Database.com

Reports can be viewed in tabular, summary, or Top N format.

Groupings in summary reports are shown as columns. Swipe right or left to see all the columns.

You can see a maximum of 100 records. To see all records, log in to the full Salesforce site.

Important:  When you drill from a dashboard to a report, you may see slightly different data in the report view from
what you saw in the dashboard view. That’s because the data displayed in a dashboard is from the last dashboard
refresh (the date and time of which are shown in the dashboard header), but drilling down to a report actually runs
the report, so you are seeing the most current report data.
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Drill Down From a Report to a Record
Tap a row in a report to see the specific record the report data is coming from.

Dashboards available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Reports available in: All editions except Database.com

Sort Data in Reports

Dashboards available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Reports available in: All editions except Database.com

Focus on the information you want by arranging data in report columns. Tap a column header to sort the report data by that
column.

When first viewed, the report is sorted the way it was sorted the last time it ran.

• Tap a column for the first time and it’s sorted smallest to largest for numerical values, or A to Z for text.

• Tap again to reverse that sort order.

• Tap a third time to remove sorting and return to the way the report was originally sorted.
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View Visualforce Dashboard Components

Dashboards available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Visualforce available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer
Editions

User Permissions Needed

“Customize Application”To create and edit Visualforce pages:

Dashboards in the Salesforce1 app are now able to display Visualforce dashboard components. But as with all Visualforce
pages, the Visualforce dashboard component must be enabled for Salesforce1 to display in the app.

To enable a Visualforce dashboard component for Salesforce1:

1. From Setup in the full Salesforce site, click Develop > Pages.
2. Click Edit for the desired Visualforce page.
3. Select Available for Salesforce mobile apps then click Save.

For more information, see Creating Visualforce Dashboard Components in the Visualforce Developer’s Guide.

Add a Simple Version of the Case Feed Email Action to Salesforce1

Case emails available in: Enterprise, Performance, Unlimited, and Developer Editions

Add the Send Email action to the publisher to give Salesforce1 users access to a simplified version of the Case Feed Email
action. They can then send case-related emails directly from the app, without having to use their mobile device’s mail program.
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Messages sent with the Send Email action are automatically associated with the case, included in the case’s feed, and added
to the Emails related list on the case.

The Send Email action is available only on Cases. You can add it to the publisher on any case page layout.

Some features that are available in the standard Email action in Case Feed aren’t available in the Send Email action in
Salesforce1.

Available in the Send Email Action in
Salesforce1

Available in Standard Case Feed Email
Action

Feature

Ability to switch between rich text and
plain text

Template support

Quick Text support

Attachments support

Ability to save messages as drafts

Inline images support

Standard header fields (To, From, CC,
BCC, Subject) available

The process of setting up the Send Email action varies depending on when your organization was created and on the features
you have enabled.
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• In organizations that had Email-to-Case enabled prior to Summer ’14, create a Send Email action from the Case Buttons,
Links, and Actions page, and then add the action to the publisher on a case page layout.

• In organizations that are created after or enable Email-to-Case after Summer ’14, once Email-to-Case is enabled, a Send
Email action is automatically created and added to the list of available actions in the page layout editor. To make the action
available to users, add it to the publisher on a case page layout.

Note:  On layouts where you can include the standard Case Feed Email action—that is, on feed-based case page
layouts if your organization has Case Feed Actions and Feed Items enabled—you can add the Send Email action to
the publisher and it will appear only in Salesforce1, not in the full Salesforce site. This helps prevent duplication—agents
won’t see two email-related actions in the publisher on case pages in the full site—and gives agents access to the more
fully featured Case Feed Email action in the full site.

For more information on creating and working with publisher actions, see the Salesforce Help.

Track Cases and Respond to Twitter Tweets in Real Time
Social Customer Service agents can quickly and easily track cases and respond to Twitter Tweets in real time with the Salesforce1
app.

Social Customer Service is available in: Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Social Objects”

AND

“Social Publisher”

AND

Case Feed enabled

AND

Social account

To send and receive social media posts or messages:

Version 5.3 of the Salesforce1 downloadable app for Android
devices

Version 5.2 of the Salesforce1 downloadable app for iOS
devices

The current release of the Salesforce1 mobile browser app

To run Social Customer Service on Salesforce1

Important:  Log a salesforce.com support ticket to enable the Social Objects and Social Publisher permissions. You
must have a Social Hub license and sufficient Radian6 managed accounts. If you are switching from the Radian6 for
Salesforce package, make note of it in your support ticket.

In Salesforce1, Social Customer Service agents can track cases and respond to tweets in real time.

From Salesforce1, agents can:

• View previous social posts associated with the case.

• Select a message type.
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• Select a social account to respond from.

• Enter and send a response.

Note:  Social Customer Service for Salesforce1 doesn’t support the Good Access™ secure mobile browser.

Receive Notifications About Task Assignments
All versions of the Salesforce1 app can now send notifications to users when they’re assigned to tasks. This notification type
is available as an in-app notification for the mobile browser app and as both an in-app and push notification for the Android
and iOS downloadable apps.

Decide Which Push Notification Types to Receive
When push notifications are enabled for your organization, Salesforce1 downloadable app users can decide for themselves
which push notification types they want to receive.

Users access the push notifications settings from the Salesforce1 navigation menu. At the bottom of the menu, tap Settings >
Push Notifications Settings. To toggle the setting for a push notification type, tap the switch. A blue background on the
switch indicates that the notification type is turned on.
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The user-configurable push notification types are:

• Mentions you

• Comments on your posts

• Posts to your profile

• Assigns you a task

• Requests your approval

Customize the Profile Layout for Salesforce1
Now you can customize the layout of user records for the Salesforce1 mobile browser app and the Salesforce1 downloadable
app for Android devices.

Edit the new User Profile Page layout to control the data that appears on user records when viewed in Salesforce1. You can
rearrange the order of fields so the most important fields display at the top of the detail page, add custom fields, include
Visualforce pages, define which related lists appear on the related information page, and more.

From Setup in the full Salesforce site, click Customize > Users > Page Layouts. Then click Edit next to the desired layout
in the User Profile Page Layouts section.

For more information about editing profile layouts, see the “Customizing Page Layouts” topic in the Salesforce Help.
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Salesforce1 Differences from the Full Salesforce Site
The Salesforce1 app doesn’t have all of the functionality of the full Salesforce site, and in some cases includes features that
aren’t available in the full site.

For complete details about which Salesforce features are different in Salesforce1, see the Salesforce Help. For features introduced
or updated in Summer ‘14, there are differences in these areas:

• Working with supported Salesforce data

• Communities

• Chatter feeds and topics

• Finding information

• Events and tasks

• Today

• Dashboards and reports

• Sending emails in Case Feed

• Chatter Questions

Differences in Working with Salesforce Data in Salesforce1
Campaigns

• When viewing the Campaign Members related list, only the status for each member appears. You can, however, tap
members to see more details about them.

Salesforce Knowledge Articles

• Articles are read-only.

• You can’t manage or attach articles to cases.

• Articles with file fields are not supported.

• In multiple language organizations, articles can be searched and viewed only in the user’s language or the default knowledge
base language if the user's language is not a supported knowledge base language.

Work.com Coaching, Goals, and Skills

In this release, you can’t:

• Edit existing coaching relationships.

• View private coaching notes.

• View goal metrics from coaching.

• Set coaching to “inactive”.

• Add new goals or edit existing goals.

• Endorse other users’ skills.

• Create custom badges.

• See the rewards/badges given or received on user records.

• Offer or request feedback.

• View custom metric fields.

• Create, fill out, or dismiss performance summaries.

• Manage performance summary cycles.
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Differences in Using Communities in Salesforce1
• The new Community Engagement Console isn’t available in Salesforce1.

• Reputation isn’t supported in Salesforce1. However, if Reputation is enabled and set up in the full site, users do accrue
points when using Salesforce1. For example, if the community manager set up a point system in the full site and assigned
point values for writing a post and commenting on a post, then users in the community earn points with every post and
comment made in Salesforce1. Users can view their points in the full site only though.

Differences in Using Chatter in Salesforce1
Feeds

• It’s now possible to search the main feed when using the Salesforce1 app. However, searching in feeds on user profiles,
records, and public or private groups isn’t available.

Topics

In this release, you can’t:

• Edit topic details (name and description)

• Tag favorite topics

• Assign topics to feed posts or records

• View records assigned to a topic

• See these related lists: Related Topics, Related Groups, Knowledgeable on Topics, Recent Files

• See topics in auto-complete options when searching

• Delete topics

Files

In the Salesforce1 Mobile Browser App:

• High-volume portal users can’t access Salesforce Files from the Salesforce1 navigation menu.

• Files shared through accounts, cases, contacts and other objects don't appear in the Recently Viewed Files list view.

Differences in Finding Information in Salesforce1
While there haven’t been any changes to how global search works in the Salesforce1 app this release, we want to clarify how
users can quickly find what they need.

Using global search in Salesforce1, a user can find records for:

• Items that an administrator has added to the Salesforce1 navigation menu

• Objects that the user sees in the Recent section of the navigation menu (with the exception of tasks and events, which
aren’t searchable). These are the user’s Smart Search Items—the objects the user has viewed or worked with recently in
the full Salesforce site

For users who are new to Salesforce and don’t yet have a history of recent objects:

• Global search includes results for the default set of objects the user sees initially in the Recent section of the navigation
menu.

• As the user works with other objects in the full Salesforce site, those objects replace the default ones in both the Recent
section and global search in Salesforce1.
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Note: It can take up to 15 days for objects they work with to appear in the Recent section. To make objects appear
under Recent sooner, they can pin them from the search results screen in the full Salesforce site.

If a option is available at the bottom of the Recent section, users can tap it to see the full list of all objects available to them
in Salesforce1. If an object isn’t yet available via global search in Salesforce1, a user can select the object from the navigation
menu and then search for records for that object using the record search box.

Differences in Tracking Your Activities in Salesforce1
Events

• If the My Events list contains all-day and time-based events, the order in which events are displayed in the list can be a
little mixed up.  Ordinarily all-day events are displayed at the top of the list but there can be cases where an all-day event
for the next day winds up interspersed with time-based events for the current day.

• Event detail pages don’t display the Recurrence or Reminder sections.

• You can’t use the Salesforce1 app to add events to Microsoft® Outlook®.

Tasks

• Group (multi-user) tasks aren’t available.

Issues Using Today
• Today uses the mobile device’s time zone setting, while Salesforce events respect the user’s Salesforce time zone setting.

If there’s a difference between these settings when a user logs a mobile calendar event from Today, the Time field in the
new Salesforce event record reflects the user’s Salesforce time zone and doesn’t match the time of the mobile calendar
event.

• Because of the way that the Android OS identifies mobile calendar events, if a user accesses Today on an Android device
to log a local event in Salesforce, then views the same event in Today on a different Android device or an iOS device, it
may look like the event wasn’t logged and it isn’t possible to access the corresponding Salesforce event from Today. The
logged event status and link is correct on the original Android device, however.

• On devices running Android 4.4, weather information is always displayed in Today, even if access to location information
is disabled. This is an Android 4.4 issue and not something that Today can control.

Differences Using Dashboards and Reports in Salesforce1
• Dashboards are read-only.

• Dynamic dashboards let you see data as yourself only.

• Chatter feeds for dashboards aren’t available, nor can you post dashboards or components to feeds.

• Filters aren’t available.

• When you view a table with groupings, the groupings are displayed as columns.

Differences Sending Emails in Case Feed using Salesforce1
There are a few differences between the Send Email action in the Salesforce1 app and the standard Email action in Case Feed.

• Users can’t switch between the rich text editor and the plain text editor in a Send Email action.

• Templates aren’t supported in the Send Email action.
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• Quick Text isn’t available in the Send Email action.

• The Send Email action doesn’t support attachments.

• Users can’t save messages as drafts when using the Send Email action.

Differences Using Chatter Questions in Salesforce1
• Similar questions and knowledge articles don’t display in the Salesforce1 app when users ask questions.

Salesforce1 App Development Overview
There are several Force.com platform enhancements that support Salesforce1 development.

• Flexible Pages

• Action Links in the Feed

• Force.com Canvas

• API Support

Flexible Pages
The flexipage:recentItems component now supports these objects, based on the specified properties.

• All custom objects
• All standard objects for which both of these conditions are true:

◊ A compact layout is defined for the object.
◊ The object is tracked in the most recently used objects list.

If an object is tracked in the most recently used objects list, either one or both of the LastViewedDate or
LastReferencedDate fields is present.

The flexipage:filterListCard component now supports all list views that are associated with standard and custom
objects except:

• Activity
• ContentVersion
• Task
• User
• UserProfile

Action Links in the Feed
Action links are available through a pilot program and only in the Salesforce1 mobile browser app. For information on enabling
action links in your organization, contact salesforce.com.

An action link is a URL on a feed item that targets an API, a Web page, or a file. An action link can also include an HTTP
method and OAuth information. Use action links to integrate Salesforce and third-party systems into the feed. For more
information, see Action Links on page 284.

Force.com Canvas
You can add a canvas app to a page layout for any standard or custom object. For more details, see Canvas Apps in a Page
Layout or a Mobile Card on page 229 and Add a Canvas App to a Page Layout on page 229.
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You can now customize the navigation menu icon for your canvas app. To customize the icon, set the Icon URL entry in the
Basic Information section of the connected app settings for your canvas app. For more information, see Custom Icon Support
in the Salesforce1 Navigation Menu on page 230.

API Support
The Force.com APIs support Salesforce1 development. Unless otherwise noted, these enhancements for Salesforce1 development
were made available in API version 31.0.

SOAP API
New call: describePrimaryCompactLayouts()—Retrieves metadata about the primary compact layout for each
of the specified object types.

REST API
New resource: Tabs—Returns a list of all tabs—including Flexible Page tabs—available to the current user, regardless
of whether the user has chosen to hide tabs via the All Tabs (+) tab customization feature.

The Compact Layouts resource has been updated to allow bulk fetching of the primary compact layout for each of a set
of objects. Up to 100 objects can be fetched in one query. For example, to get the primary compact layouts for Account,
Contact, and a custom object, the request is:

/services/data/v31.0/compactLayouts?q=Account,Contact,CustomObj__c

Tooling API
New object: FlexiPage. See Tooling API on page 301.

SalesforceA
Salesforce administrators can manage users and view information for Salesforce organizations from mobile devices.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To use SalesforceA:

Navigation Menu

The SalesforceA navigation menu provides a quick overview and easy access to all SalesforceA features.

Access Your User Record from the Home Screen

Now it's easier than ever to access your own user record. From the SalesforceA home screen, tap your user name to open the
user detail screen for your own user account.

Navigation Menu
The SalesforceA navigation menu provides a quick overview and easy access to all SalesforceA features.

To access the navigation menu, tap  in the upper-left corner of the screen. The menu contains options to:

66

SalesforceAMobile



• Search for users

• Access the Overview, Users, and Success Community pages

• View the latest release notes in HTML format

• Take a short survey to give feedback on SalesforceA

Access Your User Record from the Home Screen
Now it's easier than ever to access your own user record. From the SalesforceA home screen, tap your user name to open the
user detail screen for your own user account.

End of Support for Chatter Mobile for BlackBerry and
Salesforce Classic for BlackBerry

In case you missed the announcement last release, the Chatter Mobile for Blackberry and Salesforce Classic for Blackberry
apps are no longer supported effective Summer ’14. This is because the BlackBerry OS platform on which these apps run is
nearing the end of its lifecycle and the new BlackBerry 10 platform doesn’t support these apps. Both of these apps will remain
fully functional until they are officially deprecated.

Users who have downloaded Chatter Mobile for Blackberry or Salesforce Classic for Blackberry on their devices can continue
to use the apps. However, salesforce.com is no longer providing support in the form of bug fixes or enhancements for any

67

Access Your User Record from the Home ScreenMobile



issues that your users might encounter. Chatter Mobile for Blackberry and Salesforce Classic for Blackberry continue to be
available for download at https://downloads.salesforce.com/bb.

We encourage all customers who use these apps to migrate to the Salesforce1 app on any of its supported devices. Summer
’14 includes new BlackBerry support for the Salesforce1 mobile browser app—see More Browser and Device Support for the
Salesforce1 Mobile Browser App on page 39. To get started on Salesforce1, see the Salesforce Help.

Configure Push Notifications for Your Salesforce Mobile
SDK Connected Apps (Generally Available)

We’ve expanded connected app settings to support mobile push notifications. With these mobile app settings, developers of
Salesforce Mobile SDK connected apps can configure their users’ mobile devices to receive push notifications from Salesforce.

If you provide a native Mobile SDK app for your organization, you can use the new Mobile Push Notifications feature to alert
your users to important changes and events in your business. The Mobile Push Notifications feature supports Android and
iOS devices and requires additional configuration:

• With the mobile OS provider (Apple or Google)

• In your Mobile SDK app

• In Apex, using the new Messaging.PushNotification and Messaging.PushNotificationPayload classes

OR

With the Chatter REST API, using the new push notifications resource

In addition, we’ve provided a push notification test page. In this page, you can quickly test your push notification setup before
the feature goes live in your mobile app.

To reach the test page:

1. In Setup, go to Create > Apps.
2. Click the name of your connected app.
3. Click Send test notification next to Supported Push Platform. This link appears only if you’ve configured your connected

app to support mobile push notifications.

See the Salesforce Mobile Push Notifications Implementation Guide (available with the Summer ‘14 release) for full configuration
details. Until then, you can download the PDF file at
http://res.cloudinary.com/hy4kyit2a/image/upload/salesforce_mobile_push_notifications_implementation-2.pdf.

Note:  Push notifications for connected apps are available only for custom mobile connected apps, such as Mobile
SDK apps. This feature does not apply to Salesforce1 or SalesforceA apps.

Push Notification Limits
The maximum number of push notifications that are allowed for each mobile application associated with your Salesforce
organization depends on the type of application.

LimitMaximum number of push notifications allowed for

50,000 notifications per app
per day

Mobile applications provided by Salesforce (for example, Salesforce1)
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LimitMaximum number of push notifications allowed for

35,000 notifications per app
per day

Mobile applications developed by your organization for internal employee usage

5,000 notifications per app per
day

Mobile applications installed from the AppExchange

Only deliverable notifications count toward this limit. For example, consider the scenario where a notification is sent to 1,000
employees in your company, but 100 employees haven’t installed the mobile application yet. Only the notifications sent to the
900 employees who have installed the mobile application count toward this limit.

Each test push notification that is generated through the Test Push Notification page is limited to a single recipient. Test
push notifications count toward an application’s daily push notification limit.

You can make up to 10 push notification method calls in each Apex transaction, and send up to 2000 notifications in every
method call.

Check the Push Notification Service Type
Use the push_service_type response value in the identity URL response to check if your connected app supports push
notifications.

This response value is set to apple if the connected app is registered with Apple Push Notification Service (APNS) for iOS
push notifications, or androidGcm if it’s registered with Google Cloud Messaging (GCM) for Android push notifications.
The response value type is an array.

Package Mobile Connected Apps (Generally Available)
Mobile packaging is now available to all customers for free. Mobile packaging solves the app distribution problem for customers
building mobile apps on the Salesforce platform, by providing an easy mechanism for distributing those apps to employees or
partners.

Connected Apps can be created in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Connected Apps can be installed in: All Editions

User Permissions Needed

“Customize Application”To read:

“Customize Application” AND either

“Modify All Data” OR “Manage Connected Apps”

To create, update, or delete:

“Customize Application”To update all fields except Profiles, Permission Sets, and
Service Provider SAML Attributes:

“Customize Application” AND “Modify All Data”To update Profiles, Permission Sets, and Service Provider
SAML Attributes:

“Download AppExchange Packages”To uninstall:
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When creating a mobile connected app, you can specify a set of mobile packaging attributes, such as the platform, version,
form factor, and mobile app binary file. If you then include the mobile connected app as a component when creating a package,
these attributes are included in the package and migrated when a user moves a package from one organization to another. In
addition, after you create and package a mobile connected app, it’s instantly available for distribution via a listing in the Private
AppExchange.

Here are the steps for creating a mobile connected app.

1. From Setup, click Create > Apps.
2. In the Connected Apps section, click New.
3. Enter the relevant information in the Basic Information, API (Enable OAuth), and Web App Settings sections.
4. Enter the following information in the Mobile App Settings section.

a. Select PIN Protect, if your app supports PIN protection. This gives an administrator the option of setting the session
timeout and PIN length for mobile applications after installing the connected app. PIN protection is automatically
supported by the Salesforce Mobile SDK (http://developer.force.com/mobilesdk). You can also implement it manually
by reading the mobile_policy object from the user’s Identity URL.

b. Specify the App Platform by choosing iOS or Android from the drop-down list.
c. Specify the supported device form factor(s) for the mobile app from the Restrict to Device Type drop-down

list. The possible values are Phone, Tablet, or Mini-Tablet. If the app is universal (that is, supports all form factors),
don’t choose any value.

d. Enter the App Version number of the mobile app.
e. Enter the Minimum OS Version required for the app.
f. Select Private App to confirm this app is for internal (non-public) distribution only. This is required because Apple

doesn’t allow distribution of public mobile apps outside of its app store.
g. If the mobile app is private, specify the location of the Mobile App Binary file. This is an IPA file for iOS and an

APK file for Android.
h. For iOS apps only:

i. Specify the location of the Application Icon. This is the icon displayed during download and installation of the app
on an iOS device.

ii. Specify the iOS Bundle Identifier.

Note:  For iOS 7 and higher, you must specify the same bundle identifier that you used for developing the
app in XCode. Otherwise, the end user will see two app icons on app installation.

i. If the mobile connected app is a public app and you haven’t uploaded its binary file to Salesforce, enter the App Binary
URL here.

5. Click Save.

You can now publish your app, make further edits, or delete it.

Note:  If you remove mobile integration from a new version of an existing connected app, mobile integration is no
longer included in any version of the connected app. For example, imagine publishing a package containing version
1.0 of your connected app with mobile integration. Then remove mobile integration from the app, repackage it, and
publish it as version 1.1. If a customer installs the earlier package with version 1.0 at this point, the version 1.0
connected app will not contain mobile integration.
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Chatter
Chatter helps everyone in your organization stay connected.

Files

Simplify file management for your users with file syncing, versioning, and improved storage.

Topics

Topics help you organize feed posts and records around common themes.

Feeds

Feeds show you posts and comments you and other people make, as well as record updates across your Salesforce organization.

Other Changes in Chatter

Smaller changes can improve your experience with Chatter.

Files
Simplify file management for your users with file syncing, versioning, and improved storage.

Store, Sync, and Share with Salesforce Files Sync (Generally Available)

Salesforce Files Sync makes file management easier than ever. Your users install a desktop client called Salesforce Files. They
can then securely store, sync, and share files between Chatter, their desktops, and mobile devices.

Run File and Content Reports from the File Detail Page

See how many times a file has been downloaded, shared, liked, and commented on.

Other Changes in Files

Other changes enhance file usage and management.

Store, Sync, and Share with Salesforce Files Sync (Generally
Available)

Salesforce Files Sync makes file management easier than ever. Your users install a desktop client called Salesforce Files. They
can then securely store, sync, and share files between Chatter, their desktops, and mobile devices.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Note:  If your organization upgrades from a Contact Manager, Group, or Professional Edition to one of the editions
that support Salesforce Files Sync, contact salesforce.com to enable the feature.

Be aware of these usage limits when using the Salesforce Files Client:

• The maximum amount of data that individual users can sync in their Salesforce Files folder is 10 GB. If the folder reaches
this limit, new files won’t sync until other files are removed from the folder.

• The maximum file size that can be uploaded using the Salesforce Files folder is 500 MB.
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For more information about Salesforce Files Sync limits, refer to the Salesforce Help.

You can work with Salesforce Files Sync using the Chatter REST API. For more information, see Salesforce Files Sync
(Generally Available) on page 287.

Enable Salesforce Files Sync in Your Organization

Enable Salesforce Files Sync to allow users to sync files between their devices and Salesforce.

Grant Users Access to Salesforce Files Sync

After enabling Salesforce Files Sync, grant your users access by either creating and assigning a permission set or by granting
permission on profiles.

Changes to the Files Tab with Salesforce Files Sync Enabled

After enabling Salesforce Files Sync, you and your users will notice some changes on the Files tab in Chatter.

Install the Salesforce Files Client

Users can install the Salesforce Files client so they can sync files between their desktop, Chatter, and mobile devices.

Ways to Share Synced Files

Share synced files with people and groups on Chatter, or with anyone outside your organization via a generated link. Share
them directly from the Salesforce Files folder on your desktop, the Files tab in Chatter, or your mobile device with Salesforce1.

Share Synced Files Directly from the Salesforce Files Client

Synced files can be shared from inside the Salesforce Files folder.

Enable Salesforce Files Sync in Your Organization
Enable Salesforce Files Sync to allow users to sync files between their devices and Salesforce.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Salesforce Files Sync:

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Under File Sync, select Allow File Sync.
4. Click Save.

Salesforce Files Sync is now enabled for your organization. Next, grant your users access to Salesforce Files Sync.

Grant Users Access to Salesforce Files Sync
After enabling Salesforce Files Sync, grant your users access by either creating and assigning a permission set or by granting
permission on profiles.

User Permissions Needed

“Customize Application”To grant users access to Salesforce Files Sync:
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Grant Access to Salesforce Files Sync Using a Permission Set

Permission sets are an easy way to enable Salesforce Files Sync for users.

Enable Salesforce Files Sync for Profiles

Enable Salesforce Files Sync for all users with particular standard profiles, or for custom profiles specific to your organization.

Grant Access to Salesforce Files Sync Using a Permission Set
Permission sets are an easy way to enable Salesforce Files Sync for users.

User Permissions Needed

“Customize Application”To create a permission set:

1. From Setup, click Manage Users > Permission Sets.
2. In the top-left of the Permission Sets list view, click New.
3. Fill out the required fields.

Label

The unique label for the permission set. For example, you might call this permission set “Salesforce Files Sync
Enabled”.

API Name

The unique name used by the Force.com API.

Description

A description of this permission set. For example, “Enables Salesforce Files Sync for assigned users. Salesforce Files
Sync allows users to automatically sync files across devices.”

4. Select a user license option. If you plan to assign this permission set to users with both Salesforce and Chatter Only licenses,
select — —None- —.

5. Click Save.
The overview page for your new permission set appears.

6. Under System, click System Permissions.
7. At the top of the System Permissions list, click Edit.
8. Under System Permissions, select Sync Files.
9. Click Save.

Enable Salesforce Files Sync for Profiles
Enable Salesforce Files Sync for all users with particular standard profiles, or for custom profiles specific to your organization.

User Permissions Needed

“Customize Application”To enable Salesforce Files Sync for profiles:

To enable the Salesforce Files Sync permission for a profile:

1. From Setup, click Manage Users > Profiles.
2. Click the Profile Name of the profile that you’re granting access to.
3. On the profile detail page, click Edit.
4. Under Administrative Permissions, select Sync Files.
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5. Click Save.

Changes to the Files Tab with Salesforce Files Sync Enabled
After enabling Salesforce Files Sync, you and your users will notice some changes on the Files tab in Chatter.

With Salesforce Files Sync enabled, the Files tab gains two new features.

1. New filter names—Filter the files list by recent, owned, shared, followed, and synced files. The new Synced filter shows
the files in your Salesforce Files folder. From the Synced filter, users can search, preview, follow, share, and upload new
versions of their synced files.

Note:  Users who have the “Sync Files” permission see the new filter names. Users without this permission continue
to see their existing filter names.

2. Salesforce Files client download—One-click access to download the desktop client.

Install the Salesforce Files Client
Users can install the Salesforce Files client so they can sync files between their desktop, Chatter, and mobile devices.

The Salesforce Files client is supported on Microsoft® Windows® 7 and Apple® OS X 10.7.

1. Click Your Name > My Settings > Desktop Add-Ons > Salesforce Files.
2. Click Download.
3. Follow the installation instructions for your operating system.
4. Log in with your Salesforce credentials.

Ways to Share Synced Files
Share synced files with people and groups on Chatter, or with anyone outside your organization via a generated link. Share
them directly from the Salesforce Files folder on your desktop, the Files tab in Chatter, or your mobile device with Salesforce1.
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If you share a file with a person or group with Collaborator rights, then when collaborators download, edit, and upload a new
version of the file, you’ll get the latest version automatically synced. When you edit and sync a new version of the file, the
people and groups you’ve shared with will automatically get the latest version on Chatter.

Share Synced Files Directly from the Salesforce Files Client
Synced files can be shared from inside the Salesforce Files folder.

1. On your desktop, in your Salesforce Files folder, right-click the file you want to share.
2. Choose a menu option under Salesforce Files: share with people in your organization, with Chatter groups, or with people

outside your organization via link.
3. When prompted, enter the names of the people or groups in your organization and an optional message to share the file

with them. If you’re sharing the file via link, copy the link.

Run File and Content Reports from the File Detail Page
See how many times a file has been downloaded, shared, liked, and commented on.

User Permissions Needed

“Run Reports”

AND

“View Reports in Public Folders”

To run and view a file report

Users can run a File and Content Engagement report directly from the file detail page. The File and Content Engagement
report has these fields.

Number of times users...Field

Downloaded the file.Total Downloads

Posted the file to a feed. This number doesn’t count the
number of times the file has been attached to comments on
posts.

Posts

Commented on file posts in feeds.Post Comments

Liked file posts on feeds. This number doesn’t count likes
received by comments on the file post.

Likes

Shared the file using Share with people and Share with
groups. If a user clicks Share on a file post, it’s counted as a
post and not as a share.

Shares

Shared the file using Share via link. If the file is uploaded to
a Salesforce CRM Content library, then content deliveries are
also counted.

Links

Numbers in the File and Content Engagement report are cumulative for all versions of a file. For example, if there are 2
versions of the file, and version 1 has been downloaded 4 times while version 2 has been downloaded 5 times, then Total
Downloads reports 9 downloads.

1. From the file detail page, click Show file report.
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2. See how users have been engaging with the file in your organization.

Other Changes in Files
Other changes enhance file usage and management.

Report on File Usage

See how users are interacting with files, using the new standard report type, File and Content Report. Run these two
new standard reports from the Reports tab in Chatter:
• File and Content Downloads

• File and Content Engagement

Share Content Links and Google Docs on Feeds

If Salesforce CRM Content and Google Docs® are enabled in your organization, users can now share content links and
Google Docs when posting files to Chatter. After clicking Select a file from Salesforce, users can now choose from
content links and Google Docs, in addition to Chatter files.

Changed Who Can See the Content Delivery URL on the Content Delivery Details Page

Previously, the content delivery URL was visible to anyone who had access to the content delivery details page. Now,
to prevent unintended access to files in content deliveries, only certain users—those who have access to the content in
the delivery or access to a record associated with the content, or who are the content delivery owner—can view the
content delivery URL on the content delivery details page.

Topics
Topics help you organize feed posts and records around common themes.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

See Topics People Know about on User Profiles

Quickly identify your peers’ professional strengths.

Report on Knowledgeable People in Your Organization

Quickly identify experts on every topic and compare their knowledge levels.

View Records on Topic Detail Pages

See associated records like accounts and leads in the context of a topic's description, feed, and knowledgeable users.

Search Feeds on Topic Detail Pages

The fast, feed-specific search you’re using elsewhere in Chatter is now available on topic detail pages.

Delete Topics Directly in Salesforce

Previously, you could delete topics only by using the SOAP API, Chatter REST API, or Chatter in Apex. But in Summer
’14, you can quickly delete them right on topic detail pages.
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See Topics People Know about on User Profiles
Quickly identify your peers’ professional strengths.

The topics people are knowledgeable about now appear on their user profile pages (replacing the Recently Talked About
section). Click the Overview tab to see recognized areas of expertise and suggestions for additional endorsements.

Important:  If Work.com Skills are enabled, they replace knowledgeable topics on profile pages. See Skills (Generally
Available). (For Salesforce Communities users, skills replace topics only in the default community.)

Report on Knowledgeable People in Your Organization
Quickly identify experts on every topic and compare their knowledge levels.

User Permissions Needed

“Manage Custom Report Types”To create custom report types:

Ever wonder who the experts are? Knowledgeable User reports quickly highlight and rank them for each topic. Salesforce
recalculates knowledge rank daily, basing it on the number of user endorsements and feed actions such as likes and mentions
on posts.

To define this custom report type, choose the Knowledgeable User primary object, and select from the following fields:

• Network: Name—Name of the community the topic belongs to. This field is available only if Salesforce Communities is
enabled for you organization.

• Topic: Name

• User: Full Name

• Rank—Numeric rank of user’s knowledge.

Note:  In reports, numeric ranks are skipped for Chatter Only or Chatter External users, or users who select Hide
Me in Knowledgeable People lists.

View Records on Topic Detail Pages
See associated records like accounts and leads in the context of a topic's description, feed, and knowledgeable users.
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Topics provide a fast way to group records on common themes together, either via list views or—if Chatter is enabled—right
on the new Records tab for topic detail pages. When viewing a specific record, you can navigate directly to this tab by clicking
any topics listed below the record name.

If you don’t see a Records tab like this for a particular topic, the topic hasn’t been added to any records.

Tip:  To enable topics for additional objects, in Setup, choose Customize > Topics > Topics for Objects.

Search Feeds on Topic Detail Pages
The fast, feed-specific search you’re using elsewhere in Chatter is now available on topic detail pages.

Click  above the feed to find information in its original context.
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Delete Topics Directly in Salesforce
Previously, you could delete topics only by using the SOAP API, Chatter REST API, or Chatter in Apex. But in Summer
’14, you can quickly delete them right on topic detail pages.

User Permissions Needed

“Delete Topics”To delete topics:

Before deleting topics, carefully consider the following:

• Topics are permanently deleted. They aren’t sent to the Recycle Bin.
• Deleted topics are removed from search results, the topics list, all posts and records, Recently Talked About, Related

Topics, and Trending Topics lists, and your users’ favorites.
• Users can reintroduce a topic after it has been deleted.

To delete a topic:

• In the upper-right corner of a topic detail page, click , and choose Delete.

Tip:  Via the same menu, you can now edit details such as topic name and description, or add a topic as a favorite.

Feeds
Feeds show you posts and comments you and other people make, as well as record updates across your Salesforce organization.

Profile-Based Rollout of Chatter (Generally Available)

Roll out Chatter for a subset of users instead of all users in your organization.

Add Action Links to Posts (Pilot)

Use action links to integrate Salesforce and third-party systems into the feed. An action link is a URL on a post that links
to an API, a Web page, or a file. Enabling users to work in the feed is the most powerful way to ensure that they adopt and
engage in Chatter.

Ask Questions in the Feed with Chatter Questions (Beta)

Ask questions and get answers in Chatter with Chatter Questions.

Profile-Based Rollout of Chatter (Generally Available)
Roll out Chatter for a subset of users instead of all users in your organization.

With profile-based rollout of Chatter, you decide who has access to Chatter based on user profiles and permission sets. Once
Chatter profile-based rollout is enabled for your organization, your administrator can turn on Chatter for only the users that
have been assigned the required user profile or permission sets. All other users in your organization won’t have access to
Chatter.

With Chatter profile-based rollout, larger organizations can plan a controlled rollout and deploy Chatter in a way that enhances
adoption and engagement on a team-by-team basis. Organizations with regulatory constraints have the option to give full or
no access to Chatter based on employee roles and profiles.
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For example, if you assign a user profile or permission set that excludes Chatter access to a subset of users, these users still
have access to Salesforce objects, like accounts, leads, opportunities and so on, but they don’t see the record feed and they can’t
make posts.

For more information about profile-based rollout of Chatter, see “Profile-Based Rollout of Chatter” in the Salesforce Help.

Add Action Links to Posts (Pilot)
Use action links to integrate Salesforce and third-party systems into the feed. An action link is a URL on a post that links to
an API, a Web page, or a file. Enabling users to work in the feed is the most powerful way to ensure that they adopt and
engage in Chatter.

Note: Action links are available through a pilot program and only in the Salesforce1 mobile browser app. For
information on enabling action links in your organization, contact salesforce.com.

These action links let a user approve or reject a travel request in the feed:

Define action links in groups. Action links within a group are mutually exclusive. You can associate multiple groups with a
post. You can specify whether an action link group displays in the post or in the post’s drop-down menu. In this example,
“Approve” and “Reject” are in one group and “Clone” and “View” are in another. “Approve” and “Reject” display in the post.
“Clone” and “View” display in the drop-down menu.
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Action links are user-specific and can be private or public. In this example, Pam makes a post to Deanna’s feed asking her to
download some instructions and then place an order. Deanna can see the “Order” and “Download” action links in the post in
her feed:

Pam can see the post, but she can see only the “Download” action link because she doesn’t have permission to place the order:

During the Summer ‘14 pilot, use Chatter REST API to define action links and publish a Chatter post that contains action
links. For more information, see Action Links (Pilot) on page 284.
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Ask Questions in the Feed with Chatter Questions (Beta)
Ask questions and get answers in Chatter with Chatter Questions.

Available in: Personal, Group, Professional, Developer, Performance, Enterprise, and Unlimited Editions.

Note:  This release contains a beta version of Chatter Questions that is production quality but has known limitations.
For information on enabling this feature for your organization, contact salesforce.com.

Chatter Questions allows users to ask questions in their Chatter feed, in groups, and in records. With Chatter Questions,
users can quickly view similar questions and articles as they enter their question, without switching context. After a question
is asked, the person who asked the question or the question’s moderator can select a best answer—which is prominently
displayed in the feed—allowing other users to quickly and easily find the best response to their question.

Your users can organize their information with the question title and details about their question. They can ask the question
to their followers, to a group, or to a specific person, as they can with other Chatter feed items.

Chatter Desktop doesn’t support Chatter Questions.

You can work with Chatter Questions using the Chatter REST API. For more information, see Chatter Questions (Beta) on
page 289.

Similar Questions

Your users might ask similar questions. Chatter Questions helps reduce duplicate content in your community by showing
similar questions before your users ask their question.

Knowledge Deflection with Chatter Questions

In addition to similar questions, Salesforce Knowledge articles can also hold answers to your customers’ questions. With
Chatter Questions, you can choose to show relevant articles as users type their question in Chatter.

Enable Knowledge Deflection for Chatter Questions

Show relevant Salesforce Knowledge articles when users ask a question in Chatter.

Selecting a Best Answer for a Question in Chatter

One of the advantages of asking a question in Chatter is that your users can select the best answer for a question. When a
question has a best answer, your users don’t have to read through all of the answers to the question and can quickly resolve
their issue by going directly to the best answer.
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Chatter Questions (Beta) FAQ

Here are some questions and answers about Chatter Questions.

Similar Questions
Your users might ask similar questions. Chatter Questions helps reduce duplicate content in your community by showing
similar questions before your users ask their question.

When users type their question and press TAB or ENTER, similar questions appear. The list of similar questions shows the
number of answers a question has as well as if the question has an answer selected as the best answer. They can continue to
ask their question or click any similar question to quickly get the answers they need.

Knowledge Deflection with Chatter Questions
In addition to similar questions, Salesforce Knowledge articles can also hold answers to your customers’ questions. With
Chatter Questions, you can choose to show relevant articles as users type their question in Chatter.

Available in: Personal, Group, Professional, Developer, Performance, Enterprise, and Unlimited Editions.

Your users create a lot of content. If someone wants to ask a question in Chatter, there’s a good chance that someone in your
community might have already answered their question, possibly in a Salesforce Knowledge article. Articles often contain
information about specific configurations, errors and workaround solutions to tricky issues. Help your users find these articles
quickly by enabling Knowledge Deflection in Chatter Questions. That way, your users don’t have to search—the articles simply
show up when they ask a question in Chatter!

Enable Knowledge Deflection for Chatter Questions
Show relevant Salesforce Knowledge articles when users ask a question in Chatter.

Available in: Personal, Group, Professional, Developer, Performance, Enterprise, and Unlimited Editions.
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User Permissions Needed

“Customize Application”To enable Knowledge deflection for Chatter Questions:

You must have Salesforce Knowledge enabled.

When your users ask a question in Chatter, similar questions appear as they type. You can enable Knowledge Deflection for
Chatter Questions so articles appear too.

1. From Setup, click Customize > Knowledge > Settings.
2. Select Suggest helpful articles while creating questions in Chatter under Chatter Questions: Knowledge

Deflection.

Selecting a Best Answer for a Question in Chatter
One of the advantages of asking a question in Chatter is that your users can select the best answer for a question. When a
question has a best answer, your users don’t have to read through all of the answers to the question and can quickly resolve
their issue by going directly to the best answer.

Your users see the Select as Best option to select an answer to a question as the best answer only if they are actually able to
select the best answer for the question.

The person who asked the question and moderators can select the best answer for a question. Moderators can be the Chatter
moderator, the community moderator, or the Salesforce administrator. The same users and moderators who can select a best
answer for a question can also remove the best answer status from a question.

84

Ask Questions in the Feed with Chatter Questions (Beta)Chatter



When an answer is selected as a best answer, a green check mark ( ) appears next to it. In addition, a copy of the answer
with the green check mark appears at the top of the list of answer for the question so other users can view the best answer
quickly.

Chatter Questions (Beta) FAQ
Here are some questions and answers about Chatter Questions.

Note:  This release contains a beta version of Chatter Questions that is production quality but has known limitations.
For information on enabling this feature for your organization, contact salesforce.com.

Why should I use Chatter Questions instead of asking my question in a Chatter post?

Asking a question in Chatter saves you time. When you ask a question, similar questions and articles appear as you enter
your question. Chances are that someone already asked the same question and it could have many answers or a best
answer. Chatter Questions harnesses the value of content that already exists in Chatter.

Can I filter the Chatter feed to show only questions?

Yes! At the top of your Chatter feed, click  next to Show and select Questions.
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Can I search for questions in Chatter?

Yes! Use the Search this feed button ( ) at the top of your Chatter feed. Questions are included in the feed search
results.

Is Chatter Questions available in the Salesforce1 app?

Currently, Chatter Questions is available in the Salesforce1 mobile browser app only.

What happens when someone asks a question?

Their question appears in the Chatter feed for their followers or the person or group they asked the question of. Email
notification is also sent to the person or group they asked the question of. After a user asks a question, other users can
then answer the question directly in Chatter.

Who can select a best answer for a question?

The person who asked the question and moderators can select the best answer for a question. Moderators can be the
Chatter moderator or the community moderator. Your Salesforce administrator can also select the best answer for a
question.

Other Changes in Chatter
Smaller changes can improve your experience with Chatter.

Mobile User Context Switching from Emails

Links in Chatter email notifications or digests have been enhanced so they automatically open in the Salesforce1 app
(instead of the full Salesforce site) when the user is working on a mobile device. Links also include data that Salesforce1
uses to correctly switch the user to the correct organization or community. Currently, Communities are supported in
the Salesforce1 mobile browser app only.

New Preview Links

We’ve added more previews for linked content:
• stream.co.jp

• stream.ne.jp

The previews are powered by Embed.ly, a third-party service, and include thumbnails, descriptions, and video players
for links to videos. We don’t share any content, user, organization, or account data with Embed.ly. We only share the
URLs that are on the domain whitelist. Additionally, all of our URL requests pass through a Salesforce proxy, meaning
Embed.ly never receives calls directly from the client and therefore doesn’t have information about who's making the
URL request.

Dismiss Group Announcements

Previously, the only way to remove an announcement from a group’s page was to delete the corresponding feed post.

Now you can dismiss an announcement without deleting the post. From the group detail page, click  in the top corner
of the announcement, then click Dismiss Banner Now.
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Communities
Our improved community management tools make it even easier for your users to communicate and collaborate with customers
and partners using Communities.

Community Engagement Console

The new Community Engagement Console gives community managers a central place to monitor the health of their
community and its members. Use it to view dashboards about groups, members, feed activity, and license usage, and to
manage the community’s reputation system.

Communities Analytics

A handy set of new dashboards and reports gives community managers the tools to easily track community activity, membership,
and participation.

Reputation

Community managers know that recognition and a little friendly competition usually lead to more active members. So take
advantage of a new, easy-to-use reputation system that builds on our existing gamification capabilities. Simply use the default
levels and point values that appear when you enable reputation, or customize them to meet your needs.

Guest User Access to Public Chatter Groups Without Logging In

Open up access to community content so you can engage users who might not join otherwise. By enabling this setting, you
open up certain methods in Chatter in Apex—that provide access to public groups, group feeds, and search in groups—to
users that aren’t logged in. Your developers will need to create a custom Visualforce page with the public group feed that can
be accessed by any user.

Work.com Enhancements for Communities

Thanks badges are now specific to the community they’re created in, and communities users can receive rewards.

Other Changes in Communities

We’ve made some additional improvements for communities administrators and users.

Community Engagement Console
The new Community Engagement Console gives community managers a central place to monitor the health of their community
and its members. Use it to view dashboards about groups, members, feed activity, and license usage, and to manage the
community’s reputation system.

When a community manager first accesses the Community Engagement Console, they see dashboards set up by the Salesforce
administrator. There are up to five dashboards mapped to pages in the Community Engagement Console.

The Reputation and Point System tabs allow a community manager to customize reputation levels and a point system to
reward members for Chatter activity in the community. For example, a member may gain points by creating a post, receiving
a comment on a post, or liking someone else’s post or comment.

For more information on these new community management features, see:

• Communities Analytics

• Reputation

To be a community manager and use the Community Engagement Console, a user must have either the “Manage Communities”
or “Create and Customize Communities” permission. The user must also be an employee of your organization; external
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community members can’t be community managers. To access the Community Engagement Console, simply click the  in
the global header next to the community drop-down.

Communities Analytics
A handy set of new dashboards and reports gives community managers the tools to easily track community activity, membership,
and participation.

Dashboards for Community Managers

Community managers can use dashboards to measure the health and ROI of their communities. Dashboards highlight trends
in activity, such as member logins over time, and help compare levels of engagement across employee, customer, and partner
members. As an administrator, you must set up the dashboards that community managers see.

Communities Reporting Enhancements

As an administrator, you can use the new Communities custom report types to create reports for community managers.

Dashboards for Community Managers
Community managers can use dashboards to measure the health and ROI of their communities. Dashboards highlight trends
in activity, such as member logins over time, and help compare levels of engagement across employee, customer, and partner
members. As an administrator, you must set up the dashboards that community managers see.

Within the Community Engagement Console, there are multiple pages you can map to dashboards that contain
community-specific information. Dashboards that you map to pages in the Community Engagement Console are automatically
filtered for the community, so long as the related report was created based on the Networks object.
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Note:  It’s important that any user that clicks a dashboard to view the related report should not filter it based on a
specific Network ID. Adding a Network ID to the report will cause the report to only show data for that specific
community, regardless of which community you view it in.

Dashboards that aren’t based on the Networks object will show in the Community Engagement Console, but they
will display data from across the organization.

To show dashboards in the Community Engagement Console:

1. Set up dashboards. You must either:

• Install the Salesforce Communities Analytics package from the AppExchange. This package contains pre-configured
reports and dashboards that work right out-of-the-box.

• Create community dashboards. You must set up custom dashboards as documented in order to see relevant community
data in the Community Engagement Console.

2. Map the dashboards to pages in the Community Engagement Console.

Salesforce Communities Analytics Package
Note:  The Salesforce Communities Analytics package will be available on the AppExchange shortly after Summer
’14.

The Salesforce Communities Analytics package gives community managers an essential set of dashboards and reports to keep
tabs on activity and engagement in their communities. Get insights from the latest metrics and rapidly spot trends. How fast
is your community growing? Who are the most engaged members? Which areas need attention?

The package comes in two versions: one for communities that have Chatter enabled and one for those that don’t. Download
and install the appropriate version to access these dashboards and their source reports, alongside all your other Salesforce
dashboards and reports.

Requires ChatterDescriptionDashboard

See the overall state of your communities at a glance. 90-day trending reports show
total membership, newly joined members, and member logins. If you have Chatter
enabled, 90-day snapshots show post and comment metrics.

Overview

See metrics about posts, comments, daily unique contributors, and which types of
members are contributing posts and comments.

Activity

Monitor membership and post and comment activity within groups, one of the top
drivers of community success.

Groups

Gauge membership growth and see login metrics for the last 30 days.Members

Track license usage and login frequency by customer and partner licenses.Licenses

Create Dashboards for the Community Engagement Console
Create dashboards as documented in order to see relevant community data in the Community Engagement Console.
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User Permissions Needed

“Manage Custom Report Types”To create custom report types:

“Create and Customize Reports”To create, edit, and delete reports:

“Run Reports” AND “Manage Dashboards”To create dashboards:

Tip:  If you prefer to use out-of-box, pre-configured dashboards, install the Salesforce Communities Analytics Package.
This package will be available on the AppExchange shortly after the Summer ‘14 release.

These are the high-level steps for creating a dashboard to show in the Community Engagement Console. For detailed steps
on creating custom report types, reports, or dashboards, refer to the Salesforce Help.

1. Create custom report types based on the Networks object, so that you can easily create community-scoped reports and
dashboards.

For information on the new custom report types you can create, see Communities Reporting Enhancements on page 91.

2. Create a report with a Type of Matrix or Summary.

• Ensure that the report has a GroupBy element.
• Ensure that the report has a chart.
• Ensure that the report is not filtered by Network ID. This is required if you want to leverage dynamic community

filtering within the Community Engagement Console.
• Either save the report to a Public folder or extend access to community managers using sharing.

3. Create a dashboard using the report you created as the source.

Note:  Customizations you make to the dashboard won’t show up in the Community Engagement Console. You
must customize the report directly.

Keep in mind that the dashboards in the Community Engagement Console are automatically scoped for the community in
which you’re viewing them. The Community Engagement Console doesn’t support the “run as user” feature.

Dashboards in the Community Engagement Console are automatically refreshed every day. To see the latest data, you must
refresh the underlying report, not the dashboard.

Map Dashboards to Pages in the Community Engagement Console
Mapping dashboards makes them visible in the Community Engagement Console, which helps your community managers
monitor adoption and member engagement.

User Permissions Needed

“Customize Application”To edit Communities settings:

Dashboards selected in community settings are visible to community managers in the Community Engagement Console. You
can choose any dashboard you have access to, however, you need to ensure that your community managers have access as well.
You can map up to five dashboards.

When selecting dashboards, keep in mind that only dashboards created based on the Networks object will display
community-specific information in the Community Engagement Console. Dashboards that aren’t based on the Networks
object display data from across the organization.
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If you install the Salesforce Communities Analytics package from the AppExchange, the dashboards from the package will
automatically be mapped to the corresponding pages in the Community Engagement Console.

Note:  The Salesforce Communities Analytics package will be available on the AppExchange shortly after Summer
’14.

1. From Setup, click Customize > Communities > Settings.
2. For each of the pages, select the dashboard you want to show to community managers.
3. Click Save.

Verify the dashboard mappings by visiting the Community Engagement Console in each of your communities.

Communities Reporting Enhancements
As an administrator, you can use the new Communities custom report types to create reports for community managers.

We’re introducing four new custom report types, which can be used to create trending reports. Trending reports are a valuable
tool for exposing and tracking trends in your community, such as who are the most active members by user type for a specific
time period. Trending reports show daily or weekly aggregated data, as opposed to snapshot reports, which show only current
data.

These new custom reports types are available:

Network Membership Daily Metrics

Daily count of total active members, new members added, and external member logins by member type.

To create this custom report type, select Networks as the primary object and Network Membership Daily Metrics as
the related report object.

Network Activity Daily Metrics

Daily number of posts and comments, on groups and user profiles, by member type.

To create this custom report type, select Networks as the primary object and Network Activity Daily Metrics as the
related report object.

Network Unique Contributor Daily Metrics

Unique daily contributors. A member is counted as a contributor if he posted or commented on a group or user profile.

To create this custom report type, select Networks as the primary object and Network Unique Contributor Daily Metrics
as the related report object.

Network Tenant Usage Entitlement Weekly Metrics

Weekly usage entitlements values in buckets for login-based and member-based licenses. Buckets include portal and
Communities licenses.

To create this custom report type, select Network Tenant Usage Entitlement Weekly Metrics as the primary object.

To create custom report types, from Setup, click Create > Report Types. For full instructions, see “Create a Custom Report
Type” in the Salesforce Help.

91

Communities Reporting EnhancementsCommunities



Reputation
Community managers know that recognition and a little friendly competition usually lead to more active members. So take
advantage of a new, easy-to-use reputation system that builds on our existing gamification capabilities. Simply use the default
levels and point values that appear when you enable reputation, or customize them to meet your needs.

Community managers with the “Manage Communities” permission can personalize labels and point values directly in the
Community Engagement Console.

Members start to accrue points by performing the actions that have assigned point values. Once the member reaches the top
of the level’s point threshold, they move up a level. They, and other members of the community, see their reputation level on
their profile and when hovering over their name. Total points also show on member’s profiles.

Enable Reputation for Your Community

Enable reputation in your community to recognize and reward members for participating.

Set Up Reputation Levels

Update the default reputation levels to meet your community’s needs and help motivate your members.

Set Up Reputation Points

Set up a point system to reward users for participating in the community.

Enable Reputation for Your Community
Enable reputation in your community to recognize and reward members for participating.

User Permissions Needed

“Customize Application”To edit Communities settings:

Note:  When you enable Reputation, Chatter influence is removed from the Contribution section on the profile page.

1. From Setup, click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Miscellaneous.
3. Select Reputation, then click Save.

A default point system and set of reputation levels is created in the Community Engagement Console.

Set Up Reputation Levels
Update the default reputation levels to meet your community’s needs and help motivate your members.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Communities”To update reputation levels:
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When reputation is enabled for a community, 10 default levels are added. You can add or remove levels, give each level a name,
and update the point range for each level.

Note: A community must have at least three reputation levels and can have up to 50.

1. From the community, click  in the global header.
2. Click Reputation Levels.

From here you can:

• Give each level a name, such as “Beginner,” “Intermediate”, “Expert.” If you don’t assign a name, the default is used.
For example, “Level 1,” “Level 2,” “Level 3.”

• Edit the point range for a level.

When you update the higher value of a level’s point range, the lower value for the next level is automatically adjusted
when you save.

• Add more levels by clicking Add a level, located underneath the list of levels.

• Remove a level by clicking  next to the level.

3. Click Save to apply your changes.

You can now update the point system for the community. The point system determines how many points a user gets when
they perform certain actions or when others recognize their contributions by commenting, liking, or sharing their posts.

Set Up Reputation Points
Set up a point system to reward users for participating in the community.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Communities”To update reputation points:

When reputation is enabled for a community, there is a default point system set up. When users perform the actions with
assigned point values, their total points increase and they start to move towards the next reputation level.

The table shows the default events and points.

PointsAction

+1Write a post

+1Write a comment

+5Receive a comment

+1Like something

+5Receive a like

+1

If your post contains more than one @mention, you get a point
for each @mention.

Mention someone
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PointsAction

+5Someone mentions you

+1Share a post

+5Someone shares your post

1. From the community, click  in the global header.
2. Click Point Values.
3. Update the points for each event. If you don’t want users to accrue points for a certain event, set the Points to 0.
4. Click Save.

Point totals show up on profile pages beneath the photo. Point totals are visible to anyone in the community.

Guest User Access to Public Chatter Groups Without
Logging In

Open up access to community content so you can engage users who might not join otherwise. By enabling this setting, you
open up certain methods in Chatter in Apex—that provide access to public groups, group feeds, and search in groups—to
users that aren’t logged in. Your developers will need to create a custom Visualforce page with the public group feed that can
be accessed by any user.

To enable guest user access in your community:

1. From Setup, click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Miscellaneous.
3. In the General section, select the checkbox for allowing guest access to Chatter.

For information on the Connect in Apex endpoints that are available, see Access public Chatter groups from a guest user
account on page 262.

Work.com Enhancements for Communities
Thanks badges are now specific to the community they’re created in, and communities users can receive rewards.

Available in: Enterprise, Performance, and Unlimited Editions

Badges and Rewards require a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available
as add-on licenses for Professional Edition, Enterprise Edition or Unlimited Edition and are included in Performance
Edition.

Thanks Badges are Specific to Each Community

Badges created in a community appear only in that community. Badges created in an internal organization are not
available in a community. Only users with a Salesforce internal license can create badges in a community.

Communities Users Can Receive Rewards

Communities users with a Work.com license can now receive rewards. Work.com Rewards enable users to tie tangible
rewards, such as gift certificates, to thanks badges. See Recommended Permission Sets in the Work.com Help for more
information.
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Other Changes in Communities
We’ve made some additional improvements for communities administrators and users.

Share URL Moved To The Communities Settings Overlay

The share URL for previewing a community has moved from the Members tab to the Communities Settings overlay.
To share the URL, click Share before publishing, then copy the URL and send it to the appropriate members.

Communities Now Tracked in Login History

Users can now see a history of which communities they’ve logged in to. Administrators can report on logins by adding
the Community column to user-based reports in the Administrative folder.

Task Reminders for Partner Users

Task reminders are now available to partner users in communities. This includes users with a partner portal or Partner
Community license.

Partner users in communities can see their reminders by clicking Your Name > My Settings > Reminders.

Data Loader Available to Partner Community Users

Users with Partner Community or partner portal licenses can now use the Data Loader to import data into their
communities.

Caching Now Available for Unauthenticated Visualforce Pages

Previously, for community sites, only static resources such as images and files were cached. Now, Visualforce pages in
unauthenticated community sites are cached via our proxy Salesforce servers. This improves page load times and site
performance and helps you avoid reaching limits for bandwidth or service request time.

Control the caching behavior for your site by setting the Boolean cache attribute and integer expires attribute on
each Visualforce page. By default, pages that don’t have the cache attribute set are cached for 10 minutes.

Caching LocationCommunity Page Type

NoneAuthenticated Visualforce page

ServerUnauthenticated Visualforce page (HTTP/HTTPS)

“Create and Manage Communities” Permission Renamed

The “Create and Manage Communities” permission has been renamed to “Create and Customize Communities”.

Company Community License Renamed

The Company Community license is now called the Employee Community User license. The Company Community
for Force.com permission set is now called the Employee Community User for Force.com permission set.
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Sales
Salesforce is the world’s #1 sales and CRM application. Our latest features help your sales reps close bigger deals with even
more efficiency.

Manage Sales on the Go!

With the Salesforce1 app, your users can stay current on their most important records, activities, and conversations while
out of the office.

Opportunities and Collaborative Forecasts

Help your sales team better plan for and predict sales based on opportunities your team has in their pipeline. You can now
fully customize opportunity splits and add custom split types to better match your business model. We’ve also improved your
ability to accurately predict outcomes across sales teams and product lines, increased flexibility around how sales teams work
with forecasts, and made it easier to view opportunity splits information within a forecast.

Model, Manage, and Analyze Your Sales Territories with Territory Management 2.0 (Beta)

Territory Management 2.0 lets you model your sales territories into a logical and flexible structure that connects sales reps
to the accounts they sell to.

Salesforce for Outlook

We’re continuing to help users be more productive when they use the Salesforce Side Panel. We’re also giving you more
security control in Salesforce for Outlook.

Salesforce Console for Sales

The Salesforce Console for Sales is a dashboard-like app designed to help you access sales intelligence quickly with fewer
clicks and less scrolling.

Activities

Events and tasks are the building blocks of sales productivity. We’ve made enhancements that boost your sales teams’ edge
over the competition, along with updates to improve performance and usability.

Customizable Price Book Entries

Administrators can customize price book entries in the user interface.

Generate Orders (Pilot)

Automatically create an order with order products from an opportunity or quote. You can also generate and relate the order
to a contract.

Other Changes in the Sales Cloud

Learn about other changes that affect your sales teams.

Manage Sales on the Go!
With the Salesforce1 app, your users can stay current on their most important records, activities, and conversations while out
of the office.

The Salesforce1 app helps sales professionals manage Salesforce records like tasks, contacts, and opportunities—all from their
mobile devices. In addition, Today, an app that helps sales team members plan for and manage their day, integrates calendar
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events from their mobile devices with their Salesforce tasks, contacts, person accounts, user records, and other key CRM data.
Learn about the latest mobile features in Salesforce1.

Opportunities and Collaborative Forecasts
Help your sales team better plan for and predict sales based on opportunities your team has in their pipeline. You can now
fully customize opportunity splits and add custom split types to better match your business model. We’ve also improved your
ability to accurately predict outcomes across sales teams and product lines, increased flexibility around how sales teams work
with forecasts, and made it easier to view opportunity splits information within a forecast.

Forecasts are available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions.

Opportunity Splits are available in Enterprise, Performance, Unlimited, and Developer Editions.

Complete Customization Available for Opportunity Splits

You can now customize opportunity splits to better serve your business needs.

Add Custom Split Types for Opportunity Splits

Streamline your sales operations by creating new custom split types for your organization. By default, your organization is
provided with two splits on the Opportunity - Amount field, one of which must total 100%, and one of which can total any
percentage. Now you can create up to three more split types, for a total of up to five split types.

Opportunity Splits Appear in Subtabs

Each opportunity split type is now available in a separate subtab of the Opportunity Split edit page.

View Opportunity Split Details in Forecasts

Your sales teams can now see the splits on opportunities directly in any splits-based forecast.

Custom Field Forecasts (Pilot)

Give your sales teams added flexibility for predicting revenue—let them forecast on custom opportunity currency fields that
matter to your organization.

Overlay Forecasts (Pilot)

Sales managers can track revenue from sales team members who help close opportunities, but are not directly responsible for
them.

Historical Trending for Forecasts

Sales users can now see how their forecasts have changed over time.

Forecasts 1.0 (Classic) is Retired in Summer ’14

Effective with Summer ’14, Forecasts 1.0 (Classic) is officially retired. For more information, please contact salesforce.com
Customer Support.

Complete Customization Available for Opportunity Splits
You can now customize opportunity splits to better serve your business needs.

Available in: Enterprise, Unlimited, Performance, and Developer Editions
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You can customize opportunity splits in these ways:

• Add custom fields

• Set up validation rules

• Set up triggers

• Edit page layouts

In addition, if you use Unlimited or Performance edition, you can now set up custom split types in the Settings area for
opportunity splits, and you can configure workflows.

To set up opportunity splits for your organization, go to Setup, then click Opportunity > Opportunity Splits.

Edit Custom Fields on Opportunity Splits

Users can now edit custom fields, as well as standard fields, for their opportunities.

Edit Custom Fields on Opportunity Splits
Users can now edit custom fields, as well as standard fields, for their opportunities.

Available in: Enterprise, Unlimited, Performance, and Developer

User Permissions Needed

“Edit” on Opportunities

AND

Owner of the opportunity record, or above the owner in the
organization hierarchy

To edit opportunity splits:

Now your users can edit custom fields for each opportunity split in-line on the Opportunity Split Detail page. Standard fields
(Team Member, Percent, Amount, and Note) can still be edited on the Opportunity Split edit page.

To edit custom fields for opportunity splits, on the opportunity split related list, select the name of the team member for the
opportunity to be edited. Then click in the field being edited. When edits for the opportunity split are complete, click Save.

Add Custom Split Types for Opportunity Splits
Streamline your sales operations by creating new custom split types for your organization. By default, your organization is
provided with two splits on the Opportunity - Amount field, one of which must total 100%, and one of which can total any
percentage. Now you can create up to three more split types, for a total of up to five split types.

Available in: Unlimited, Performance, and Developer Editions

Split types can be based on most Opportunity currency fields, except formula currency fields.

Custom split types let you customize opportunity splits to better reflect your business process. For example, your company
may want to split credit for the opportunity on the standard Estimated Revenue field. Or perhaps your company wants to add
a currency field for profit, then create a new split type based on profit from the opportunity.
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Contact Salesforce to have custom split types enabled for your organization.

Create Custom Split Types for Opportunity Splits

Create custom opportunity splits to better reflect your business operations by setting up splits on most currency fields for an
opportunity, including custom currency fields and roll-up summary fields.

Create Custom Split Types for Opportunity Splits
Create custom opportunity splits to better reflect your business operations by setting up splits on most currency fields for an
opportunity, including custom currency fields and roll-up summary fields.

Available in: Unlimited, Performance, and Developer Editions

User Permissions Needed

“Customize Application”To create custom split types:

Note:  Changes to opportunity split types are completed by a background process. You will be notified by email when
the background process has finished making changes to your organization. We recommend not editing any existing
splits on your opportunities until the changes are complete.

1. From Setup, click Opportunities > Opportunity Splits, then click Edit Split Types.
2. Click + Add a new split type.
3. If you don’t want the split to be visible to users yet, deselect Active.
4. Enter a name for the split type. The name will be visible to users when the type is visible.
5. Select a field to split. You can split most currency fields created on opportunities, including custom currency fields and

roll-up summary fields. However, you can’t split formula currency fields.
6. If you want the splits for this type to total 100%, select Totals 100%.

Credit for team members directly responsible for the opportunity should usually total 100%.

7. Click Save.

Opportunity Splits Appear in Subtabs
Each opportunity split type is now available in a separate subtab of the Opportunity Split edit page.

Available in: Enterprise, Unlimited, Performance, and Developer

To edit opportunity split data, from the Opportunity Splits related list on an opportunity, click Edit Opportunity Splits, then
select the split type you’d like to edit.

To save changes made to a split assignment, click Save before switching tabs.
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View Opportunity Split Details in Forecasts
Your sales teams can now see the splits on opportunities directly in any splits-based forecast.

To view the splits for an opportunity, sales users can hover over the split percent for the opportunity and then click . The
Opportunity Splits detail window appears, showing splits that roll up to the selected forecast cell in bold. Other splits on the
opportunity that do not roll up to the selected forecast cell appear in gray. Opportunities that contain only a single 100% split
for the opportunity owner do not display split details.

Custom Field Forecasts (Pilot)
Give your sales teams added flexibility for predicting revenue—let them forecast on custom opportunity currency fields that
matter to your organization.

Track and Predict Revenue from Custom Opportunity Fields

Help your sales teams predict revenue beyond the standard Amount field they’ve already been using.

Enable Custom Field Forecasts for Sales Managers

To enable a custom field forecast, first enable a custom split type for the field, and then add a forecast for it.

Track and Predict Revenue from Custom Opportunity Fields
Help your sales teams predict revenue beyond the standard Amount field they’ve already been using.

Custom Field Forecasts are available in: Performance, Unlimited, and Developer Editions

Note:  Custom Field Forecasts are currently available through a pilot program. Contact salesforce.com to enable this
feature for your organization. Any unreleased services or features referenced in this or other press releases or public
statements are not currently available and may not be delivered on time or at all. Customers who purchase our services
should make their purchase decisions based upon features that are currently available.

Now, your sales teams can forecast on custom currency fields on opportunities. For example, your sales teams might use a
custom field such as Margin, Monthly Recurring Revenue, Annual Contract Value, or any other currency field that your
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organization requires. You can easily set up forecasts based on any of those custom fields, which your sales managers can then
view in the Forecasts tab like any other forecast.

If you use opportunity splits with your custom field, your forecast incorporates those splits. You can use a custom field forecast
by itself or in addition to other forecasts, such as an opportunity-revenue forecast based on the opportunity Amount field.

Forecasting on Annual Contract Value-a Simple Custom Field Forecast

Here we see an opportunity owned by sales rep Anna Bressan. Anna’s organization has a lot of multi-year deals, so they use
a custom Annual Contract Value field to track the revenue received from the deal each year.

1. Anna owns this opportunity
2. The custom Annual Contract Value field

The Annual Contract Value field in all of Anna’s opportunities rolls up into her Annual Contract Value forecast, which appears
in the Forecasts tab along with any other forecasts that you set up.

1. The Annual Contract Value forecast for Anna
2. This forecast has the same name as the custom field
3. The Forecasted Amount is the value of the Annual Contract Value field that rolls up into Anna’s forecast
4. The amount from the Annual Contract Value field on Anna’s Acme – Premium Support opportunity
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A Custom Field Forecast with Opportunity Splits

If you use opportunity splits on your custom fields, your custom field forecasts roll up those splits. For example, here we can
see that sales representative Anna owns an opportunity, which includes a custom split on the Annual Contract Value field for
Kevin, a sales engineer responsible for increasing overall Annual Contract Value for the company. In this case, Kevin’s 25%
split will roll up into his Annual Contract Value forecast.

1. Anna owns this opportunity
2. The opportunity contains a custom currency field called Annual Contract Value
3. Kevin receives a 25% split on the Annual Contract Value field

Kevin’s manager can view the Annual Contract Value forecast where he can see the deal to which Kevin is contributing, along
with all of the other opportunities his sales engineer team is working on. Kevin’s manager can see that Kevin is receiving a 25%
credit for all of his opportunities, which contribute to a total of $1,052,250 revenue in his Best Case forecast. If Kevin’s manager
thinks the deal will ultimately close for a higher amount, his manager can adjust the Best Case forecast amount upward. Anna’s
manager can see Anna’s 75% split in their forecast.
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1. Kevin’s Annual Contract Value split forecast
2. Kevin’s 25% splits on Anna’s Acme – Premium Support opportunity

Forecasts with the Expected Revenue Field

If your organization uses the standard Expected Revenue field, you can set up a forecast for it as well. The Expected Revenue
field is useful for opportunities that are likely to produce more or less revenue than indicated in the Amount field.

Enable Custom Field Forecasts for Sales Managers
To enable a custom field forecast, first enable a custom split type for the field, and then add a forecast for it.

User Permissions Needed

“Customize Application”To enable opportunity split types:

“View Setup and Configuration”To view Forecast Setup:

“Customize Application”To edit Forecast Settings:

For each custom field your sales teams want to forecast on, first enable a custom split type—even if the fields don’t include
splits. When a sales rep creates an opportunity, the rep automatically receives a 100% split for any 100% validated custom split
type you enable. So even if you don’t intend to split the custom field, the forecast rollup always includes 100% of the amount
in the custom field.

Before you enable custom field forecasts, make sure you’ve enabled:

• Collaborative Forecasts
• At least one custom opportunity currency field
• Team Selling and Opportunity Splits
• A custom opportunity split type based on the custom field (For details on enabling split types, search Salesforce Help for

“Enabling Opportunity Splits and Split Types” .)

With those features enabled, you’re ready to enable a custom field forecast.

1. From Setup, click Customize > Forecasts > Settings.
2. If your organization:

• Doesn’t yet have any forecast types enabled, click Add a Forecast Type.
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• Already has at least one forecast type enabled, click Add Another Forecast Type. Enable up to four forecast types.

3. From the Forecast Type menu, choose the name of the custom opportunity split type you created based on your custom
opportunity field. Revenue is the only forecast measurement available for custom field forecasts.

4. Choose the columns you want to display in the related opportunities list on the Forecast tab for the custom field forecast.
5. Click OK and then Save.

Overlay Forecasts (Pilot)
Sales managers can track revenue from sales team members who help close opportunities, but are not directly responsible for
them.

Note:  Overlay Forecasts are currently available through a pilot program. Contact salesforce.com to enable this feature
for your organization. Any unreleased services or features referenced in this or other press releases or public statements
are not currently available and may not be delivered on time or at all. Customers who purchase our services should
make their purchase decisions based upon features that are currently available.

Your sales managers may already be using revenue splits for crediting team members who are directly responsible for
opportunities. To provide more flexibility with how they assign credit for opportunities, we’ve added overlay splits, which help
sales managers and other team members allocate credit to overlay sales roles for working on opportunities. Overlay splits can
add up to any percentage of the opportunity amount, sometimes exceeding 100%. For example, a sales team may include sales
engineers, product specialists, or partners who help close deals, but are not directly responsible for them.

Overlay Forecasts let sales managers predict revenue from overlay splits. Forecast amounts roll up through the role hierarchy
based on the opportunity’s amount field and the overlay team member’s split percentage.

For complete details, see Predicting Revenue from Supporting Team Members with Overlay Forecasts (Pilot).

Enable Overlay Forecasts for Sales Managers

Help your sales teams track revenue from overlay sales roles when you add Overlay Forecasts to your organization.

Enable Overlay Forecasts for Sales Managers
Help your sales teams track revenue from overlay sales roles when you add Overlay Forecasts to your organization.

User Permissions Needed

“View Setup and Configuration”To view Forecast Setup:

“Customize Application”To edit Forecast Settings:

Before you enable Overlay Forecasts, make sure you’ve enabled:

• Collaborative Forecasts
• Team Selling and Opportunity Splits
• The Overlay opportunity split type

With those features enabled, you’re ready to enable Overlay Forecasts.

1. From Setup, click Customize > Forecasts > Settings.
2. If your organization:

• Doesn’t yet have any forecast types enabled, click Add a Forecast Type.
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• Already has at least one forecast type enabled, click Add another forecast type. You can enable up to four forecast
types.

3. From the Forecast Type menu, choose Opportunity Overlay Splits. Revenue is the only forecast measurement available
for overlay splits.

4. Choose the columns you want to display in the related opportunities list on the Forecast tab for the overlay forecast.
5. Click OK and then Save.

Historical Trending for Forecasts
Sales users can now see how their forecasts have changed over time.

You can now use reports to examine how your forecast data has changed over the prior three months or quarters. For complete
details, see Track Forecasting Changes.

Forecasts 1.0 (Classic) is Retired in Summer ’14
Effective with Summer ’14, Forecasts 1.0 (Classic) is officially retired. For more information, please contact salesforce.com
Customer Support.

We recommend using Collaborative Forecasts to manage your forecasts. To get started, see the Forecasts Administrator's
Workbook, which provides a full step-by-step description of how to set up Collaborative Forecasts for your organization.

Note:  Customizable Forecasts is not affected by this announcement. Only Forecasts 1.0 (Classic) is being retired.

Model, Manage, and Analyze Your Sales Territories with
Territory Management 2.0 (Beta)

Territory Management 2.0 lets you model your sales territories into a logical and flexible structure that connects sales reps to
the accounts they sell to.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Salesforce’s original territory management feature lets you grant users access to accounts based on criteria such as postal code,
industry, revenue, or a custom field relevant to your business. Territory Management 2.0 builds on that by introducing territory
types, territory models, and territory model states. Use these tools to create and preview multiple territory structures and
strategies before you activate and implement the one that works best. Custom reports help you organize your territory model
for optimum coverage, assess territory effectiveness, and modify your model if necessary.

Territory Management 2.0 is API ready, with nine new objects that help you manage territories, assign records, and assign
users programatically. For more information, check out New Objects on page 271.

For best success with Territory Management 2.0, read the full product implementation documentation—available in the
Salesforce Help and as a PDF guide: Implementing Territory Management 2.0 (Beta). We also welcome you to join our success
community on Chatter, Sales Cloud – Territory Management, where you can interact with our development team and post
questions and comments. Find us at https://success.salesforce.com/.
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Beta Limitations
The beta release of Territory Management 2.0:

• Is not supported on Internet Explorer 7.0 or earlier versions.
• Is not integrated with Customizable Forecasts.
• Allows only accounts to be assigned to territories: direct assignment of contacts, opportunities, and cases is not available.
• Allows manual user assignments only. Users cannot be transferred between territories.
• Allows Salesforce Partner Relationship Management and Customer Support portal users to be assigned to territories but

does not allow those users to view Territory Management 2.0 objects, as Salesforce standard users can.

Implement Territory Management 2.0

Use Territory Management 2.0 to manage and maintain your organization’s sales territories. Create territory types, build a
model, and then add and test your account assignment rules. When you’re satisfied with your model, activate it, then assign
users and accounts. Roll it out to your organization, and then run reports to assess its impact and make adjustments if
necessary.

Implement Territory Management 2.0
Use Territory Management 2.0 to manage and maintain your organization’s sales territories. Create territory types, build a
model, and then add and test your account assignment rules. When you’re satisfied with your model, activate it, then assign
users and accounts. Roll it out to your organization, and then run reports to assess its impact and make adjustments if necessary.
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Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”To manage sales territories:

Before you begin building your territory model, plan your approach. Choose organizing characteristics such as industry, annual
revenue, or location information to divide your organization’s accounts into logical segments that work for the way you do
business.

Enable Territory Management 2.0

You need to contact salesforce.com Customer Support to get Territory Management 2.0 before you enable the feature in
your organization.

Define Default Record Access for your Sales Territories

Specify the default settings for how users can access and modify records associated with the sales territories you set up. The
access provided by default settings can be modified when you create or edit an individual territory.

Build a Territory Model

A territory model organizes all the elements of your organization’s territory management plan, including a territory hierarchy,
account assignments, and user assignments. Keep your model in the planning state as you build your hierarchy, define
assignment rules for territories, add users to territories, and run your rules to see the resulting account assignments.

Assign Users to Territories

Assign users to the territories they will operate in to sell products and services.

Activate a Territory Model

When you’re satisfied with the structure of your territory model and its territory account assignments, you’re ready to activate
it. Remember that you can also maintain models in Planning and Archived states for further modeling and reference.

Configure Territory Management 2.0 Access for Users

As part of implementing Territory Management 2.0, you need to make sure your users can access and use its features.

Create Custom Report Types for Territory Management 2.0 Reports

Organizations using Territory Management 2.0 run reports that show account assignments, user assignments, and more.
Set up custom report types so sales managers can create the reports they need. See the Salesforce Help for detailed instructions
on creating selected reports from these types, as listed here.

Enable Territory Management 2.0
You need to contact salesforce.com Customer Support to get Territory Management 2.0 before you enable the feature in your
organization.

User Permissions Needed

“Customize Application”To enable Territory Management 2.0:

Note:  Enabling Territory Management 2.0 (Beta) automatically clears the value (if any) in the Territory field on
opportunity records in your organization.
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1. From Setup, click Manage Territories > Settings.
2. Click Enable Territory Management 2.0.

Define Default Record Access for your Sales Territories
Specify the default settings for how users can access and modify records associated with the sales territories you set up. The
access provided by default settings can be modified when you create or edit an individual territory.

The standard settings are for accounts and opportunities. If your organization uses Private default internal access for Contacts
and Cases, you’ll also see options for those objects on this page.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To create a territory model:

1. From Setup, click Manage Territories > Settings.
2. Select the default access levels you want for accounts and opportunities.
3. If applicable, select the default access levels for contacts and cases.
4. Click Save.

Build a Territory Model
A territory model organizes all the elements of your organization’s territory management plan, including a territory hierarchy,
account assignments, and user assignments. Keep your model in the planning state as you build your hierarchy, define
assignment rules for territories, add users to territories, and run your rules to see the resulting account assignments.

Create Territory Types

Territory types help you categorize and define individual territories. Creating territory types is the first step in building your
territory model in Salesforce.

Create a Territory Model Record

The first step in building your territory model is creating the record that connects the other elements, including territories,
user assignments, and account assignments. When you create a territory model record, Salesforce generates a territory hierarchy
for it.

Create Territories

Create territories as you build your organization’s territory model. When you create a territory, it appears on the model’s
territory hierarchy.

Create and Preview Territory Account Assignments

You assign accounts to territories by either creating rules that assign them automatically or adding them manually. Rules can
be configured to apply to both parent territories and their descendents. Manual assignments apply only to the territory where
they are created.

Create Territory Types
Territory types help you categorize and define individual territories. Creating territory types is the first step in building your
territory model in Salesforce.
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User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To create a territory type:

Examples of territory types you might wish to create to organize your territories are Named Accounts, Direct Accounts, or
Overlay Sales.

1. From Setup, click Manage Territories > Territory Types.
2. Click New Territory Type.
3. Enter a label and a description. In your description, make sure you clearly indicate what kinds of territories should belong

to that type.
4. Click Save.

Create a Territory Model Record
The first step in building your territory model is creating the record that connects the other elements, including territories,
user assignments, and account assignments. When you create a territory model record, Salesforce generates a territory hierarchy
for it.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To create a territory model:

1. From Setup, click Manage Territories > Territory Models.
2. Click New Territory Model.
3. Define the label and description fields.
4. Click Save.

Create Territories
Create territories as you build your organization’s territory model. When you create a territory, it appears on the model’s
territory hierarchy.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To create a territory:

1. Open the territory model where you want to create the territory.
2. If you need to, select Tree View from the drop-down to show the model’s territory hierarchy, including any existing

territories.
3. To create a top-level territory, hover over the territory model name and click Create Territory. To create a child territory

from an existing territory, hover over the territory name and click Create Territory.
4. On the New Territory page, define the territory: give it a meaningful label, choose its territory type. If the territory requires

different user access for accounts and opportunities than the default user access for those records, define the territory’s user
access levels.

5. Click Save.
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Create and Preview Territory Account Assignments
You assign accounts to territories by either creating rules that assign them automatically or adding them manually. Rules can
be configured to apply to both parent territories and their descendents. Manual assignments apply only to the territory where
they are created.

Before you commit to your model’s account assignments, you should preview them by running assignment rules and related
reports while the model is in Planning state. When you’re satisfied with your planned account assignments, change the
model to Active state. Then run rules and make manual assignments again.

Use Rules to Assign Accounts to Territories

Create and run rules that automatically assign new or edited accounts to territories. A rule identifies one or more characteristics
you use to define that territory, and tells Territory Management 2.0 to assign accounts with those characteristics to that
territory automatically. If your territory is in Planning state, running rules lets you preview account assignments. If your
territory is in Active state when you run rules, accounts are assigned to territories according to your rules.

Assign Accounts to Territories Manually

Accounts that are not assigned to territories by rules can be assigned to territories manually. Manual assignment is useful for
accounts that have unique characteristics and therefore can’t be assigned by rules.

Preview Territory Account Assignments

Before you activate a territory model, you should preview and validate its territory account assignments. Preview assignments
by running assignment rules when the model is in Planning state. Also verify your manual assignments.

Use Rules to Assign Accounts to Territories

Create and run rules that automatically assign new or edited accounts to territories. A rule identifies one or more characteristics
you use to define that territory, and tells Territory Management 2.0 to assign accounts with those characteristics to that territory
automatically. If your territory is in Planning state, running rules lets you preview account assignments. If your territory is
in Active state when you run rules, accounts are assigned to territories according to your rules.

User Permissions Needed

“Customize Application”

“Manage Territories”

“View All” on accounts

To create rules within your territories:

1. From the territory model hierarchy, open the territory where you want to create a rule.
2. On the detail page, in the Assignment Rules Defined in this Territory related list, click New.
3. On the rule edit page, enter a name for the new rule and define selection criteria.
4. If you want the rule to also apply to the current territory’s descendents, select the Apply to child territories checkbox.
5. If you want the rule to run automatically whenever a user creates or edits an account, select the Active checkbox.
6. Click Save to save the rule and return to the territory detail page.
7. (Optional) In the Assignment Rules Defined in This Territory related list, click Run Rules.

You’ll receive an email when the process is complete.

Rules can work together within and across territories and child territories. For example, you create a territory called Western
States, with child territories Washington, Oregon, and California. From the Western States territory record, you create a
rule that assigns accounts in Washington, Oregon, and California to that territory. You apply that rule to child territories
and then, from the California territory record, you create a rule that assigns accounts in far northern California to the
Oregon territory.
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Assign Accounts to Territories Manually

Accounts that are not assigned to territories by rules can be assigned to territories manually. Manual assignment is useful for
accounts that have unique characteristics and therefore can’t be assigned by rules.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To assign accounts manually within your territories:

1. From the territory model hierarchy, open the territory where you want to assign an account.
2. On the territory’s detail page, in the Manually Assigned Accounts related list, click Add Accounts to see a list of your

organization’s accounts.
3. In the Available related list, select the checkbox for each account you want to assign. If you need to view more records,

click More beneath the list.
Each selected account appears in the Selected related list.

4. Click Assign.

Preview Territory Account Assignments

Before you activate a territory model, you should preview and validate its territory account assignments. Preview assignments
by running assignment rules when the model is in Planning state. Also verify your manual assignments.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To preview territory model account assignments:

Important:  To protect data quality, you cannot modify a territory until you receive the email confirming that the
rules have been run successfully. If rules do not run successfully, follow instructions provided in the email for
troubleshooting specific issues.

1. Open the record for the territory model whose assigned accounts you want to preview and click View Hierarchy.
2. Verify that the model is in Planning state.
3. Click Run All Rules.

When rules are finished running, we’ll send an email to let you know. Processing may take some time, depending on the
size and complexity of your organization.

4. From the territory model hierarchy, open each territory and descendent affected assignment rules. Also open territories
that have manual account assignments.

5. On the territory detail page, click View Accounts to see assigned accounts. The Method column indicates how each
account was assigned: by a rule or manually.

Note:

If you make changes to the rules for a territory, you must run rules again to view those changes. In this case, you may
want to run rules on that territory only. To do so, navigate to the territory’s detail page, scroll to the Assignment
Rules Defined in this Territory related list, and click Run Rules.
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Assign Users to Territories
Assign users to the territories they will operate in to sell products and services.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To assign users to territories:

1. From the territory model hierarchy, open the territory where you want to assign users.
2. On the territory’s detail page, in the Assigned Users related list, click Manage Users.
3. On the Assign Users page, select or search for the user you want to add.
4. Click Save.

Activate a Territory Model
When you’re satisfied with the structure of your territory model and its territory account assignments, you’re ready to activate
it. Remember that you can also maintain models in Planning and Archived states for further modeling and reference.

User Permissions Needed

“View Setup and Configuration”

“Manage Territories”

To activate a territory model:

Important:  Only one model can be in the Active state at one time in your organization, and you can only activate
a model that is in the Planning state. After activating a model, you cannot reset it to Planning state: you can only
set it to Archived state.

1. If you need to, preview account assignments before activating the model.
2. Open the record for the territory model you want to activate and click View Hierarchy.
3. Click Activate.

The model state changes to Activating while Salesforce processes your request. Activation may take some time, depending
on the size and complexity of your organization. When the process is complete, we’ll send you an email to let you know.

Configure Territory Management 2.0 Access for Users
As part of implementing Territory Management 2.0, you need to make sure your users can access and use its features.

User Permissions Needed

“Manage Users”To assign user permissions:

“Customize Application”To create, edit, and delete page layouts:

1. Make sure you understand how permissions affect territory model and record access in Territory Management 2.0.
2. Assign user permissions as needed.
3. Add the Assigned Territories related list to your account page layouts.
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How Permissions Affect Feature and Data Access in Territory Management 2.0

When implementing Territory Management 2.0, make sure you understand how the feature’s permissions affect administration
and provide access to records and data.

How Permissions Affect Feature and Data Access in Territory Management 2.0
When implementing Territory Management 2.0, make sure you understand how the feature’s permissions affect administration
and provide access to records and data.

Make sure user permissions provide the appropriate level of access for users. For example, you might want Sales Operations
managers and selected Sales managers to be able to manage territories. If so, assign them the Manage Territories permission.
Anyone who will also create account assignment rules also needs the View All permission on Accounts.

Require these permissions:Users who need to:

Manage Territories• Create territory models and all related records (such as
territory types).

• View and manage territory models in all states:
Planning, Active, and Archived.

• Activate, archive, and delete territory models.

• View territory information on territory-assigned account
records for territories in models in all states (Planning,
Active, and Archived).

Manage Territories AND View All on Accounts• Create account assignment rules.

Note:  Which fields are available for account
assignment rules depends on account field-level
security settings, if any. For example, a user has the
appropriate permissions for creating account
assignment rules, but her profile prevents her from
viewing the Account object’s Annual Revenue
field. She will not be able to create account
assignment rules that include that field.

View Setup and Configuration• View the Salesforce Setup tree, including the Manage
Territories section.

Note:  View Setup and Configuration is enabled by
default for the Standard User profile.• View the territory model in Active state, including its

related records (such as territory types and assignment
rules) and other elements (such as the territory hierarchy).

• View all account records assigned to territories in the
Active territory model.

• View territory information on territory-assigned account
records for territories in models in the Active state only.

Create Custom Report Types for Territory Management 2.0 Reports
Organizations using Territory Management 2.0 run reports that show account assignments, user assignments, and more. Set
up custom report types so sales managers can create the reports they need. See the Salesforce Help for detailed instructions
on creating selected reports from these types, as listed here.
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User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

1. Make sure you’re familiar with custom report types and the general steps for creating and maintaining them.
2. Create custom report types relating these objects and configuring them where necessary. Make all fields available for

reporting. Add each report to the Territory Management report type category. Provide a clear name and description for
each report type so users who create reports can understand which one to use for their needs.

CBA (Primary Object)Report (*Documented in the
Salesforce Help)

–Territories

Select “A” records must have
related “B” records.

Accounts*Accounts assigned to
territories

–Territories

Select “A” records may or
may not have related “B”
records.

AccountsAccounts not assigned to
territories

Territory-Assigned Records

Select “B” records must have
related “C” records.

TerritoriesTerritory ModelsTerritories with assigned
accounts

Territory-Assigned Records

Select “B” records may or
may not have related “C”
records.

TerritoriesTerritory Models*Territories without assigned
accounts

–Territories

Select “A” records must have
related “B” records.

UsersUsers assigned to territories

–Territories

Select “A” records may or
may not have related “B”
records.

Users*Users not assigned to
territories

Users

Select “B” records must have
related “C” records.

TerritoriesTerritory Models*Territories with assigned
users

Users

Select “B” records may or
may not have related “C”
records.

TerritoriesTerritory ModelsTerritories without assigned
users
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CBA (Primary Object)Report (*Documented in the
Salesforce Help)

–Territories

Select Each “A” record must
have at least one related “B”
record.

Accounts*Summarizable account
information by territory

3. Deploy the report types you want to make available to users.
4. Let users know that they can create reports using these custom report types.

Salesforce for Outlook
We’re continuing to help users be more productive when they use the Salesforce Side Panel. We’re also giving you more
security control in Salesforce for Outlook.

Available in: All Editions

Before we dive into our latest features, it’s a good time to consider migrating any remaining folks in your organization who
use Connect for Outlook to Salesforce for Outlook, because in addition to including Connect for Outlook features your users
know, Salesforce for Outlook includes:

• Support for Microsoft Exchange Online—the Microsoft-hosted service that integrates with Office 365™

• The Salesforce Side Panel

• Options to sync only some or all Microsoft® Outlook® contacts, events, and tasks

• Automatically scheduled sync cycles

Take a look at our latest enhancements to Salesforce for Outlook and the side panel.

Salesforce Side Panel Available in Contact Manager and Group Editions

Now all Salesforce for Outlook users have access to the side panel.

Create More Kinds of Salesforce Records Directly from the Side Panel

If your Salesforce for Outlook users generate sales prospects while they’re working in Microsoft® Outlook®, they’ll love that
they now can create more kinds of records directly from the side panel using the Salesforce Side Panel Publisher.

Customize Side Panel Publisher Menus for Different Users

Depending on your Salesforce edition, you can create multiple publisher layouts for the Salesforce Side Panel and customize
each layout with different sets of Publisher Actions. This helps users with different responsibilities create different kinds of
records directly from the side panel.

Users Can Download Salesforce for Outlook without Administrative Support

Now your users can download Salesforce for Outlook and access select features with less work on your part.

Schedule Logouts for Salesforce for Outlook with Connected Apps

If your organization is required to comply with a security policy that periodically logs your users out of their applications,
you’ll love that refresh token expirations you set in Connected Apps now also apply to Salesforce for Outlook.
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Salesforce Side Panel Available in Contact Manager and Group
Editions

Now all Salesforce for Outlook users have access to the side panel.

Contact Manager and Group Editions can now:

• View Salesforce contacts and leads related to their Microsoft® Outlook® emails.

• Create records directly in the side panel with the side panel publisher.

• Add Microsoft® Outlook® emails and events to Salesforce records.

Learn more in “Available Salesforce for Outlook Features by Salesforce Edition” in the Salesforce Help.

Create More Kinds of Salesforce Records Directly from the Side
Panel

If your Salesforce for Outlook users generate sales prospects while they’re working in Microsoft® Outlook®, they’ll love that
they now can create more kinds of records directly from the side panel using the Salesforce Side Panel Publisher.

User Permissions Needed

“Side Panel” in Outlook configurationsTo display the Salesforce Side Panel:

“Create” and “Read” on all objects that users create records
from AND “Visible” on all required fields in records that users
create

To create new records from the Salesforce Side Panel:

We’re packing even more functionality into the side panel by making the create case feature even better. We’re introducing
the Salesforce Side Panel Publisher, which lets users create not only cases, but also accounts, contacts, leads, opportunities,
and custom object records—all directly from the side panel.

Here’s how users create records from the side panel publisher.

1. After selecting an email in Microsoft Outlook®, click  and select the type of record that you want to create.

2. Provide details that are relevant to the record.

3. Click  to save the record.

Keep in mind that email attachments aren’t included in the new records.
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You must set up the side panel publisher for your users by adding publisher actions to a publisher layout. The process for
setting up your users depends on your Salesforce edition. During setup, you can also choose which fields appear on record
detail pages in your users’ side panel menus. Those fields can be different from the ones you’ve chosen for record detail pages
in Salesforce.

• Contact Manager, Group, or Professional Edition users create Create a Record global actions, add them to their
Global Publisher Layout, and assign the layout to the appropriate user profile or profiles.

• Enterprise, Performance, Unlimited, or Developer Editions users create Create a Record global actions, add them to
one or multiple Outlook Side Panel Publisher Layouts, and assign those layouts to the appropriate user profile or profiles.

For more details about the new Outlook Side Panel Publisher Layouts feature, see the next section.

Customize Side Panel Publisher Menus for Different Users
Depending on your Salesforce edition, you can create multiple publisher layouts for the Salesforce Side Panel and customize
each layout with different sets of Publisher Actions. This helps users with different responsibilities create different kinds of
records directly from the side panel.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel” in Outlook configurationsTo display the Salesforce Side Panel:

“Customize Application”To set up global actions:

“View Setup”To view side panel publisher layouts:

For example, you might want your sales managers to be able to create new account, case, contact, and opportunity records
from the side panel, but your service reps to be able to create only new case records. You also might want your sales managers
to have more fields to complete in the case record detail page than your service reps do.

As administrator, you’ll customize side panel publisher menus by:

1. Creating a Create a Record global action for each publisher action you want to be available in your users’ side panel
publisher menus, and adding the appropriate fields for those actions. If you’ve already set up Create a Record global
actions to use in other Salesforce features, you don’t need to create them for the same kinds of records again—they’re
already available to add to the side panel publisher.

2. Creating a new Outlook Side Panel Publisher Layout from Setup > Desktop Administration > Outlook Configurations.
3. Editing the new layout to add the publisher actions that you want to be available to a user or a group of users.
4. Assigning the layout to a user profile or profiles that includes the group of users you want to use this publisher layout.

Create additional layouts with different sets of publisher actions for other groups of users.

Users Can Download Salesforce for Outlook without
Administrative Support

Now your users can download Salesforce for Outlook and access select features with less work on your part.
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Salesforce for Outlook available in: All Editions

Outlook Configurations available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel” in Outlook configurationsTo display the Salesforce Side Panel:

“Modify All Data”To enable or disable Email to Salesforce:

In the past, you had to grant your users access to download Salesforce for Outlook by creating an Outlook® configuration and
adding those users to it. Now all Salesforce users automatically have access to download Salesforce for Outlook, and can take
advantage of these Salesforce Side Panel features: 

• Viewing Salesforce contacts and leads related to emails in users' Outlook Inboxes.

• Viewing Salesforce activities, opportunities, and cases associated to those contacts and leads.

Users who have enabled the My Email to Salesforce feature can also save Outlook® emails to Salesforce, and add an email or
event to multiple contacts, and to one other record with which you can associate tasks, such as an account, a case, or an
opportunity.

If you're using Professional, Enterprise, Performance, Unlimited, or Developer Editions of Salesforce, you can still control
the access your users have to Salesforce for Outlook features by editing your Outlook® configurations, just as you have in the
past. For example, to prevent users from downloading Salesforce for Outlook, add them to an Outlook® configuration in
which all features are disabled.

To access your Outlook® configurations, from Setup, click Desktop Administration > Outlook Configurations.

Schedule Logouts for Salesforce for Outlook with Connected
Apps

If your organization is required to comply with a security policy that periodically logs your users out of their applications, you’ll
love that refresh token expirations you set in Connected Apps now also apply to Salesforce for Outlook.

User Permissions Needed

“Side Panel” in Outlook configurationsTo display the Salesforce Side Panel:

“Customize Application” AND either

“Modify All Data” OR “Manage Connected Apps”

To create, update, or delete a Connected App:

If you have already scheduled refresh token expirations for your Salesforce application users through Connected Apps, you’ll
notice that Salesforce for Outlook users are now logged out on the same schedule. Salesforce for Outlook won’t run scheduled
syncs or allow a user to access Salesforce data from the side panel until the user logs back into Salesforce manually. Users will
be prompted to log back in again when a scheduled sync fails or a user tries to use the side panel.

Salesforce Console for Sales
The Salesforce Console for Sales is a dashboard-like app designed to help you access sales intelligence quickly with fewer clicks
and less scrolling.
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Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

Salesforce Console Enhancements
The Salesforce Console for Sales and the Salesforce Console for Service share new features that help administrators and
developers customize the console for users. For more information, see Salesforce Console for Service on page 157.

Activities
Events and tasks are the building blocks of sales productivity. We’ve made enhancements that boost your sales teams’ edge
over the competition, along with updates to improve performance and usability.

Available in: All Editions except Database.com

Default Event Action Lets Users Create Events from Any Publisher

We’ve added New Event to the default actions on the global publisher layout. Now users can create events on the Home
tab, the Chatter tab, and record detail pages, without administrator setup.

Use Formulas to Track and Validate Activities by Date or by Date and Time

Now you can include the date or the date and time of an activity in a custom formula field or a validation rule. Set a validation
rule based on the due date of an event or a task, or track sales reps’ appointments or approaching task due dates.

Report on Sales Reps’ Meetings with Customers

Now your sales managers can get more insight into which customers sales reps are spending their time with. To create a
custom report on sales reps’ meetings with leads and contacts, relate the User object to the new Activity Relationship object.

Use Additional Activities Fields to Run More Comprehensive Reports

In custom reports on activity relationships, now you can include details including related contacts and accounts, invitees, and
task status.

Related To and Status Fields Make Task Lists More Useful

We’ve added the fields Related To and Status to the task lists on the Home tab and in the calendar day view. Users can now
see the account, opportunity, or other record a task is related to, and the task’s status.

Other Changes in Activities

We’ve made some additional changes to Salesforce events and tasks.

Default Event Action Lets Users Create Events from Any Publisher
We’ve added New Event to the default actions on the global publisher layout. Now users can create events on the Home tab,
the Chatter tab, and record detail pages, without administrator setup.

Here is the New Event action in the Salesforce app:
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And here is the action in Salesforce1:

Use Formulas to Track and Validate Activities by Date or by Date
and Time

Now you can include the date or the date and time of an activity in a custom formula field or a validation rule. Set a validation
rule based on the due date of an event or a task, or track sales reps’ appointments or approaching task due dates.

Suppose that your sales managers want to remind reps to follow up on five-day-old leads, or that you want to prevent reps
from marking tasks closed before they’re due. Use the ActivityDate field to create a validation rule based on all-day events or
on tasks.

This example shows the ActivityDate field selected in the Formula Builder:

Or let’s say that sales managers want to compare the number of morning and afternoon appointments that sales reps make
with customers. Use the ActivityDateTime field to create a custom formula based on events with a date and time. (The Task
object doesn’t support this field.)

This example shows the ActivityDateTime field selected in the Formula Builder:
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For more information, see “Work with Formulas in Report Builder” in the Salesforce Help.

Report on Sales Reps’ Meetings with Customers
Now your sales managers can get more insight into which customers sales reps are spending their time with. To create a custom
report on sales reps’ meetings with leads and contacts, relate the User object to the new Activity Relationship object.

This example shows each sales rep’s past or future customer meetings to discuss opportunities.

Note: If you haven’t enabled Shared Activities, then custom reports based on activity relationships don’t include
event organizers along with invitees, and they don’t show events to which no one has been invited.

For more information, see “Report on Sales Reps’ Meetings with Customers” in the Salesforce Help.

Use Additional Activities Fields to Run More Comprehensive
Reports

In custom reports on activity relationships, now you can include details including related contacts and accounts, invitees, and
task status.

These fields are now available for reports:
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• Is Parent

• Is What

• Is Invitee

• Date Responded

• Invitee Status

• Invitee Comment

In addition, reports created using the new Activity Relationships object include two status fields:

• Invitee Status indicates whether invitees have accepted, declined, or not responded to events.

• Task Status shows the status of tasks.

Related To and Status Fields Make Task Lists More Useful
We’ve added the fields Related To and Status to the task lists on the Home tab and in the calendar day view. Users can now
see the account, opportunity, or other record a task is related to, and the task’s status.

Other Changes in Activities
We’ve made some additional changes to Salesforce events and tasks.

Security is Improved in the Multi-User Calendar View

In the multi-user calendar view, a user who doesn’t have permission to view an event in another user’s calendar now sees
only the event’s start and end time. The user no longer sees the subject or other event details in the calendar overlay:

Likewise, if you’ve enabled the option to show event details in the calendar, the user no longer sees the subject or other
event details in the calendar itself:

Custom Reports Based on Activity Relationships Not Fully Supported without Shared Activities

If you haven’t enabled Shared Activities, then custom reports based on activity relationships don’t include event organizers
along with invitees, and they don’t show events to which no one has been invited.
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API Objects Changed

For details about changes to the objects ActivityHistory, Event, OpenActivity, and Task, see Changed Objects on page
273.

Customizable Price Book Entries
Administrators can customize price book entries in the user interface.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view setup options:

“Customize Application”To customize your organization:

“Read” on price books

AND

To view price book entries:

“Read” on products

“Create” or “Edit” on productsTo create or change standard price book entries:

“Create” or “Edit” on price booksTo create or change custom price book entries:

“Create” on price booksTo clone price book entries:

“Edit” on price booksTo delete price book entries:

The three types of product-related records are  products, price books, and price book entries.  Products were customizable
when they were first introduced.  Price books were made customizable in Summer ’13.  With this release (Summer ’14), 
price book entries are customizable!  You can now create fields, page layouts, and validation rules for your price book entries
in Setup.

Let’s look at some of the ways that you can take advantage of these enhancements.

• Easier integration: You can now create a custom field to store an external ID in each price book entry record, which
enables efficient import, export, and synchronization with an external source.

• More flexibility: You can now create custom fields to store the validity of your price book entries by setting effective start
and end dates. Also, you can create custom fields to help drive calculated pricing or discounts on your opportunities
according to business logic.

• Data quality: You can now improved the data quality of price book entry records by preventing users from saving incorrect
data through the use of validation rules.

• More control: To address the business needs of your different business units, you can create multiple page layouts to
control the fields that users see on price book entry detail and edit pages.

Price Book Entry now exists in Setup!  From Setup, click Customize > Price Books > Price Book Entries.

123

Customizable Price Book EntriesSales



Note:  The price book entry object doesn’t support the creation of roll-up summary fields.  In addition, the price book
entry object isn’t available as related lookups from other objects.

Users can now view and edit price book entries. Every field on the detail page maps to an underlying field of the corresponding
PricebookEntry standard object. One field is added to the user interface that is not on the standard object—the Standard Price
field, which is a derived field that stores the standard price from the product’s standard price book.

Note:  There are no field dependencies for price book entry fields in the user interface. If the Use Standard Price
checkbox is removed from the page layout and this checkbox is selected for a price book entry, users won’t be able to
edit the list price because the List Price field will be disabled and can’t be enabled on this page.

You can access a price book entry in various ways. Click View or Edit next to an entry in any of the following locations.

• From the price book detail page, in the Products related list

• From the product detail page, in the Standard Price related list

• From the product detail page, in the Price Books related list

• From the price book entry list view

This image shows a price book with two price book entries listed in the Products related list of a custom price book.

124

Customizable Price Book EntriesSales



1. In the Products related list, each row is a price book entry.
2. Click View, Edit, or Del next to each price book entry to view, edit, or delete the entry.

Considerations for Custom Fields in Price Book Entries
The following considerations apply only to price book entries that were created or edited by using the Salesforce user interface. 
There is no impact to price book entries that were created or edited by using Data Loader or the API.

You can add standard or list prices only through the multiline add pages (the Add Standard Price page and the Add List Price
page).  These pages do not support custom fields.  To add standard or list prices and populate custom fields, you must add
the price book entry via the multiline add page and then update the custom fields via the price book entry edit page.

You can edit standard or list prices in either of the following ways: through the multiline edit pages (Edit Standard Price and
Edit List Price) or the Price Book Entry Edit page.  Similar to the multiline add pages, the multiline edit pages do not support
custom fields.  You can only edit custom fields that are associated to your standard or list prices via the Price Book Entry edit
page.

Note:  If your price book entry object has custom fields set as Required, you can’t create price book entries in the
Salesforce user interface. You can create price book entries only by using Data Loader or the API.

Generate Orders (Pilot)
Automatically create an order with order products from an opportunity or quote. You can also generate and relate the order
to a contract.

Generate Orders is available in: Enterprise, Performance, Unlimited, and Developer Editions

Note:  Generate Orders is currently available through a pilot program. Contact salesforce.com to enable this feature
for your organization. Any unreleased services or features referenced in this or other press releases or public statements
are not currently available and may not be delivered on time or at all. Customers who purchase our services should
make their purchase decisions based upon features that are currently available.
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Leveraging the new standard lookup fields in Summer ’14 and the declarative power of Flow, the Generate Orders package
gives you the ability to automatically create an order and order products from the line items on an opportunity or quote. It can
even create and link a contract if needed. Generate Orders helps you increase value in several ways:

• Increase Productivity—Your sales and operations teams don’t want to waste time keying in orders. Now you can automatically
generate a complete order with the click of a button. The orders are automatically linked to your opportunities, quotes,
contracts, and accounts, so you immediately have a complete picture of the closed deal.

• Reduced Errors—Ensure that your orders exactly match your opportunities or quotes. The products, sales prices, and
quantities are automatically carried over to the order just as presented to the customer. You can be sure that your customers
get exactly what they ordered.

• Streamlined Process—Create orders quickly and accurately.

◊ Process your orders in record time. As soon as you close the deal, the order can be created and ready to be fulfilled, and
your customers can start using your products and services without delay.

◊ Your back office gets timely and accurate data.

◊ It’s easy to modify your flow as your business changes.

The Generate Orders package comes with a set of flow templates and custom buttons which you can tailor to exactly match
your business requirements. You can easily add field mappings for additional standard or custom fields, or even custom objects.
When you’re done, link the flow to a custom button or workflow rule to streamline the order create process for your sales and
operations teams.

Note:  Flow trigger workflow actions and trigger-ready flows are available through a separate pilot program.

A Simple Generate Order Example
Here we see an opportunity detail page modified to use Generate Orders. (1) Generate the order from a custom button or (2)
from a workflow rule, for example when the Stage is set to Closed Won.

You can modify the flow to (3) also link a contract and (4) create the order automatically.
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(5) The order is automatically linked to the opportunity or quote, and (6) the products, prices, and quantities are automatically
pulled and added to the order.

How Generate Orders Works
Generate Orders is a set of flow templates that you can install and customize to automatically create an order with order
products from an opportunity or quote, and also generate and relate the order to a contract.

Every customer has different business requirements for how and when orders should be created, as well as the information
that needs to be stored on orders. Flow is a great tool to convert opportunities or quotes into orders because it provides a
declarative way to create and maintain the logic and to create or update records in Salesforce. (7) select the flow template that
matches your requirements, and (8) customize the flow’s steps as necessary. No coding required! As your business changes,
you can easily modify the flow to accommodate your new process and data requirements.
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These flow templates retrieve selected data from the opportunity or quote and account that’s used to create the orders and
order products. Depending on the template you use, the flow could also create a contract and relate it to the opportunity or
quote. The flow creates an order, looks up the opportunity products or quote line items, and creates an order product for each
line. You can modify one or more of these templates to:

• Retrieve additional fields from other objects and map them to fields on the contract, order, or order products being created.
• Include or exclude certain opportunity products or quote lines to be used for generating order products.
• Create records for other objects and relate them to the newly created records.

Other Changes in the Sales Cloud
Learn about other changes that affect your sales teams.

Territory Field Removed on Accounts for Organizations Using Territory Management 2.0 (Beta)

For organizations using Territory Management 2.0 (Beta), the Territories field is no longer available on Accounts.
Territory Management 2.0 offers a related list called Assigned Territories that you can add to account page layouts. The
Assigned Territories related list provides information on territories the account is assigned to, including the territory
model. It includes Territory, Territory Model, Model State, Assignment Date, and Method fields. If your organization
uses Territory Management 2.0 (Beta), you’ll find implementation details in these release notes.

Territory Field Value Cleared on Opportunity Records for Organizations Enabling Territory Management 2.0
(Beta)

Enabling Territory Management 2.0 (Beta) automatically clears the value (if any) in the Territory field on opportunity
records in your organization.

Custom Formula Fields on Accounts

You can now insert Person Contact ID fields into formulas when creating custom formula fields for person accounts.
When using the Advanced Forumula editor, select Contact ID to insert a Person Contact ID into a formula. When
creating a formula manually, add PersonContactID to reference the Person Contact ID field. Previously, the Person
Contact ID field was not available for person accounts.

New Field on Opportunities

The Opportunity object has a new field: Contract.
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New Fields on Orders

The Order object has two new fields: Opportunity and Quote.

New Field on Order Product

The Order Product object has a new field: Quote Line Item.

New Field on Quotes

The Quote object has a new field: Contract.

Users Can Associate Records Related to Pipeline with Records Related to Sales in Progress

Help your sales teams identify relationships between records they use to increase pipeline (opportunities and quotes)
and records they use to manage sales in progress (orders and contracts). A single record may have multiple other records
associated with it. For example, when a sales representative creates multiple orders based on an existing opportunity, she
can relate all of those orders to that opportunity by entering the opportunity in the order’s Opportunity field.

In the following screenshot, the sales representative relates order 00000105 to opportunity Acme - 1,200 Widgets.

That order then appears in the opportunity’s Orders related list.

Your sales teams can relate the objects listed here. Follow the steps to set up this feature for each affected object.

Complete these stepsTo relate

Opportunities to a
contract

1. On Opportunity page layouts, add the Contract field.
2. On Contract page layouts, add the Opportunities related list.

Users can create opportunities directly from the Opportunities related list on a contract.

3. Grant your users the appropriate access to the Contract field on opportunities.
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Complete these stepsTo relate

Orders to an
opportunity

1. On Order page layouts, add the Opportunity field.
2. On Opportunity page layouts, add the Orders related list.
3. Grant your users the appropriate access to the Opportunity field on orders.

Orders to a quote 1. On Order page layouts, add the Quote field.
2. On Quote page layouts, add the Order related list.
3. Grant your users the appropriate access to the Quote field on orders.

Order products to a
quote line item

1. On Order Product page layouts, add the Quote Line Item field.
2. On Quote Line Items page layouts, add the Order Products related list.
3. Grant your users the appropriate access to the Quote Line Item field on order products.

Quotes to a contract 1. On Quote page layouts, add the Contract field.
2. On Contract page layouts, add the Quotes related list.
3. Grant your users the appropriate access to the Contract field on quotes.

For more details about page layouts and user access, see “Customizing Page Layouts” in the Salesforce Help and “Overview
of User Permissions and Access” in the Salesforce Help.
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Work.com
Work.com is a sales and service performance-management tool that helps managers and teams learn faster and perform better.

The Summer ’14 features only apply to Work.com on Salesforce, and not the legacy Work.com product. Work.com is currently
limited to English language support.

Skills (Generally Available)

Ever wish you could quickly find the experts in project management, contract negotiation, or any other field? Want a way
to showcase your talents or abilities? Skills allow users to share information about their professional expertise. With skills,
users can discover, collaborate with, and endorse others based on their knowledge.

Give Different Types of Rewards

Work.com Rewards allow you to tie tangible rewards to your badges. You can now attach badges to tangible rewards from
most digital gift codes globally.

Work.com Goal Enhancements

You can now track reduction metrics and metrics that don’t have an initial value of zero. You can also adjust the weight of
different metrics.

Added Support for Triggers and Workflow

The following Work.com objects now support triggers and workflow. For a full list of the features compatible with Work.com
objects, see “Triggers and Workflow for Work.com Objects” in the Salesforce Help.

Other Changes in Work.com

There are other important changes to Work.com, including additional functionality in Communities and Salesforce1.

Skills (Generally Available)
Ever wish you could quickly find the experts in project management, contract negotiation, or any other field? Want a way to
showcase your talents or abilities? Skills allow users to share information about their professional expertise. With skills, users
can discover, collaborate with, and endorse others based on their knowledge.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Skills requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as add-on
licenses for Professional Edition, Enterprise Edition, or Unlimited Edition and are included in Performance Edition.

Note:

The generally available Skills feature requires a Work.com license. Organizations that previously enrolled in the pilot
will have access to their Skills data after they obtain a Work.com license.

Users can add or remove skills on their Chatter profile page or on record detail pages, and other users can endorse those skills.
Use the global search bar to search for experts with specific skills.

Administrators can change object permissions for the skill and endorsement objects to suit the needs of their organization.
For example, you could restrict users from creating skills, and designate that only skills created by an administrator can be
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assigned to others. By default, supported user profiles have the ability to see, create, edit, and remove skills, and administrators
have “Modify All Data” and “View All Data” permissions.

Additionally, administrators can customize the skill and endorsement objects by adding custom fields, modifying page layouts,
and adding triggers, workflow, and validation rules. The skill hover can also be customized to expose specific standard and
custom fields.

There are improvements to skills in Summer ’14:

• Customizable hovers that can expose custom fields

• Feed posts when a person adds a new skill

Note:  The Skills feature is not supported in Communities.

Skills have special behaviors and limitations. See “Skills Limitations” in the Salesforce Help for details about who can see and
work with skills and endorsements.

Enable Skills

Enable skills in your organization on the Work.com Settings page.

Enable Skills
Enable skills in your organization on the Work.com Settings page.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Skills requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as add-on
licenses for Professional Edition, Enterprise Edition, or Unlimited Edition and are included in Performance Edition.

User Permissions Needed

“Customize Application”To enable skills:
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1. From Setup, click Customize > Work.com > Settings.
2. Click Enable under Turn on Skills.

Optionally, you can enable other skills settings:

Edit Skills and Endorsements via record detail pages

Disables inline editing of skills and endorsements on Chatter profiles. Recommended if you have customized these
objects with custom required fields.

Generate feed posts when users add a new skill

Automatically creates a Chatter feed post when a user adds a new skill to a profile.

3. Click Save.

Give Different Types of Rewards
Work.com Rewards allow you to tie tangible rewards to your badges. You can now attach badges to tangible rewards from
most digital gift codes globally.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Recognition requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as
add-on licenses for Professional Edition, Enterprise Edition, or Unlimited Edition, and are included in Performance
Edition.

Work.com Rewards now supports your choice of rewards programs or brands. Some of the information previously held in a
Reward Fund is now held in a new object, Reward Fund Type. Additionally, Reward Fund Type records also can hold more
information to support different types of rewards. Here’s a quick introduction to the differences between the two.

Reward Fund Type

This object holds the fixed information about a reward such as the currency type, redemption information, and CSV
file upload details. Examples include Amazon.com™, iTunes™, or Starbucks™.

Reward Fund

This object holds the gifts codes and can only be tied to a single reward fund type. Each reward fund has a set value that
you determine by purchasing gift codes for the specific denomination.

For example, a reward fund called Q1 US Rewards may contain codes linked to Amazon.com gift cards worth $100
each. Another reward fund called Q1 Customer Service Rewards may contain codes linked to Amazon.com gift cards
worth $20 each. These reward funds would be related to the same reward fund type. However, a reward fund linked to
Starbucks gift cards would be related to a different reward fund type.

You can create reward badges in three steps.

1. Create a reward fund type or use the default Amazon.com reward fund type.
2. Create a reward fund and upload reward codes.
3. Tie a thanks badge to a reward fund.

Create Reward Fund Types

Use reward fund types to specify general reward information, such as currency codes, redemption information, and CSV file
upload details.
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Create Reward Funds

Use reward funds to hold the gift codes related to a reward fund type.

Create Reward Badges

Create rewards badges the same way you would create any other badge.

Create Reward Fund Types
Use reward fund types to specify general reward information, such as currency codes, redemption information, and CSV file
upload details.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Recognition requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as
add-on licenses for Professional Edition, Enterprise Edition, or Unlimited Edition, and are included in Performance
Edition.

User Permissions Needed

“Read” on Reward Fund TypesTo view Reward Fund Types:

“Create” on Reward Fund Types

“Read” and “Create” on Reward Funds

“Read” and “Create” on Rewards

To create Reward Fund Types:

Note: Work.com is currently limited to English language support.

1. Click the Reward Fund Type tab.

If the Reward Fund Type tab isn’t available, click  to the right of your current tabs and select it from the All Tabs page.

2. Click New.
3. Enter the Reward Fund Type details.

DescriptionField

The name of the reward fund type. Try to pick something descriptive, like Amazon.CA (Canada)
or Starbucks (US).

Reward Fund Type
Name

Select Gift Codes to tie your rewards to a cash reward. Select Points if the reward is not tied
to cash. Reward Fund Types that use Points ignore the Currency Code field.

Credit System

The column in a CSV file that specifies the reward values. The upload uses the third column
by default. Enter a number to specify a different column.

Reward Value Column

The instructions for redeeming the reward, including any extra steps the user may need to take
to redeem the reward.

Redemption Information

Read-only setting that indicates if a reward fund type is predefined, like the default Amazon.com
type. You can’t change the name, credit system, or currency code on predefined reward fund
types. Predefined fund types are system generated and can’t be edited.

Predefined
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DescriptionField

The owner of the reward fund type.Owner Name

Whether the reward fund type is active or not. Reward funds can only be tied to active reward
fund types.

Active

The type of currency.Currency Code

The column in a CSV file that specifies the reward codes. The upload uses the second column
by default. Enter a number to specify a different column.

Reward Code Column

The URL where the reward is redeemed. This field is optional based on the type of reward
code. For reward codes that are links, do not enter a redemption URL.

Redemption Url

Extra legal information about the reward fund type.Terms and Disclaimer

4. Click Save.

Create Reward Funds
Use reward funds to hold the gift codes related to a reward fund type.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Recognition requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as
add-on licenses for Professional Edition, Enterprise Edition, or Unlimited Edition, and are included in Performance
Edition.

User Permissions Needed

“Read” on Reward FundsTo view Reward Funds:

“Create” on Reward Funds

“Create” on Rewards

To create Reward Funds:

Users can build reward badges from the reward funds they created. Reward funds can include Amazon.com™ gift cards
purchased from one of our third-party vendors, such as TangoCard™, or different rewards programs beyond Amazon.com.

1. Click the Reward Fund tab.

If the Reward Fund tab isn’t available, click  to the right of your current tabs and select it from the All Tabs page.

2. Click New.
3. Name your fund, select the Reward Fund Type, and enter the reward value.
4. Click Save.
5. Upload or enter your gift codes.

• To upload gift codes through a CSV file, select Upload CSV, then select Choose File. Select a CSV file and click
Upload.

• To manually enter gift codes, select New Reward. Enter the value of your gift code and click Save.
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Create Reward Badges
Create rewards badges the same way you would create any other badge.

Available in: Professional, Enterprise, Performance, and Unlimited Editions

Recognition requires a license to Work.com Motivate, Work.com Align, or Work.com Perform, which are available as
add-on licenses for Professional Edition, Enterprise Edition, or Unlimited Edition, and are included in Performance
Edition.

User Permissions Needed

“Read” on Reward FundsTo view Reward Badge:

“Create” on Reward Fund

“Create” on Rewards

“Create” and “Edit” on Documents

AND

“Create Custom Badge Definitions” if the “Restrict Custom
Badge Creators” setting is enabled for your organization

To create Reward Badge:

You need available reward fund types and reward funds prior to creating reward badges.

1. On the Recognition tab, click Build a Badge.
2. Enter a title and description for the badge, then add a badge image.
3. Select a reward fund for the badge.

Optionally, you can add badge limits, restrict users who can give the badge, and make the badge a Company Badge.

4. Click Save.

Work.com Goal Enhancements
You can now track reduction metrics and metrics that don’t have an initial value of zero. You can also adjust the weight of
different metrics.

Track progress for reduction metrics

In addition to tracking progress on metrics with increasing targets, you can now track reduction metrics as well. For
example, you can add a metric for reducing the number of pushed opportunities from 5 to 2. The progress is visible in
the completion percentage of the metric. Metrics that don’t have an initial value of zero are also now supported.
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Adjust metric weights

Assign different weights to metrics to precisely track the completion of a goal. For example, if an account executive is
using different measures to track a single goal, they can assign a different weight percentage to each measure based on
its importance. The effect of the metric weighting is visible in the total completion percentage of the goal.

Added Support for Triggers and Workflow
The following Work.com objects now support triggers and workflow. For a full list of the features compatible with Work.com
objects, see “Triggers and Workflow for Work.com Objects” in the Salesforce Help.

Work.com Editions AffectedFeatures EnabledObjects

Motivate, Align, PerformTriggers, WorkflowReward, Reward Fund, Reward Fund
Type

Align, PerformWorkflowGoals, Goal Collaborator, Goal Link
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Work.com Editions AffectedFeatures EnabledObjects

Align, PerformTriggers, WorkflowCoaching Notes

Align, PerformTriggers, WorkflowFeedback, Feedback Question, Feedback
Request

PerformTriggers, WorkflowFeedback Question Set, Performance
Cycles

Motivate, Align, PerformWorkflowSkills

Other Changes in Work.com
There are other important changes to Work.com, including additional functionality in Communities and Salesforce1.

Communities Additions

Thanks badges are now specific to the community they’re created in. Additionally, communities users can now create
rewards. For more information, see Work.com Enhancements for Communities.

Salesforce1 Additions

Skills, Goals, and Coaching are now accessible from Salesforce1. For more information, see Salesforce1 Enhancements.

Set Limits on Work.com Badges

Set limits on the number of badges that can be given per user or across all users when creating or editing badges on the
Recognition tab. This is particularly useful when creating badges tied to reward funds.

Autofollow Goals and Coaching

Users now automatically follow the goals they create or commit to. Additionally, users also automatically follow their
coaching relationships. Users can unfollow goals and coaching relationships, if necessary.

Customize the Chatter Publisher for Goals and Coaching

Administrators can customize the goal or coaching feed with custom actions. For example, custom coaching actions can
help focus the conversation by asking the coach to record progress on the sales pipeline, obstacles, and next steps.

New Filters for Metrics on the Coaching Page

There are additional filters available for metrics displayed on coaching relationships. Users can now filter metrics by
“Goals Owned” or “Committed Goals” and also further filter for metrics that are in progress or completed.
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Data.com
Data.com is the solution for delivering leading business data inside Salesforce. The Data.com product suite includes Data.com
Prospector  and Data.com Clean, as well as related Data.com features: Social Key, Data.com Reports, and Data.com Data
Assessments.

We haven't made any changes to  Data.com Prospector, Clean, or Social Key this release. However, we have made some
enhancements to the Data.com Search API, specifically the DatacloudContact and DatacloudCompany objects. For more
information, see Data.com API on page 299.
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Service
Salesforce’s Service Cloud helps you provide a comprehensive customer service experience for your customers.

Case Feed

Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases so that they can resolve
customer issues more quickly in a Chatter-like feed.

Case Management

Case management helps your support team receive, track, and resolve customers’ issues.

Community Templates for Self-Service (Beta)

Community Templates for Self-Service lets you build, brand, and deploy self-service customer support sites that look great
on any device.

Entitlement Management

Entitlement Management lets you and your support agents verify and fulfill customers’ support contracts.

Knowledge

Salesforce Knowledge is a Knowledge Centered Support certified knowledge base that’s designed to help your support team
easily create, organize, and retrieve information.

Live Agent

Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based, text-only
live chat.

Open CTI

Open CTI helps partners integrate Salesforce with Computer-Telephony Integration (CTI) systems without installing
adapter programs on call center users’ machines.

Salesforce Console for Service

The Salesforce Console for Service is an app designed for users in fast-paced environments who need to find, update, and
create records quickly to support their customers.

Service Communities

Chatter Answers and Ideas provides customers with a self-service community where they can post questions and receive
answers from other customers or support agents, as well as post, vote for, and comment on innovative ideas on the Web.

Social Customer Service

Social Customer Service allows you to respond to your customers via social networks and capture important case information.

Case Feed
Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases so that they can resolve
customer issues more quickly in a Chatter-like feed.

Available in: Enterprise, Performance, Unlimited, and Developer Editions
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Customize Case Feed Layouts in New Ways

With a resizable highlights panel, collapsible publisher, and full-width feed, it’s easier than ever to create Case Feed layouts
that put the information your agents need front and center.

Associate Contacts with Outgoing Email in Case Feed in New Ways

We’ve improved the way we associate outgoing emails with contacts so it’s easier to send an email to multiple contacts and
clearer to see which contacts are associated with an email.

Make Quick Text Messages Available to Agents in More Case Feed Actions

Quick Text messages are now available in the Case Feed Portal, Log a Call, and Change Status actions, making it easy for
support agents to add standardized text when replying to customers and updating cases.

Simple Version of the Case Feed Email Action Available for Salesforce1

Add the Send Email action to case page layouts to let Salesforce1 users send email messages directly from case records,
without having to use the mail program on their mobile device.

Inline Images Now Appear Correctly in Email Replies from Case Feed

We’ve fixed an issue that prevented inline images in incoming emails from being displayed when support agents replied to
messages using the Email action in Case Feed. Now it’s easier for agents to refer to those images when they’re responding
to customers.

Add the Attachment Component to Case Feed

Add the attachment component to the Case Feed page so your support agents can quickly view and manage all of the files
associated with a case.

Increase Agent Collaboration and Productivity with Case Experts (Pilot)

Easily identify the experts on case topics so agents can collaborate to solve customer issues quickly.

Other Changes to Case Feed

We made updates to Case Feed to improve the agent experience, including helpful feed items and email presentation in the
feed.

Customize Case Feed Layouts in New Ways
With a resizable highlights panel, collapsible publisher, and full-width feed, it’s easier than ever to create Case Feed layouts
that put the information your agents need front and center.
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1. Resizable highlights panel—Agents can click and drag the dividers between columns on the highlights panel to show more
of the information they’re interested in and hide less important details. Double-clicking a divider returns the columns to
their original sizes. Columns that have no fields in the layout are automatically collapsed. In addition, when agents resize
the height of the highlights panel when viewing a case in a primary tab in the Salesforce console, the description field now
expands to show more text.

The resizable highlights panel is automatically available on all Case Feed pages.

2. Collapsible publisher—Let agents see more of what’s in the feed without having to scroll by collapsing the publisher when
the page loads and after an action is complete—for example, after an agent creates a call log using the Log a Call action.
As soon as an agent clicks inside the publisher, the highlighted action and all of its fields are immediately available. To
collapse the publisher again, the agent can click the carat at the bottom.

To enable the collapsible publisher, select Automatically Collapse Publisher on the Case Feed Settings page.

3. Full-width feed—Expand the feed to take up more of the page so agents can see more information with less scrolling when
they view cases in Salesforce console tabs and subtabs. How much space the feed occupies when this setting is enabled
depends on the size of the page, which can change based on the size and resolution of an agent’s screen and on whether
there are components in the sidebar of the Case Feed page or the console.

To enable a full-width feed, select Use Full-Width Feed in the Console on the Case Feed Settings page.

Note:  The resizable highlights panel and full-width feed aren’t supported on Internet Explorer 7.

For more information, see “Create and Edit Feed Layouts in Case Feed” in the Salesforce Help.
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Associate Contacts with Outgoing Email in Case Feed in New
Ways

We’ve improved the way we associate outgoing emails with contacts so it’s easier to send an email to multiple contacts and
clearer to see which contacts are associated with an email.

1. When agents enter an email address that matches one contact, the address appears as a button with the contact’s name.
2. Agents can copy and paste multiple email addresses separated by spaces or commas. These email addresses appear as

buttons, and, if they’re associated with a contact, will show the contact’s name.
3. When agents enter an email address that matches multiple contacts, the address appears as a button. Clicking the button

brings up a list of contacts associated with the email address. Agents can choose from this list the contact they want to
associate with the email message.

This functionality is available in the To, Cc, and Bcc fields in the Case Feed email action.

Make Quick Text Messages Available to Agents in More Case Feed
Actions

Quick Text messages are now available in the Case Feed Portal, Log a Call, and Change Status actions, making it easy for
support agents to add standardized text when replying to customers and updating cases.

When you create or update a Quick Text message, you can make it available in as many channels as you want. Depending on
which features are enabled in your organization, these channels may be available:

• Email—the Case Feed Email action

• Live Agent—the Live Agent console or Live Agent in the Salesforce console

• Portal—a community or a customer portal

• Phone—the Case Feed Log a Call action

• Internal—the Case Feed Change Status action
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To add or change channels on a Quick Text message, click New on the Quick Text home page, or click Edit next to an existing
message.

Simple Version of the Case Feed Email Action Available for
Salesforce1

Add the Send Email action to case page layouts to let Salesforce1 users send email messages directly from case records, without
having to use the mail program on their mobile device.

Messages sent with the Send Email action are automatically associated with the case, included in the case’s feed, and added
to the Emails related list on the case.

The Send Email action is available only on cases. You can add it to the publisher on any case page layout.

For more information, see Add a Simple Version of the Case Feed Email Action to Salesforce1 on page 57.
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Inline Images Now Appear Correctly in Email Replies from Case
Feed

We’ve fixed an issue that prevented inline images in incoming emails from being displayed when support agents replied to
messages using the Email action in Case Feed. Now it’s easier for agents to refer to those images when they’re responding to
customers.

When an agent clicks Reply or Reply All in the feed item for an incoming email message, the message appears as part of a
thread in the Email action. If the agent is using the rich text editor in the Email action, any inline images included in the
original email message are included in the thread. When the agent sends the reply, the original images are included in the
email, and count toward the size limit for the message.

Note:  Images aren’t displayed in the Email action when agents use the plain text editor.

Add the Attachment Component to Case Feed
Add the attachment component to the Case Feed page so your support agents can quickly view and manage all of the files
associated with a case.

Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

Access to all of the files associated with a case is critical to support agents when they’re helping your customers. The attachment
component lets agents view and manage all of the Chatter files, attachments from emails, and case attachment related list files
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for a case, all on the Case Feed page. Using the attachment component, agents can quickly attach a file to an email and
download a file.

Agents can toggle between a view of the most recent attachments for a case across all sources and a view of all of the files
associated with a case sorted by their creation date.

1. From Setup, click Customize > Cases > Page Layouts.
2. How you access the Case Feed Settings page depends on what kind of page layout you’re working with.

• For a layout in the Case Page Layouts section, click Edit, and then click Feed View in the page layout editor.

• For a layout in the Page Layouts for Case Feed Users section, click  and choose Edit feed view. (This section
appears only for organizations created before Spring ’14.)

3. In the Other Tools and Components section, select Files, and specify where on the page you want it to appear.
4. Click Save.

Add the attachment component to your custom pages by including the <apex:caseUnifiedFiles> component in a
Visualforce page, or add it as a Salesforce console component to make it available to agents without having to take up space
on a Case Feed page.

Increase Agent Collaboration and Productivity with Case Experts
(Pilot)

Easily identify the experts on case topics so agents can collaborate to solve customer issues quickly.

Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

Note:  Case Experts is currently available through a pilot program. For information on enabling Case Experts for
your organization, contact salesforce.com.

Using the power of topics on cases, support agents can be endorsed as experts on specific topics. Agents endorsed as experts
can help other agents who might be less knowledgeable on the topic. To establish case experts in your organization, you must
have Chatter and topics for cases enabled.

To enable Case Experts, display the Experts component on Case Feed.

1. From Setup, click Customize > Cases > Page Layouts.
2. Click Edit, and then click Feed View in the page layout editor.
3. In the Other Tools and Components section, select Case Experts, and specify where on the page you want it to appear.
4. Click Save.

Add the experts component to your custom pages by including the <apex:support:caseExperts> component in a
Visualforce page.

For more information about using topics and endorsing experts, see “Find and Endorse People Knowledgeable about a Topic”
in the Salesforce Help.
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Other Changes to Case Feed
We made updates to Case Feed to improve the agent experience, including helpful feed items and email presentation in the
feed.

See Feed Items for Attachments Added from the Case Detail View

Now, when a support agent attaches a file to a case from the Case Detail view in Case Feed, a feed item is generated.
Feed items for attachments make the feed a more complete history of the activity on a case and make it easier for agents
to quickly and easily review what’s happened on the case. Previously, only attachments added with the Post or File action
in the Case Feed publisher generated a feed item.

Exclude Email Threads from Drafts in the Feed

Improve email publishing in the feed by excluding the previous emails in the thread when composing emails. This
prevents the previous emails in the thread from being incorporated in the outbound email message. For more information,
see Settings for Feed Views in Case Feed.

Customize the Appearance of Emails in the Feed

Improve the presentation of emails in the feed by applying Size of Email Feed Item Body, Blank Lines in
Email Feed Item Body, or Collapse Previous Emails in Email Feed Item Body. For more information,
see Customize Support Settings.

Case Management
Case management helps your support team receive, track, and resolve customers’ issues.

Available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Receive Larger Emails with On-Demand Email-to-Case

We’ve increased the size limit for email messages that come in through On-Demand Email-to-Case from 10MB to 25MB,
so customers can now send you longer emails and more attachments.

Receive Larger Emails with On-Demand Email-to-Case
We’ve increased the size limit for email messages that come in through On-Demand Email-to-Case from 10MB to 25MB,
so customers can now send you longer emails and more attachments.

The 25MB per message limit applies to the entire message: the headers, the body, all attachments, and the encoding. Note
that two other limits still apply to On-Demand Email-to-Case emails:

• On-Demand Email-to-Case automatically shortens email text to 32,000 characters. Contact salesforce.com if you’d like
this limit raised to 128,000 characters for your organization.

• Individual attachments can’t be larger than 10MB each.

For more information, see “Email-to-Case and On-Demand Email-to-Case Overview” in the Salesforce Help.
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Community Templates for Self-Service (Beta)
Community Templates for Self-Service lets you build, brand, and deploy self-service customer support sites that look great
on any device.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Note:

This release contains a beta version of Community Templates for Self-Service that is production quality but has
known limitations. For information on enabling this feature for your organization, contact Salesforce.

Your customers want an easy way to interact with your company whenever and wherever they are. A self-service community
gives your customers easy access to knowledge articles so that they can help themselves when they have questions. Guest users
can access information and articles organized by data categories for your different products. Authenticated users can contact
agents through official support channels and create and manage their cases. The self-service templates let you extend your
community to a variety of devices with a consistent user experience every time.

To create a mobile self-service community, you need to create a Salesforce Community, create articles in Salesforce Knowledge,
set up data categories, and then use Community Templates for Self-Service in Site.com to customize and brand your site.

Within Site.com, these templates supply all of the page elements you’ll need to create a single-page application to display your
site. Simply edit a few of the page elements to include information about your data categories, add a few images to extend
your branding, and you’re ready to go—without any coding! Site.com Studio even lets you to create different language versions
of your site. And because all languages are maintained within the site, you don’t need to create and manage a separate site for
each language.

Select a Predefined Template to Customize Your Site
Each template produces a site that is based on a single-page application—a Web app that loads a single HTML page. Unlike
a traditional website, which comprises several pages that the user navigates between, a single-page application consists of
several views that are used to update the page dynamically when the user interacts with it.

We’ve created two self-service templates to choose from. Both self-service templates provide the page elements you need to
quickly customize a site where users can:

• Search a public knowledge base for answers to their questions without contacting an agent.
• View articles based on their categories.
• Select a specific category and search or browse within a smaller subset of articles.
• Log in and create a case when they can’t find the answer they’re looking for.
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Kokua (1) is a visually rich self-service template that presents users with knowledge articles organized by data categories. Users
can also submit cases to get help from agents.

Koa (2) is a text-based self-service template that’s optimized for mobile devices. It lets users search for and view articles by
text categories, and contact support if they can’t find what they’re looking for.

Set Up the Template and Edit Its Views
A wizard in Site.com Studio lets you select a template and then walks you through the initial setup for your data categories.

Each template is made up of a collection of different views that you can edit to reflect things like number of articles you’d like
to display for each category, or the number of articles to return as search results. You can also customize the text that your
customers see in the search boxes, buttons, and other labels. Just open the view for editing, select the page element you’d like
to customize, and make your changes right in the Properties panel. Leverage the design capabilities of Site.com by dragging
and dropping additional components onto the views to further customize your site.
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In the designer, you can see a live preview of your site as you’re configuring it. Using the Site.com Studio designer you can:

• Specify whether you’re a designer or a contributor
• Switch between Design and Live modes
• Preview and publish changes as you make them
• View the site on a desktop, tablet, or mobile phone.

Let Your Customers Contact Support Reps
While the templates have different ways of presenting articles to your customers, both templates provide the same user
experience when a customer contacts a support agent. Once a customer logs in, they can create a case and manage existing
cases all from one location.

Using the case publisher, customers can create a case and then manage the case through its lifecycle: The case publisher lets
customers:

• Submit and view detailed information (1) regarding their case or support request.
• Add attachments (2) to case comments.
• Add comments to the case (3) as well as view and respond to comments from support reps.

To learn more about setting up your own mobile-ready, self-service site, see the Community Templates for Self-Service
Implementation Guide.
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Entitlement Management
Entitlement Management lets you and your support agents verify and fulfill customers’ support contracts.

Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

Add the Milestone Tracker as a Salesforce Console Component

Agents working on cases need to be aware of how much time they have until their milestones are due because their performance
is often measured based on how often they miss milestones. The milestone tracker lets agents see the time remaining on an
active milestone or how overdue the milestone is if its target date has passed, along with a list of upcoming milestones and
closed milestones.

Add the Milestone Tracker as a Salesforce Console Component
Agents working on cases need to be aware of how much time they have until their milestones are due because their performance
is often measured based on how often they miss milestones. The milestone tracker lets agents see the time remaining on an
active milestone or how overdue the milestone is if its target date has passed, along with a list of upcoming milestones and
closed milestones.

User Permissions Needed

“Customize Application”To create custom console components:

Previously, you could add the milestone tracker only as a component on Case Feed layouts. Now you can add it as a Salesforce
console component instead, giving you more flexibility to customize the desktop based on your company’s needs. Including
the milestone tracker tool in a console, rather than on a Case Feed page, lets agents track milestones when they’re working
with cases and leaves space on the Case Feed page for other tools or a wider feed.

The milestone tracker is available for case page layouts in organizations that have enabled entitlement management. You can
add it from the Custom Console Components link in the page layout editor.

Knowledge
Salesforce Knowledge is a Knowledge Centered Support certified knowledge base that’s designed to help your support team
easily create, organize, and retrieve information.

Salesforce Knowledge is available in Performance and Developer editions.

Salesforce Knowledge is available for an additional cost in Enterprise and Unlimited editions.
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Provide Code Samples with the Click of a Button

With the new code sample button, knowledge base authors can add code samples in the rich text editor without worrying
about tricky formatting.

Next-Gen Knowledge Search (Pilot)

Apache Solr (pronounced “solar”) now powers the next generation of search infrastructure in Salesforce Knowledge. We’re
excited to unveil a major search engine upgrade, bringing you faster, smarter search and more relevant results.

Search Synonym Groups More Easily

When your knowledge base administrators search for a synonym within synonym groups, search results now show the number
of groups containing that synonym. We’ve also redesigned the search area, making the search box always visible.

Search Suggested Queries Resource in REST API (Generally Available)

A new resource in REST API, Search Suggested Queries, returns a list of suggested searches based on the user’s query string
text matching searches that other Knowledge users have performed.

Provide Code Samples with the Click of a Button
With the new code sample button, knowledge base authors can add code samples in the rich text editor without worrying
about tricky formatting.

Readers can easily identify the content that is a code sample.

Next-Gen Knowledge Search (Pilot)
Apache Solr (pronounced “solar”) now powers the next generation of search infrastructure in Salesforce Knowledge. We’re
excited to unveil a major search engine upgrade, bringing you faster, smarter search and more relevant results.
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Note:  Next-Gen Knowledge Search is currently available through a pilot program. Contact salesforce.com to enable
this feature for your organization.

Take advantage of these improvements and new search capabilities.

• Faster indexing means it takes less time for records to be searchable after they're created or updated.

• Improved alphanumeric search means more relevant search results. We now handle punctuation more efficiently, so that
it’s easier for the search engine to recognize when a user is searching for specialized strings such as URLs, email addresses,
and phone numbers.

• Improved tokenization also means more relevant search results. The search engine breaks down all searchable text into
smaller pieces, or tokens, at meaningful boundaries (spaces, punctuation, and alphanumeric) and stores them in the search
index. Proper tokenization is essential for accurate search results in any language, and especially so for East Asian languages
that are written without spaces between words, such as Chinese, Japanese, Korean, and Thai (CJKT). For these
languages, morphological tokenization replaces the more simplistic bigram tokenization and reduces the number of
non-meaningful tokens indexed.

• Organizations searching in CJKT languages are uniquely affected. Besides tokenization, we've enhanced punctuation
handling and added support for stemming.

• Enable the option to change the default search operator from OR to AND. Matching on all terms in the user’s query
tends to produce more relevant search results.

Warning:  Enabling the default AND operator means that multi-term synonyms are no longer supported. If your
organization has defined multi-term synonyms, they will be ignored and excluded from search results.

• If your organization has enabled synonyms:

◊ Use SynonymDictionary components in the Metadata API to manage synonym groups. Optimize search results for
acronyms, variations of product names, and other terminology unique to your organization.

◊ Enable the option to perform synonym matching for search queries that include trailing wildcards. For example, if
you've defined a synonym group containing the terms bill and invoice, a search for bill* returns matches for bill,
billing (wildcard expansion), and invoice (synonym matching).

Search Synonym Groups More Easily
When your knowledge base administrators search for a synonym within synonym groups, search results now show the number
of groups containing that synonym. We’ve also redesigned the search area, making the search box always visible.

Previously, the search box wasn’t visible until users clicked a Show Filters link. We’ve removed the link to make it easier to
start a search.

These changes affect synonym search in Setup, in Customize > Search > Knowledge Synonyms.
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Search Suggested Queries Resource in REST API (Generally
Available)

A new resource in REST API, Search Suggested Queries, returns a list of suggested searches based on the user’s query string
text matching searches that other Knowledge users have performed.

For more information, see New Resources on page 277 and the Force.com REST API Developer’s Guide.

Live Agent
Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based, text-only
live chat.

Live Agent is available in: Performance Editions and Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Transfer Files During a Chat (Generally Available)

Give Live Agent customers the ability to upload and transfer files to agents during a chat so they can easily share important
information without leaving their chat window.

Transfer Chats to a Chat Button Queue

Agents can now transfer chats to chat button queues. This increases the chance of connecting a customer with an agent who
can answer the customer’s question.

Create and Share Articles Using the Knowledge One Widget

We replaced the Live Agent articles tool with the improved Knowledge One widget to give your agents better access to
articles they can share with their chat customers.

Other Changes in Live Agent

We made a few updates to Live Agent that improve the agent’s experience during chats with customers.

Live Agent Deployment API: New Methods

Use the enhanced Live Agent Deployment API methods to search for Salesforce Knowledge articles based on your customers’
information.

Live Agent REST API: New Visitor Resources

We’ve added a few Live Agent REST API resources to make it easier to customize and extend the functionality of Live
Agent chat windows in your company’s mobile and Web applications. With the latest resources, you can customize your
chat visitors’ experience as they chat with agents.

Transfer Files During a Chat (Generally Available)
Give Live Agent customers the ability to upload and transfer files to agents during a chat so they can easily share important
information without leaving their chat window.
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Agents associate incoming files with new or existing records. For example, if a customer is receiving an error when they try
to complete a process, they can upload and transfer a screenshot of the error message to the agent, which the agent could
attach to an existing case to provide more context for the customer’s issue.

Transfer Chats to a Chat Button Queue
Agents can now transfer chats to chat button queues. This increases the chance of connecting a customer with an agent who
can answer the customer’s question.

Previously, agents could transfer chats, but they could only transfer them to a specific agent or an agent who was associated
with a skill group. Now, agents can also transfer a chat to a chat button queue, allowing it to be routed to a new agent associated
with that queue.

Agents can transfer chats directly from the chat window in the Salesforce console. Agents can transfer chats to a skill group
or a chat button queue, but not both.

Create and Share Articles Using the Knowledge One Widget
We replaced the Live Agent articles tool with the improved Knowledge One widget to give your agents better access to articles
they can share with their chat customers.

Previously, agents could send articles to customers with a Live Agent-specific articles tool. We’ve discontinued the Live Agent
articles tool in the Salesforce console and replaced it with the Knowledge One widget. This gives your agents a more consistent
user experience as they assist customers.

The Knowledge One widget lets agents:

• Send a published chat answer to a customer.

• Share an article as a URL, if the article is published publicly.

• Create and manage articles.

• Make adjustments based on your window width. In the console, in windows smaller than 600 pixels, the searchable objects
are displayed in a drop-down menu.

To learn more about the Knowledge One widget, see Compare Article Widgets for Cases at a Glance and Setting Up Knowledge
One Widget in the Salesforce Help.

Note:  If you have an existing organization that uses the Live Agent articles tool to share knowledge-base articles,
your agents will still see the Live Agent articles tool in the Salesforce console. To replace the articles tool, enable
Knowledge One. The Knowledge One widget will be automatically visible for new organizations created after the
Summer ’14 release.
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Other Changes in Live Agent
We made a few updates to Live Agent that improve the agent’s experience during chats with customers.

Limited Support for Right-to-Left Languages

To support more users and chats in Salesforce consoles, Live Agent now offers support for right-to-left languages, such
as Arabic or Hebrew. Previously, Live Agent didn't support right-to-left languages in chat windows. Now these languages
are partially supported to give your agents and customers the best chat experience possible, regardless of language. Since
right-to-left languages aren’t fully supported, some features might not display as expected.

Chat Workspace Closes When a Chat Is Transferred to Another Agent

When an agent transfers a Live Agent chat to someone else, the chat log and related subtabs close automatically, freeing
up the agent’s workspaces to handle new customer chats. Previously, agents had to close the chat log and open subtabs
that were associated with the chat manually after the chat had been transferred to another agent. Now this happens
automatically, saving agents time.

Warning:  Agents must save any changes to the chat log and related subtabs before they transfer the chat to
another agent because any unsaved changes will be lost when the workspace closes.

Live Agent Deployment API: New Methods
Use the enhanced Live Agent Deployment API methods to search for Salesforce Knowledge articles based on your customers’
information.

New Methods

These methods are new in version 31.0 of the Live Agent Deployment API.
• addCustomDetail.doKnowledgeSearch—

Retrieves a custom detail value from a pre-chat form when a customer requests a chat with an agent. After an agent
accepts the chat request, this value is used as a search keyword to find articles in the Knowledge One widget. The
doKnowledgeSearch() method conducts a search by using the value parameter in the addCustomDetail
method. Available in API version 31.0 and later.

For more information (English only) about the Live Agent Deployment API, see the Live Agent Developer’s Guide.

Live Agent REST API: New Visitor Resources
We’ve added a few Live Agent REST API resources to make it easier to customize and extend the functionality of Live Agent
chat windows in your company’s mobile and Web applications. With the latest resources, you can customize your chat visitors’
experience as they chat with agents.

DescriptionResource

Indicates whether a chat button is available to receive new
chat requests.

Availability

Sets a breadcrumb value to the URL of the Web page that
the chat visitor is viewing as the visitor chats with an agent.

Breadcrumb
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DescriptionResource

The agent can then see the value of the breadcrumb to
determine the page the chat visitor is viewing.

Retrieves all settings information about the Live Agent
deployment that’s associated with your chat session. The

Settings

Settings request is required as the first request to establish
a chat visitor’s session.

Generates a unique ID to track a chat visitor when they initiate
a chat request and tracks the visitor’s activities as the visitor
navigates from one Web page to another.

VisitorId

Open CTI
Open CTI helps partners integrate Salesforce with Computer-Telephony Integration (CTI) systems without installing adapter
programs on call center users’ machines.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Open CTI: New Directory Numbers Method

Access an API method to retrieve phone numbers from the directory of a Salesforce call center.

Open CTI: New Directory Numbers Method
Access an API method to retrieve phone numbers from the directory of a Salesforce call center.

A new method is available to help developers and advanced administrators retrieve a list of phone numbers from a Salesforce
call center’s directory. For more information, see Open CTI API  on page 312 and “Customizing a Call Center Directory” in
the Salesforce Help.

Salesforce Console for Service
The Salesforce Console for Service is an app designed for users in fast-paced environments who need to find, update, and
create records quickly to support their customers.

Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

Salesforce Console Integration Toolkit: New Methods

Access API methods to customize a console programmatically.
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Add the Topics List and Milestone Tracker as Salesforce Console Components

Let agents categorize records with the topics list and track their performance against milestones with the milestone tracker
while working with cases in the Salesforce console.

Other Changes to the Salesforce Console

Updates were made to the console, such as including multi-components in saved user sessions, new buttons on the interaction
log, and limited support for right-to-left languages.

Related Lists as Console Components
Add related lists to the sidebars of a Salesforce console to display relevant information next to specific pages.

For example, add related lists to a console’s sidebar on accounts to show relevant information without scrolling:

Adding Related Lists as Console Components
With a few clicks, you can add related lists to the sidebars of a Salesforce console.

User Permissions Needed

“Customize Application”To add custom console components:

1. For standard objects, from Setup, click Customize > Object > Page Layouts.

For custom objects, from Setup, click Create > Objects, then choose the object.

2. Click Edit next to a page layout.
3. Click Custom Console Components.
4. Next to the sidebar in which you want to add your related list component, choose how to display and organize your

component by Style. You can choose either Stack, Tabs, or Accordion. For more information, see “Sidebar Styles for
Console Components” in the Salesforce Help.
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5. Specify the size of the sidebar in the console by selecting height or width, and typing its percentage or number of pixels.
6. Under Type, choose Related List.
7. Under Component, choose a related list’s name. Optionally, you can hide a related list from pages where it appears as a

component to prevent duplicate information from showing. If you want to reorder related lists, you must do so from page
layouts.

8. Under Label, type the name for your component as it should display to console users from the sidebar.
9. Specify the size of the component in the sidebar by selecting height or width, and typing its percentage or number of pixels.
10. Click Save.

Note:

Custom buttons don’t appear on related list components.

Salesforce Console Integration Toolkit: New Methods
Access API methods to customize a console programmatically.

Several new methods are available to help developers and advanced administrators customize a console’s interaction log and
navigation tab. For more information, see Salesforce Console API (Integration Toolkit) on page 310.

Add the Topics List and Milestone Tracker as Salesforce Console
Components

Let agents categorize records with the topics list and track their performance against milestones with the milestone tracker
while working with cases in the Salesforce console.

These tools were introduced in Spring ’14 and were previously available only as sidebar components on feed-based page layouts.
Now you can add them as console components instead so they’re available to users but don’t take up space on page layouts.

The topics list shows the topics associated with a case. Agents can click on a topic to see other records related to it, and can
easily add or delete topics.

The milestone tracker shows the entitlement process milestones related to a case. Agents can see details about each milestone
and can mark milestones as completed.

For more information on the milestone tracker console component, see Add the Milestone Tracker as a Salesforce Console
Component on page 151. For more information on adding console components, see Add Console Components to Page Layouts
on page 158.
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Other Changes to the Salesforce Console
Updates were made to the console, such as including multi-components in saved user sessions, new buttons on the interaction
log, and limited support for right-to-left languages.

Saved User Sessions Include Multi-Components

To help users continue working from where they left off in a console, multi components that appear during users’ sessions
appear again when users refresh their browsers, close and open browser tabs, or log out and log back in to Salesforce.
To include multi-components in saved sessions, administrators must select Save User Sessions on a console. For more
information, see “Save User Sessions for a Salesforce Console” and “Custom Console Components Overview” in the
Salesforce Help.

Add Call Data to an Interaction Log

In consoles with SoftPhones, a new Add Call Data button displays on interaction logs. When clicked, it adds a call’s
date and time to a log so that users can quickly track customer interactions. When users handle multiple calls, the button
includes a drop-down list from which users can add a specific call’s data to a log. For more information, see “Add Notes
to Records in a Salesforce Console” and “Use a SoftPhone with a Salesforce Console” in the Salesforce Help.

Clear Notes from an Interaction Log

A new Clear Log button displays on interaction logs. When clicked, it removes notes or a Subject from a log’s current
session so that users can start over or add new notes. Saved notes aren’t removed, and they are stored on the record’s
Activity History related list. For more information, see “Add Notes to Records in a Salesforce Console” in the Salesforce
Help.

Limited Support for Right-to-Left Languages

To support more users, a Salesforce console offers new support for right-to-left languages, such as Arabic or Hebrew.
Since right-to-left languages aren’t fully supported, some features might not display as expected in a console, such as
Case Feed or Salesforce Knowledge.

App Launcher Removed from the Navigation Tab

The App Launcher is no longer available from the navigation tab because the logos and links it presents to connected
and standard apps caused navigation problems for console users. To learn more about the App Launcher, see “Using the
App Launcher” in the Salesforce Help.

New Look for Lookup Components

Lookup components have a new design that’s more modern and consistent with the console’s user interface:
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For more information, see “Add Console Components to Page Layouts” in the Salesforce Help.

Service Communities
Chatter Answers and Ideas provides customers with a self-service community where they can post questions and receive answers
from other customers or support agents, as well as post, vote for, and comment on innovative ideas on the Web.

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

Ideas is available in: Enterprise, Developer, Performance, Unlimited, and Professional Editions.

Introducing Chatter Questions (Beta)

Ask questions and get answers in Chatter with Chatter Questions.

Introducing Chatter Questions (Beta)
Ask questions and get answers in Chatter with Chatter Questions.

This release contains a beta version of Chatter Questions that is production quality but has known limitations. For more
information, see Ask Questions in the Feed with Chatter Questions (Beta) on page 82.

Social Customer Service
Social Customer Service allows you to respond to your customers via social networks and capture important case information.

Social Customer Service is available in Enterprise, Performance, and Unlimited editions.
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User Permissions Needed

“Manage Users”

AND

“Customize Application”

AND

“Social Objects”

AND

“Social Publisher”

To administer Social Customer Service

Feed Tracking for All Related Objects on the Case objectTo create case feed items:

“Social Objects”

AND

“Social Publisher”

AND

Case Feed enabled

AND

Social account

To send and receive social media posts or messages

Important:  Log a salesforce.com support ticket to enable the Social Objects and Social Publisher permissions. You
must have a Social Hub license and sufficient Radian6 managed accounts. If you are switching from the Radian6 for
Salesforce package, make note of it in your support ticket.

For setup information see, Getting Started with Social Customer Service.

Moderation for Social Customer Service

Now agents can manually triage social posts instead of automatically creating or updating a case for each new post, thus
focusing on real customer issues and avoiding unnecessary open cases. 

Quick Text for Social Customer Service

Quick Text lets you create ready-to-send responses that Social Customer Service agents can post to social networks.

Other changes in Social Customer Service

Now agents can do more within the case feed, reducing the need to navigate out of Salesforce and into social networks.

Moderation for Social Customer Service
Now agents can manually triage social posts instead of automatically creating or updating a case for each new post, thus focusing
on real customer issues and avoiding unnecessary open cases. 

Not all posts require a case. For example, a complementary tweet or post does not need agent assistance. However, with
standard social customer service setup, cases are automatically created from each social post. Using moderation, agents can
manage which posts get cases and which are ignored.
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Moderation is enabled with a Social Hub rule in your Radian6 account to turn off automatic case creation. See the Radian6
online help for detailed information.

1. From your Radian6 account, click on the Rules tab.
2. Create a rule, or use an existing one, to indicate no case is created in Salesforce.

For example, the rule should have the following setup.

a. Action: send to Salesforce.
b. Create Case checkbox unchecked.

3. Save and enable your rule.

You can enable your rule for all social posts or only those coming from certain managed accounts.

Case creation can also be customized by implementing custom Apex case logic in Setup > Customize > Social Apps
Integration > Social Customer Management > Settings. See Modifying the Default Apex Class in the Salesforce Help.

Quick Text for Social Customer Service
Quick Text lets you create ready-to-send responses that Social Customer Service agents can post to social networks.

Agents can quickly insert pre-created text to increase efficiency and consistency in delivering common answers. For example,
during a service outage, an agent can create a Quick Text message about how to check the status of the outage. All agents
with access to this Quick Text can post and respond quickly and accurately. For information on Quick Text, see Enable Quick
Text and Quick Text Home Page in the Salesforce Help.

Other changes in Social Customer Service
Now agents can do more within the case feed, reducing the need to navigate out of Salesforce and into social networks.
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Giving out passwords to your organizations’ social network accounts is risky. The less agents and social media managers need
to login directly to social networks, the better. Now Social Customer Service agents have more actions and information available
within the case feed, reducing the need log in to Twitter or Facebook.

Delete an Outbound Social pPost

An agent can delete an outbound social post from its social network. The post appears grayed out in the case feed.

Identify Posts Deleted Externally

If a social post was deleted externally, in its social network, the post appears grayed out in the case feed and agents know
it can’t be viewed on the social network.

Retweet Inbound Social Posts

An agent can retweet an inbound social post. For example, when a customer posts a complimentary tweet, an agent may
want to retweet to a wider audience.

Identify Social Accounts Able to Direct Message a Customer

When an agent needs to communicate privately with a customer, the Managed Social Account drop-down identifies
which accounts can’t direct message the customer. The social account must follow the customer to send a direct message.
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Identify When Images, Videos, or Links are Included in Social Posts

Agents can see when a customer includes an image, video, or link and respond more accurately. Previews are available
if the content is public.
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Analytics
With reports and dashboards, you can analyze historical trends, embed report charts in object records, and use the analytics
API to develop your own Salesforce analytics applications.

Analytics Dashboards API (Generally Available)

The REST-based Analytics Dashboards API gives you programmatic access to your Salesforce dashboards. You can easily
integrate dashboard data into any web or mobile application, inside or outside the Salesforce platform.

Track Forecasting Changes

How well are your forecasts predicting your team’s progress towards its sales goals? Now you can answer that question with
a historical trend report using Forecast data.

Keep Favorite Report Folders In View

Navigating to the report you want on the Reports tab can be a bother when the folder pane contains many report and
dashboard folders. Now users can pin their most-used report and dashboard folders to the top of the folder list so they don’t
have to scroll down every time.

Other Changes in Analytics

We’ve made some additional changes to analytics features.

Analytics Dashboards API (Generally Available)
The REST-based Analytics Dashboards API gives you programmatic access to your Salesforce dashboards. You can easily
integrate dashboard data into any web or mobile application, inside or outside the Salesforce platform.

The Dashboards API enables you to:

• Retrieve a list of recently used dashboards

• Get metadata, data, and status for a specified dashboard

• Trigger a dashboard refresh

For more information and code examples, see the Analytics API Developer Guide.

Resources for the Dashboards API

The Analytics Dashboards API provides several REST resources for accessing and refreshing dashboards.

Dashboards API Limits

The Dashboards API has some restrictions in addition to the general API limits.

Resources for the Dashboards API
The Analytics Dashboards API provides several REST resources for accessing and refreshing dashboards.

To access the Analytics Dashboards API, establish an authenticated OAuth session and encode responses and requests in
JSON. The API has the following resources:
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Resource URLDescriptionSupported
HTTP
Method

Resource

/services/data/v31.0/analytics/dashboardsReturns a list of recently used
dashboards.

GETDashboard
List

/services/data/v31.0/analytics/dashboards/
<dashboardID>

A GET request returns the metadata,
data, and status for the specified
dashboard. A PUT request triggers a
dashboard refresh.

GET

PUT

Dashboard
Results

/services/data/v31.0/analytics/dashboards/
<dashboardID>/status

Returns the status for the specified
dashboard.

GETDashboard
Status

Dashboards API Limits
The Dashboards API has some restrictions in addition to the general API limits.

• Your organization can request up to 200 dashboard refreshes per hour.

• Your organization can request results for up to 5,000 dashboards per hour.

Note:  All limits that apply to dashboards created in the dashboard builder also apply to the API.

Track Forecasting Changes
How well are your forecasts predicting your team’s progress towards its sales goals? Now you can answer that question with a
historical trend report using Forecast data.

Historical trending comes with a new custom report type designed to highlight forecast changes between five snapshot dates,
such as five business days or five business weeks. You can visually represent the data changes in charts and on dashboards.
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You can track changes in these key forecasting fields:

• Amount Without Adjustments

• Amount Without Manager Adjustment

• Quantity Without Adjustments

• Quantity Without Manager Adjustment

• Forecast Amount

• Forecast Quantity

• Owner Only Amount

• Owner Only Quantity

For existing organizations, you must activate historical trend reporting in the Setup menu. For new organizations created in
Spring ’14 and thereafter, it is activated by default. For information about activating and configuring it, see "Set Up Historical
Trend Reporting" in the online help.

Important:  Historical trend reporting in Salesforce is not a replacement for a data warehouse and will not be extended
in the future to serve warehouse requirements. Hard system limits are enforced to ensure its usefulness for the purpose
for which it was built. This includes limits on the time duration of tracking, limits on row count, and limits on fields
and objects that are tracked.
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Keep Favorite Report Folders In View
Navigating to the report you want on the Reports tab can be a bother when the folder pane contains many report and dashboard
folders. Now users can pin their most-used report and dashboard folders to the top of the folder list so they don’t have to scroll
down every time.

Available in: All Editions

Other Changes in Analytics
We’ve made some additional changes to analytics features.

History tracking reports can now include two fields whose values are calculated by lookup.

Until now, history tracking was only available on fields belonging to the current object.

Recent performance upgrades may change the way scales are displayed in some charts.

In a few cases, the scale (not the data) may include a slightly greater range. The accuracy of the data displayed is not
affected.
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Site.com
Site.com is a Web content management system (CMS) that makes it easy to build dynamic, data-driven Web pages quickly,
edit content in real time, and manage your websites. To improve usability, we’ve streamlined Site.com Studio and added new
features.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Rename Site Assets

Site.com designers and site administrators can now rename assets. To rename an asset on your site if you're a site
administrator or designer, hover over the asset and click  > Rename.

Edit Plain Text Files

Contributors, designers, and site administrators can now edit plain text files, such as .txt, .xml, and .htm files, directly
in Site.com Studio. To edit a plain text file, hover over the file in the Assets view on the Overview tab and click  >
Edit.

Pane Names Replaced with Icons

To streamline the appearance of Site.com Studio, we’ve replaced the names of several panes with icons.

Now when a page is open for editing, site administrators and designers can click:
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•  to open the Page Elements pane
•  to open the Page Structure pane
•  to open the Properties pane
•  to open the Style pane
•

 to open the Events pane

Make Rich-Text Area Fields Compatible with Internet Explorer® 11

If your site contains a form that uses rich-text area fields and your site visitors use Internet Explorer 11, we recommend
that a site administrator or designer deletes and then replaces the form to ensure that Internet Explorer 11 correctly
displays the field-editing toolbar in the live site.
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Force.com Customization
Customization features enable you to expand your organization by enhancing your objects, data, and fields, customizing your
organization's look and feel, augmenting your business processes, creating websites, and creating apps—all using point-and-click
tools. Customization features also include tools to administer and secure your organization.

Custom Permissions (Developer Preview)

Use custom permissions to give users access to custom processes or apps.

Publisher Enabled for Chatter Off Organizations

Organizations that don’t have Chatter enabled can now take advantage of all the robust functionality that actions provide in
Salesforce1.

Improvements to Setup Search (Beta)

With Advanced Setup Search, you can search for Setup menu items, custom fields, custom objects, custom profiles, permission
sets, public groups, roles, and users from the sidebar in Setup.

General Administration

Administration helps you manage your organization to suit your business needs.

Data

The Force.com platform makes it easy for you to manage and track your data.

Business Logic and Process Automation

Workflow, approvals, and Visual Workflow provide point-and-click tools for automating and simplifying complex business
processes.

Security

Use security to protect both your data and applications.

Sharing

Sharing improves your control over who sees what.

Globalization

Globalization tools help administrators manage resources that vary from country to country, such as multilanguage,
multicurrency, and translated content.

Critical Updates

This release includes updates that improve the performance, logic, and usability of Salesforce but may affect your existing
customizations.

Other Changes in Force.com Customization

Even small customization enhancements can make Salesforce easier to use.

Custom Permissions (Developer Preview)
Use custom permissions to give users access to custom processes or apps.

Available in: Developer Edition
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Note:  Custom permissions are currently available as a developer preview; they’re available only in Developer Edition
organizations.

In Salesforce, many features require access checks that specify which users can access certain functions. Permission set and
profiles settings include built-in access settings for many entities, like objects, fields, tabs, and Visualforce pages. However,
permission sets and profiles don't include access for some custom processes and apps. For example, for a time-off manager
app, all users might need to be able to submit time-off requests but only a smaller set of users need to approve time-off requests.
You can use custom permissions for these types of controls.

Custom permissions let you define access checks that can be assigned to users via permission sets or profiles, similar to how
you assign user permissions and other access settings. For example, you can define access checks in Apex that make a button
on a Visualforce page available only if a user has the appropriate custom permission.

You can query custom permissions in these ways.

• To determine which users have access to a specific custom permission, use Salesforce Object Query Language (SOQL)
with the SetupEntityAccess and CustomPermission sObjects.

• To determine what custom permissions users have when they authenticate in a connected app, reference the user's Identity
URL, which Salesforce provides along with the access token for the connected app.

Using OAuth requests, you can retrieve custom permissions associated with a connected app for an organization, and information
on whether a user has associated permissions enabled. For more information, see Get Custom Permissions in the Identity
URL Response on page 208.

Note:

• Custom permissions aren’t available in unmanaged packages.

• Custom permissions aren't included in profile settings for packages.

• If you deploy a change set with a custom permission that includes a connected app, the connected app must already
be installed in the destination organization.

Create Custom Permissions

Create custom permissions to give users access to custom processes or apps.

Enable Custom Permissions in Permission Sets

Custom permissions give you a way to provide access to custom processes or apps. After you’ve created a custom permission
and associated it with a process or app, you can enable the permission in permission sets.

Enable Custom Permissions in Profiles

Custom permissions give you a way to provide access to custom processes or apps. After you’ve created a custom permission
and associated it with a process or app, you can enable the permission in profiles.

Create Custom Permissions
Create custom permissions to give users access to custom processes or apps.

Available in: Developer Edition

User Permissions Needed

“Manage Custom Permissions”To create custom permissions:
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Note:  Custom permissions are currently available as a Developer Preview.

1. From Setup, click Develop > Custom Permissions.
2. Click New.
3. Enter the permission information:

• Label—the permission label that appears in permission sets
• Name—the unique name that’s used by the API and managed packages
• Description—a description that explains what functions the permission grants access to, such as “Approve time-off

requests.”
• Connected App—the connected app that’s associated with this permission

4. Click Save.

Enable Custom Permissions in Permission Sets
Custom permissions give you a way to provide access to custom processes or apps. After you’ve created a custom permission
and associated it with a process or app, you can enable the permission in permission sets.

Available in: Developer Edition

User Permissions Needed

“Manage Profiles and Permission Sets”To enable custom permissions in permission sets:

Note:  Custom permissions are currently available as a Developer Preview.

1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set, or create one.
3. On the permission set overview page, click Custom Permissions.
4. Click Edit.
5. To enable custom permissions, select them from the Available Custom Permissions list and then click Add. To remove

apps from the permission set, select them from the Enabled Custom Permissions list and then click Remove.
6. Click Save.

Enable Custom Permissions in Profiles
Custom permissions give you a way to provide access to custom processes or apps. After you’ve created a custom permission
and associated it with a process or app, you can enable the permission in profiles.

Available in: Developer Edition

User Permissions Needed

“Manage Profiles and Permission Sets”To enable custom permissions in profiles:
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Note:  Custom permissions are currently available as a Developer Preview.

1. From Setup, click Manage Users > Profiles.
2. Select a profile.
3. Depending on which user interface you’re using, do one of the following.

• Enhanced profile user interface: Click Custom Permissions, and then click Edit.
• Original profile user interface: In the Enabled Custom Permissions related list, click Edit.

4. To enable custom permissions, select them from the Available Custom Permissions list and click Add. To remove apps
from the permission set, select them from the Enabled Custom Permissions list and click Remove.

5. Click Save.

Publisher Enabled for Chatter Off Organizations
Organizations that don’t have Chatter enabled can now take advantage of all the robust functionality that actions provide in
Salesforce1.

You can enable or disable Chatter for your organization in Setup at Customize > Chatter > Settings. If Chatter is enabled,
on that page you'll see the Enable Publisher Actions checkbox, which controls whether the actions that you create
display in the Chatter publisher.

If you have Chatter and publisher actions disabled, you can still create global and object-specific actions, which appear only
in Salesforce1. You just won’t have the standard Chatter actions such as Post, File, Link, Poll, and Thanks available.

Summer ’14 Action Behavior

This table represents the new behavior for actions as of Summer ’14. Changes in behavior are indicated in bold text.

Chatter On, Publisher
Actions On

Chatter On, Publisher
Actions Off

Chatter Off, Publisher
Actions Off

YesYesYesGlobal actions can be created.

YesYesYesGlobal action lists can be
customized.

YesYesYesObject-specific actions can be
created.

YesYesYesObject-specific action lists can be
customized.

YesYes1NoActions appear on the Home page
and Chatter tab in the full
Salesforce site.

Yes2Yes1,2NoActions appear in object feeds in the
full Salesforce site.

YesYes4No3The actions tray is available on the
Feed in Salesforce1.

Yes6Yes6Yes5The actions tray is available on the
record view in Salesforce1.
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Chatter On, Publisher
Actions On

Chatter On, Publisher
Actions Off

Chatter Off, Publisher
Actions Off

YesYesYes5The actions tray is available on
Flexible Pages in Salesforce1.

1. If publisher actions aren’t enabled, only standard Chatter actions (Post, File, Link, Poll, and Thanks) appear in the
Chatter publisher in the full Salesforce site.

2. The Chatter feed appears on an object’s detail page in the full Salesforce site only for objects that have Feed Tracking
enabled.

3. When Chatter is disabled, the Feed item isn’t available in Salesforce1.
4. When Chatter is enabled but publisher actions are disabled, standard and nonstandard actions appear in the actions

tray in Salesforce1 or in third-party apps that use action lists. Nonstandard actions include Create, Update, Log a
Call, custom actions, and Mobile Smart Actions.

5. When Chatter and publisher actions are disabled, only nonstandard actions appear in the action tray in Salesforce1
or in third-party apps that use action lists. Nonstandard actions include Create, Update, Log a Call, custom actions,
and Mobile Smart Actions.

6. If Feed Tracking is not enabled on the object, only nonstandard actions appear in the actions tray in Salesforce1 or
in third-party apps that use action lists. Nonstandard actions include Create, Update, Log a Call, custom actions,
and Mobile Smart Actions.

What Else Has Changed?

Regardless of your organization’s Chatter settings:
• The Buttons, Links, and Actions node in Setup is now available on all standard objects that support buttons, links,

and actions.
• The Publisher Actions section in page layouts appears for all objects that support actions.

• The Buttons, Links, and Actions related list is available for all custom objects.

Improvements to Setup Search (Beta)
With Advanced Setup Search, you can search for Setup menu items, custom fields, custom objects, custom profiles, permission
sets, public groups, roles, and users from the sidebar in Setup.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Advanced Setup Search:

“View Setup and Configuration”To search Setup:

Note:

• Advanced Setup Search is in beta. It is production-quality but has known limitations.

• After Summer ’14 is available for your organization, it might take a few weeks before your organization’s setup
data is indexed and searchable. During those initial weeks, searches might not return all possible results.
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Advanced Setup Search includes the following enhancements.

• Search results now include custom objects and custom fields.

• Search results for permission sets return the permission set label instead of the API name.

To enable Advanced Setup Search for your organization, in Setup, click Customize > User Interface, then scroll to Enable
Advanced Setup Search (Beta). If Advanced Setup Search is disabled, users can find only Setup pages.

To find setup items, enter at least two consecutive characters of the item that you want in the Setup Search box, and then click

 or press Enter. In the Setup Search Results page that appears, select an item from the list.

General Administration
Administration helps you manage your organization to suit your business needs.

Description Field Added to Login IP Ranges

When setting the Login IP Ranges for a profile or your organization, you can also enter a description for each range to help
identify the purpose of the range setting.

More Specific Permissions for Managing Users

We've added more specific user-management permissions that distribute the access of the “Manage Users” permission. Now
organizations have more precise control over what user-management permissions their administrators have.

Limit Raised for External IDs

The limit has been raised from three to seven for external IDs on custom fields.

Customize Feed-Based Page Layouts in New Ways

Expand the feed horizontally and automatically collapse the publisher when it’s not in use so users can see more information
at a glance when they work with records.

All Custom Objects Classified as Light or Enterprise Objects

Every custom object is now classified based on whether you can use a private sharing model, Bulk API, or Streaming API
with it.

Home Page Components

We made some significant changes to how HTML code is handled in home page components. We also introduced a new
Visualforce Area home page component.

Actions

We’ve made some changes to the way actions work in Salesforce and Salesforce1.

Monitor Your Organization’s Usage-based Entitlements (Generally Available)

Track how much your organization is using a given entitlement, such as the number of logins to a customer community each
month. Usage-based entitlements were formerly a beta feature.

Description Field Added to Login IP Ranges
When setting the Login IP Ranges for a profile or your organization, you can also enter a description for each range to help
identify the purpose of the range setting.
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Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view login IP ranges:

“Manage IP Addresses”To edit login IP ranges:

To view or edit the Description field for login IP ranges for each profile:

1. From Setup, click Manage Users > Profiles, then select a profile.
2. In the profile page, go to the Login IP Ranges section.

As you add or edit a Login IP Range, use the Description field to provide details, such as which part of your network
corresponds to the range.

To view or edit the Description field for login IP ranges for your entire organization:

1. From Setup, click Security Controls > Network Access.
2. Click New, or Edit for an existing range.

More Specific Permissions for Managing Users
We've added more specific user-management permissions that distribute the access of the “Manage Users” permission. Now
organizations have more precise control over what user-management permissions their administrators have.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

The “Manage Users” permission gives access to many user-management tasks, such as managing profiles, permission sets,
roles, and password policies. You might need to give users access to some, but not all, of those tasks. For example, some users
might need to manage profiles and permission sets but not to deactivate users. To improve the control over user management
permissions, we’ve added the following permissions.

Allows Users toPermission Name

Assign permission sets to users and remove permission set
assignments.

“Assign Permission Sets”

Create and edit internal users.“Manage Internal Users”

Create, edit, and delete trusted IP ranges.“Manage IP Addresses”

Specify the login access policies that apply to administrators
and support organizations.

“Manage Login Access Policies”

Set password restrictions and login lockout policies for all
users.

“Manage Password Policies”

Create, edit, and delete profiles and permission sets.“Manage Profiles and Permission Sets”

Create, edit, and recalculate sharing rules, and edit
organization-wide defaults.

“Manage Sharing”

Create, edit, and delete roles.“Manage Roles”
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The “Manage Users” permission still exists and provides the same access that it has provided in earlier releases. When “Manage
Users” is enabled, these new permissions are also automatically enabled.

Limit Raised for External IDs
The limit has been raised from three to seven for external IDs on custom fields.

Customize Feed-Based Page Layouts in New Ways
Expand the feed horizontally and automatically collapse the publisher when it’s not in use so users can see more information
at a glance when they work with records.

Two new settings for feed-based page layouts let you customize feed views so users can see more information without having
to scroll.

• Use the Auto-Collapse Publisher setting to collapse the publisher when it’s not in use. The publisher expands to
its regular height when a user clicks inside it.

Figure 3: Collapsible Publisher

• Enable the Use Full-Width Feed setting to expand the feed horizontally to take up all available space on the page.

Note:  This setting applies only when users view records on tabs or subtabs in the Salesforce console. The portion
of the page the feed takes up with this setting enabled depends on whether you have tools or components in the
right column of the page layout, and whether you have console sidebar components.
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Figure 4: Full-Width Feed

To enable either of these settings, click Feed View in the top menu of the page layout editor when you’re editing a feed-based
page layout, and then choose the setting you want. Both of these settings are automatically enabled in organizations created
after Summer ’14.

For more information about feed-based layouts, see “Feed-Based Layouts Overview” in the Salesforce Help.

All Custom Objects Classified as Light or Enterprise Objects
Every custom object is now classified based on whether you can use a private sharing model, Bulk API, or Streaming API
with it.

When you create custom objects, you can classify the object as a Light Application object or an Enterprise Application object
by enabling or disabling the following settings.

• Allow Sharing

• Allow Bulk API Access

• Allow Streaming API Access

If these settings are enabled on an object, it’s an Enterprise Application object. If these settings are disabled on an object, it’s
a Light Application object. The settings must all be enabled or all be disabled.

Objects created before Summer ’14 automatically have these settings enabled and are classified as Enterprise Application
objects.

If your organization uses Force.com Light App or Force.com Enterprise App licenses, use these object classifications to verify
that your organization is following the contractual limits of those licenses.

Track Your Organization's Custom Object Usage by User License Type

To keep track of how many custom objects your users are assigned to, create a custom report type with the User Licenses
and Custom Object Usage by User License Metrics objects.
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Track Your Organization's Custom Object Usage by User License Type
To keep track of how many custom objects your users are assigned to, create a custom report type with the User Licenses and
Custom Object Usage by User License Metrics objects.

Custom objects are available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and
Developer Editions

Custom report types are available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

1. From Setup, click Create > Report Types.
2. Click New Custom Report Type.
3. Fill out the fields.

Enter or select...For this field...

User LicensesPrimary Object

A label for this report type. The label appears when users
create a report.

For example, Custom Object Usage by User
License.

Report Type Label

A unique name for this report type.Report Type Name

A description for this report type. This description appears
when users create a report.

Description

Other ReportsStore in Category

4. (Optional) To make this report type available to other users, select a Deployment Status of Deployed.
5. Click Next.
6. Click the box under the primary object.
7. Select Custom Object Usage by User License Metrics.
8. Click Save.
9. Create a report using the new report type.

Home Page Components
We made some significant changes to how HTML code is handled in home page components. We also introduced a new
Visualforce Area home page component.
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New Rich Text Editor for HTML Area Home Page Components

We replaced the rich text editor in HTML Area home page components with a new version that supports more markup
but doesn’t allow HTML to be manually entered.

New HTML Area home page components will use the new rich text editor. HTML Area home page components
created prior to Summer ’14 that contain simple markup that is supported by the new rich text editor will appear in the
new editor.

HTML Area home page components that were created prior to Summer ’14 that contain code that’s no longer supported
for HTML components, such as JavaScript and iframes, will continue to work and will still use the old rich text editor
(see note below).

Important:  In Summer ’15 we will start removing unsupported code from HTML Area home page components.
As a result, components that contain JavaScript, CSS, iframes, or other unsupported markup might stop working
properly. To use JavaScript or other advanced HTML elements in your home page component, we recommend
that you use a Visualforce Area component instead.

Increased Validation for Image and HTML Area Home Page Components

If you create or edit an Image home page component that contains unsupported HTML markup, all unsupported markup
is removed upon saving.

The new rich text editor for HTML components doesn’t allow you to enter unsupported markup. Existing HTML
home page components with unsupported markup will continue to work until Summer ’15, per the previous note.

New Visualforce Area Home Page Component

The new Visualforce Area home page component lets you create home page components with custom markup, including
JavaScript and CSS, which are now restricted from use in HTML Area home page components. Use Visualforce Area
home page components to add dynamic content to your home page. For example, you can present content from partner
apps, display charts in conjunction with the Analytics API, or add a canvas app to the home page.

Visualforce Area home page components can be added to the narrow or the wide column of the home page layout, and
the referenced Visualforce page can use a standard or custom controller. You can include JavaScript in your Visualforce
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page, but because the component is rendered in an iframe on the home page layout, the JavaScript can’t interact with
the page that contains the component.

Actions
We’ve made some changes to the way actions work in Salesforce and Salesforce1.

Global Publisher Layouts and Global Actions Have New Locations in Setup

Removing actions’ dependence on Chatter means that we needed to rearrange things in Setup.

Changes to Mobile Smart Actions Behavior

Mobile smart actions no longer automatically display in Salesforce1.

Default Event Action Lets Users Create Events from Any Publisher

We’ve added a create action for events to the default actions on the global publisher layout. Now users can create events on
the Home tab, the Chatter tab, and record detail pages, without administrator setup.

Default Action Lets Users Ask Questions in Chatter

We’ve added a new default action for questions. Now users can ask questions on the Home tab, the Chatter tab, and record
detail pages in the full Salesforce site, and on the Feed, in groups, and on record pages in Salesforce1.

Global Publisher Layouts and Global Actions Have New Locations in Setup
Removing actions’ dependence on Chatter means that we needed to rearrange things in Setup.

Global actions are now located in Setup at Create > Global Actions > Actions. Global publisher layouts can now be found
in Setup at Create > Global Actions > Publisher Layouts.

Changes to Mobile Smart Actions Behavior
Mobile smart actions no longer automatically display in Salesforce1.

If your organization existed prior to Winter ’14, and it had Chatter enabled but didn’t have publisher actions enabled when
Winter ’14 was released, mobile smart actions were automatically displayed in Salesforce1 on the Feed page and on account,
contact, lead, opportunity, and case records. However, with Summer ’14, mobile smart actions are no longer automatically
displayed.

In Summer ’14, publisher actions are enabled for all organizations that have Chatter enabled, but nonstandard actions—actions
other than Post, File, Link, Poll, and Thanks—aren’t added to organizations that didn’t have publisher actions enabled
previously. If you disable publisher actions, and you want mobile smart actions on your page layouts, you need to add the
mobile smart actions element manually. However, we recommend that you create your own actions or customize the default
actions instead. Mobile smart actions display the full edit form based on the object’s page layout, while actions that you create
can be optimized for mobile use.

Default Event Action Lets Users Create Events from Any Publisher
We’ve added a create action for events to the default actions on the global publisher layout. Now users can create events on
the Home tab, the Chatter tab, and record detail pages, without administrator setup.
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Default Action Lets Users Ask Questions in Chatter
We’ve added a new default action for questions. Now users can ask questions on the Home tab, the Chatter tab, and record
detail pages in the full Salesforce site, and on the Feed, in groups, and on record pages in Salesforce1.

For more information, see Ask Questions in the Feed with Chatter Questions (Beta).

Monitor Your Organization’s Usage-based Entitlements
(Generally Available)

Track how much your organization is using a given entitlement, such as the number of logins to a customer community each
month. Usage-based entitlements were formerly a beta feature.

Available in: Enterprise, Performance, and Unlimited Editions

To see your organization’s usage-based entitlements, from Setup, click Company Profile > Company Information. In the
Usage-based Entitlements related list:

• The Amount Used column (1) shows how much of the allowance your organization has used.
• The Usage Date column (2) shows when your usage was last updated.
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Data
The Force.com platform makes it easy for you to manage and track your data.

Retain Field History Data (Pilot)

Storing data and how long to store it for have emerged as key concerns for our customers. We hear you and are responding
with an improved Field History Retention pilot that lets you retain your data longer.

Retain Field History Data (Pilot)
Storing data and how long to store it for have emerged as key concerns for our customers. We hear you and are responding
with an improved Field History Retention pilot that lets you retain your data longer.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com
Editions

As the first part of a larger data life cycle management initiative, salesforce.com is continuing the pilot that began in Winter
'14. Use the Salesforce Metadata API to define a retention policy for your field history. Then use the REST API, SOAP API,
and Tooling API to work with your archived data.

The pilot lets you define a retention policy for field history in these Salesforce objects:

• Accounts

• Cases

• Contacts

• Leads

• Opportunities

The pilot also supports setting policies for custom objects.

Salesforce.com will eventually move toward a policy of deleting field history data that is older than 18 months, which is why
actively specifying your own history retention policies will become important for your organization.

To learn more about the pilot, see the Field History Retention Implementation Guide.

For more information about joining the pilot, contact your account team or Customer Support.

Business Logic and Process Automation
Workflow, approvals, and Visual Workflow provide point-and-click tools for automating and simplifying complex business
processes.
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Visual Workflow is available in: Enterprise, Performance, Unlimited, and Developer Editions

Approvals are available in: Enterprise, Performance, Unlimited, and Developer Editions, and for an additional cost in:
Professional Edition

Workflow is available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions, and for an additional
cost in: Professional Edition

Workflow tasks, email alerts, and flow triggers are not available in Database.com

Workflow

• Workflow Target User Merge Fields for Email Templates (Beta)

Workflow email alerts for the User object can reference fields from the user record that triggered the workflow rule.
When creating or editing email templates in Salesforce, the Select Field Type drop-down list now contains the
Workflow Target User option.

• Flow Triggers Can Pass Previous Record Values into SObject Variables (Pilot)

A new value is available for setting a flow’s sObject variable from a flow trigger workflow action. Enter {!old} to
use the most recent previous values of the record that was edited to cause the workflow rule to fire.

• Default Workflow User is Notified When Email Alerts Approach or Exceed Limits

When workflow email alerts approach or exceed certain limits, Salesforce sends a warning email to the default
workflow user or—if the default workflow user isn't set—to an active system administrator.

• Verify Formula References to Custom Fields in Workflow Rule Criteria and Workflow Actions

Previously, when an object had two custom fields with the same name—one with a namespace prefix
(abc__Expense__c) and one without (Expense__c)—formulas in workflow rule criteria and workflow actions
that reference the custom field without the namespace prefix would incorrectly access the custom field with the
namespace prefix.

• Increased Limits for Total Rules

The limits for the total number of rules were raised.

Approvals

• Expanded Approval History Reports

You can now run reports on completed and in-progress approval processes and their steps. Previously, reports were
available only for pending approval requests. We also made more fields and objects that contain approval history data
available via SOQL queries.

• Submit Records for Approval from within the Salesforce1 App

Users can now submit records for approval from the Salesforce1 app.

• Submit Records for Approval from a Flow (Pilot)

You can now submit records for approval from a flow. Because approval processes are fully configured in Salesforce,
you only need to identify the ID of the record that you want to submit. Optionally, you can add submission comments.

Visual Workflow

• Changes to Trigger-Ready Flows
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A trigger-ready flow is a flow that can be launched without user interaction. Formerly available only via a pilot
program for launching flows from workflow rules, there are new methods of launching a trigger-ready flow. We’ve
also updated the list of elements and resources that trigger-ready flows can contain.

• Manipulate Multiple Salesforce Fields and Records at One Time in a Flow (Generally Available)

Collect the values for multiple fields for Salesforce records with a single query, and manipulate that data with a single
DML statement by using sObject variables, sObject collection variables, and loops in a flow. In Spring ’14, this
functionality was available only with a pilot program.

• Cross-Object Field References in Flows

When building a flow, you can now reference fields for records that are related to the values that are stored in an
sObject variable. To do so, you must manually enter the references. You can reference cross-object fields to use their
values anywhere you can reference a flow resource or enter a value.

• Use an Object-Specific or Global Action in a Flow

As an alternative to Record or Fast elements, flows can now use object-specific and global actions to create and update
Salesforce records. Set the input assignments to transfer data from the flow to the action.

• Send Email from a Flow

You now have two options for sending email from a flow: call an existing workflow email alert or configure the email
within the flow.

• Submit Records for Approval from a Flow (Pilot)

You can now submit records for approval from a flow. Because approval processes are fully configured in Salesforce,
you only need to identify the ID of the record that you want to submit. Optionally, you can add submission comments.

• Governor Limits Enforced on All Flows

Previously, flows could potentially consume more resources than are allowed by our governor limits, such as the
number of DML statements or SOQL queries issued in a single transaction. Create, update, and delete elements
issue DML statements, and lookup elements issue SOQL queries. This critical update more strictly enforces governor
limits on flows.

• Flow Formulas Can Resolve to Non-Numeric Values

Formula resources in flows no longer need to return a numeric value.

• Date/Time Values in the Cloud Flow Designer Include GMT Offset

At runtime, time zones for date/time values may differ from what you see in the Cloud Flow Designer. During
runtime, date/time values reflect the running user's time zone settings in Salesforce. In the Cloud Flow Designer,
date/time values reflect the time zone set on your computer. For your reference, the Cloud Flow Designer appends
the GMT offset to your date/time value.

Submit Records for Approval from a Flow (Pilot)

You can now submit records for approval from a flow. Because approval processes are fully configured in Salesforce, you only
need to identify the ID of the record that you want to submit. Optionally, you can add submission comments.
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Workflow Target User Merge Fields for Email Templates (Beta)
Workflow email alerts for the User object can reference fields from the user record that triggered the workflow rule. When
creating or editing email templates in Salesforce, the Select Field Type drop-down list now contains the Workflow Target
User option.

Note: This release contains a beta version of workflow on the User object that is production quality but has known
limitations. To provide feedback and suggestions, go to IdeaExchange.

To use merge fields from user records in email templates, select from the following merge field types:

• User Fields—Use these merge fields to represent the sending user. Merge fields named {!User.field_name} return
values from the user record of the person who created or updated the record that triggered the workflow rule.

• Workflow Target User Fields—Use these merge fields only in email templates for workflow rules on the User object.
Merge fields named {!Target_User.field_name} return values from the user record that was created or updated to
trigger the workflow rule.

For example, if you have a workflow rule that emails new employees when their user records are created, you could use the
following email template to reference both the name of the employee and the person who created the user record.
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Default Workflow User is Notified When Email Alerts Approach
or Exceed Limits

When workflow email alerts approach or exceed certain limits, Salesforce sends a warning email to the default workflow user
or—if the default workflow user isn't set—to an active system administrator.

Warning Email Includes...Salesforce Sends...When...

The unsent email alert’s content and
recipients

A warning email for each unsent email
alert

An email alert isn't sent because the
number of recipients exceeds the limit
for a single email

The limit and the organization's usageOne warning emailThe organization reaches 90% of the
limit of emails per day

The limit and the organization's usageOne warning emailThe organization reaches 90% of the
limit of workflow emails per day

The limit and the organization's usageA warning email after every 100
attempted email alerts over the limit

An email alert isn't sent because the
organization reaches the limit of emails
per day

The limit and the organization's usageA warning email after every 100
attempted email alerts over the limit

An email alert isn't sent because the
organization reaches the limit of
workflow emails per day

For example, the default workflow user could receive a warning email with this message:

Your organization (AW Computing) has almost reached the limit of 2,000,000 workflow emails
per day. The number of emails already sent is 1,800,000.

Flow Triggers Can Pass Previous Record Values into SObject
Variables (Pilot)

A new value is available for setting a flow’s sObject variable from a flow trigger workflow action. Enter {!old} to use the
most recent previous values of the record that was edited to cause the workflow rule to fire.

Note:

• Flow trigger workflow actions are currently available through a pilot program. For information on enabling this
feature in your organization, contact salesforce.com.

• Similar to {!this}, {!old} can be assigned only to sObject variables.

• Unlike {!this}, {!old} can’t be selected by clicking . You must manually enter {!old} in the Value column.

A flow that is launched by a flow trigger workflow action can now easily access both the current and most recent previous
values of the record that was edited to cause the workflow rule to fire. The flow just needs two sObject variables that have:

189

Default Workflow User is Notified When Email Alerts
Approach or Exceed Limits

Force.com Customization



• the same object type as the flow trigger

• the Input/Output Type set to allow input access

When setting those sObject variables from the flow trigger:

• Enter {!this} to specify the current values of the record that was edited to cause the workflow rule to fire.

• Enter {!old} to specify the record’s values from immediately before it was edited to cause the workflow rule to fire.

If the record was newly created, {!old} is null.

This screenshot shows how you would set flow sObject variables to access both the current and most recent previous values
of the record that was edited to cause the workflow rule to fire.

1. Enter {!this} as the value for the sObject variable that you want to contain the current values.
2. Enter {!old} as the value for the sObject variable that you want to contain the most recent previous values.

Expanded Approval History Reports
You can now run reports on completed and in-progress approval processes and their steps. Previously, reports were available
only for pending approval requests. We also made more fields and objects that contain approval history data available via
SOQL queries.

Note:  After Summer ’14 is available for your organization, it may take a few weeks before your organization’s approval
history data becomes available. During those initial weeks, approval history reports may not return all possible data.
Also, some data from previously completed and currently pending approval processes may never be reflected in the
approval history. For details, see Considerations for Approval History Reports on page 193.

You can now create a custom report type with primary object Process Instance and related object Process Instance Node. A
process instance represents one instance of an approval process. A new process instance is created each time a record is submitted
for approval. A process instance node represents an instance of an approval step. A new process instance node is created each
time a record enters a step in an approval process. No process instance node is created when the record doesn’t meet the step
criteria or if the approval process instance is otherwise completed without entering the step.

After you create the custom report type, you can create and run approval history reports. For example, use approval history
reports to:

• See how long (maximum, minimum, or average time) it takes for your users to complete an approval process or a particular
step in an approval process.
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• See all pending approval process instances with a view of which ones are waiting at a specific approval step.

• See all approval processes that were completed for an object or a specific record, and filter the results for a specific range
of dates.

Additional details—such as specific approval requests that are made within each approval step—are available via SOQL queries
of the following objects. (You can even create a Visualforce page or other custom UI to act as a management console for
approvals in your organization.)

• ProcessDefinition

• ProcessInstance

• ProcessInstanceHistory

• ProcessInstanceNode

• ProcessInstanceStep

• ProcessInstanceWorkitem

• ProcessNode

Report Example: Approval Steps—Elapsed Times
This sample report displays all approval process instances (1) and groups results by approval process name (2) and record name
(3). The results are sorted by step name (4) and include step status (5), step start date (6), step elapsed minutes (7), step
completed date (8), and approval process instance ID (9).
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Notice that the previous sample report doesn't include the approvers for each step and the elapsed time for each approval
request. To get this information, you need to run a SOQL query by using the approval process instance ID from the report.
The following sample SOQL query obtains the ActorID (user or queue that received the approval request) and the
ElapsedTimeInHours (elapsed time since the approval request was sent) for the first pending step in the report.

SELECT ActorId,ElapsedTimeInHours FROM ProcessInstanceWorkitem where processInstanceId =
'04gD0000000LvIV'
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The sample query has only one result, and you can view that approver's user profile page by appending the resulting ActorID
to the organization's base URL (https://MyCompany.salesforce.com/005D00000015vGGIAY), which gets redirected
to the user profile page.

Considerations for Approval History Reports
Understand the limitations and special behaviors when you create or view approval history reports, which provide a detailed
history of approval processes and steps.

Considerations for Approval Process Instances that are Completed Before or are Pending During the Summer ’14
Rollout

When Summer ’14 becomes available for your organization, the approval history data is automatically populated for completed
and pending approvals. However, some approval history field values are never populated or are populated only after the approval
process instance is next acted upon—such as when a user approves, rejects, or reassigns an approval request—after the Summer
’14 rollout.

When Fields are PopulatedObject

For approval process instances that were completed before the Summer ’14 rollout, all Process
Instance fields are automatically populated, with one exception: Completed Date is never
populated for approval process instances that were completed before January 1, 2013.

For approval process instances that were pending during the Summer ’14 rollout, all Process
Instance fields are automatically populated, with two exceptions: Completed Date and Last
Actor: Full Name are populated only after the approval process instance is complete.

Process Instance
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When Fields are PopulatedObject

Never populated for approval process instances that were completed before the Summer ’14
rollout.

For approval process instances that were pending during the Summer ’14 rollout, all Process
Instance Node fields are populated only after the approval process instance is next acted upon
after the Summer ’14 rollout.

Process Instance Node

Additional exceptions apply to approval history data that is available via SOQL queries of the following objects.

When Fields are PopulatedObject

For approval process instances that were completed before the Summer ’14 rollout, all
Process Instance fields are automatically populated, with one exception: CompletedDate

ProcessInstance

is never populated for approval process instances that were completed before January 1,
2013.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstance fields are automatically populated, with two exceptions: CompletedDate
and LastActorId are populated only after the approval process instance is complete.

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceNode fields are populated only after the approval process instance is next
acted upon after the Summer ’14 rollout.

ProcessInstanceNode

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceStep fields are populated only after the approval process instance is next
acted upon after the Summer ’14 rollout.

ProcessInstanceStep

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceWorkitem fields are populated after the approval process instance is next

ProcessInstanceWorkitem

acted upon after the Summer ’14 rollout, with three exceptions: ElapsedTimeInDays,
ElapsedTimeInHours, and ElapsedTimeInMinutes fields are never populated in
ProcessInstanceWorkitem records for which equivalent ProcessInstanceStep records
were created before the Summer ’14 rollout.

For all other ProcessInstanceWorkitem records, these three fields are populated after the
approval process instance is next acted upon after the Summer ’14 rollout.

Note:  Because ProcessInstanceHistory combines fields from ProcessInstanceStep
and ProcessInstanceWorkitem, you may notice incorrect elapsed times of 0 in
ProcessInstanceHistory records because the elapsed time fields were never
populated in the related ProcessInstanceWorkitem record.

Considerations for the Sandbox Environment

If you copy approval history data to a sandbox, some field values are overwritten and won’t reflect the actual approval history.
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When an Existing Process Instance or Process Instance Node Record is Copied
to a Sandbox...

FieldObject

This value is overwritten by the date and time when the process instance record is
copied to the sandbox.

Submitted
Date

Process Instance

This value is overwritten by the name of the user who copied the process instance
record to the sandbox.

Submitter:
Full Name

This value is overwritten by the date and time when the process instance node record
is copied to the sandbox.

Step Start
Date

Process Instance
Node

Changes to Trigger-Ready Flows
A trigger-ready flow is a flow that can be launched without user interaction. Formerly available only via a pilot program for
launching flows from workflow rules, there are new methods of launching a trigger-ready flow. We’ve also updated the list of
elements and resources that trigger-ready flows can contain.

New Methods of Launching Trigger-Ready Flows

You can now launch a trigger-ready flow with these new methods, which are generally available.
• The Apex start() method

• A custom button or link

• The flow URL

• The Run button in the Cloud Flow Designer

Formerly, you could only launch a trigger-ready flow with a flow trigger workflow action. Flow trigger workflow actions
are currently available through a pilot program. For information on enabling this feature in your organization, contact
salesforce.com.

Updated Run Restrictions

A trigger-ready flow can now contain Apex Plug-in elements, but it can no longer contain choice or dynamic choice
resources. Here’s a full list of the elements and resources that aren’t supported in trigger-ready flows.
• Choice resources

• Dynamic Choice resources

• Screen elements

• Step elements

Run restrictions are now determined by the flow’s active version—or the latest version, if there’s no active version. If the
active or latest version includes restricted elements or resources, that flow is not trigger-ready and it has a run restriction
of “No triggers”. If the active or latest version doesn’t include any restricted elements or resources, the flow is trigger-ready
and it has no run restrictions.

Manipulate Multiple Salesforce Fields and Records at One Time
in a Flow (Generally Available)

Collect the values for multiple fields for Salesforce records with a single query, and manipulate that data with a single DML
statement by using sObject variables, sObject collection variables, and loops in a flow. In Spring ’14, this functionality was
available only with a pilot program.
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DML statements make changes to the Salesforce database by adding, updating, or deleting records. For information about
the per-transaction limits for DML statements and queries, see “Understanding Execution Governors and Limits” in the
Force.com Apex Code Developer’s Guide.

Store multiple field values for a Salesforce record in one variable.

An sObject variable is a container that can store values for multiple fields for a single Salesforce record.

Previously, you had to use one flow variable for each individual field value that you want to store.

Store multiple field values for multiple Salesforce records in one variable.

An sObject collection variable is a container for an ordered group of related items. An individual item in a collection is
similar to an sObject variable, as it contains the field values for one Salesforce record. To store field values in an sObject
collection variable, use a Fast Lookup element. For example, if you create an Account-based collection and your query
returns three records, the collection contains three items. The first item in the collection contains field values from the
first account returned, the second item contains the second account record’s values, and so on.

Previously, you had to use one flow variable for each individual field value that you want to store.

Use a single query to look up multiple field values.

The new Fast Lookup element uses a single query to obtain multiple field values for one Salesforce record (when storing
values in an sObject variable) or multiple Salesforce records (when storing values in an sObject collection variable).

Previously, you had to obtain field values using Record Lookup elements. A Record Lookup element uses one variable
for each individual field value that you want to store. To store field values for multiple records with Record Lookup
elements, you must use one Record Lookup element for each individual record.

Use a single DML statement and a single variable to create Salesforce records.

The new Fast Create element adds records to the Salesforce database by using the field values stored in an sObject variable
(one record) or sObject collection variable (one or more records). For example, when you use a Fast Create element that
references an sObject collection, the flow creates one record for each item in the collection.

Previously, you had to use a Record Create element to create Salesforce records from a flow. With a Record Create
element, you can create only one record at a time and you must identify the fields and their values individually.

Use a single DML statement and a single variable to update, or delete Salesforce records.

The new Fast Update and Fast Delete elements make changes to the Salesforce database by using the field values stored
in an sObject variable (one record) or sObject collection variable (one or more records). For example, when you use a
Fast Delete element that references an sObject collection, the flow deletes all the records whose IDs are stored in the
collection.

Previously, you had to use Record Update and Record Delete elements to update or delete Salesforce records from a
flow. With a Record Update element, you can update multiple records at a time, but you must identify the fields and
their values individually.

Whereas each Record Update and Record Delete element uses one query and one DML statement, each Fast Update
and Fast Delete element uses only one DML statement. With Fast elements, you can combine the results of multiple
queries and perform a single DML statement against those results rather than performing a DML statement for every
query.

Examine the values for a collection of Salesforce records.

A loop examines each item in a collection and executes actions on them based on the elements in the flow. For each item
that the loop examines, the item’s field values are copied into an sObject variable, which you identify when you create
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the loop. The elements within the loop can examine and update the contents of the sObject variable—not the collection
item itself.

You can’t update items in a collection. However, as the loop iterates through each collection item, the loop can modify
the data in the loop variable. The loop can then add the contents of the loop variable to a new collection before moving
on to the next item.

To add items to an existing collection, use an Assignment element. If you populate an existing sObject collection variable
by using a Fast Lookup or Record Lookup element, all the previous collection items are deleted and replaced by the new
items, even if they contain completely different fields.

You can’t remove items from an existing collection. Instead, loop through the collection and add the items you want to
keep to a new collection. Use a Decision element to differentiate between the items you want to add to the new collection
and the items you don’t want to add to the new collection.

To try out these new elements and resources, from Setup click Create > Workflow & Approvals > Flows and open a new or
existing flow.

Changes Since Spring ’14
sObject variables, sObject collection variables, Fast Lookup/Create/Update/Delete elements, and Loop elements were formerly
available through a pilot program. Here’s what’s changed since then.

• These elements and resources are now available in all flows. In Spring ’14, they were available only in trigger-ready flows.
• Values for sObject variables and sObject collection variables can be set or retrieved through Visualforce and Apex. These

values cannot be set through URL parameters.

Sample Flow that Loops through a Collection
This example demonstrates how to use sObject collection variables and a loop to transfer ownership of accounts from one user
to another. The flow already has the required user IDs.

First, create an Account-based sObject collection variable called collAcctJSmith and populate it with all account records
that John Smith owns.

Then create a loop that iterates through the collection. For each item in the collection, the loop does the following:

1. Assigns the collection item to the loop variable.
2. Evaluates whether or not the account has more than 10,000 employees.
3. Assigns Madison’s user ID to the OwnerId field in the loop variable if the account has more than 10,000 employees.
4. Assigns Amber’s user ID to the OwnerId field in the loop variable if the account doesn’t have more than 10,000 employees.
5. Adds the loop variable’s values as a new item in a second collection called collReassignedAccts.

Finally, create a Fast Update element to update the accounts in collReassignedAccts with the new OwnerId after the
loop finishes iterating through the collection.
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This section of the flow uses a single query to look up the list of accounts and a single DML statement to update those accounts.
If you created a similar flow by using Record Update elements, you would use:

• One Record Update element to find all accounts that were owned by John and had more than 10,000 employees (1 query)
and then update those records’ OwnerId to Madison’s Id (1 DML statement).

• One Record Update element to find all accounts that were owned by John and didn’t have more than 10,000 employees
(1 query) and then update those records’ OwnerId to Amber’s Id (1 DML statement).

Cross-Object Field References in Flows
When building a flow, you can now reference fields for records that are related to the values that are stored in an sObject
variable. To do so, you must manually enter the references. You can reference cross-object fields to use their values anywhere
you can reference a flow resource or enter a value.

Implementation Tips
If a flow interview encounters a null value at any point in the cross-object expression, the element containing the reference
fails. The reference runs successfully if the last field value in the cross-object expression is null. For example, if you store a
contact in {!sObjContact} and try to reference {!sObjContact}.Account.Name, the flow will fail if AccountId
on the stored contact is null (because there isn’t an account to look at), but it won’t fail if Name on the related account is
null. If an element contains a cross-object reference that fails and the element doesn’t have a fault path defined, the entire
interview fails. To avoid this, you can:

• Make the fields that you want to reference in the expression required in Salesforce. For example, for the expression
{!sObjContact}.Account.Name, you could require AccountId on contact page layouts. Then use another flow to
find any records with null values for that field and update them.

• Determine whether each field that’s referenced in the expression has a value by using the wasSet operator in a Decision
element.

Cross-object field references in flows don’t count against your organization’s limits for:

• Cross-object relationships per object
• DML operations per transaction
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Syntax
To reference a cross-object field, start with the sObject variable that you want to traverse from, enter the relationship names
of the objects to which you are spanning, and then enter the field that you want to reference. Separate the relationship names
of each object and the field with periods.

{!sObjectVariable.relationshipName.relationshipName.fieldName}

To reference custom objects, always append __c to the field. Don’t use __r to identify relationships for custom objects.

When you create an sObject variable that you plan to reference cross-object fields from, you must store the ID field value for
the first relationship in the sObject variable. For example, if you want to reference an opportunity’s contract, you must store
ContractId in the sObject variable or add a value for ContractId by using an Assignment element.

For example, to update a contract’s owner to be the contract’s account’s owner:

1. Use a Fast Lookup element to store the contract’s fields, including AccountId, in an sObject variable called
varContract.

2. Use a Decision element to verify that the value of AccountId was set in varContract.
3. Use a Fast Lookup to store the fields for the contract’s account, including OwnerId, in another sObject variable called

varAccount.
4. Use a Decision element to confirm that the value of OwnerId was set in varAccount.
5. Use an Assignment element to specify {!varContract.Account.OwnerId} as the value for

{!varContract.OwnerId}.
6. Use a Fast Update element to write the values in varContract, including the updated OwnerId value, to the contract

in Salesforce.
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Send Email from a Flow
You now have two options for sending email from a flow: call an existing workflow email alert or configure the email within
the flow.

With an Email Alert element, you only need to associate the email with a record. Workflow email alerts are configured in
Salesforce, and they already have a set email template, list of recipients, and sender. The Palette displays each workflow email
alert that exists in your organization.

With the Send Email element, you need to provide the subject, body, list of recipients, and sender for the email. Nothing
about this email has been previously configured, so you can completely customize the email in your flow. The Palette displays
one Send Email element.

1. From Setup, click Create > Workflow & Approvals > Flows, and open a new or existing flow.
2. In the Palette, find the email element that you want to call.

• To call a workflow email alert, click  and select EMAIL ALERTS. Optionally, type three or more letters to search
for a specific email alert.

• To customize an email in the flow, type Send next to .

3. Drag the email element that you want onto the canvas, and fill in the general settings and input parameters.

Submit Records for Approval from a Flow (Pilot)
You can now submit records for approval from a flow. Because approval processes are fully configured in Salesforce, you only
need to identify the ID of the record that you want to submit. Optionally, you can add submission comments.

Note:  Submit for Approval actions in a flow are currently available through the “Launch Flows from Workflow
Rules” pilot program. For information on enabling this feature in your organization, contact salesforce.com.

If a flow submits a record for approval, the user who launched the flow is the submitter. If a workflow rule triggers a flow that
submits a record for approval, the user who triggered the workflow rule (by creating or editing a record) is the submitter. When
the record is approved or rejected, the user who launched the flow or triggered the workflow rule is notified.

This action call succeeds only for approval processes where the approver on submit is determined automatically and the user
who launched the flow is an allowed initial submitter on the approval process that runs. If the executed approval process
requires the submitter to manually chose the approver or if the user who launches the flow isn’t an allowed initial submitter
on the approval process that runs, the flow interview fails and the user who launched the flow sees an error. Make sure that
the approver on submit is determined automatically and that the initial submitters for the approval processes related to this
object include all users who could launch this flow. For details, see “Creating Approval Processes” in the Salesforce Help.

Consider using a fault connector path to gracefully handle these errors.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.

2. In the Palette, type Submit next to .
3. Drag the Submit for Approval element onto the canvas.
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4. Fill in the general settings and input parameters.

Use an Object-Specific or Global Action in a Flow
As an alternative to Record or Fast elements, flows can now use object-specific and global actions to create and update Salesforce
records. Set the input assignments to transfer data from the flow to the action.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. Find the action that you want to call.

a. In the Palette, click  and select OTHER ACTIONS.

The Palette displays only the object-specific and global actions in your organization.

b. Optionally, type three or more letters to search for a specific action.

3. Drag the action onto the canvas, and fill out the general settings and input parameters.

The layout for the action determines which parameters are required.

Governor Limits Enforced on All Flows
Previously, flows could potentially consume more resources than are allowed by our governor limits, such as the number of
DML statements or SOQL queries issued in a single transaction. Create, update, and delete elements issue DML statements,
and lookup elements issue SOQL queries. This critical update more strictly enforces governor limits on flows.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Available for additional cost in: Professional Edition

User Permissions Needed

“View Setup and Configuration”To view critical updates:

“Modify All Data”

AND

“Customize Application”

To activate critical updates:

Flows launched from a workflow rule are executed with the other workflow actions as part of the larger transaction. Flows
with screen elements can span multiple transactions; a new transaction begins each time the user clicks Next. Flow trigger
workflow actions are currently available through a pilot program. For information on enabling this feature in your organization,
contact salesforce.com.

If you activate this update now, governor limits will be enforced on all executed flows. Otherwise, this will be enabled for your
organization on the auto-activation date.

We recommend that you activate this update now and test your flows to identify any that violate the governor limits. If you
encounter any errors, you can deactivate this update, modify the flows so that they don’t violate the limits, and then reactivate
the update.

To modify your flows to be more efficient:

• You can examine DML statements and SOQL queries throughout your flow and determine whether you could combine
multiple operations into fewer create, update, delete, and lookup elements. For example, if your flow updates a field on a
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record and later updates another field on that record, consider whether you could update both fields simultaneously within
the same Record Update or Fast Update element.

• You can also perform one DML statement or SOQL query on multiple records by using an sObject collection variable
with a Fast Create, Fast Lookup, Fast Update, or Fast Delete element.

For more information about the governor limits, see “Understanding Execution Governors and Limits” in the Force.com Apex
Code Developer’s Guide.

Other Business Logic and Process Automation Changes
There are other important enhancements to workflow, approvals, and Visual Workflow.

Verify Formula References to Custom Fields in Workflow Rule Criteria and Workflow Actions

Previously, when an object had two custom fields with the same name—one with a namespace prefix (abc__Expense__c)
and one without (Expense__c)—formulas in workflow rule criteria and workflow actions that reference the custom
field without the namespace prefix would incorrectly access the custom field with the namespace prefix.

Now these formulas reference the correct custom fields, but this correction may change the behavior of your workflow
rules and actions—for both workflow rules and approval processes. We strongly recommend that you check all formulas
in your workflow rules and actions for any references to custom fields that need a namespace prefix. Specifically, for each
formula reference to a custom field:

1. Verify that no other custom fields for the same object have the same name.
2. If other custom fields have the same name, determine which one is the correct custom field for the formula to

reference.
3. If the correct custom field has a namespace, make sure the formula reference includes that namespace.

Increased Limits for Total Rules

The limits for the total number of rules were raised:
• From 300 to 500 per object

• From 1,000 to 2,000 per organization

These limits apply to any combination of active and inactive workflow, assignment, auto-response, and escalation rules.

Flow Formulas Can Resolve to Non-Numeric Values

Formula resources in flows no longer need to return a numeric value. The following data types are supported.
• Boolean

• Currency

• Date

• Date/Time

• Number

• Text

Date/Time Values in the Cloud Flow Designer Include GMT Offset

At runtime, time zones for date/time values may differ from what you see in the Cloud Flow Designer. During runtime,
date/time values reflect the running user's time zone settings in Salesforce. In the Cloud Flow Designer, date/time values
reflect the time zone set on your computer. For your reference, the Cloud Flow Designer appends the GMT offset to
your date/time value.
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For example, if your computer’s time zone is set to Pacific Standard Time and you create a variable MidYear with a
date/time value of 05/31/2014 11:59 PM, the Cloud Flow Designer appends GMT -8:00 when displaying that
value on your computer. When a flow that displays MidYear is run by a user whose time zone is set to Pacific Standard
Time in Salesforce, 05/31/2014 11:59 PM appears. When a flow that displays MidYear is run by a user whose
time zone is set to Eastern Standard Time in Salesforce, 05/31/2014 02:59 AM appears.

Security
Use security to protect both your data and applications.

Password Changes Improve Organization Security

Now additional options help to improve your organization’s security.

Force Logout On Session Timeout

Prevent unwanted access to your organization using the Force logout on session timeout session setting.

More Session Types Available for User Session Information

See the session types of users logged into your organization.

New Fields Available for User Session Information

See the unique session IDs of users logged into your organization.

App Launcher Available for More Profiles

Previously, profiles cloned from a specific set of existing Force.com and Platform profiles only supported the App Launcher
as a custom app. Now, administrators can add the App Launcher directly to those profiles.

10 Identity Connect Licenses for New Developer Edition Organizations

Developer Edition organizations now get 10 Identity Connect permission set licenses for testing and development.

Cross-Domain Exchanges Switch to POST Requests

For better security, organizations should send cross-domain session information using POST requests, instead of GET
requests.

Specify an Authorization Endpoint as a Request Parameter

Send your user to a specific authorization endpoint.

Get Custom Permissions in the Identity URL Response

OAuth requests can use the custom_permissions scope to retrieve custom permissions associated with a connected app
for an organization, and whether an individual user has each permission enabled.

Community ID and URL Values Included in OAuth Responses

Use OAuth to get a user’s community ID and community URL values.

Organization ID Allowed as a Salesforce Identity Provider Custom Attribute

When using Salesforce as an identity provider, you can now pass the organization_id attribute in the SAML assertion.

Identity Provider Logout URL Supported for External Users of a Community

When logging out of a community, external users are redirected to the logout URL specified in the community’s SAML
settings, if the external user logged in using SAML for single sign-on.
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New Conditions for Access To Multiple Identity URLs With One Access Token

One access token can provide access to more than one identity URL, but only if several conditions are met.

OpenID Connect Discovery Endpoint Added

Get information about Salesforce OpenID Connect support from a static URL.

Improved Internet Explorer Browser Compatibility for Login Features

Login hints and Log in to a custom domain are now available for older Internet Explorer browser versions.

Log in to a Custom Domain Field Suggestions for Communities

After users click on Log in to a custom domain on the Salesforce.com login page, and start typing, the page displays
suggestions for completing a Communities URL.

Microsoft Authentication Provider Support

You can use Microsoft Access Control Service as an authentication provider using OAuth. Authorization is typically done
by a Microsoft Office 365 service like Sharepoint® Online.

Password Changes Improve Organization Security
Now additional options help to improve your organization’s security.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com
Editions

User Permissions Needed

“Manage Password Policies”To set password policies:

Additional Password History Options: Remember Up to 24 Passwords

Minimize password reuse by selecting up to 24 passwords to be remembered in the organization history.

Longer Minimum Password Length Option

Make passwords hard to hack by requiring a minimum password length of up to 12 characters.

Uppercase and Lowercase Password Complexity Option

Increase organization security by requiring both uppercase and lowercase letters in passwords.

Minimum Password Lifetime Option

Require a minimum password lifetime to prevent multiple resets in short periods of time.

Additional Password History Options: Remember Up to 24 Passwords
Minimize password reuse by selecting up to 24 passwords to be remembered in the organization history.

Previously, administrators could limit user password reuse by selecting an option of up to 15 passwords remembered in an
organization’s history. Now administrators can select up to 24 passwords remembered. (The default remains 3 passwords
remembered.) This option further reduces password reuse and can better protect organizations from improper access. To reset
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the password history option, from Setup, click Security Controls > Password Policies and select a value for Enforce password
history.

Longer Minimum Password Length Option
Make passwords hard to hack by requiring a minimum password length of up to 12 characters.

Administrators could previously require minimum password lengths of up to 10 characters but can now require a 12 character
minimum length. (The default remains 8 characters.) A longer password presents more possible password combinations and
helps protect an organization from improper access. To set the minimum password length, from Setup, click Security Controls >
Password Policies and select a value for Minimum password length.

Uppercase and Lowercase Password Complexity Option
Increase organization security by requiring both uppercase and lowercase letters in passwords.

Administrators can require that passwords contain alpha, numeric, and special characters. Now, administrators can also require
that passwords include both uppercase and lowercase letters. More complex passwords improve organizational security. To
set the password complexity requirements, from Setup, click Security Controls > Password Policies and select a value for
Password complexity requirement.

Minimum Password Lifetime Option
Require a minimum password lifetime to prevent multiple resets in short periods of time.

Previously administrators could require a maximum lifetime for a password, such as 90 days. Now administrators can also
require that password lifetimes be a minimum of one day. If this option is selected, passwords can’t be reset more than once
during the minimum lifetime. To set the minimum password lifetime option, from Setup, click Security Controls > Password
Policies and select Require a minimum 1 day password lifetime.

Force Logout On Session Timeout
Prevent unwanted access to your organization using the Force logout on session timeout session setting.

Use the Force logout on session timeout setting in Security Controls > Session Settings to require that when
sessions time out for inactive users, current sessions become invalid. Browsers are automatically refreshed and return to the
login page. To access the organization again when this occurs, users must log in again.

This helps prevent unauthorized users from using an organization when someone has left an active session in a browser.

Note:  Do not select Disable session timeout warning popup when enabling this option.

More Session Types Available for User Session Information
See the session types of users logged into your organization.

Two additional session types can now be viewed in the User Session Information page:

• TempVisualforceExchange
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• UserSite

TempVisualforceExchange is a temporary session used to switch to the Visualforce domain. UserSite is initiated when a Canvas
app is invoked. To access user session detail, from Setup, click Security Controls > Session Management.

New Fields Available for User Session Information
See the unique session IDs of users logged into your organization.

Two additional fields, Session ID and Parent Session ID, are now available in the User Session Information page. These
fields help you to better manage specific user sessions by providing unique session ID information. For example, a user may
have more than one session open, and you may want to end only one of them. The unique IDs help you to identify correct
sessions on which to take action.

To access the page, from Setup, click Security Controls > Session Management. If you don’t see the fields in your view, click
Create New View and add them.

App Launcher Available for More Profiles
Previously, profiles cloned from a specific set of existing Force.com and Platform profiles only supported the App Launcher
as a custom app. Now, administrators can add the App Launcher directly to those profiles.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view app permissions:

“Manage Profiles and Permission Sets”To edit app permissions:

The App Launcher can be added directly to profiles cloned from the following existing profiles.

• Force.com - App Subscription User
• Force.com - One App User
• Force.com - Partner App User
• Standard Platform Light User
• Standard Platform One App User
• Standard Platform User

1. From Setup, click Manage Users > Profiles.
2. Click New.
3. Select an Existing Profile as a basis for the new profile.

For example, select Standard Platform User.

4. Enter the name of the new profile.

For example, Standard Platform User Identity.

5. Click Save.
6. In the detail page for the new profile, click Edit.
7. In Administrative Permissions, select Use Identity Features.
8. In Custom App Settings, set the App Launcher to Visible.

In Tab Settings, the App Launcher tab should be set to Default On. If not, set the value to Default On.
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9. Click Save.
10. From Setup, click Manage Users > Users.
11. Click Edit next to an existing user to whom you want to give access to the App Launcher.
12. For the user’s profile, select the new profile that has Use Identity Features enabled.
13. Click Save.

When you log in as the selected user, the App Launcher appears in the drop-down app menu.

Note:  You can also enable the App Launcher for users using permission sets. For more information, see Configure
and Use the App Launcher.

10 Identity Connect Licenses for New Developer Edition
Organizations

Developer Edition organizations now get 10 Identity Connect permission set licenses for testing and development.

Identity Connect provides Active Directory integration with Salesforce via a service which runs on either Windows or Linux
platforms. This integration includes syncing Active Directory users with either Salesforce or Identity Connect acting as the
Identity Service Provider (IDP) for Single Sign On (SSO) Active Directory integration when  logging  into Salesforce.

Developer Edition organizations must be created in the Summer ’14 release or later to get the 10 Identity Connect permission
set licenses.

In your Developer Edition organization, from Setup, click Security Controls > Identity Connect to get started.

Cross-Domain Exchanges Switch to POST Requests
For better security, organizations should send cross-domain session information using POST requests, instead of GET requests.

Administrators can modify session security settings to enable POST requests for cross-domain session exchanges, such as
when a user is using a Visualforce page. In this context, POST requests are more secure than GET requests, because POST
requests keep the session information in the body of the request.

From Setup, click Security Controls > Session Settings. Select Use POST requests for cross-domain sessions
to enable this feature, otherwise your organization will use GET requests for cross-domain sessions.
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Specify an Authorization Endpoint as a Request Parameter
Send your user to a specific authorization endpoint.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

You can add a provAuthorizeEndpointHost parameter to a Salesforce authentication provider URL to direct users to an
authorization endpoint for a provided domain, such as a custom domain created using My Domain. Providing an authorization
endpoint lets you take advantage of features like session discovery during authorization. This parameter is only available for
Salesforce authentication providers, and cannot be used to send users to an authorization page outside of a Salesforce domain.

To direct your users to a specific Salesforce authorization endpoint, you need to specify a URL with the
provAuthorizeEndpointHost request parameter and a valid https host. Query strings appended to the host URL are
ignored. However, you can specify a community path.

If an authorization endpoint is not provided, Salesforce uses the default authorization endpoint for the authorization provider.
If no default is set for the authorization provider, Salesforce uses the endpoint for login.salesforce.com.

The authorization endpoint does not change the token endpoint, which continues to be the configured or default host. For
example,  if the authorization endpoint is a sandbox instance, and your provider is set to use a production token endpoint, the
flow fails, because authorization was granted by the sandbox instance, only.

The following is an example of a provAuthorizeEndpointHost parameter added to the authentication provider URL:

• orgID is your Auth. Provider ID
• URLsuffix is the value you specified when you defined the authentication provider

https://login.salesforce.com/services/auth/sso/orgID/
URLsuffix?provAuthorizeEndpointHost=https%3A%2F%2Fmydomain.my.salesforce.com

The following is an example of a provAuthorizeEndpointHost directed to a community URL

https://login.salesforce.com/services/auth/sso/orgID/
URLsuffix?provAuthorizeEndpointHost=https%3A%2F%2Fmycommunity.force.com%2Fbilling

Get Custom Permissions in the Identity URL Response
OAuth requests can use the custom_permissions scope to retrieve custom permissions associated with a connected app
for an organization, and whether an individual user has each permission enabled.
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Available in: All Editions

User Permissions Needed

“Manage Connected Apps”To manage, create, edit, and delete OAuth applications:

Note:  Custom permissions are currently available as a Developer Preview.

Salesforce supports a new OAuth scope to include a map of custom permissions information in the response from a user’s
identity URL. When a request includes the custom_permissions scope parameter, the response includes a map containing
custom permissions in an organization associated with the connected app. If the connected app is not installed in the
organization, or has no associated custom permissions, the response does not contain a custom_permissions map.

http://login.salesforce.com/services/oauth2/authorize?response_type=token&client_
id=3MVG9lKcPoNINVBKV6EgVJiF.snSDwh6_2wSS7BrOhHGEJkC_&redirect_uri=http://www.example.org/qa/security/oauth
/useragent_flow_callback.jsp&scope=api%20id%20custom_permissions

When the new scope is included, the user’s identity URL includes a block like the following.

"custom_permissions":
{
"Email.View":true,
"Email.Create":false,
"Email.Delete":false

}

Configure connected apps to include the new scope when you create or edit the app’s OAuth settings by selecting Access
custom permissions (custom_permissions) from the available OAuth scopes.

Note:  This selection in the UI is not available until July 2014.

The new scope is also included in the organization’s metadata. For more information on the metadata addition, see Metadata
Types and Fields.

Community ID and URL Values Included in OAuth Responses
Use OAuth to get a user’s community ID and community URL values.

Salesforce includes the following return parameters for a successful Web server, user-agent, or refresh token OAuth flow
request if the user is currently a member of a Salesforce community.

• sfdc_community_id

• sfdc_community_url

The following is a partial example of a response to an OAuth Web Server Authentication Flow request.

{"id":"https://login.salesforce.com/id/00Dx0000V7z/005x0009P",
"issued_at":"1392854341715","scope":"full","instance_url":
"https://UniversalTelco.my.salesforce.com",
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"sfdc_community_url":"https://UniversalTelco.force.com/customers","token_type":"Bearer","id_token":"eyJhbGci...",
"sfdc_community_id":"000000"...}

Organization ID Allowed as a Salesforce Identity Provider Custom
Attribute

When using Salesforce as an identity provider, you can now pass the organization_id attribute in the SAML assertion.

Connected Apps can be created in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Connected Apps can be installed in: All Editions

User Permissions Needed

“Customize Application”To read:

“Customize Application” AND either

“Modify All Data” OR “Manage Connected Apps”

To create, update, or delete:

“Customize Application”To update all fields except Profiles, Permission Sets, and
Service Provider SAML Attributes:

“Customize Application” AND “Modify All Data”To update Profiles, Permission Sets, and Service Provider
SAML Attributes:

“Download AppExchange Packages”To uninstall:

Previously, the organization_id attribute was not allowed in SAML assertions generated by Salesforce when Salesforce
is acting as an identity provider. Now, the organization_id is allowed, and can be added to a SAML assertion as a custom
attribute. This is particularly useful if you are using Salesforce as the identity provider for portal users.

After you create a connected app for your service provider, use the following steps to add a custom attribute.

1. From Setup, click Create > Apps.
2. Click the Connected App Name for the service provider in the list to open the detail page.
3. In the Custom Attributes section, click New.

Each custom attribute must have a unique key and must use fields available from the Insert Field menu.

Identity Provider Logout URL Supported for External Users of a
Community

When logging out of a community, external users are redirected to the logout URL specified in the community’s SAML
settings, if the external user logged in using SAML for single sign-on.

Available in: Enterprise, Performance, Unlimited, and Developer Editions
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If the Identity Provider Logout URL is set in the community’s SAML settings, external users of the community who
authenticated with SAML for single sign-on are redirected to the Identity Provider Logout URL after logging out.
The SAML settings are in Setup, Security Controls > Single Sign-On Settings.

However, the Identity Provider Logout URL is used only when one SAML configuration is defined for the community.
If more than one SAML configuration is defined for the community, the external users logging out of the community are
returned to the community login page.

New Conditions for Access To Multiple Identity URLs With One
Access Token

One access token can provide access to more than one identity URL, but only if several conditions are met.

A successful request for an access token returns an identity URL for the authorized user. Once issued, the same access token
can be used to access other users’ identity URLs in the same organization, if the following conditions are met.

• The OAuth request for the access token included the full or api scope.

• The access token is for a user with the “API Enabled” permission.

• The access token is for a user who has access to the other user according to the User Sharing rules of the organization.

• The access token is for an internal user, meaning the user_type value in the response is STANDARD.

OpenID Connect Discovery Endpoint Added
Get information about Salesforce OpenID Connect support from a static URL.

The OpenID Connect discovery endpoint is a static page that can be used to query (no session required) for information about
the Salesforce OpenID Connect configuration. Salesforce returns basic information about endpoints, supported scopes, and
other values used for OpenID Connect authorization.

The format of the URL is: https://login.salesforce.com/.well-known/openid-configuration.

Note: For a sandbox, login.salesforce.com is replaced with test.salesforce.com.

The URL must always be HTTPS.

OpenID Connect Discovery Endpoint Response
That URL request returns the information in JSON format, only.

The following is a response in JSON format:

{"issuer":"https://login.salesforce.com",
"authorization_endpoint":"https://login.salesforce.com/services/oauth2/authorize",
"token_endpoint":"https://login.salesforce.com/services/oauth2/token",
"revocation_endpoint":"https://login.salesforce.com/services/oauth2/revoke",
"userinfo_endpoint":"https://login.salesforce.com/services/oauth2/userinfo",
"jwks_uri":"https://login.salesforce.com/id/keys",
"scopes_supported":["id","api","web","full","chatter_api",
"visualforce","refresh_token","openid","profile","email",
"address","phone","offline_access", "custom_permissions"],
"response_types_supported":["code","token","token id_token"],
"subject_types_supported":["public"],
"id_token_signing_alg_values_supported":["RS256"],
"display_values_supported":["page","popup","touch"],
"token_endpoint_auth_methods_supported":["client_secret_post","private_key_jwt"] }
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Improved Internet Explorer Browser Compatibility for Login
Features

Login hints and Log in to a custom domain are now available for older Internet Explorer browser versions.

Two features introduced in Spring ’14, multiple username login hints and the link to “Log in to a custom domain” were not
available in Internet Explorer versions older then version 10.

The multiple username login hints feature lets the Salesforce.com login page remember usernames from past logins, across
multiple organizations or custom domains. This feature is now supported in Internet Explorer 8 and later, as well as other
browsers.

The Log in to a custom domain link appears on the Salesforce.com login page to help users of organizations using the My
Domain feature. This feature is available in Internet Explorer 6 and later, as well as other browsers.

Note:  These changes will not be available until August 2014.

Log in to a Custom Domain Field Suggestions for Communities
After users click on Log in to a custom domain on the Salesforce.com login page, and start typing, the page displays suggestions
for completing a Communities URL.

The Salesforce login page includes a link, Log in to a custom domain, so users of organizations that implemented My Domain
or Communities can easily get to their organization. As users type the subdomain name, the page provides a full URL suggestion
below the field. For example, as the user types UniversalTelco, the page displays
https://UniversalTelco.my.salesforce.com.

Now the suggestion can include URLs for Communities, such as https://UniversalTelco.force.com (no “my”) and
supports appending names to the URL, such as https://UniversalTelco.force.com/customers.

Note:  This change will not be available until August 2014.

Microsoft Authentication Provider Support
You can use Microsoft Access Control Service as an authentication provider using OAuth. Authorization is typically done by
a Microsoft Office 365 service like Sharepoint® Online.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:
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Salesforce supports authentication from a Microsoft Access Control Service using only OAuth. Single sign-on authentication
from a Microsoft authentication provider is not supported.

1. Define a Microsoft Access Control Service authentication provider in your Salesforce organization.
2. Register your application with Microsoft, making Salesforce the application domain.
3. Edit your Microsoft Access Control Service authentication provider details in Salesforce to use the Consumer Key and

Consumer Secret generated when you registered your application with Microsoft.
4. Test the connection using the Test-Only Initialization URL on the Auth. Provider detail page.

Defining a Microsoft Access Control Service Authentication Provider in Your Salesforce
Organization
Before you can register an application in SharePoint Online or the Microsoft Seller Dashboard, you need the callback URL
that will be used to redirect the authorized user to Salesforce.

1. From Setup, click Security Controls > Auth. Providers.
2. Click New.
3. Select Microsoft Access Control Service for the Provider Type.
4. Enter a Name for the provider.
5. Enter the URL Suffix. This is used in the client configuration URLs. For example, if the URL suffix of your provider

is “MyMicrosoftACSProvider,” your callback URL is similar to:

https://login.salesforce.com/services/authcallback/00Dx00000000001/MyMicrosoftACSProvider

6. Enter a placeholder value for the Consumer Key field (you’ll edit this value after your application is registered with
Microsoft).

7. Enter a placeholder value for the Consumer Secret field (you’ll edit this value after your application is registered with
Microsoft).

8. Enter the base URL from your provider for the Authorize Endpoint URL. For example, SharePoint Online uses the
following form:

https://<sharepoint online host name>/_layouts/15/OAuthAuthorize.aspx

9. Enter the Token Endpoint URL in the following form.

https://accounts.accesscontrol.windows.net/<tenant>/tokens/OAuth/2?resource=<senderID>/<sharepoint online host name>@<tenant>

• <tenant> is the Office 365 tenant name ending with .onmicrosoft.com or the corresponding tenant globally
unique identifier (GUID).

• <sender ID> is the identifier for the sender of the token. For example, SharePoint uses
00000003-0000-0ff1-ce00-000000000000

10. Optionally, set the following fields.

• Default Scopes to send along with the request to the authorization endpoint. See
http://msdn.microsoft.com/en-us/library/jj687470.aspx#Scope for more information about scopes for SharePoint
Online. Or Using the Scope Parameter for more information about using scopes with Salesforce.

• Custom Error URL for the provider to use to report any errors.
• To use a portal with your provider, select the portal from the Portal drop-down list. If you have a portal set up for

your organization, this option can redirect the login request to the portal login page. Otherwise, leave as None.

11. Click Save.

Be sure to note the generated Auth. Provider Id value. You can use it with the Auth.AuthToken Apex class.

Several client configuration URLs are generated after defining the authentication provider:
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• Test-Only Initialization URL: Administrators use this URL to ensure the third-party provider is set up correctly.
The administrator opens this URL in a browser, signs in to the third party, and is redirected back to Salesforce with a map
of attributes.

• Oauth-Only Initialization URL: Use this URL to obtain OAuth access tokens for a third party. Users must
authenticate with Salesforce for the third-party service to get a token; this flow does not provide for future single sign-on
functionality.

• Callback URL: Use the callback URL for the endpoint that the authentication provider calls back to for configuration.
The authentication provider has to redirect to the Callback URL with information for each of the above client configuration
URLs.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites,
obtain customized permissions from the third party, or go to a specific location after authenticating.

Sharing
Sharing improves your control over who sees what.

User Sharing Auto-Enabled for All Organizations

User Sharing controls who sees whom in the organization.

Control Manual Sharing for User Records

Enable or prevent users from sharing their own user records with other users across the organization.

External Organization-Wide Defaults Auto-Enabled for All Organizations

External Organization-Wide Defaults enable you to set a different default access level for external users.

Asynchronous Parallel Recalculation of Sharing Rules (Generally Available)

Speed up sharing recalculation when you’re working with sharing rules.

User Sharing Auto-Enabled for All Organizations
User Sharing controls who sees whom in the organization.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Sharing controls the visibility of internal users and external users within your organization, communities, and portals.
Previously, User Sharing was automatically enabled only for new organizations that were provisioned after Winter ’14. With
Summer ’14, User Sharing is automatically enabled for all organizations.

Watch a demo: Who Sees Whom: User Sharing

With User Sharing, you can:

• Set the organization-wide defaults for user records to Private or Public Read Only. The default is Public Read Only for
internal users and Private for external users.

• Create user sharing rules that are based on group membership or other criteria.
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• Create manual shares for user records to open access to individual users or groups.

For example, you’re a manufacturer who needs to include all dealers in your organization while preventing them from seeing
or interacting with each other. You can set the organization-wide defaults for the user object to Private. Then, open access
among groups of dealers who need to see and interact with each other in the organization with sharing rules or manual
sharing. Additionally, you can assign the “View All Users” permission to users who need to see everyone in the organization.
Users with the “Manage Users” permission are automatically granted the “View All Users” permission.

For more information, see “User Sharing Overview” in the Salesforce Help.

Control Manual Sharing for User Records
Enable or prevent users from sharing their own user records with other users across the organization.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Sharing”To enable or disable manual user record sharing:

Previously, the Sharing button was available on all user detail pages for organizations with User Sharing. This button enables
a user to grant others access to the user’s own user record, a method that is known as manual sharing. Now you can enable or
disable the Sharing button for all users via the Sharing Settings page by following these steps.

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. Select the Manual User Record Sharing checkbox to display the Sharing button on user detail pages, which enables users

to share their records with others. Or deselect the checkbox to hide the button, which prevents users from sharing their
user records with others.

4. Click Save.

With Summer ’14, organizations that are enabling User Sharing get the Sharing button hidden on all user detail pages by
default.

When the organization-wide default for users is set to Public Read Only, users get read access to all other user records, can
see those users in search and list views, and can interact with those users on Chatter and Communities.

For example, a partner user wants to collaborate with the sales representative in Communities. If you have disabled the
Community User Visibility checkbox in the Sharing Settings page, community users can only be seen by themselves
and their superiors in the role hierarchy. You can use manual sharing to grant the partner user read access to the sales
representative by using the Sharing button on the sales representative’s user detail page. This access enables both parties
to interact and collaborate in Communities.

External Organization-Wide Defaults Auto-Enabled for All
Organizations

External Organization-Wide Defaults enable you to set a different default access level for external users.
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Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Previously, if your organization wanted Public Read Only or Public Read/Write access for internal users but Private for external
users, you would have to set the default access to Private and create a sharing rule to share records with all internal users.

With separate organization-wide defaults, you can achieve similar behavior by setting the default internal access to Public
Read Only or Public Read/Write and the default external access to Private. These settings also speed up performance for
reports, list views, searches, and API queries.

External organization-wide defaults simplify your sharing rules configuration and improve recalculation performance.
Furthermore, they reduce overhead of sharing checks for search and reports, and improves sharing maintenance around
realignments.

The following objects support external organization-wide defaults.

• Accounts and their associated contracts and assets

• Cases

• Contacts

• Opportunities

• Custom Objects

• Users

External users include:

• Authenticated website users

• Chatter external users

• Community users

• Customer Portal users

• Guest users

• High-volume portal users

• Partner Portal users

• Service Cloud Portal users

To start using the external organization-wide defaults, from Setup, click Security Controls > Sharing Settings. Click the
Enable External Sharing Model button to enable the feature. Then, click Edit in the Organization-Wide Defaults area to
edit the defaults.

For example, you want employees to have read and write access to accounts, but keep them private for external users in
portals and communities.
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1. Set the default internal access to Public Read Only or Public Read/Write.
2. Set the default external access to Private to prevent external users from accessing those records.

The default external access level must be more restrictive or equal to the default internal access level.

Asynchronous Parallel Recalculation of Sharing Rules (Generally
Available)

Speed up sharing recalculation when you’re working with sharing rules.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

When you create, update, or delete sharing rules, the resulting recalculation is now processed asynchronously and in parallel.
The recalculation is run in parallel and asynchronously in the background, which speeds up the process and provides better
resilience to site operations such as patches and server restarts. You’ll receive an email notification upon completion. Before
the recalculation is completed, you can’t run other sharing operations such as creating a sharing rule or updating the
organization-wide defaults.

Parallel sharing rule recalculation is also run in these cases.

• Click the Recalculate button for the sharing rules on the Sharing Settings page

• Recalculate your sharing rules on the Defer sharing page

To view your recent sharing operations, from Setup, click Security Controls > View Setup Audit Trail. The View Setup
Audit Trail page displays entries for when the recalculation is started and whether it’s successful.

To monitor the progress of your parallel recalculations, from Setup, click Monitoring > Background Jobs or Jobs > Background
Jobs. The Background Jobs page displays granular information on each sharing operation.

For example, when parallel recalculation is run when an account criteria-based sharing rule is updated, the Job Type column
displays Parallel Sharing Rule Recalculation and the Job Sub Type column displays Account —
Criteria-based Sharing Rule.
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Globalization
Globalization tools help administrators manage resources that vary from country to country, such as multilanguage, multicurrency,
and translated content.

Language Additions and Changes

Spanish (Mexico) is a fully supported language, and four platform-only languages have been added. Some language details
have changed. You and your customers can access Salesforce and your custom applications in more languages than before.

Additional Globalization Changes

Updates were made to the default names of several countries in state and country picklists.

Language Additions and Changes
Spanish (Mexico) is a fully supported language, and four platform-only languages have been added. Some language details
have changed. You and your customers can access Salesforce and your custom applications in more languages than before.

Spanish (Mexico) has been “promoted” from an End User language to a Fully Supported language. More user interface labels,
text, and Help are translated, and Spanish (Mexico) is available as a choice during service sign-up.

Four new languages are available as Platform-Only languages.

• Bengali

• German (Austria)

• German (Switzerland)

• Tamil

Platform-Only languages don’t provide translations for Salesforce labels or Help but allow you to provide translations for
standard objects and fields, and for your customizations to Salesforce.

To reflect a European constitutional court decision, the Platform-Only language Moldovan has been renamed Romanian
(Moldova). This change is label-only, and behavior is otherwise unaffected.

Additional Globalization Changes
Updates were made to the default names of several countries in state and country picklists.

Critical Updates
This release includes updates that improve the performance, logic, and usability of Salesforce but may affect your existing
customizations.
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User Permissions Needed

“View Setup and Configuration”To view critical updates:

“Modify All Data”

AND

“Customize Application”

To activate critical updates:

To ensure a smooth transition, each critical update has an opt-in period, which ends on the auto-activation date displayed on
the Critical Updates page in Setup. During this period, you can manually activate and deactivate the update as much as you
need to evaluate the impact on your organization and modify any affected customizations. Once the opt-in period has passed,
the update is automatically activated. For more details, see “Critical Updates Overview” in the Salesforce Help.

Governor Limits Enforced on All Flows

Previously, flows could potentially consume more resources than are allowed by our governor limits, such as the number
of DML statements or SOQL queries issued in a single transaction. Create, update, and delete elements issue DML
statements, and lookup elements issue SOQL queries. This critical update more strictly enforces governor limits on
flows.

Enhanced Session ID Management for Visualforce

Visualforce session management has been improved to more correctly handle transitions between different salesforce.com
servers. The critical update is transparent in normal use but fixes problems with certain edge cases.

Other Changes in Force.com Customization
Even small customization enhancements can make Salesforce easier to use.

Link to Success Community Site in Force.com App Menu

The Force.com App Menu (the drop-down list that displays at the top of every Salesforce page) now includes a Success
Community link. From the Salesforce Success Community site, you can engage with and get answers from a community
of customers, partners, and Salesforce experts.

Twitter Component Added by Default onto Page Layouts

In organizations that are created after Spring ’14, the Twitter component is added by default to the Mobile Cards section
of page layouts for objects that support it.

Permission Sets and Enhanced Profile User Interface: Users Section Added to System Permissions

In permission sets and the enhanced profile user interface, the System Permissions page now includes a Users section.
All user-related system permissions are listed in this section.

Increased Maximum Length for Long Text and Rich Text Fields

The maximum length for Long Text and Rich Text custom fields has been increased, from 32,768 characters (32 KB)
to 131,072 characters (128 KB). The default length remains 32,768 characters, and existing fields are unchanged. To
increase the length of an existing field, edit the field in Setup.

Increased Maximum Number of Relationship Fields

The maximum number of Relationship Fields per object has been increased, from 25 fields to 40 fields.

Increased Validation for Custom Web Tabs

Salesforce now validates custom Web tab URLs upon saving. If the URL is invalid or contains JavaScript, the save fails.
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Support for Compound Address Fields in the DISTANCE() Formula Function

The DISTANCE() formula function now supports compound address fields, introduced in Spring ’14. Previously, only
geolocation fields were supported in formula field DISTANCE() calculations.

Support for Compound Address Fields in Custom Geolocation Indexes

Compound address fields can now use custom indexing on the geolocation element of the field. In organizations with
hundreds of thousands of records, this change should in most cases significantly improve the performance of SOQL
queries that include WHERE DISTANCE() and ORDER BY DISTANCE() clauses. To enable a custom index on a
compound address field, contact salesforce.com.

220

Other Changes in Force.com CustomizationForce.com Customization



Force.com Development
Force.com helps you develop new applications and integrations to help your organization or for resale to other organizations.

Sandboxes

Use sandboxes to develop, test, and simulate deployment of your customization.

Change Sets and Deployment Tools

Administrators and developers now have new ways to use change sets and external tools for deployments.

Force.com Canvas

Force.com Canvas enables you to easily integrate a third-party application in Salesforce. Force.com Canvas is a set of tools
and JavaScript APIs that you can use to expose an application as a canvas app. This means you can take your new or existing
applications and make them available to your users as part of their Salesforce experience.

Developer Console

Use new features of Developer Console to more easily manage code in your organization.

Visualforce

Develop apps that combine Visualforce and JavaScript, including Salesforce1 and other mobile apps.

Apex Code

Using syntax that looks like Java and acts like database stored procedures, Apex enables developers to add business logic to
most system events, including button clicks, related record updates, and Visualforce pages. Apex code execution can be
initiated by Web service requests and from triggers on objects.

API

Use the API to create applications that integrate with Salesforce. We've made improvements in API version 31.0.

ISVforce

Improvements include a new Partner Community for ISVs, a simplified package installer, packaging of mobile apps, usage
metrics tracking and visualization, as well as enhancements to package licensing and the Environment Hub.

Sandboxes
Use sandboxes to develop, test, and simulate deployment of your customization.

Packaged Connected Apps Copied to Sandboxes

Sandbox copy and refresh now support connected apps installed using a package installation, such as connected apps installed
from the AppExchange.

Match Production Licenses to Sandbox without a Refresh

You can match provisioned licenses in production to your sandbox organization without having to refresh your sandbox.
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Packaged Connected Apps Copied to Sandboxes
Sandbox copy and refresh now support connected apps installed using a package installation, such as connected apps installed
from the AppExchange.

Available in: Enterprise, Performance, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

Packaged connected apps can be copied to a sandbox, automatically during the creation or refresh of a sandbox. However,
Sandbox copy and refresh do not copy connected apps created within the production organization. For connected apps created
within the production organization, delete any connected apps in the sandbox after the copy or refresh finishes. Then, re-create
them in the sandbox to match the configuration in the production organization. The new connected app in the sandbox cannot
use the same Connected App API Name value (this is the same value as the fullName field in the metadata API).

Match Production Licenses to Sandbox without a Refresh
You can match provisioned licenses in production to your sandbox organization without having to refresh your sandbox.

Available in: Enterprise, Performance, Unlimited, and Database.com Editions

User Permissions Needed

“Modify All Data”To match licenses to sandbox:

The matching process updates your sandbox organization with licenses from production and deletes any licenses in sandbox
that aren’t in production. To match licenses to a sandbox organization, log in to your sandbox organization, and then from
Setup, click Company Profile > Company Information > Match Production Licenses. You’ll get an alert informing you
that the matching process has started. After all licenses have been matched in sandbox, a confirmation email is sent to you.
The confirmation email is always sent to the user who initiates the license copy.

Change Sets and Deployment Tools
Administrators and developers now have new ways to use change sets and external tools for deployments.

Available in Enterprise, Performance, Unlimited, and Database.com Editions

If you’re using the Force.com Migration Tool or Force.com IDE, also see the changes in the Metadata Types and Fields.

The components available for a change set vary by edition. The following components are now available for change sets.

Entitlement Types

The following entitlement type sets are now included in change sets.

222

Packaged Connected Apps Copied to SandboxesForce.com Development



• Entitlement Process

• Entitlement Template

• Milestone

Account Access on Territory

Account access permissions are now included in territories and deployed as part of territories in change sets. Previously,
account access permissions weren’t deployed as part of territories in change sets. As part of this change, a new field has
been added to the Territory metadata type. See Territory in the “Metadata Types and Fields” release note.

Change Sets Included in the Deployment Status Page

You can monitor the status of all deployments in one place.

Force.com Migration Tool Support for rollbackOnError

The Force.com Migration Tool now accepts the rollbackOnError parameter in build.xml for deployment targets and
no longer ignores this value.

Change Sets Included in the Deployment Status Page
You can monitor the status of all deployments in one place.

In Spring ’14, the user interface to monitor deployments (the Deployment Status page) was improved to include more
information about deployments, including errors and test failures. The Deployment Status page included only deployments
that are started from the Metadata API or tools such as the Force.com IDE or the Force.com Migration Tool. In this release,
the Deployment Status page shows all deployments—change sets, Metadata API, and tools-based deployments.

The deployment type is added to the in-progress deployment section and the details page to differentiate between change sets
and API-based deployments. For example, this image shows an in-progress change set deployment.

To access the Deployment Status page from Setup, click Deployment Status or Deploy > Deployment Status.

The deployment history of change sets is retained on the Deployment Status page for 30 days. After a deployment finishes,
it is moved to the Failed or Succeeded section depending on whether the deployment failed or succeeded. You can check the
deployment results, including errors and test failures, on the Deployment Detail page by clicking View Details next to a
deployment.

Alternatively, deployment history is available on the Change Set Detail page. In the Deployment History section, click View
Details next to a deployment to get more information.
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Force.com Migration Tool Support for rollbackOnError
The Force.com Migration Tool now accepts the rollbackOnError parameter in build.xml for deployment targets and
no longer ignores this value.

Previously, the rollbackOnError parameter in build.xml always defaulted to true for deployment targets. With the
new version of the Force.com Migration Tool, you can specify whether a complete rollback of a deployment is performed if
a failure occurs by setting this parameter to true or false. This parameter must be set to true if you’re deploying to a
production organization. If the rollbackOnError parameter is not specified, the default is true.

Force.com Canvas
Force.com Canvas enables you to easily integrate a third-party application in Salesforce. Force.com Canvas is a set of tools
and JavaScript APIs that you can use to expose an application as a canvas app. This means you can take your new or existing
applications and make them available to your users as part of their Salesforce experience.

Available in: Performance, Unlimited, Enterprise, Professional, Group, and Developer Editions

The version of the Force.com Canvas SDK is 31.0.

For more information, see the Force.com Canvas Developer’s Guide.

entityFields Attribute Added to <apex:canvasApp>

The <apex:canvasApp> component has a new attribute called entityFields. This attribute lets you specify object
fields to be returned in the signed request Record object.

SDK Object and Field Changes

This release includes a number of changes to the context objects and fields in the Force.com Canvas SDK.

Orientation Event for Handling Mobile Device Orientation

The new orientation event enables you to handle changes in orientation when your canvas app appears on a mobile
device.

Canvas Apps in a Page Layout or a Mobile Card

You can add a canvas app to a page layout for any standard or custom object. For the Canvas Apps category to appear in the
palette when you edit a page layout, you must set the canvas app location to Layouts and Mobile Cards when you create the
canvas app in the Salesforce application.

Custom Icon Support in the Salesforce1 Navigation Menu

You can now customize the navigation menu icon for your canvas app. To customize the icon, set the Icon URL entry in
the Basic Information section of the connected app settings for your canvas app.

Request a Signed Request On Demand

You can now request signed request information in your canvas app on demand.

Signed Request Canvas Apps Can Be User-Approved

Canvas apps that use signed request as their access method can now be user-approved. Previously, a canvas app could only
be user-approved if you used OAuth authentication.
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SAML Single Sign-On for Canvas Apps

Whether you use signed request or OAuth authorization, you can use SAML-based single sign-on (SSO) to provide your
users with a seamless authentication flow. You can leverage Salesforce as an identity provider or as a service provider. SAML
SSO enables you to give your users automatic authentication into your canvas app via SAML and authentication into
Salesforce via the signed request.

Custom App Lifecycle

By providing a custom Apex class, you can control the context information that’s sent to your canvas app and add custom
behavior when your app is rendered.

entityFields Attribute Added to <apex:canvasApp>
The <apex:canvasApp> component has a new attribute called entityFields. This attribute lets you specify object fields
to be returned in the signed request Record object.

The entityFields attribute lets you specify fields returned in the signed request Record object when the component appears
on a Visualforce page placed on an object. If this attribute isn’t specified or is blank, then only the Id field is returned. Valid
attribute values include:

• Comma-separated list of field names. For example, to return the Account Phone and Fax fields, the attribute would look
like: entityFields="Phone,Fax".

• Asterisk “*” to return all fields from the associated object.

Default ValueRequired?DescriptionAttribute TypeAttribute Name

NoThe object fields to
return.

StringentityFields

Returning Fields in the Record Object
When you use the <apex:canvasApp> component to display a canvas app on a Visualforce page, and that page is associated
with an object (placed on the page layout, for example), you can specify fields to be returned from the related object. To do
this, use the entityFields attribute. You can use this attribute in one of the following ways.

Return Specific Object Fields

You can return specific object fields in the Record object by setting the entityFields attribute to a comma-separated list
of field names. If there’s an invalid field name in the list, then that field name is ignored and the valid fields are returned in
the Record object.

<apex:canvasApp applicationName="MyApp" entityFields="Phone,Fax,BillingCity"
containerId="canvasAppDiv"/>

returns a Record object that looks like this:

"record":{
"attributes":{

"type":"Account",
"url":"/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"
},

"Id":"001xx000003DGWiAAO",
"Phone":"(555) 555-5555",
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"Fax":"(555) 555-5555",
"BillingCity":"Seattle"
}

Return All Object Fields

You can return all object fields in the Record object by setting the entityFields attribute to the wildcard "*".

<apex:canvasApp applicationName="MyApp" entityFields="*" containerId="canvasAppDiv"/>

returns a Record object that looks like this:

"record":{
"attributes":{

"type":"Account",
"url":"/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"
},

"Id":"001xx000003DGWiAAO",
"IsDeleted":false,
"MasterRecordId":null,
"Name":"Edge Communications",
"Type":"Customer - Channel",
"ParentId":null,
"BillingStreet":"123 Main Street",
"BillingCity":"Seattle",
"BillingState":"WA",
"BillingPostalCode":"98121",
"BillingCountry":"USA",

...
}

Return the Id Field

If the <apex:canvasApp> component doesn’t have the entityFields attribute or if the attribute is blank, then only the
Id field is returned in the Record object.

<apex:canvasApp applicationName="MyApp" containerId="canvasAppDiv"/>

returns a Record object that looks like this:

"record":{
"attributes":{

"type":"Account",
"url":"/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"
},

"Id":"001xx000003DGWiAAO"
}

SDK Object and Field Changes
This release includes a number of changes to the context objects and fields in the Force.com Canvas SDK.
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• The Client object contains a new field that’s called refreshToken. The client uses this token to authenticate a session. This
value is returned only if the canvas app has “Perform requests on your behalf at any time (refresh_token, offline_access)”
as one of the selected OAuth scopes; otherwise null is returned.

"client":
{

"instanceId":"06Px000000002JZ",
"instanceUrl":"http://instance.salesforce.com:8080",
"oauthToken":"00Dx0000X00Or4J!ARQAQJ34YLUq54RMTrQbxVoWUgorjFi3...",
"refreshToken":"00DD0000000K1NM!ARAAQGJVGOyMjh1jjqvShRpLuAq0ke...",
"targetOrigin":"http://instance.salesforce.com:8080"

}

• The Environment object contains a new Record object. The Record object is a JSON-formatted object that contains
information about the object on which the canvas app appears. This could be a standard object like Account or a custom
object like Warehouse__c. If the canvas app doesn’t appear on an object page or in the publisher or feed associated with
an object, then the Record object is empty.

DescriptionField

The ID of the related object. For example, if the canvas app appears
on an Account page, this field contains the AccountId.

Id

"record":{
"attributes":{

"type":"Account",
"url":"/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"

},
"Id":"001xx000003DGWiAAO",
"Phone":"(555) 555-5555",
"Fax":"(555) 555-5555",
"BillingCity":"Seattle"

}

• The Environment object contains two new values for displayLocation.

◊ MobileNav—The canvas app was called from the navigation menu in Salesforce1.
◊ PageLayout—The canvas app was called from an element within a page layout. If the displayLocation is PageLayout,

one of the subLocation values might be returned.

• The Environment object contains a new field that’s called subLocation. This is the sublocation in the application where
the canvas app was called from when the canvas app is loaded in a mobile device. The subLocation is related to the
displayLocation. Valid values for this field when the displayLocation is PageLayout are:

◊ S1MobileCardFullview—The canvas app was called from a mobile card.
◊ S1MobileCardPreview—The canvas app was called from a mobile card preview. The user must click the preview to

open the app.
◊ S1RecordHomePreview—The canvas app was called from a record detail page preview.  The user must click the preview

to open the app.
◊ S1RecordHomeFullview—The canvas app was called from a page layout.

"environment":
{

"parameters":{},
"dimensions":
{

"clientHeight": "50px",
"clientWidth": "70px",
"height":"900px",
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"width":"800px",
"maxHeight":"2000px",
"maxWidth":"1000px"

},
"record": {

"attributes": {
"type": "Account",
"url": "/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"

},
"Id": "001xx000003DGWiAAO",
"Phone": "(555) 555-5555",
"Fax": "(555) 555-5555",
"BillingCity": "Seattle"

},
"displayLocation":"PageLayout",
"locationUrl":"http://www.salesforce.com/some/path/index.html",
"subLocation":"S1MobileCardFullview",
"uiTheme":"Theme3",
"version":
{

"api":"31.0",
"season":"SUMMER"

}
}

• The Record object contains a new Attributes object. The Attributes object is a JSON-formatted object that contains
information about the object on which the canvas app appears.

DescriptionField

The object that the canvas app is associated with. This value could
be a standard object like Account or a custom object like
Warehouse__c.

If the canvas app appears in the publisher, then the type is the name
of the associated object. For example, CollaborationGroup or

type

Account. If the canvas app appears in a user feed or the feed
associated with an object, then the type is FeedItem.

The URL of the associated object. The format of the URL is the
same as the REST API resource for the given record.

url

"record":{
"attributes":{

"type":"Account",
"url":"/services/data/v31.0/sobjects/Account/001xx000003DGWiAAO"

},
"Id":"001xx000003DGWiAAO"

}

Orientation Event for Handling Mobile Device Orientation
The new orientation event enables you to handle changes in orientation when your canvas app appears on a mobile device.

After your canvas app subscribes to the event, the event fires whenever the parent window fires a window.orientation
event. The event returns a payload that contains these values.
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DescriptionValue

The height of the app in pixels, specific to the device
on which the canvas app renders

clientHeight

The width of the canvas app in pixels, specific to the
device on which the canvas app renders

clientWidth

Contains one of these values.orientation

• 0: landscape to portrait
• 90: portrait to landscape
• -90: portrait to landscape turned counterclockwise

The following code example shows how to subscribe to the orientation event.

// Capture the orientation event of the parent window.
Sfdc.canvas.client.subscribe(sr.client,

{name : 'canvas.orientation',
onData : function (event) {

console.log("Parent's orientation: " + event.orientation +
"Canvas app height: " + event.clientHeight +
"Canvas app width: " + event. clientWidth);

}} );
});

Canvas Apps in a Page Layout or a Mobile Card
You can add a canvas app to a page layout for any standard or custom object. For the Canvas Apps category to appear in the
palette when you edit a page layout, you must set the canvas app location to Layouts and Mobile Cards when you create the
canvas app in the Salesforce application.

Add a Canvas App to a Page Layout

Follow these steps to add a canvas app to the page layout for an Account.

Where Canvas Apps Appear in a Page Layout

Depending on where you place the canvas app on the page layout, the canvas app might appear in the full Salesforce site or
in Salesforce1.

Add a Canvas App to a Page Layout
Follow these steps to add a canvas app to the page layout for an Account.

1. Use the Heroku Quick Start to create a canvas app. To do this, follow the steps in Create the App in the Force.com Canvas
Developer’s Guide.

2. In the Salesforce application, from Setup, click Create > Apps.
3. In the Connected Apps related list, click Edit next to the app that you just created.
4. In the Canvas Apps Settings section, in the Locations field, select Layouts and Mobile Cards.
5. Click Save.
6. From Setup, click Customize > Accounts > Page Layouts.
7. Click Edit next to Account Layout.
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You’ll see the Canvas Apps category in the palette and the canvas app, because you set the location of the canvas app to
Layouts and Mobile Cards.

8. Drag the canvas app element to where you’d like it to appear in the page layout, and then click Save.

• If you add the canvas app to any section other than the Mobile Cards section, the canvas app appears in the page layout
in the full Salesforce site or in the record detail page in Salesforce1.

• If you add the canvas app to the Mobile Cards section, the canvas app appears only in the mobile card in Salesforce1.

9. To see your changes, click the Accounts  tab, and then click an account. You’ll see the canvas app on the page layout where
you added it.

Where Canvas Apps Appear in a Page Layout
Depending on where you place the canvas app on the page layout, the canvas app might appear in the full Salesforce site or
in Salesforce1.

This table describes where the canvas app appears when you add it to the page layout.

Where the canvas app appears in Salesforce1The canvas app
appears in

Salesforce1?

The canvas app
appears in the full

Salesforce site?

If the canvas app is added to
the page layout in ...

Record detail pageYesYesAny section (other than the
Mobile Cards section)

Mobile cardYesNoMobile Cards section

Custom Icon Support in the Salesforce1 Navigation Menu
You can now customize the navigation menu icon for your canvas app. To customize the icon, set the Icon URL entry in the
Basic Information section of the connected app settings for your canvas app.

The icon URL must be a secure HTTPS URL that points to an icon image file. The image file must be in the GIF, JPG, or
PNG file format. For the Salesforce1 navigation menu, the icon can’t be larger than 60 pixels high by 60 pixels wide.

Request a Signed Request On Demand
You can now request signed request information in your canvas app on demand.

If your canvas app is set to use signed request for authentication, you can request a signed request on demand by using the
SDK. Your app can ask Salesforce to resend the signed request that was used when your app was loaded or to send a new
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signed request. Requesting a signed request is useful when you are refreshing an expired session or getting authentication
information after your app has been redirected.

You can request a signed request on demand by using the refreshSignedRequest() or repost() JavaScript methods
in the SDK. refreshSignedRequest() returns a new signed request via a callback, while repost() asks the parent
window to initiate a new POST to your canvas app and reloads the app page with a refreshed signed request.

Signed Request Canvas Apps Can Be User-Approved
Canvas apps that use signed request as their access method can now be user-approved. Previously, a canvas app could only be
user-approved if you used OAuth authentication.

This is the default authorization method for canvas apps. The signed request authorization flow varies depending on whether
the canvas app’s Permitted Users field is set to "Admin approved users are pre-authorized" or "All users may self-authorize."
You’ll need to modify the Web application that’s exposed as a canvas app to handle a GET or POST call as shown in this
table.

POST or GET BehaviorWhen the User Needs
to Approve the Canvas

App

Canvas App
Accessibility

Permitted Users Value

Salesforce performs a POST to the canvas
app with all the authorization information

NeverThe app is accessible
to users as soon as the

Admin approved users are
pre-authorized

contained in the body of the signed request,
including the refresh token.

administrator installs
it in the organization
and configures which
users can see it. Users
don’t need to approve
or deny access.

If the user has previously approved the app
and the access hasn’t been revoked or expired,

The app is accessible
to all users, but the

All users may self-authorize • The first time that
the user opens the
appuser is prompted to

approve or deny access
to the app.

Salesforce performs a POST to the canvas
app with a signed request payload.

If the user hasn’t approved the app, or if the
access has been revoked or expired, Salesforce

• If the access token
is revoked by the
administrator

• If the administrator
sets a time limit on

performs a GET to the canvas app URL. The
canvas app must handle the GET by

the token and that accepting the call and looking for the URL
time limit is
exceeded

parameter _sfdc_canvas_authvalue. If
the canvas app receives this parameter value,
the canvas app should initiate the approve or
deny OAuth flow.

_sfdc_canvas_authvalue =
user_approval_required

After the OAuth flow is initiated and the user
approves the app, the canvas app should call
the repost() method with a parameter of
true to retrieve the signed request.
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SAML Single Sign-On for Canvas Apps
Whether you use signed request or OAuth authorization, you can use SAML-based single sign-on (SSO) to provide your
users with a seamless authentication flow. You can leverage Salesforce as an identity provider or as a service provider. SAML
SSO enables you to give your users automatic authentication into your canvas app via SAML and authentication into Salesforce
via the signed request.

SAML (Security Assertion Markup Language) is an XML-based standard for user authentication on the Web which allows
the exchange of authorization data between two domains. With this feature you can create a canvas app that begins a standard
SAML authentication flow when opened by a user. After this process completes, the user is authenticated into your Web
application.

For canvas apps that use signed request authentication, two methods that are included in the Force.com Canvas SDK enable
your canvas app to call into Salesforce to receive a new signed request directly or enable Salesforce to repost the signed request
to your Web application endpoint. This results in a complete end-to-end authentication flow.

The elements that support this feature include the following features:

SAML Initiation Method Field
This field lets you specify which provider initiates the SSO flow to access your canvas app.
• Identity Provider Initiated—Salesforce makes the initial request to start the SSO flow.
• Service Provider Initiated—The canvas app starts the SSO flow after the app is invoked.

For more information, see the topic “Creating a Connected App” in the Salesforce Help.

refreshSignedRequest Method
Returns a new signed request via a callback. After the SAML SSO process is completed, your app can call this method
and receive a new signed request. This method is intended for developers who need to retrieve the signed request by
using a more client-side JavaScript approach. (The Force.com Canvas SDK sends the signed request to your app.)

repost Method
Requests the parent window to initiate a POST to your canvas app and reloads the app page with a refreshed signed
request. After the SAML SSO process is completed, your app can call this method and a new signed request is sent to
your app via a POST. This method is for developers who need to retrieve the signed request using a more server-side
approach. (Salesforce POSTs the signed request to your server.)

Custom App Lifecycle
By providing a custom Apex class, you can control the context information that’s sent to your canvas app and add custom
behavior when your app is rendered.

Salesforce provides several Apex interfaces and classes in the Canvas namespace that provide additional control over the canvas
app lifecycle. You can use the Canvas namespace and the CanvasLifecycleHandler interface to:

• Control what sections of the CanvasRequest Context data get sent to your app. You can, for example, require that Salesforce
never send the Organization information in the CanvasRequest data. Excluding sections of context data improve performance
by reducing the amount of data that’s sent in the request and remove the need to process the organization data in your
app.

• Retrieve application context data when the app is rendered and alter the behavior of your app accordingly. You can obtain
the application version and, depending on the version, change how the app runs.

• Modify some of the context data, such as the canvas app URL, custom parameters, or the list of object fields that are
returned in the Record data when the app is rendered.

• Present a well-formed error message to the user in the Salesforce UI if something goes wrong.
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Salesforce also provides a Test class in the Canvas namespace that you can use to create test context data and verify the behavior
of your lifecycle handler without having to run your app.

Developer Console
Use new features of Developer Console to more easily manage code in your organization.

Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Search and Edit Files with the Edit Menu

The new Edit menu in the Developer Console allows you to quickly access search and edit functionality.

Find Files By Name

Search for files by name using the new Open Resource dialog in the Developer Console.

Speed Up Queries with the Query Plan Tool

The new Query Plan tool in the Developer Console can help speed up SOQL queries done over large volumes.

View Color-Coded Logging Expiration Data

The Change Log Levels dialog in the Developer Console now includes a color-coded Expiration field that displays the
current logging status.

Search and Edit Files with the Edit Menu
The new Edit menu in the Developer Console allows you to quickly access search and edit functionality.

The following options are now in the Edit menu:

• Find: Searches the current view for the selected text. If no text is selected, opens a search dialog.

• Find Next: Finds the next match for the selected or specified text in the current view.

• Find/Replace: Finds and replaces the selected or specified text in the current view.

• Search in Files: Opens a search dialog to search the contents of all code files.

• Fix Indentation: Corrects the indentation in the current code file.

Find Files By Name
Search for files by name using the new Open Resource dialog in the Developer Console.

In addition to the type-based Open dialog, the new Open Resource dialog allows you to search for a file by name by entering
a simple string, or by using regular expressions (prefix with “re:”). Click File > Open Resource or press SHIFT+CTRL+O.

Speed Up Queries with the Query Plan Tool
The new Query Plan tool in the Developer Console can help speed up SOQL queries done over large volumes.

Use the Query Plan tool to optimize and speed up queries done over large volumes. To enable the tool, click Help > Preferences
and set Enable Query Plan to true. To use the tool, enter your query and click the Query Plan button in the Query
Editor. The Query Plan window displays all query operations and the cost of each.
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View Color-Coded Logging Expiration Data
The Change Log Levels dialog in the Developer Console now includes a color-coded Expiration field that displays the
current logging status.

The Expiration field displays the time that logging will expire. The field remains green as long as there are 10 or more
minutes of logging time remaining, turns yellow when there are less than 10 minutes remaining, and turns red after logging
has expired and is no longer active.

Visualforce
Develop apps that combine Visualforce and JavaScript, including Salesforce1 and other mobile apps.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

For further information on features affected by these enhancements, refer to the Visualforce Developer’s Guide.

Visualforce Development

Visualforce language and feature improvements make app development easier. Enhancements in this release are focused on
improving the experience of developing apps that combine Visualforce and JavaScript. These release notes explain the new
features in detail, and also provide an extended code sample showing how the different features can be used.

Other Changes in Visualforce

We’ve made some additional changes in Visualforce.

Visualforce Development
Visualforce language and feature improvements make app development easier. Enhancements in this release are focused on
improving the experience of developing apps that combine Visualforce and JavaScript. These release notes explain the new
features in detail, and also provide an extended code sample showing how the different features can be used.
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Improvements to Remote Objects (Developer Preview)

Visualforce Remote Objects has been improved with new features, including remote method overrides, an upsert()
operation, the orderby query condition for specifying sort order, and new query operators for where conditions. Also,
Remote Objects now supports geolocation fields, which removes a limitation of the prior release.

Overriding Default Remote Objects Operations

Override the default Remote Objects operations with your own Apex code to extend or customize the behavior of Remote
Objects.

An Example of Using Remote Method Overrides in Remote Objects

This sample code illustrates how to create remote method overrides for Remote Objects operations. The example presents
a sorted list of contacts and a simple form to enter a new contact. The new contact action overrides the built-in Remote
Objects create() operation. The sample also illustrates blending Remote Objects with several Web development libraries
to present a mobile-friendly user interface.

API Versioning for sforce.one Functions

The sforce.one JavaScript utility object is used for managing navigation on Visualforce pages that are used in Salesforce1
apps. This object is now versioned. Changes that alter its behavior won’t break Visualforce pages, and you can write code
that depends on version-specific functionality using the new sforce.one.getVersion() function.

Deferred Creation of Dynamic Components

A dynamic component can now wait for page actions to be completed before the method that creates the dynamic component
runs. You can now design dynamic components that change depending on the result of, for example, a page initialization
action or a callout. This enhancement gives you additional options for creating dynamic, adaptable user interfaces in Visualforce.

Improvements to Remote Objects (Developer Preview)
Visualforce Remote Objects has been improved with new features, including remote method overrides, an upsert() operation,
the orderby query condition for specifying sort order, and new query operators for where conditions. Also, Remote Objects
now supports geolocation fields, which removes a limitation of the prior release.

Remote Objects remains a Developer Preview in this release. See “Limitations of Remote Objects” in the Visualforce Developer’s
Guide for additional details about the Developer Preview.

Remote Method Overrides

Remote method overrides enable you to extend or replace the built-in behavior of the basic create, retrieve, update, and delete
(CRUD) operations. Overrides give you new flexibility in what you can build with Remote Objects by enabling you to add
your own custom logic to the basic operations. See Overriding Default Remote Objects Operations on page 236 for complete
details.

upsert() Operation

The upsert() operation is a convenience method that gives you a shortcut for saving new data by updating an object or
creating an object if it doesn’t exist.

orderby Conditions

orderby enables you to set a sort order for your results. You can sort on up to three fields.
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Specify your orderby conditions as an array of JavaScript objects that contain name-value pairs. The field to sort on is the
name, and the sort description is the value. The sort description enables you to sort ascending or descending and to sort null
values first or last. For example:

orderby: [ {Phone: "DESC NULLS LAST"} , {FirstName: "ASC"} ]

where Condition Operators

The following new operators are available for where conditions.

• ne: not equals
• lte: less than or equals
• gte: greater than or equals

Geolocation Support

Remote Objects now supports retrieving and accessing geolocation custom fields. You can use either the compound or individual
components form of a geolocation field, by using slightly different code.

Compound Geolocation Fields

The compound form of a geolocation field groups latitude and longitude values in a single field. Declare the field as usual for
Remote Objects:

<apex:remoteObjectModel name="Warehouse__c" jsShorthand="Warehouse" fields="Id,Name">
<apex:remoteObjectField name="Location__c" jsShorthand="Location"/>

</apex:remoteObjectModel>

The returned field is a JavaScript object with two attributes, longitude and latitude. With a Warehouse record as
declared in the previous paragraph, access the individual longitude and latitude values by using dot notation:

var long = record.get("Location").longitude;
var lat = record.get("Location").latitude;

Geolocation Field Components

You can also treat the two values of a geolocation field as individual component fields. Declare each field separately, using the
special individual component field naming convention of adding “__Longitude__s” and “__Latitude__s” to the geolocation
field name:

<apex:remoteObjectModel name="Warehouse__c" jsShorthand="Warehouse" fields="Id,Name">
<apex:remoteObjectField name="Location__Longitude__s" jsShorthand="longitude"/>
<apex:remoteObjectField name="Location__Latitude__s" jsShorthand="latitude"/>

</apex:remoteObjectModel>

The returned fields are strings. With a Warehouse record as declared in the previous paragraph, access the individual
longitude and latitude values directly:

var long = record.get("longitude");
var lat = record.get("latitude");

Overriding Default Remote Objects Operations
Override the default Remote Objects operations with your own Apex code to extend or customize the behavior of Remote
Objects.
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Behind the scenes of Remote Objects, the basic operations—create(), retrieve(), update(), and del()—use a Remote
Objects controller that’s the equivalent of the standard controller for normal Visualforce pages. You can override Remote
Objects operations to extend or replace the built-in behavior of this controller. Overrides of Remote Objects operations are
written in Apex and take effect by adding them to your page’s Remote Objects definitions.

Note:  You can’t override the upsert() operation. It’s just a convenience function, and behind the scenes it delegates
to either create() or update(). When you override either of those methods, the overridden method is automatically
used by upsert() as appropriate.

Remote Objects Access Definitions for Method Overrides

To override a Remote Objects operation with a remote method, set the attribute for the operation to the method that replaces
the default method. For example, here’s how to override the create() operation for contacts with a remote method.

<apex:remoteObjectModel name="Contact" fields="FirstName,LastName,Phone"
create="{!$RemoteAction.RemoteObjectContactOverride.create}"/>

The attribute takes a Visualforce expression that references the @RemoteAction method to use as the override for the built-in
create() operation. The expression takes the form of $RemoteAction.OverrideClassName.overrideMethodName,
where the $RemoteAction global handles your organization namespace, as it does for JavaScript remoting. Note that the
class that contains the @RemoteAction method needs to be set as the page’s controller or as a controller extension for the
page.

With this declaration, whenever your page’s JavaScript code calls the create() function for a contact Remote Object, instead
of using the Remote Objects controller, your remote method will be called.

Remote Objects Override Methods

Remote Objects override methods are written as @RemoteAction methods in an Apex class, which you add to your page as
a controller or controller extension.

The method signature for an override method is:

@RemoteAction
public static Map<String,Object> methodName(String type, Map<String,Object> fields)

The type parameter is the sObject type that’s being acted upon, and the fields map is a collection that contains the values
that were set on the Remote Object before the overridden method was called.

The return value is a map that represents the result of a Remote Objects operation. This map typically include the results of
the call, the status, and any custom data that you want to provide as part of your custom method.

The simplest way to construct a valid return map is to use the RemoteObjectController. This is the standard controller
that provides the built-in functionality for Remote Objects, and you can delegate data manipulation language (DML) operations
to it by passing along your method’s parameters. For example, here’s a create() method that does nothing more than the
built-in version of create() does:

@RemoteAction
public static Map<String, Object> create(String type, Map<String, Object> fields) {

Map<String, Object> result = RemoteObjectController.create(type, fields);
return result;

}

This method is effectively a no-op; that is, this method does exactly the same thing the built-in version would have done,
nothing more and nothing less. Your override methods can execute whatever additional Apex you need to, including logging,
additional DML, other method calls, and so on. For a more complete example of a Remote Objects override method, and the
page that uses it, see An Example of Using Remote Method Overrides in Remote Objects on page 238.
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Important:  The RemoteObjectController standard controller automatically handles sharing rules, ownership,
and other security concerns for Remote Objects. In contrast, methods in a custom controller or controller extension
operate in system mode by default, which allows full access to all data in the organization. This behavior is the same
as for standard Visualforce pages that use custom controllers or controller extensions. When you write the controller
code, you need to handle access rights and other concerns yourself.

As a best practice, use the with sharing keyword for your controller or controller extension class, and delegate as
much as you can to the RemoteObjectController.

An Example of Using Remote Method Overrides in Remote Objects
This sample code illustrates how to create remote method overrides for Remote Objects operations. The example presents a
sorted list of contacts and a simple form to enter a new contact. The new contact action overrides the built-in Remote Objects
create() operation. The sample also illustrates blending Remote Objects with several Web development libraries to present
a mobile-friendly user interface.

This example uses the jQuery, Bootstrap, and Mustache tool kits, loading them from an external content distribution network
(CDN).

Here’s the Visualforce page, with the remote override declaration in bold.

<apex:page showHeader="false" standardStylesheets="false" docType="html-5.0"
title="Contacts—RemoteObjects Style" controller="RemoteObjectContactOverride">

<!-- Include in some mobile web libraries -->
<apex:stylesheet

value="//netdna.bootstrapcdn.com/bootswatch/3.1.1/superhero/bootstrap.min.css"/>
<apex:includeScript value="//ajax.googleapis.com/ajax/libs/jquery/1.11.0/jquery.min.js"/>

<apex:includeScript
value="//cdnjs.cloudflare.com/ajax/libs/mustache.js/0.7.2/mustache.min.js"/>

<!-- Set up Remote Objects, with an override for create() method -->
<apex:remoteObjects jsNamespace="$M">
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<apex:remoteObjectModel name="Contact" fields="FirstName,LastName,Phone"
create="{!$RemoteAction.RemoteObjectContactOverride.create}"/>

</apex:remoteObjects>

<!-- Page markup -->
<div class="container">

<div class="row">
<div class="col-md-2"></div>
<div class="col-md-8">

<table id="myTable"
class="table table-bordered table-striped table-condensed">
<colgroup>

<col class="col-md-3" />
<col class="col-md-3" />
<col class="col-md-3" />

</colgroup>
<caption>

Contact Data Order ([ {LastName: 'ASC'}, {FirstName: 'DESC'} ])
<button id="bRefresh" class="btn btn-success btn-sm"

type="button">Refresh</button>
</caption>
<caption id="msgBox" class="alert alert-danger hidden"></caption>
<thead>

<tr><td>FirstName</td><td>LastName</td><td>Phone</td></tr>
</thead>
<tbody></tbody>
<tfoot>

<tr>
<td><input type="text" name="FirstName" id="iFirstName"

placeholder="John" class="form-control" /></td>
<td><input type="text" name="LastName" id="iLastName"

placeholder="Doe" class="form-control" /></td>
<td>

<div class="input-group">
<input type="text" name="Phone" id="iPhone"
placeholder="(123) 456-7890" class="form-control" />

<span class="input-group-btn">
<button id="bAdd" class="btn btn-primary"

type="button">Save</button>
</span>

</div>
</td>
</tr>

</tfoot>
</table>
<div class="panel panel-default">
<div class="panel-heading">Log</div>
<div class="panel-body" id="log">
</div>

</div>
</div>
<div class="col-md-2"></div>

</div>
</div>

<!-- Results template (table rows of Contacts) -->
<script id="tmpl" type="x-tmpl-mustache">

<tr><td>{{FirstName}}</td><td>{{LastName}}</td><td>{{Phone}}</td></tr>
</script>

<!-- Page functionality -->
<script>

var table = $('#myTable tbody');
var template = $('#tmpl').html();
Mustache.parse(template);

// Retrieve all contacts and add to results table on page
var fetchContacts = function() {

(new $M.Contact()).retrieve({
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orderby: [ {LastName: 'ASC'}, {FirstName: 'DESC'} ],
}, function(err, records) {

if (!err) {
// Add some status messages to the log panel
$('#log')
.append('<p>Fetched contact records.</p>')
.append('<p>Records Size: '+ records.length + '!</p>');

// Update the table of contacts with fresh results
table.empty();
records.forEach(function(rec) {

table.append(Mustache.render(template, rec._props));

});
} else {

$('#msgBox').text(err.message).removeClass('hidden');
}

});
};

var addContact = function() {
// Create a new Remote Object from form values
(new $M.Contact({

FirstName: $('#iFirstName').val(),
LastName: $('#iLastName').val(),
Phone: $('#iPhone').val()

})).create(function(err, record, event) {
// New record created...
if (!err) {

// Reset the New Record form fields, for the next create
$('input').each(function() {

$(this).val('');
});

// Add some status messages to the log panel
$('#log')
.append('<p>Contact created!</p>')
// Custom data added to event.result by override function
.append('<p>Got custom data: ' + event.result.custom + '</p>');

// Redraw the results list with current contacts
fetchContacts();

} else {
$('#msgBox').text(err.message).removeClass('hidden');

}
});

};

// Bind application functions to UI events
$('#bRefresh').click(fetchContacts);
$('#bAdd').click(addContact);

// Initial load of the contacts list
fetchContacts();

</script>
</apex:page>

The key line of code in the preceding sample is in the Remote Objects access definition. Adding a single attribute to the
contact Remote Object definition sets up the override:

create="{!$RemoteAction.RemoteObjectContactOverride.create}"

The attribute takes a Visualforce expression that references the @RemoteAction method to use as the override for the built-in
create() operation.
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In this case, the referenced method is in an Apex class that’s the page’s controller. The code for the override method is
straightforward.

public class with sharing RemoteObjectContactOverride {

@RemoteAction
public static Map<String, Object> create(String type, Map<String, Object> fields) {

System.debug(LoggingLevel.INFO, 'Before calling create on: ' + type);

// Invoke the standard create action
// For when you want mostly-normal behavior, with a little something different
Map<String, Object> result = RemoteObjectController.create(type, fields);

System.debug(LoggingLevel.INFO, 'After calling create on: ' + type);
System.debug(LoggingLevel.INFO, 'Result: ' + result);

// Here's the little something different, adding extra data to the result
Map<String, Object> customResult =

new Map<String, Object> {'custom' => 'my custom data' };
customResult.putAll(result);

return customResult;
}

}

This method logs the @RemoteAction call and then uses the standard RemoteObjectController.create() call to
perform the create. It’s performing the same data manipulation language (DML) commands to create the record that the
built-in version would, because it’s using the built-in version. After performing the create, the method does a little more
logging. Finally it adds some extra data to the return payload that will be received by the JavaScript callback function on the
Visualforce page.

It’s adding the extra data that’s interesting and makes overriding the built-in method useful. The extra data that’s added by
the preceding controller is trivial, for the purposes of illustration only. A real-world override can include more complex
logic—the result of a calculation, other method calls, and so on. What’s important to understand is that the new custom
override method can do additional things behind the scenes, and can return extra data that the built-in version can’t.

API Versioning for sforce.one Functions
The sforce.one JavaScript utility object is used for managing navigation on Visualforce pages that are used in Salesforce1
apps. This object is now versioned. Changes that alter its behavior won’t break Visualforce pages, and you can write code that
depends on version-specific functionality using the new sforce.one.getVersion() function.

How sforce.one Handles API Versions

The sforce.one object is frequently improved in new releases of the Salesforce1 Platform. To maintain backward compatibility,
sforce.one provides version-specific behavior, and you can use a specific version of sforce.one in your apps.

By default, sforce.one uses the same version as the API version of the requested Visualforce page. For example, if a
Visualforce page has an API version of 30.0, JavaScript on that page that uses sforce.one by default uses the API version
30.0 of sforce.one.

This means that when a Visualforce page is updated to a new API version, the page automatically uses the updated version of
sforce.one. In the preceding example, if that Visualforce page is updated to API version 31.0, app functionality that uses
sforce.one uses the API version 31.0 of sforce.one.

If updated behavior in a new API version of sforce.one causes compatibility problems with the page’s features, you have
three options for correcting the problem.

• Revert the Visualforce page’s API version to the prior version. This action requires no code changes.
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• Update the code for the page’s features to fix the problem. This solution is best, but it might require some debugging, and
it will definitely require code changes.

• Use a specific version of sforce.one. This solution often requires minimal code changes.

Note: sforce.one was added in Winter ’14 (API version 29.0) and wasn’t versioned until Summer ’14 (API version
31.0). All versions of sforce.one earlier than version 31.0 are identical to version 31.0. You can specify a version
of sforce.one for any version that’s valid for Visualforce, that is, from version 15.0 to the current API version.

Using a Specific Version of sforce.one

To use a specific version of sforce.one, use the sforce.one.getVersion() function and provide it with the API version
and a callback function that needs to use a specific version of sforce.one. The appropriate versions of sforce.one are
automatically loaded by this call.

The signature for sforce.one.getVersion() is:

sforce.one.getVersion(versionString, callbackFunction);

versionString is the API version that your application requires. It’s always two digits, a period, and one digit, such as
“30.0”. Calls with invalid version strings fail silently.

callbackFunction is a JavaScript function that uses a specific version of sforce.one. sforce.one.getVersion()
operates asynchronously, and your callback function is called when it finishes loading the requested version of sforce.one.
Your callback function receives a single parameter, an sforce.one object for the specified API version. Use the object passed
in instead of the global sforce.one to make calls to sforce.one that conform to the API version that your app requires.

Examples of Using a Specific Version of sforce.one

The next examples all add a Create Account function to the following input button:

<input type="button" value="Create Account" onclick="btnCreateAccount()" id="btnCreateAcct"/>

Defaulting to the Visualforce Page’s API Version

App code that should use the default version of sforce.one—the version that corresponds to the Visualforce Page’s API
version—doesn’t need to ask for a version. Using that version happens automatically, and the code is straightforward.

<script>
function MyApp() {

this.createAccount = function() {
sforce.one.navigateToURL("/001/e");

};
}

var app = new MyApp();

function btnCreateAccount() {
app.createAccount();

}
</script>

App functionality is created in a MyApp object, and then an event handling function calls the app function when that event,
a button click, occurs. Separating application functionality from application event handling is a best practice, and it sets you
up for using version-specific versions of sforce.one.

Using a Specific sforce.one API Version (Simple)
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To use a specific version of sforce.one, get and save a reference to a versioned instance of the object. Then use this object
to make sforce.one calls. The simplest way is to save it in the MyApp object. In the next sample, references to the versioned
instance of sforce.one are in bold.

<script>
function MyApp(sfone) {

this.createAccount = function() {
sfone.navigateToURL("/001/e");

};
}

var app30 = null;

function btnCreateAccount() {
// Create our app object if not already defined
if(!app30) {

// Create app object with versioned sforce.one
sforce.one.getVersion("30.0", function(sfoneV30) {

app30 = new MyApp(sfoneV30);
app30.createAccount();

});
return;

}
app30.createAccount();

}
</script>

In the preceding example, the event-handling function is expanded from the first example to include the creation of a
version-specific instance of sforce.one. If your app needs to mix multiple versions, you can create multiple MyApp instances
with appropriate versions and names. More than one or two, though, are cumbersome to manage. We recommend the next
approach instead.

Using a Specific sforce.one API Version (Best)

A better way to organize your app code is to create version-specific instances of sforce.one in an app initialization block
of code so you can keep the event handling separate.

<script>
function MyApp(sfone) {

this.createAccount = function() {
sfone.navigateToURL("/001/e");

};
}

var app30 = null;

// Initialize app: get versioned API, wire up clicks
sforce.one.getVersion("30.0", function(sfoneV30) {

// Create app object with versioned sforce.one
app30 = new MyApp(sfoneV30);

// Wire up button event
var btn = document.getElementById("btnCreateAcct");
btn.onclick = btnCreateAccount;

});

// Events handling functions
// Can't be fired until app is defined
function btnCreateAccount() {

app30.createAccount();
}

</script>
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In this sample the app initialization is separated only by white space and comments, but you can separate it into functions for
better encapsulation.

Using a Specific sforce.one API Version (Synchronous)

You can trigger a synchronous mode for sforce.one by manually including the specific version of sforce.one’s JavaScript
on your page. The format for the URL to the library is:/sforce/one/sforceOneVersion/api.js. Here’s an example:

<script src="/sforce/one/30.0/api.js"></script>
<script>

function MyApp(sfone) {
this.createAccount = function() {

sfone.navigateToURL("/001/e");
};

}

var app = null;

sforce.one.getVersion("30.0", function(sfoneV30) {
app = new MyApp(sfoneV30);

});

// Events handling function
// Can't be fired until app is defined
function btnCreateAccount() {

app.createAccount();
}

</script>

Although some situations require synchronous mode, the asynchronous version is preferred. If you forget to manually include
the correct versions of the sforce.one library, your code will contain bugs that are difficult to diagnose.

Deferred Creation of Dynamic Components
A dynamic component can now wait for page actions to be completed before the method that creates the dynamic component
runs. You can now design dynamic components that change depending on the result of, for example, a page initialization
action or a callout. This enhancement gives you additional options for creating dynamic, adaptable user interfaces in Visualforce.

Dynamic Visualforce components enable you to create user interfaces that adapt to a variety of conditions, adapting to differences
in user settings or permissions, organization settings, custom settings, and so on. Dynamic components achieve this flexibility
by being defined in Apex rather than in markup. Prior to this release, the Apex method that defines a dynamic component
was always executed at page load time, before any action method that’s defined for the page was run. This meant that the
component couldn’t depend on a page’s initialization or setup, callouts, or other long-running actions.

You can set the new invokeAfterAction attribute of a dynamic component to true, and the component is created after
any action that’s defined for the <apex:page>.

Here’s a simple page that has a single dynamic component, which is created after the page’s action method,
pageActionUpdateMessage, is completed.

<apex:page controller="DeferredDynamicComponentController"
action="{!pageActionUpdateMessage}" showHeader="false">

<apex:dynamicComponent componentValue="{!dynamicComp}" invokeAfterAction="true"/>

</apex:page>
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Here’s the associated controller that provides the dynamic component definition, and illustrates the effect of the
invokeAfterAction attribute.

public class DeferredDynamicComponentController {

private String msgText { get; set; }

public DeferredDynamicComponentController() {
this.msgText = 'The controller is constructed.';

}

public Component.Apex.OutputPanel getDynamicComp() {

// This is the component to return
Component.Apex.OutputPanel dynOutPanel= new Component.Apex.OutputPanel();
dynOutPanel.layout = 'block';

// Child component to hold the message text
Component.Apex.OutputText msgOutput = new Component.Apex.OutputText();
msgOutput.value = this.msgText;
dynOutPanel.childComponents.add(msgOutput);

return dynOutPanel;
}

public Object pageActionUpdateMessage() {
this.msgText= 'The page action method has been run.';
return null;

}
}

With the previous behavior for dynamic components, the msgText value that’s set in the constructor is displayed by the
dynamic component. Setting invokeAfterAction="true" on the dynamic component changes that behavior. The page
waits for the pageActionUpdateMethod to be completed and then creates the dynamic component, and so the component
displays the value for msgText that’s set in the pageActionUpdateMessage action method instead.

This change is versioned, and you must update your pages to API version 31.0 or later to use the invokeAfterAction
attribute.

Deferred Creation of Dynamic Components and Other Actions

invokeAfterAction="true" affects dynamic components immediately at page load time, because that’s when page actions
run. Setting invokeAfterAction="true" reverses the order of component creation and any action method on the page.
That is, the order of execution is changed for action methods on all the following components.

• <apex:actionFunction>

• <apex:actionPoller>

• <apex:actionSupport>

• <apex:commandButton>

• <apex:commandLink>

• <apex:page>

• <apex:togglePanel>

When invokeAfterAction="false" is set on a dynamic component, the order of execution is as follows. This is the
default behavior for dynamic components.

1. Invoke the dynamic component’s creation method, which constructs the component.
2. Invoke the action method.
3. Rerender the page.

When invokeAfterAction="true" is set on a dynamic component, the order of execution is as follows.
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1. Invoke the action method.
2. Invoke the dynamic component’s creation method, which constructs the component.
3. Rerender the page.

Note:  In the second case, if the action method returns a PageReference, Visualforce will redirect the request to the
new page, and the dynamic component’s creation method won’t be run. To avoid a possible order-of-execution bug,
it’s a best practice that methods that create dynamic components don’t have side effects.

Other Changes in Visualforce
We’ve made some additional changes in Visualforce.

renderStyle Attribute Added to topics:widget

The topics widget lets users see, add, and remove topics on a record so it’s easy to tag and categorize records. Use the
renderStyle attribute to specify whether the widget appears with a basic or an advanced user interface.

<apex:lineSeries> markerFill and fillColor Attributes Default to strokeColor

The markerFill and fillColor attributes of the <apex:lineSeries> charting component weren’t defaulting to match
the component’s strokeColor as documented. This behavior has been corrected for pages that are set to API versions 31.0
and later.

Consolidated Inclusion of Salesforce CSS and JavaScript Resources

The way that Visualforce adds Salesforce CSS and JavaScript resources to generated pages has been optimized. The result
is pages that are faster to download and more efficient to render in the browser than in prior releases.

Enhanced Session ID Management for Visualforce

Visualforce session management has been improved to more correctly handle transitions between different salesforce.com
servers. The critical update is transparent in normal use but fixes problems with certain edge cases.

renderStyle Attribute Added to topics:widget
The topics widget lets users see, add, and remove topics on a record so it’s easy to tag and categorize records. Use the
renderStyle attribute to specify whether the widget appears with a basic or an advanced user interface.

Default ValueRequired?DescriptionAttribute TypeAttribute Name

simpleNoThe style in which the
topics widget is

StringrenderStyle

rendered. Acceptable
values are simple and
enhanced.

Here’s what the topics widget looks like when renderStyle=simple:

Here’s what it looks like when renderStyle=enhanced:
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The renderStyle attribute is available in API version 31.0 and later.

<apex:lineSeries> markerFill and fillColor Attributes Default to
strokeColor

The markerFill and fillColor attributes of the <apex:lineSeries> charting component weren’t defaulting to match
the component’s strokeColor as documented. This behavior has been corrected for pages that are set to API versions 31.0
and later.

Visualforce <apex:lineSeries> charts are designed so that, by default, the lines, markers, and fill color all match. This
worked as documented if the line colors were chosen automatically by Visualforce, but if you set any of the line colors manually
by using the strokeColor attribute, the corresponding markerFill and fillColor didn’t change to match. The
work-around was to manually specify the markerFill and fillColor, which adds extra markup. (The alternative—a
hideous, mixed-color line series—is too horrible to contemplate.)

This behavior has been fixed, and markerFill and fillColor default to the strokeColor if specified. You can still
manually specify mixed colors by setting markerFill or fillColor explicitly. This change is versioned, and you must
update your pages or components to API 31.0 or later to access the improved behavior.

Consolidated Inclusion of Salesforce CSS and JavaScript Resources
The way that Visualforce adds Salesforce CSS and JavaScript resources to generated pages has been optimized. The result is
pages that are faster to download and more efficient to render in the browser than in prior releases.

This optimization affects the Salesforce resources that are used to provide Salesforce styling and application functionality.
This change doesn’t apply to the CSS and JavaScript that you add to your Visualforce pages by using <apex:stylesheet>,
<apex:includeScript>, or static HTML. <apex:stylesheet> and <apex:includeScript> automatically consolidate
duplicate inclusions of resources.

Note: Salesforce doesn’t support direct use of or dependency on the resources that are optimized by this change. So,
in theory, there should be no visible effect on your pages. In practice, sometimes customers make unsupported use of
these resources. If your pages depend on specific Salesforce stylesheets or JavaScript files, we recommend that you
test them thoroughly in a sandbox or Developer Edition organization and fix any problems that you discover.

Enhanced Session ID Management for Visualforce
Visualforce session management has been improved to more correctly handle transitions between different salesforce.com
servers. The critical update is transparent in normal use but fixes problems with certain edge cases.

The update changes how and when session IDs are generated and managed. Salesforce.com servers handle the change
automatically, but if you have a custom integration that relies on session ID values, we recommend that you verify this update
for compatibility in a sandbox or Developer Edition organization before enabling it permanently in your production organization.

If you activate this update now, the enhanced session ID management will be used for all Visualforce pages in your organization.
Otherwise, this update will be enabled for your organization on the activation date.
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Apex Code
Using syntax that looks like Java and acts like database stored procedures, Apex enables developers to add business logic to
most system events, including button clicks, related record updates, and Visualforce pages. Apex code execution can be initiated
by Web service requests and from triggers on objects.

Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Apex includes the following enhancements. For detailed information on these enhancements, refer to the Force.com Apex Code
Developer's Guide.

Describe Limits Removed

Limits for all Apex describe calls have been removed for all API versions. Describe calls include describes for sObjects, fields,
field sets, child relationships, picklists, and record types.

Script Statement Limits Methods Removed

The Limits methods for script statements have been removed but are available and deprecated in API version 30.0 and earlier.
Because the script statement limit is no longer enforced in any API version since Winter ’14, the associated Limits methods
are no longer needed.

Create Price Book Entries in Apex Tests

You can create price book entries for standard and custom price books in Apex tests.

Submit More Batch Jobs with Apex Flex Queue (Pilot)

You can submit more batch jobs simultaneously and actively manage the order of the queued jobs.

Run Future Methods with Higher Limits (Pilot)

Avoid reaching governor limits in your asynchronous future method by running your method with double or triple capacity
for a resource.

New and Changed Apex Classes

These methods, classes, and interfaces are new or have changed in this release.

Chatter in Apex (ConnectApi)

To create custom Chatter experiences in Salesforce, use Chatter in Apex.

Describe Limits Removed
Limits for all Apex describe calls have been removed for all API versions. Describe calls include describes for sObjects, fields,
field sets, child relationships, picklists, and record types.

You’re no longer limited to describing 100 objects or to executing 100 describe statements.

For example, describeSObjects can now describe more than 100 sObjects.

Schema.DescribeSobjectResult[] results =
Schema.describeSObjects(new String[]{'Account','Contact',...});
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You’re no longer bound by 100 fields or fieldSets statements in your code to describe fields and field sets respectively.
The following example shows fields and fieldSets statements.

// Get the field describe result for the Name field on the Account object
Schema.DescribeFieldResult fieldResult = Schema.sObjectType.Account.fields.Name;

// Get information about a field set named fieldset1
Schema.FieldSet fs1 = Schema.SObjectType.Account.fieldSets.fieldset1;

The previous examples show only a subset of the describe method calls that are no longer bounded by the describe limit. Other
method calls include getChildRelationships() and getRecordTypeInfos() of Schema.DescribeSObjectResult,
among others.

Also, the associated Limits methods for describe calls are now removed. For earlier versions (API version 30.0 and earlier),
these methods still exist but are deprecated. The affected methods are:

• getChildRelationshipsDescribes()

• getFieldsDescribes()

• getFieldSetsDescribes()

• getPicklistDescribes()

• getRecordTypesDescribes()

• getLimitChildRelationshipsDescribes()

• getLimitFieldsDescribes()

• getLimitFieldSetsDescribes()

• getLimitPicklistDescribes()

• getLimitRecordTypesDescribes()

Script Statement Limits Methods Removed
The Limits methods for script statements have been removed but are available and deprecated in API version 30.0 and earlier.
Because the script statement limit is no longer enforced in any API version since Winter ’14, the associated Limits methods
are no longer needed.

The affected methods in the Limits class are:

• getScriptStatements()

• getLimitScriptStatements()

Create Price Book Entries in Apex Tests
You can create price book entries for standard and custom price books in Apex tests.

Previously, you couldn’t create price book entries in an Apex test by default unless the test had access to organization data via
the @isTest(SeeAllData=true) annotation. With this new support, you can isolate your price book test data from your
organization data. Note that custom price books can be created but standard price books cannot.

Support for test price book entries is added for all tests, including tests that use the default data isolation mode (tests that can’t
access organization data). With this support, you can do the following.

• Query for the ID of the standard price book in your organization with the Test.getStandardPricebookId() method.

• Create test price book entries with standard prices by using the standard price book ID that’s returned by
Test.getStandardPricebookId().
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• Create test custom price books, which enables you to add price book entries with custom prices.

Example
This example creates some test data for price book entries. The test method in this example gets the standard price book ID
and uses this ID to create a price book entry for a product with a standard price. Next, the test creates a custom price book
and uses the ID of this custom price book to add a price book entry with a custom price.

@isTest
public class PriceBookTest {

// Utility method that can be called by Apex tests to create price book entries.
static testmethod void addPricebookEntries() {

// First, set up test price book entries.
// Insert a test product.
Product2 prod = new Product2(Name = 'Laptop X200',

Family = 'Hardware');
insert prod;

// Get standard price book ID.
// This is available irrespective of the state of SeeAllData.
Id pricebookId = Test.getStandardPricebookId();

// 1. Insert a price book entry for the standard price book.
// Standard price book entries require the standard price book ID we got earlier.
PricebookEntry standardPrice = new PricebookEntry(

Pricebook2Id = pricebookId, Product2Id = prod.Id,
UnitPrice = 10000, IsActive = true);

insert standardPrice;

// Create a custom price book
Pricebook2 customPB = new Pricebook2(Name='Custom Pricebook', isActive=true);
insert customPB;

// 2. Insert a price book entry with a custom price.
PricebookEntry customPrice = new PricebookEntry(

Pricebook2Id = customPB.Id, Product2Id = prod.Id,
UnitPrice = 12000, IsActive = true);

insert customPrice;

// Next, perform some tests with your test price book entries.
}

}

Submit More Batch Jobs with Apex Flex Queue (Pilot)
You can submit more batch jobs simultaneously and actively manage the order of the queued jobs.

Note:  This feature is currently available through a pilot program. For information about enabling Apex Flex Queue
for your organization, contact salesforce.com.

The Apex Flex Queue pilot enables you to submit batch jobs beyond the allowed limit of five queued or active jobs. Any jobs
that are submitted for execution but aren’t processed immediately by the system are in holding status and are placed in a
separate queue (the Apex flex queue). Up to 100 batch jobs can be in the holding status. When system resources become
available, the system picks up jobs from the Apex flex queue and moves them to the batch job queue. The status of these moved
jobs changes from Holding to Queued. Queued jobs get executed when the system is ready to process new jobs.

Without administrator intervention, jobs are processed first-in first-out—in the order in which they’re submitted. Administrators
can modify the order of jobs that are held in the Apex flex queue to control when they get processed by the system. For example,
you can move a batch job up to the first position in the holding queue so that it is the first job that gets processed when the
system fetches the next held job from the flex queue.
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Monitoring and Reordering the Apex Flex Queue
You can monitor and reorder batch jobs that are held in the flex queue in the Salesforce user interface. To do so, from Setup,
click Jobs > Apex Flex Queue. This page lists all batch jobs that are in Holding status with some information about the job,
such as the job ID, the submission date, and the Apex class. By default, these jobs are numbered in the order they were
submitted, starting with position 1, which corresponds to the job that was submitted first. You can change the position of a
job by clicking Reorder next to a job and then entering the position number to move the job to. All other jobs in the holding
queue are reordered and renumbered accordingly.

When a job is selected from the Apex flex queue for processing, this job is removed from the Apex flex queue and moved to
the batch job queue. You can monitor the moved job in the Apex Jobs page by clicking Apex Jobs.

Submitting Jobs by Calling Database.executeBatch
To submit a batch job, call Database.executeBatch. The resulting outcome of Database.executeBatch depends on
whether your organization has reached the five queued or active batch job limit.

• Ifsystem resources are available for processing jobs, the batch job is queued for execution and its status is Queued.
• If no system resources are available, the batch job is placed in the Apex flex queue and its status is Holding.
• If the Apex flex queue has the maximum number (100) of jobs, this method returns an error and doesn’t place the job in

the queue.

AsyncApexJob Status Field
The AsyncApexJob object, which represents a batch job, has a new status field value of Holding. This new status indicates
that the job is placed in the Apex flex queue and is waiting to be picked up when system resources are available.

The following table lists all possible statuses for a batch job and a description of each.

DescriptionStatus

Job has been submitted and is held until system resources are
freed up.

Holding

Job is awaiting execution.Queued

The start method of the job has been invoked. This status
might last a few minutes depending on the size of the batch
of records.

Preparing

Job is being processed.Processing

Job was aborted by a user.Aborted

Job completed with or without failures.Completed

Job experienced a system failureFailed

Run Future Methods with Higher Limits (Pilot)
Avoid reaching governor limits in your asynchronous future method by running your method with double or triple capacity
for a resource.

Note:  This feature is currently available through a pilot program. For information about enabling enhanced future
methods for your organization, contact salesforce.com.

Apex future methods (methods that are annotated with @future) currently have the higher asynchronous limits for heap
size, CPU timeout, and number of SOQL queries. This pilot enables you to specify even higher values for these and for
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additional limits in future methods. If you were exceeding a governor limit in your future method, or if you think a future
method requires a higher limit, you can increase this limit for your future method.

Note:  Running future methods with higher limits might slow down the execution of all your future methods.

One of the following limits can be doubled or tripled for each future method.

• Heap size

• CPU timeout

• Number of SOQL queries

• Number of DML statements issued

• Number of records that were processed as a result of DML operations, Aprroval.process, or
Database.emptyRecycleBin

The higher limit is specified in the method definition as part of the @future annotation by using the limit parameter, in
the following syntax:

@future(limits='2x|3xlimitName')

For example, to double the amount of heap size that is allowed in your future method, define your method as follows:

@future(limits='2xHeap')
public static void myFutureMethod() {

// Your code here
}

Tip:  Keep in mind that you can specify only one higher limit per future method. Decide which of the modifiable
limits you need the most for your method.

The following limit modifiers are supported. The string value passed to the limits parameter inside the annotation is
case-insensitive.

DescriptionModifier

Heap size limit is doubled (24 MB).@future(limits='2xHeap')

Heap size limit is tripled (36 MB).@future(limits='3xHeap')

CPU timeout is doubled (120,000 milliseconds).@future(limits='2xCPU')

CPU timeout is tripled (180,000 milliseconds).@future(limits='3xCPU')

Number of SOQL queries limit is doubled (400).@future(limits='2xSOQL')

Number of SOQL queries limit is tripled (600).@future(limits='3xSOQL')

Number of DML statements limit is doubled (300).@future(limits='2xDML')

Number of DML statements limit is tripled (450).@future(limits='3xDML')

Number of records that were processed as a result of DML
operations is doubled (20,000).

@future(limits='2xDMLRows')1

Number of records that were processed as a result of DML
operations is tripled (30,000).

@future(limits='3xDMLRows')1
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1 Includes Aprroval.process and Database.emptyRecycleBin operations.

New and Changed Apex Classes
These methods, classes, and interfaces are new or have changed in this release.

New Methods
The following existing classes have new methods.

Flow.Interview class:

start()

Launches a trigger-ready flow.

System.Crypto class:

signWithCertificate(String, Blob, String)

Computes a unique digital signature for the input string, using the specified algorithm and the supplied certificate
and key pair.

signXML(String, Dom.XmlNode, String, String)

Envelops the signature into an XML document.

System.Limits class:

getLimitMobilePushApexCalls()

Returns the total number of Apex calls that are allowed per day for mobile push notifications.

getMobilePushApexCalls()

Returns the number of Apex calls that have been used by mobile push notifications during the current metering
interval.

System.String class:

charAt(Integer)

Returns the value of the character at the specified index.

codePointAt(Integer)

Returns the Unicode code point value at the specified index.

codePointBefore(Integer)

Returns the Unicode code point value that occurs before the specified index.

codePointCount(Integer, Integer)

Returns the number of Unicode code points within the specified text range.

getChars()

Returns an array of character values that represent the characters in this string.

indexOfChar(Integer)

Returns the index of the first occurrence of the character that corresponds to the specified character value.
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indexOfChar(Integer, Integer)

Returns the index of the first occurrence of the character that corresponds to the specified character value, starting
from the specified index.

lastIndexOfChar(Integer)

Returns the index of the last occurrence of the character that corresponds to the specified character value.

lastIndexOfChar(Integer, Integer)

Returns the index of the last occurrence of the character that corresponds to the specified character value, starting
from the specified index.

offsetByCodePoints(Integer, Integer)

Returns the index of the Unicode code point that is offset by the specified number of code points, starting from
the given index.

System.Test class:

getStandardPricebookId()

Returns the ID of the standard price book in the organization.

Changed Methods
The following classes have changed methods.

System.Crypto class:

sign(String, Blob, Blob)

The Crypto.sign() method now supports both RSA-SHA1 and RSA-SHA256 values for the algorithmName
parameter.

New Classes
Canvas.Test

Contains methods for automated testing of your Canvas classes.

mockRenderContext(Map<String,String>,Map<String,String>)

Creates and returns a test Canvas.RenderContext based on the provided application and environment context
parameters.

testCanvasLifecycle(Canvas.CanvasLifecycleHandler, Canvas.RenderContext)

Calls the canvas test framework to invoke a CanvasLifecycleHandler with the provided RenderContext.

Messaging.PushNotification
PushNotification is used to configure push notifications and send them from an Apex trigger.

PushNotification()

Creates a new instance of the Messaging.PushNotification class.

PushNotification(Map<String, Object> payload)

Creates a new instance of the Messaging.PushNotification class using the specified payload parameters as
key-value pairs. When you use this constructor, you don’t need to call setPayload to set the payload.

send(String application, Set<String> users)

Sends a push notification message to the specified users.
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setPayload(Map<String, Object> payload)

Sets the payload of the push notification message.

setTtl(Integer ttl)

Reserved for future use.

Messaging.PushNotificationPayload
Contains methods to create the notification message payload for an Apple device.

apple(String alert, String sound, Integer badgeCount, Map<String, Object> userData)

Helper method that creates a valid Apple payload from the specified arguments.

apple(String alertBody, String actionLocKey, String locKey, String[] locArgs, String
launchImage, String sound, Integer badgeCount, Map<String, Object> userData)

Helper method that creates a valid Apple payload from the specified arguments.

New Interfaces
Canvas.ApplicationContext

Use this interface to retrieve application context information, such as the application version or URL.

getCanvasUrl()

Retrieves the fully qualified URL of the canvas app.

getDeveloperName()

Retrieves the internal API name of the canvas app.

getName()

Retrieves the name of the canvas app.

getNamespace()

Retrieves the namespace prefix of the canvas app.

getVersion()

Retrieves the current version of the canvas app.

setCanvasUrlPath(String)

Overrides the URL of the canvas app for the current request.

Canvas.CanvasLifecycleHandler
Implement this interface to control context information and add custom behavior during the application render phase.

excludeContextTypes()

Lets the implementation exclude parts of the CanvasRequest context, if the application does not need it.

onRender(Canvas.RenderContext)

Invoked when a canvas app is rendered. Provides the ability to set and retrieve canvas application and environment
context information during the application render phase.

Canvas.EnvironmentContext
Use this interface to retrieve environment context information, such as the app display location or the configuration
parameters.
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addEntityField(String)

Adds a field to the list of object fields that are returned in the signed request Record object when the component
appears on a Visualforce page that’s placed on an object.

addEntityFields(Set<String>)

Adds a set of fields to the list of object fields that are returned in the signed request Record object when the
component appears on a Visualforce page that’s placed on an object.

getDisplayLocation()

Retrieves the display location where the canvas app is being called from. For example, a value of Visualforce indicates
that the canvas app was called from a Visualforce page.

getEntityFields()

Retrieves the list of object fields that are returned in the signed request Record object when the component appears
on a Visualforce page that’s placed on an object.

getLocationUrl()

Retrieves the location URL of the canvas app.

getParametersAsJSON()

Retrieves the current custom parameters for the canvas app. Parameters are returned as a JSON string.

getSublocation()

Retrieves the display sublocation where the canvas app is being called from.

setParametersAsJSON(String)

Sets the custom parameters for the canvas app.

Canvas.RenderContext
A wrapper interface that is used to retrieve application and environment context information.

getApplicationContext()

Retrieves the application context information.

getEnvironmentContext()

Retrieves the environment context information.

Chatter in Apex (ConnectApi)
To create custom Chatter experiences in Salesforce, use Chatter in Apex.

Many Chatter REST API resource actions are exposed as static methods on Apex classes in the ConnectApi namespace.
These methods use other ConnectApi classes to input and return information. The ConnectApi namespace is referred to
as Chatter in Apex.

In Apex, it’s possible to access some Chatter data using SOQL queries and objects. However, ConnectApi classes expose
Chatter data in a much simpler way. Data is localized and structured for display. For example, instead of making many calls
to access and assemble a feed, you can do it with a single call.

Note:  To integrate mobile apps, intranet sites, and third party Web applications with Chatter, use Chatter REST
API.
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General Updates to Chatter in Apex
New and Changed Chatter in Apex Classes
New and Changed Chatter in Apex Input Classes
New and Changed Chatter in Apex Output Classes
New and Changed Chatter in Apex Enums

General Updates to Chatter in Apex
Documentation indicates whether a method requires Chatter

Each ConnectApi method in the Apex Developer’s Guide has a section indicating whether or not the method requires
that the user calling the method has access to Chatter. To verify that the user has access, check the hasChatter property
of the ConnectApi.UserDetails or the ConnectApi.UserSettings output objects.

New and Changed Chatter in Apex Classes

Feed Elements

In API versions 30.0 and earlier, a feed contains feed items. As of API version 31.0, a feed contains feed elements.

The ConnectApi.FeedElement class is abstract. In API version 31.0, its concrete subclasses are ConnectApi.FeedItem
and ConnectApi.Bundle. A bundle (or bundled post) contains feed elements and keeps the feed clean and organized. In
Summer ‘14, bundled posts are collections of feed tracked change feed items in record feeds only and are supported in the
Salesforce1 mobile browser app only. Bundled posts are available through a pilot program. For information on enabling bundled
posts for your organization, contact salesforce.com.

The feed element in this image is a bundle of feed tracked changes for the Acme Inc. account:

1. The header indicating that this bundle contains feed tracked changes for a record.
2. The auxiliary body indicating the changed field and the new and old values.

To see the individual feed tracked change feed items, click on the bundle.

To get a feed that includes bundles, call ChatterFeeds.getFeedElementsFromFeed(String communityId,
ConnectApi.FeedType feedType, String subjectId, Integer recentCommentCount, Integer
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elementsPerBundle, ConnectApi.FeedDensity density, String pageParam, Integer pageSize,
ConnectApi.FeedSortOrder sortParam, Boolean showInternalOnly) and pass ConnectApi.FeedType.Record
for the feedType parameter.

In API versions 30.0 and earlier, every feed item supported comments, likes, topics, and so on. In versions 31.0 and later, every
feed item (and feed element) can have a unique set of capabilities. If a capability property exists on a feed element, that capability
is available, even if the capability property doesn’t have a value. For example, if the ChatterLikes capability property exists
on a feed element (with or without a value), the logged-in user can like that feed element. If the capability property doesn’t
exist, it isn’t possible to like that feed element. A capability can also contain associated data. For example, the Moderation
capability contains data about moderation flags.

Methods that get feed elements return ConnectApi.FeedElementPage objects, which contain a list of
ConnectApi.FeedElement objects. The ConnectApi.FeedElement.capabilities property contains a
ConnectApi.FeedElementCapabilities object that contains all the capabilities of a particular feed element.

Tip:  The getFeedItem and postFeedItem methods are still supported, but to future-proof your applications,
use the getFeedElement and postFeedElement methods. For example, as of API version 31.0, the only feed
element types are feed item and bundle, but that could change in future releases.

Get feed elements for a favorite
These new ChatterFavorites.getFeedElements methods get feed elements instead of feed items for a favorite.

• getFeedElements(String, String, String)—Returns the first page of feed elements for the specific favorite
in the specified community.

• getFeedElements(String, String, String, String, Integer,
ConnectApi.FeedSortOrder)—Returns the specified page of feed elements for the specified favorite, in the
specified community in the specified order.

• getFeedElements(String, String, String, Integer, Integer, String, Integer,
ConnectApi.FeedSortOrder)—Returns the specified page of feed elements for the specified favorite, in the
specified community in the specified order and includes no more than the specified number of comments per feed
element.

Each of these methods has an associated setTest method to register data for use in a test context.

Delete a feed element
Delete a specific feed element with this new ChatterFeeds method: deleteFeedElement(String, String).

Get a specific feed element
These new ChatterFeeds.getFeedElement methods get a specific feed element:
• getFeedElement(String, String)—Returns information about the specified feed element.
• getFeedElement(String, String, Integer, Integer)—Returns information about the specified feed

element with the specified number of elements per bundle including no more than the specified number of comments
per feed element.

Get information about a list of feed elements
Get information about a list of feed elements with this new ChatterFeeds method: getFeedElementBatch(String,
List<String>).

Get feed elements from a bundle
A bundle is a feed element that is a container of feed elements. These new
ChatterFeeds.getFeedElementsFromBundle methods get feed elements from a bundle:
• getFeedElementsFromBundle(String, String)—Returns the first page of feed-elements from a bundle.
• getFeedElementsFromBundle(String, String, String, Integer, Integer, Integer)—Returns

the feed elements on the specified page for the bundle. Each feed element includes no more than the specified number
of comments. Specify the maximum number of feed elements in a bundle.
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Get feed elements from a feed
These new ChatterFeeds.getFeedElementsFromFeed methods get feed elements. Feed elements are new in
Summer ‘14. Feed elements are the top-level items that a feed contains. Feeds are feed element containers. A feed element
is an abstract object. In concrete form, it can be either a feed item or a bundle.

Use these methods to get feed elements from the company feed or the moderation feed:
• getFeedElementsFromFeed(String, ConnectApi.FeedType)—Returns the first page of feed elements

from the Company and Moderation feed types. The page contains the default number of items.
• getFeedElementsFromFeed(String, ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder)—Returns the feed items for the specified page for the Company and Moderation
feed types, in the specified order.

• getFeedElementsFromFeed(String, ConnectApi.FeedType, Integer, ConnectApi.FeedDensity,
String, Integer, ConnectApi.FeedSortOrder)—Returns the feed elements for the specified page for the
Company and Moderations feed types, in the specified order. Each feed element contains no more than the specified
number of comments.

Use these methods to get feed elements from any feed other than the company feed, moderation feed, or a filter feed:
• getFeedElementsFromFeed(String, ConnectApi.FeedType, String)—Returns the first page of feed

elements for the specified feed type, for the specified user or record. The page contains the default number of elements.
• getFeedElementsFromFeed(String, ConnectApi.FeedType, String, String, Integer,

ConnectApi.FeedSortOrder)—Returns the feed elements on the specified page for the specified user or record,
for the specified feed type in the specified order.

• getFeedElementsFromFeed(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder)—Returns the feed
elements on the specified page for the specified user or record, for the specified feed type in the specified order. Each
feed element includes no more than the specified number of comments.

• getFeedElementsFromFeed(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, Boolean)—Returns
the feed elements on the specified page for the specified user or record, for the specified feed type in the specified
order. Each feed element includes no more than the specified number of comments. Specify whether to return feed
elements posted by internal (non-community) users only.

• getFeedElementsFromFeed(String, ConnectApi.FeedType, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, Boolean)—Returns
the feed elements on the specified page for the specified user or record, for the specified feed type in the specified
order. Each feed element includes no more than the specified number of comments. Specify whether to return feed
elements posted by internal (non-community) users only. Specify the maximum number of feed elements in a bundle.

Each of these methods has an associated setTest method to register data for use in a test context.

Get feed elements from a feed updated since the last request
These new ChatterFeeds.getFeedElementsFromFeedUpdatedSince methods get feed elements instead of feed
items.

Use these methods to get feed elements from the company or the moderation feed:
• getFeedElementsUpdatedSince(String, ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer, String)—Returns the specified page of feed elements for
the Company and Moderation feed types. Includes only feed elements that have been updated since the time
specified in the updatedSince parameter. Each feed element contains no more than the specified number of
comments.

Use these methods to get feed elements from any feed other than the company feed, moderation feed, or a filter feed:
• getFeedElementsUpdatedSince(String, ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer, String)—Returns the specified page of feed elements for
the Files, Groups, News, People, and Record feed types. Includes only feed elements that have been updated
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since the time specified in the updatedSince parameter. Each feed element contains no more than the specified
number of comments.

• getFeedElementsUpdatedSince(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, String, Boolean)—Returns the specified page of feed
elements for the Record feed type. Includes only feed elements that have been updated since the time specified in
the updatedSince parameter. Specify whether to return feed elements posted by internal (non-community) users
only.

• getFeedElementsUpdatedSince(String, ConnectApi.FeedType, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, String, Boolean)—Returns the specified page of feed
elements for the Record feed type. Includes only feed elements that have been updated since the time specified in
the updatedSince parameter. Specify whether to return feed elements posted by internal (non-community) users
only. Specify the maximum number of feed elements in a bundle.

Each of these methods has an associated setTest method to register data for use in a test context.

Get feed elements from a filtered feed
These new ChatterFeeds.getFeedElementsFromFilterFeed methods get feed elements instead of feed items
from a filtered feed.

• getFeedElementsFromFilterFeed(String, String, String)—Returns the first page of feed elements
for the specified user and the specified key prefix.

• getFeedElementsFromFilterFeed(String, String, String, String, Integer,
ConnectApi.FeedSortOrder)—Returns the specified page of feed elements for the specified user and the
specified key prefix, in the specified order.

• getFeedElementsFromFilterFeed(String, String, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder)—Returns the specified
page of feed elements for the specified user and the specified key prefix, in the specified order. Each feed element
contains no more than the specified number of comments.

Each of these methods has an associated setTest method to register data for use in a test context.

Get feed elements from a filtered feed updated since the last request
This new ChatterFeeds.getFeedElementsFromFilterFeedUpdatedSince method gets feed elements instead
of feed items.

• getFeedElementsFromFilterFeedUpdatedSince(String, String, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, String)—Returns the specified page of feed elements for
the specified user and the specified key prefix. Includes only feed elements that have been updated since the time
specified in the updatedSince parameter.

This method has an associated setTest method to register data for use in a test context.

Post feed elements
Post feed elements with these new ChatterFeeds methods:
• postFeedElement(String, String, ConnectApi.FeedElementType, String)—Posts a feed element

with plain text from the context user.
• postFeedElement(String, ConnectApi.FeedElementInput, ConnectApi.BinaryInput)—Posts a

feed element from the context user. Use this method to post rich text, including mentions and hashtag topics, and
to attach a file to a feed element. You can also use this method to share a feed element and add a comment.

Search feed elements
These new ChatterFeeds.searchFeedElements methods get feed elements instead of feed items.

Use these methods to get feed elements from the company feed or the moderation feed:
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• searchFeedElements(String, String)—Returns the first page of all the feed elements that match the
specified search criteria.

• searchFeedElements(String, String, ConnectApi.FeedSortOrder)—Returns the first page of all
the feed elements that match the specified search criteria in the specified order.

• searchFeedElements(String, String, String, Integer)—Searches feed elements and returns a specified
page and page size of search results.

• searchFeedElements(String, String, String, Integer, ConnectApi.FeedSortOrder)—Searches
feed elements and returns a specified page and page size in a specified order.

• searchFeedElements(String, String, Integer, String, Integer,
ConnectApi.FeedSortOrder)—Searches feed elements and returns a specified page and page size in a specified
order. Each feed element includes no more than the specified number of comments.

Each of these methods has an associated setTest method to register data for use in a test context.

Search feed elements in a feed
These new ChatterFeeds.searchFeedElementsInFeed methods get feed elements instead of feed items. Feed
elements are the top-level items that a feed contains. Feeds are feed element containers.

Use these methods to get feed elements from the company feed or the moderation feed:
• searchFeedElementsInFeed(String, ConnectApi.FeedType, String)—Searches the feed elements

for the Company and Moderation feed types.
• searchFeedElementsInFeed(String, ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder, String)—Searches the feed elements for the Company and Moderation feed
types and returns a specified page and page size in a specified sort order.

• searchFeedElementsInFeed(String, ConnectApi.FeedType, Integer, ConnectApi.FeedDensity,
String, Integer, ConnectApi.FeedSortOrder, String)—Searches the feed elements for the Company
and Moderation feed types and returns a specified page and page size in a specified sort order. Each feed element
includes no more than the specified number of comments.

Use these methods to get feed elements from any feed other than the company feed, moderation feed, or a filter feed:
• searchFeedElementsInFeed(String, ConnectApi.FeedType, String, String)—Searches the feed

items for a specified feed type.
• searchFeedElementsInFeed(String, ConnectApi.FeedType, String, String, Integer,

ConnectApi.FeedSortOrder, String)—Searches the feed elements for a specified feed type and context user,
and returns a specified page and page size in a specified sort order.

• searchFeedElementsInFeed(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, String)—Searches
the feed elements for a specified feed type and returns a specified page and page size in a specified sort order. Each
feed element includes no more than the specified number of comments.

• searchFeedElementsInFeed(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, String,
Boolean)—Searches the feed elements for a specified feed type and context user, and returns a specified page and
page size in a specified sort order. Each feed element includes no more than the specified number of comments.
Specify whether to return feed elements posted by internal (non-community) users only.

Each of these methods has an associated setTest method to register data for use in a test context.

Search feed elements in a filtered feed
These new ChatterFeeds.searchFeedElementsInFilterFeed methods search feed elements instead of feed
items in a filtered feed.

• searchFeedElementsInFilterFeed(String, String, String, String)—Searches the feed elements
of a feed filtered by key prefix.
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• searchFeedElementsInFilterFeed(String, String, String, String, Integer,
ConnectApi.FeedSortOrder, String)—Searches the feed elements of a feed filtered by key prefix, and returns
a specified page and page size in a specified sort order.

• searchFeedElementsInFilterFeed(String, String, String, Integer, ConnectApi.FeedDensity,
String, Integer, ConnectApi.FeedSortOrder, String)—Searches the feed elements of a feed filtered
by key prefix, and returns a specified page and page size in a specified sort order. Each feed element includes no more
than the specified number of comments.

Each of these methods has an associated setTest method to register data for use in a test context.

Share feed elements
Share feed elements with this new ChatterFeeds method: shareFeedElement(String, String,
ConnectApi.FeedElementType, String).

Get, add, and remove moderation flags to and from feed elements
Use these new CommunityModeration methods to get, add, and remove moderation flags to and from feed elements.

• addFlagToFeedElement(String, String)—Add a moderation flag to a feed element. To add a flag to a feed
element, Allow members to flag content must be selected for a community.

• addFlagToFeedElement(String, String, ConnectApi.CommunityFlagVisibility)—Add a moderation
flag with specified visibility to a feed element. To add a flag to a feed element, Allow members to flag content
must be selected for a community.

• getFlagsOnFeedElement(String, String)—Get the moderation flags on a feed element. To get the flags,
the logged-in user must have the Moderate Communities Feeds permission.

• getFlagsOnFeedElement(String, String, ConnectApi.CommunityFlagVisibility)—Get the
moderation flags with specified visibility on a feed element. To get the flags, the logged-in user must have the
Moderate Communities Feeds permission.

• removeFlagFromFeedElement(String, String, String)—Remove a moderation flag from a feed element.
To remove a flag from a feed element, the logged-in user must have added the flag or must have the Moderate
Communities Feeds permission.

Other Changes to Chatter in Apex Classes

Access public Chatter groups from a guest user account
If your community allows access without logging in, all signatures of these methods are available to guest users. These
methods return information the guest user has access to.

ChatterFeeds methods:
• getComment()

• getCommentsForFeedItem()

• getFeedElement()

• getFeedElementsFromFeed()

• getFeedElementsUpdatedSince()

• getFeedItem()

• getFeedItemsFromFeed()

• getFeedItemsUpdatedSince()

• getLikesForComment()

• getLikesForFeedItem()

• searchFeedElements()

• searchFeedElementsInFeed()

• searchFeedItems()

• searchFeedItemsInFeed()

262

Chatter in Apex (ConnectApi)Force.com Development



ChatterGroups methods:
• getGroup()

• getGroups()

• searchGroups()

Update, delete, or get information about an announcement
Use the new ConnectApi.Announcements class to get and post information about announcements. An announcement
displays in a designated location in the Salesforce UI until 11:59 p.m. on its expiration date, unless it’s deleted or replaced
by another announcement.

It has these methods:
• deleteAnnouncement(String, String)—Deletes the specified announcement.
• getAnnouncement(String, String)—Gets information about the specified announcement.
• updateAnnouncement(String, String, Date)—Updates the expiration date of an existing announcement.

Post an announcement or get information about all announcements in a group
The ConnectApi.ChatterGroups class has these new methods for getting and posting announcements:
• getAnnouncements(String, String)—Gets the first page of announcements in a group.
• getAnnouncements(String, String, Integer, Integer)—Gets the specified page of announcements

in a group.
• postAnnouncement(String, String, ConnectApi.AnnouncementInput)—Posts an announcement to

a group.

Get information about a batch of feed items
ConnectApi.ChatterFeeds.getFeedItemBatch(String, List<String>)—Returns information about the
specified list of feed items. Returns a list of BatchResult objects containing ConnectApi.FeedItem objects. Errors
for feed items that can't be loaded are returned in the results.

Get information about a batch of Chatter groups
ConnectApi.ChatterGroups.getGroupBatch(String, List<String>)—Gets information about the specified
list of groups. Returns a list of BatchResult objects containing ConnectApi.ChatterGroup objects. Returns errors
embedded in the results for groups that couldn’t be loaded.

Get information about a batch of Chatter group memberships
ConnectApi.ChatterGroups.getMembershipBatch(String, List<String>)—Gets information about the
specified list of group memberships. Returns a list of BatchResult objects containing ConnectApi.GroupMember
objects. Returns errors embedded in the results for group memberships that couldn’t be accessed.

Get information about a batch of record motifs
ConnectApi.Records.getMotifBatch(String, List<String>)—Gets a motif for the specified list of objects.
Returns a list of BatchResult objects containing ConnectApi.Motif objects. Returns errors embedded in the results
for those users that couldn’t be loaded.

Get information about a batch of Chatter users
ConnectApi.ChatterUsers.getUserBatch(String, List<String>)—Gets information about the specified
list of users. Returns a list of BatchResult objects containing ConnectApi.User objects. Returns errors embedded
in the results for those users that couldn’t be loaded.
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New and Changed Chatter in Apex Input Classes
ConnectApi.AnnouncementInput

This new class represents an announcement. An announcement displays in a designated location in the Salesforce UI
until 11:59 p.m. on its expiration date, unless it’s deleted or replaced by another announcement.

It has these properties:
• body—Text of the announcement.
• expirationDate—The Salesforce UI displays an announcement until 11:59 p.m. on this date unless another

announcement is posted first. The Salesforce UI ignores the time value in the expirationDate. However, you
can use the time value to create your own display logic in your own UI.

ConnectApi.ChatterGroupInput

This class has a new announcement property, which is the 18-character ID of an announcement. An announcement
displays in a designated location in the Salesforce UI until 11:59 p.m. on its expiration date, unless it’s deleted or replaced
by another announcement.

ConnectApi.FeedElementInput

Feed elements are the top-level items that a feed contains. Feeds are feed element containers.

This class is abstract. It’s a superclass of ConnectApi.FeedItemInput and has these properties:
• feedElementType—The type of feed element this input represents. The only possible value is FeedItem.
• subjectId—The ID of the parent this feed element is being posted to. This value can be the ID of a user, group,

or record, or the string me to indicate the logged-in user.

ConnectApi.FeedItemInput

This class now inherits from ConnectApi.FeedElementInput.

New and Changed Chatter in Apex Output Classes
ConnectApi.AbstractBundleCapability

If a feed element has this capability, it can be a container of feed elements called a bundle.

This class is a subclass of ConnectApi.FeedElementCapability.

This class has these properties:
• bundleType—Defines this feed element's bundle type. The bundle type determines what additional information

appears in the bundle.
• feedElements—A collection of feed elements.
• totalElements—The total number of feed elements that this bundle aggregates.

ConnectApi.Announcement

An announcement displays in a designated location in the Salesforce UI until 11:59 p.m. on its expiration date, unless
it’s deleted or replaced by another announcement.

This new class has these properties:
• expirationDate—The Salesforce UI displays an announcement until 11:59 p.m. on this date unless another

announcement is posted first. The Salesforce UI ignores the time value in the expirationDate. However, you
can use the time value to create your own display logic in your own UI.

• feedElement—The feed element that contains the body of the announcement and its associated comments, likes,
and so on.

• id—18-character ID of the announcement.
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ConnectApi.AnnouncementPage

A collection of announcements.

This new class has these properties:
• announcements—A collection of ConnectApi.Announcement objects.
• currentPageUrl—Chatter REST API URL identifying the current page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• previousPageUrl—Chatter REST API URL identifying the previous page or null if there isn’t a previous page.

ConnectApi.BannerCapability

If a feed element has this capability, it has a banner motif and style.

This class is a subclass of ConnectApi.FeedElementCapability.

This class has these properties:
• motif—A ConnectApi.Motif object.
• style—A ConnectApi.BannerStyle enum specifying the color and icon set of the banner.

ConnectApi.BatchResult

Calls to batch methods return a list of BatchResult objects. Each element in the BatchResult list corresponds to
the strings in the list parameter passed to the batch method. The first element in the BatchResult list matches the
first string passed in the list parameter, the second element corresponds with the second string, and so on. If only one
string is passed, the BatchResult list contains a single element.

This new output class has these instance methods:
• getError()—If an error occurred, returns a ConnectApi.ConnectApiException object providing the error

code and description.
• getErrorMessage()—Returns a String that contains an error message.
• getErrorTypeName()—Returns a String that contains the name of the error type.
• getResult()—Returns an object that contains the results of the batch operation. The object is typed according to

the batch method. For example, if you call getMembershipBatch(), a successful call to BatchResult getResult()
returns a ConnectApi.GroupMembership object.

• isSuccess()—Returns a Boolean that is set to true if the batch operation was successful for this object, false
otherwise.

ConnectApi.BookmarksCapability

If a feed element has this capability, the logged-in user can bookmark it.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.Bundle

A bundle is a feed element that is a container of feed elements.

This class is a subclass of ConnectApi.FeedElement.

This class has these properties:
• bundleType—Specifies the type of bundle. One of these values:

◊ GenericBundle—A bundle that contains no additional information and is just a collection of feed elements.
◊ TrackedChanges—A bundle that represents a collection of feed tracked changes. The bundle includes summary

information about the feed tracked changes that make up the bundle.
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ConnectApi.ChatterGroup

This class has these new properties:
• announcement—A ConnectApi.Announcement object
• lastFeedElementPostDate—ISO8601 date string, for example, 2011-02-25T18:24:31.000Z, of the most recent

feed element posted to the group

Use lastFeedElementPostDate instead of lastFeedItemPostDate, which is not supported in API versions 31.0
and later.

ConnectApi.ChatterLikesCapability

If a feed element has this capability, the logged-in user can like it.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.CommentsCapability

If a feed element has this capability, the logged-in user can add a comment to it.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.Community

This output class has these new properties:
• allowChatterAccessWithoutLogin—Specifies if guest users can access public groups in the community without

logging in.
• reputationEnabled—Specifies whether reputation is calculated and displayed for members of the community.

ConnectApi.ContentAttachment

This output class has a new contentUrl property, which specifies the URL of the content if it’s a link or a Google
Doc; otherwise the property returns null.

ConnectApi.File

This class has one new property, isMajorVersion, which is true if the file is a major version; false if the file is a
minor version. Major versions can’t be replaced.

ConnectApi.Features

This output class has a new communitiesEnabled property, which specifies whether Salesforce Communities is
enabled.

ConnectApi.Feed

This class has these new properties:

• feedElementPostUrl—Chatter REST API URL for posting feed elements to this subject.
• feedElementsUrl—Chatter REST API URL of feed elements.

ConnectApi.FeedDirectoryItem

This class has one new property, feedElementsUrl, which is a Chatter REST API resource URL for the feed elements.

ConnectApi.FeedElement

Feed elements are the top-level items that a feed contains. Feeds are feed element containers.

This class has these properties:
• body—Information about the feed element.
• capabilities—A container for all capabilities that can be included with a feed element.
• createdDate—The date the feed element was created. An ISO 8601 format date string, for example,

2011-02-25T18:24:31.000Z.
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• feedElementType—Feed elements are the top-level objects that a feed contains. The feed element type describes
the characteristics of that feed element. One of these values:

◊ Bundle—A container of feed elements. A bundle also has a body made up of message segments that can always
be gracefully degraded to text-only values.

◊ FeedItem—A feed item has a single parent and is scoped to one community or across all communities. Feed
items can have comments, likes, and topics. Depending on the feed item type, a feed item can have an attachment
of additional information (a poll, file, dashboard, and so on). Feed items have a body made up of message segments
that can always be gracefully degraded to text-only values.

• header—The header is the title of the post. This property contains renderable plain text for all the segments of the
message. If a client doesn’t know how to render a feed element type, it should render this text.

• id—18-character ID of the feed element.
• modifiedDate—The date the feed element was last modified. An ISO 8601 format date string, for example,

2011-02-25T18:24:31.000Z.
• parent—A ConnectApi.ActorWithId object representing the feed element’s parent.
• relativeCreatedDate—The created date formatted as a relative, localized string, for example, “17m ago” or

“Yesterday.”
• url—Chatter REST API URL to the feed element.

ConnectApi.FeedElementCapabilities

A container for all capabilities that can be included with a feed element.

This class has these properties:
• banner—If a feed element has this capability, it has a banner motif and style.
• bookmarks—If a feed element has this capability, the logged-in user can bookmark it.
• bundle—If a feed element has this capability, it can be a container of feed elements called a bundle.
• chatterLikes—If a feed element has this capability, the logged-in user can like it.
• comments—If a feed element has this capability, the logged-in user can add a comment to it.
• moderation—If a feed element has this capability, users in a community can flag it for moderation.
• poll—If a feed element has this capability, it can include a poll.
• questionAndAnswers—If a feed element has this capability, users can answer questions on the feed element

instead of commenting.
• topics—If a feed element has this capability, the logged-in user can add topics to it. Topics help users organize

and discover conversations.

ConnectApi.FeedElementCapability

A feed element capability, which defines the characteristics of a feed element.

In API versions 30.0 and earlier, every feed item supported comments, likes, topics, and so on. In versions 31.0 and
later, every feed item (and feed element) can have a unique set of capabilities. If a capability property exists on a feed
element, that capability is available, even if the capability property doesn’t have a value. For example, if the ChatterLikes
capability property exists on a feed element (with or without a value), the logged-in user can like that feed element. If
the capability property doesn’t exist, it isn’t possible to like that feed element. A capability can also contain associated
data. For example, the Moderation capability contains data about moderation flags.

This class is abstract and is a superclass of:
• ConnectApi.AbstractBundleCapability

• ConnectApi.BannerCapability

• ConnectApi.BookmarksCapability

• ConnectApi.ChatterLikesCapability

• ConnectApi.CommentsCapability

• ConnectApi.ModerationCapability
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• ConnectApi.PollCapability

• ConnectApi.QuestionAndAnswersCapability

• ConnectApi.TopicsCapability

ConnectApi.FeedElementPage

A paged collection of ConnectApi.FeedElement objects.

This class has these properties:
• currentPageToken—Token identifying the current page.
• currentPageUrl—Chatter REST API URL identifying the current page.
• elements—A collection of feed elements.
• isModifiedToken—An opaque polling token to use in the since parameter of the ChatterFeeds.isModified

method. The token describes when the feed was last modified.
• isModifiedUrl—A Chatter REST API URL with a since request parameter that contains an opaque token that

describes when the feed was last modified. Returns null if the feed isn’t a news feed. Use this URL to poll a news
feed for updates.

• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• updatesToken—A token to use in a request to the

ConnectApi.ChatterFeeds.getFeedElementsUpdatedSince method.
• updatesUrl—A Chatter REST API feed resource containing the feed elements that have been updated since the

feed was refreshed. If the feed doesn’t support this feature, the value is null.

ConnectApi.FeedItem

This class now inherits from ConnectApi.FeedElement.

These properties have been moved to ConnectApi.FeedElement:
• ConnectApi.FeedItem.body

• ConnectApi.FeedItem.createdDate

• ConnectApi.FeedItem.id

• ConnectApi.FeedItem.modifiedDate

• ConnectApi.FeedItem.parent

• ConnectApi.FeedItem.relativeDate

• ConnectApi.FeedItem.url

The moderationFlags property is not supported in API versions 31.0 and later. Moderation flags are now available
in the ConnectApi.ModerationCapability object, which you can access from the
ConnectApi.FeedElement.capabilities property.

The preamble property has been moved to ConnectApi.FeedElement and renamed header. Use the
ConnectApi.FeedElement.header property as the default case for rendering text.

ConnectApi.GenericBundleCapability

If a feed element has this capability, the feed element may be a group of other feed elements condensed into one feed
element. This group is called a bundle.

This class is a subclass of ConnectApi.AbstractBundleCapability.

ConnectApi.GroupMember

This class has a new lastFeedAccessDate property, which is the date on which the group member last accessed the
group feed.
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ConnectApi.ModerationCapability

If a feed element has this capability, it can include a poll.

This class is a subclass of ConnectApi.FeedElementCapability.

This class has one property, moderationFlags, which is a ConnectApi.ModerationFlags object describing the
flags associated with this feed element. Community moderators can view and take action on flagged feed elements.

ConnectApi.PollCapability

If a feed element has this capability, it can include a poll.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.QuestionAndAnswersCapability

If a feed element has this capability, users can answer questions on the feed element instead of commenting.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.TopicsCapability

If a feed element has this capability, the logged-in user can add topics to it. Topics help users organize and discover
conversations.

This class is a subclass of ConnectApi.FeedElementCapability.

ConnectApi.TrackedChangeBundleCapability

If a feed element has this capability, it can be a group of other feed elements aggregated into one feed element called a
bundle. This type of bundle aggregates feed tracked changes.

This class is a subclass of ConnectApi.AbstractBundleCapability.

In addition to the property it inherits, this class has one property, changes, which is a List of
ConnectApi.TrackedChangeItem objects.

ConnectApi.User

If a community allows access without logging in, the value of the companyName and title properties is null for guest
users.

ConnectApi.UserDetail

This class has a new hasChatter property, which is true if the user has access to Chatter.

ConnectApi.UserSettings

This class has a new hasChatter property, which is true if the user has access to Chatter.

New and Changed Chatter in Apex Enums
ConnectApi.BannerStyle

Decorates a feed item with a color and set of icons.
• Announcement—An announcement displays in a designated location in the Salesforce UI until 11:59 p.m. on its

expiration date, unless it’s deleted or replaced by another announcement.

ConnectApi.BundleType

Specifies the type of bundle.
• GenericBundle—A bundle that contains no additional information and is just a collection of feed elements.
• TrackedChanges—A bundle that represents a collection of feed tracked changes. The bundle includes summary

information about the feed tracked changes that make up the bundle.
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ConnectApi.FeedElementCapabilityType

Specifies the capabilities of a feed element in API versions 31.0 and later. If a capability exists on a feed element, the
capability is available. If the capability doesn’t exist, it isn’t available.
• AssociatedActions—Reserved for future use.
• Banner—The body of the feed element has an icon and border.
• Bookmarks—The logged-in user can bookmark the feed element. Bookmarked feed elements are visible in the

bookmarks feed.
• Bundle—The feed element can be a group of other feed elements that display as a bundle in the feed. The bundle

type determines the additional data associated with the bundle.
• ChatterLikes—The logged-in user can like the feed element.
• Comments—The logged-in user can add comments to the feed element.
• Moderation—Users in a community can flag the feed element for moderation.
• Poll—The feed element supports poll voting.
• QuestionAndAnswers—Users can add answers to the feed element instead of comments. Users can also select the

best answer.
• Topics—The logged-in user can add topics to the feed element.

ConnectApi.FeedElementType

Feed elements are the top-level objects that a feed contains. The feed element type describes the characteristics of that
feed element.
• Bundle—A container of feed elements. A bundle also has a body made up of message segments that can always be

gracefully degraded to text-only values.
• FeedItem—A feed item has a single parent and is scoped to one community or across all communities. Feed items

can have comments, likes, and topics. Depending on the feed item type, a feed item can have an attachment of
additional information (a poll, file, dashboard, and so on). Feed items have a body made up of message segments
that can always be gracefully degraded to text-only values.

ConnectApi.FeedItemType

This enum has a these new values:
• AdvancedTextPost—A text post with advanced formatting, such as a group announcement.
• ProfileSkillPost—Feed item generated when a skill is added to a user's profile.

API
Use the API to create applications that integrate with Salesforce. We've made improvements in API version 31.0.

Developer Edition Changes

Use Developer Edition organizations to develop Force.com applications.

New and Changed Objects

API objects represent database tables that contain your organization's information.

REST API

Use REST API to interact with Force.com data.

SOAP API

Use SOAP API to interact with Force.com data.
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Chatter REST API

Use Chatter REST API to integrate mobile apps, intranet sites, and third party Web applications with Chatter.

Data.com API

The Data.com APIs provide access to the most up-to-date Data.com records. You can search, match, and purchase company
and contact records.

Bulk API

Use Bulk API to work with large sets of records.

Tooling API

Use Tooling API to build custom development tools for Salesforce applications.

Metadata API

Use the Metadata API to manage customization information, such as custom object definitions and page layouts, for your
organization.

Salesforce Console API (Integration Toolkit)

The toolkit includes new methods that let you customize a console’s navigation tab and interaction log programmatically.

Open CTI API

Open CTI includes a new method that lets you retrieve phone numbers from a Salesforce call center’s directory.

Analytics Dashboards API

Use the Analytics Dashboards API to integrate Salesforce dashboard data into your applications programmatically.

Developer Edition Changes
Use Developer Edition organizations to develop Force.com applications.

Increased API limits

The maximum number of API requests for a Developer Edition organization has been increased from 5,000 to 15,000.

New and Changed Objects
API objects represent database tables that contain your organization's information.

New Objects

These objects are new in API version 31.0.

Changed Objects

These objects have changed in API version 31.0.

New Objects
These objects are new in API version 31.0.
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CustomPermission

Represents a permission created to control access to a custom process or app, such as sending email. Custom permissions
are currently available as a developer preview.

KnowledgeableUser

Represents a user identified as knowledgeable about a specific topic, and ranks them relative to other knowledgeable
users.

MetricsDataFile

Represents a data file containing usage metrics on all installations of a managed package in a Salesforce instance.

ObjectTerritory2AssignmentRule

Represents a territory assignment rule that’s associated with an object, such as Account.
ObjectTerritory2AssignmentRuleItem can only be created or deleted if the BooleanFilter field on its corresponding
ObjectTerritory2AssignmentRule is null. Available only if Territory Management 2.0 has been enabled for your
organization.

ObjectTerritory2AssignmentRuleItem

A single row of selection criteria for an ObjectTerritory2AssignmentRule object. ObjectTerritory2AssignmentRuleItem
can only be created or deleted if the BooleanFilter field on its corresponding ObjectTerritory2AssignmentRule
object is a null value. Available only if Territory Management 2.0 has been enabled for your organization.

ObjectTerritory2Association

Represents an association (by assignment) between a territory and an object record, such as an account. Available only
if Territory Management 2.0 has been enabled for your organization.

PackageLicense

Represents a license for an installed managed package.

ProfileSkill

Represents a profile skill, which describes a user’s professional knowledge. This is a global record for the organization,
and users are associated through the ProfileSkillUser object.

RuleTerritory2Association

Represents a record-assignment rule and its association to an object, such as Account. Available only if Territory
Management 2.0 has been enabled for your organization.

Territory2

Represents a sales territory. Available only if Territory Management 2.0 has been enabled for your organization.

Territory2Model

Represents a territory model. Available only if Territory Management 2.0 has been enabled for your organization.

Territory2ModelHistory

Represents the history of changes to the values in the fields on a territory model. Available only if Territory Management
2.0 has been enabled for your organization.

Territory2Type

Represents a category for territories (Territory2). Every Territory2 must have a Territory2Type. Available only if Territory
Management 2.0 has been enabled for your organization.
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UserConfigTransferButton

Represents the association between a Live Agent configuration and a live chat button. This association allows users
associated with a specific configuration to transfer chats to a button queue.

UserConfigTransferSkill

Represents the association between a Live Agent configuration and a skill. This association allows users associated with
a specific configuration to transfer chats to agents who have that skill.

UserPackageLicense

Represents a license for an installed managed package, assigned to a specific user.

UserTerritory2Association

Represents an association (by assignment) between a territory and a user record. Available only if Territory Management
2.0 has been enabled for your organization.

WorkRewardFundType

Represents the type of WorkRewardFund object.

WorkRewardFundTypeHistory

Represents the history of changes to the values in the fields of a WorkRewardFundType object.

WorkRewardFundTypeShare

Represents a sharing entry on a WorkRewardFundType.

Changed Objects
These objects have changed in API version 31.0.

Changed Objects That Affect Earlier API Versions

These objects have changed in API version 31.0 and affect earlier API versions.

AccountTerritoryAssignmentRuleItem
The AccountTerritoryAssignmentRuleItem object can now be created or deleted if the BooleanFilter field on its
corresponding AccountTerritoryAssignmentRule object is a null value.

PermissionSet and Profile
The following user permissions, which were previously available only in the Salesforce user interface, are now available
in the API.
• PermissionsActivateContract
• PermissionsActivateOrder
• PermissionsDataExport
• PermissionsDeleteActivatedContract
• PermissionsEditBrandTemplates
• PermissionsEditHtmlTemplates
• PermissionsEditPublicTemplates
• PermissionsEmailMass
• PermissionsEmailSingle
• PermissionsExportReport
• PermissionsImportPersonal
• PermissionsManageTranslation
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Note:  Availability of specific permissions depends on the organization edition and user licenses.

Changed Objects That Don’t Affect Earlier API Versions

These objects have changed in API version 31.0 and the changes do not affect earlier API versions.

ActivityHistory
The ActivityHistory object has the following new field: IsHighPriority.

Account
The Account object has the following new fields. Contact salesforce.com Customer Support to enable these fields.
• MiddleName (beta)
• Suffix (beta)

AttachedContentDocument
The AttachedContentDocument object has the following new fields.
• ContentUrl

• FileExtension

BusinessHours
The BusinessHours object has the following new field: BusinessHoursId.

Contact
The Contact object has the following new fields. Contact salesforce.com Customer Support to enable these fields.
• MiddleName (beta)
• Suffix (beta)

CollaborationGroupMember
The CollaborationGroupMember object has the following new field: LastFeedAccessDate.

CombinedAttachment
The CombinedAttachment object has the following new fields.
• ContentUrl

• FileExtension

ContentDocument

ContentDocument now supports the describeLayout() call.

The ContentDocument object has the following new fields.

• ContentSize

• Description

• FileExtension

• FileType

ContentVersion
The ContentVersion object has the following new field: FileExtension.
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ContentVersionHistory
The Field field on the ContentVersionHistory object has the following new picklist value:
contentVersionDataReplaced.

Event
The following labels were added to the ClientGuid field and the the IsClientManaged field respectively: Client GUID
and Is Client Managed.

The description of the AccountId field was expanded to clarify how Salesforce determines the related account on an
event.

FieldHistoryArchive
The FieldHistoryArchive object has the following new field: FieldHistoryType.

Lead
The Lead object has the following new fields. Contact salesforce.com Customer Support to enable these fields.
• MiddleName (beta)
• Suffix (beta)

LiveChatUserConfig
The LiveChatUserConfig object has the following new field: OptionsHasChatTransfer.

LoginHistory
The LoginHistory object has the following new field: NetworkId.

Name
The Name object has the following new fields. Contact salesforce.com Customer Support to enable these fields.
• MiddleName (beta)
• Suffix (beta)

Network
The Network object has the following new fields:
• OptionsGuestChatterEnabled

• OptionsReputationEnabled

OpenActivity
The OpenActivity object has the following new field: IsHighPriority.

Organization
The Organization object has the following new read-only fields.
• InstanceName

• IsSandbox

OwnedContentDocument
The OwnedContentDocument object has the following new fields.
• ContentUrl

• FileExtension

PricebookEntry
The PricebookEntry object now supports the describeLayout() call.
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SetupEntityAccess
In Developer Edition only, the SetupEntityType field now includes the value CustomPermission.

Task
The following field was added: IsHighPriority.

The description of the AccountId field was expanded to clarify how Salesforce determines the related account on a task.

New Type field picklist values
The AdvancedTextPost, QuestionPost, and ProfileSkillPost picklist values were added to the Type field of
the following objects:
• AccountFeed
• AssetFeed
• CampaignFeed
• CaseFeed
• CollaborationGroupFeed
• ContentDocumentFeed
• ContractFeed
• DashboardComponentFeed
• DashboardFeed
• EntitlementFeed
• EventFeed
• FeedItem
• LeadFeed
• OpportunityFeed
• Product2Feed
• ProfileSkillFeed
• ReportFeed
• ServiceContractFeed
• SolutionFeed
• TaskFeed
• TopicFeed
• UserFeed
• WorkCoachingFeed
• WorkGoalFeed
• WorkPerformanceCycleFeed

User
The User object has the following new fields. Contact salesforce.com Customer Support to enable these fields.
• MiddleName (beta)
• Suffix (beta)

The UserPreferencesDisableCoachingEmail field was removed from the User object.

UserProfile
The following fields were removed from the UserProfile object.
• UserPreferencesDisableCoachingEmail

• UserPreferencesOptOutOfTouch
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WorkBadgeDefinition
The WorkBadgeDefinition object has the following new fields.
• IsLimitPerUser

• LimitNumber

• LimitStartDate

• NetworkId

WorkCoaching
The object attribute searchable has changed to true.

WorkFeedback
The RequestId field’s updateable property has changed to false.

WorkGoal
The WorkGoal object has the following new fields.
• OverallStatus

• Weight

WorkReward
The WorkReward object has the following new fields.
• RewardFundTypeId

• Value

WorkRewardFund
The Type field’s nillable property has changed to true. Additionally, the WorkRewardFund object has the following
new fields.
• IsActive

• RewardFundTypeId

REST API
Use REST API to interact with Force.com data.

New Resources
Search Suggested Queries (Generally Available)

vXX.X/search/suggestSearchQueries?q=search string&language=language of query

Returns a list of suggested searches based on the user’s query string text matching searches that other users have performed
in Salesforce Knowledge. Provides a way to improve search effectiveness, before the user performs a search.

SObject Named Layouts
vXX.X/sobjects/Object/describe/namedLayouts/layoutName

Retrieves information about alternate named layouts for a given object.

Tabs
/vXX.X/tabs/

Returns a list of all tabs—including Flexible Page tabs—available to the current user, regardless of whether the user has
chosen to hide tabs via the All Tabs (+) tab customization feature.
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Changed Resources
Process Rules Restriction Removed

The contextId in a POST method invocation can now use either a 15-character or 18-character ID.

Bulk Fetch Now Available for Compact Layouts
Up to 100 objects can be fetched in one query. For example, to get the primary compact layouts for Account, Contact,
and a custom object, the request is:

/services/data/v31.0/compactLayouts?q=Account,Contact,CustomObj__c

SOAP API
Use SOAP API to interact with Force.com data.

New Calls
These calls are new in API version 31.0.

describeAllTabs()

Returns information about all the tabs—including Flexible Page tabs—available to the logged-in user, regardless of
whether the user has chosen to hide tabs in his own user interface via the All Tabs (+) tab customization feature.

describePrimaryCompactLayouts()

Retrieves metadata about the primary compact layout for each of the specified object types.

Changed Calls
These calls have changed in API version 31.0.

describeLayout(), DescribeLayoutResult, and associated types
We added 15 new fields to DescribeLayoutButton, and the following sub-types to support them:
• WebLinkPosition—Represents the window position for a new window opened upon clicking a DescribeLayoutButton
• WebLinkType—Represents the content being delivered by the custom button.
• WebLinkWindowType—Represents the behavior for a DescribeLayoutButton.

The editable field under DescribeLayoutItem has been removed, and its functionality has been replaced with two
new DescribeLayoutItem fields:
• editableForNew—Indicates whether a new DescribeLayoutItem can be edited when creating a new record (true)

or not (false).
• editableForUpdate—Indicates whether an existing DescribeLayoutItem can be edited when editing a record

(true) or not (false).

The following field has been added to the DescribeLayoutSection subtype:
• tabOrder—Indicates the tab order for the item in the row.

The following type was added to LayoutComponentType:
• Canvas—A canvas component on the page layout.

The following subtype has been added:
• DescribeLayoutCustomLinkSection—Custom link(s) associated with the specified custom link section.
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Added a new LayoutComponentType, CustomLink, and a new subtype to go with it:
• CustomLinkComponent—When the LayoutComponentType value is CustomLink, this type contains information

about a single custom link on the page layout.

Added a new subtype, FieldLayoutComponent—Extends the information returned by DescribeLayoutComponent.
When the LayoutComponentType value is Field, and the field being described is an Address or Person Name field,
FieldLayoutComponent includes information about the field’s components.

Added a new argument to describeLayout():
• layoutName—The specified value must be a valid named layout for this object. Layout names are obtained from

namedLayoutInfos in DescribeSObjectResult. The entity name is not valid because the primary layout is not
considered “named.”

describeSObjects() and DescribeSObjectResult

• The filteredLookupInfo field was added to the Field subtype. If the field is a reference field type with a
lookup filter, filteredLookupInfo contains the lookup filter information for the field. If there is no lookup filter,
or the filter is inactive, this field is null.

• The FilteredLookupInfo subtype was added.
• The namedLayoutInfos field was added. The specific named layouts that are available for the objects other than

the default layout.
• The NamedLayoutInfo subtype was added.

New Objects
These objects are new in API version 31.0.

ProcessDefinition
Represents the definition of a single, end-to-end approval process. This is the basis for the configuration of an approval
process.

ProcessDefinition has the following fields.

DescriptionTypeField Name

A description of this process, to a maximum of 3,000 characters.stringDescription

The external name of the process; the name seen by users.stringDeveloperName

The type of lock applied to the record being approved. When a record
is in the approval process, it’s always locked, and only an administrator

picklistLockType

can edit it. However, the currently assigned approver can also be allowed
to edit the record.
• Total
• Admin
• Owner
• Workitem
• Node
• none

The unique process name, used internally.stringName

The current state of this process.picklistState
• Active
• Inactive
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DescriptionTypeField Name

• Obsolete

Reserved for future use.picklistTableEnumOrId

The type of this process.picklistType
• Approval Process—Used to control the action taken for a record.
• State-based Process—Used internally to track various control

processes, such as for developing Salesforce Knowledge articles.

ProcessInstanceNode
Represents a step in an instance of a single, end-to-end approval process.

ProcessInstanceNode has the following fields.

DescriptionTypeField Name

The completion date and time of this step in the approval process. The
ElapsedTimeDay, ElapsedTimeHours, and ElapsedTimeMinutes
field values are calculated using CompletedDate.

dateTimeCompletedDate

The total time in days since this step was started.doubleElapsedTimeInDays

The total time in hours since this step was started.doubleElapsedTimeInHours

The total time in minutes since this step was started.doubleElapsedTimeInMinutes

The last actor that approved or rejected this step.referenceLastActorId

The status of this approval instance, for example Started, Pending, or
Approved.

picklistNodeStatus

The approval process this step is part of.referenceProcessInstanceId

The identifier for this step.referenceProcessNodeId

The name of this step.stringProcessNodeName

ProcessNode
Describes a step in a process definition when the process is set up.

ProcessNode has the following fields.

DescriptionTypeField Name

A description of this node, to a maximum of 3,000 characters.stringDescription

The external name of the process; the name seen by users.stringDeveloperName

The unique node name, used internally.stringName

ID of the object affected by this approval instance.referenceProcessDefinition

Changed Objects
These objects have been changed in API version 31.0.
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ProcessInstance
ProcessInstance has new fields.

DescriptionTypeField Name

The total elapsed time in days between when the approval process instance
was started and the current time.

doubleElapsedTimeInDays

The total elapsed time in hours between when the approval process
instance was started and the current time.

doubleElapsedTimeInHours

The total elapsed time in minutes between when the approval process
instance was started and the current time.

doubleElapsedTimeInMinutes

The last actor that approved, rejected, or recalled the process.referenceLastActorId

The ID of this approval process instance.referenceProcessDefinitionId

ProcessInstanceHistory
ProcessInstanceHistory has new fields.

DescriptionTypeField Name

The total elapsed time in days between when the approval process instance
was started and the current time.

doubleElapsedTimeInDays

The total elapsed time in hours between when the approval process
instance was started and the current time.

doubleElapsedTimeInHours

The total elapsed time in minutes between when the approval process
instance was started and the current time.

doubleElapsedTimeInMinutes

ProcessInstanceStep
ProcessInstanceStep has new fields.

DescriptionTypeField Name

The total time in days since this step was started.doubleElapsedTimeInDays

The total time in hours since this step was started.doubleElapsedTimeInHours

The total time in minutes since this step was started.doubleElapsedTimeInMinutes

ID of the node currently assigned to this approval step.referenceStepNodeId

ProcessInstanceWorkitem
ProcessInstanceWorkitem has new fields.

DescriptionTypeField Name

The total time in days since this approval request was started.doubleElapsedTimeInDays

The total time in hours since this approval request was started.doubleElapsedTimeInHours

The total time in minutes since this approval request was started.doubleElapsedTimeInMinutes
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Approval History Data Limitations
For the new object ProcessInstanceNode and the changed objects ProcessInstance, ProcessInstanceHistory, ProcessInstanceStep,
and ProcessInstanceWorkitem, additional exceptions apply to approval history data that is available only via the SOAP API.
For each approval process instance that was pending when Summer ’14 became available for your organization, some field
values are never populated or are populated only after the approval process instance is next acted upon—such as when a user
approves, rejects, or reassigns an approval request—after the Summer ’14 rollout.

When Fields are PopulatedObject

For approval process instances that were completed before the Summer ’14 rollout, all
Process Instance fields are automatically populated, with one exception: CompletedDate

ProcessInstance

is never populated for approval process instances that were completed before January 1,
2013.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstance fields are automatically populated, with two exceptions: CompletedDate
and LastActorId are populated only after the approval process instance is complete.

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceNode fields are populated only after the approval process instance is next
acted upon after the Summer ’14 rollout.

ProcessInstanceNode

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceStep fields are populated only after the approval process instance is next
acted upon after the Summer ’14 rollout.

ProcessInstanceStep

Never populated for approval process instances that were completed before the Summer
’14 rollout.

For approval process instances that were pending during the Summer ’14 rollout, all
ProcessInstanceWorkitem fields are populated after the approval process instance is next

ProcessInstanceWorkitem

acted upon after the Summer ’14 rollout, with three exceptions: ElapsedTimeInDays,
ElapsedTimeInHours, and ElapsedTimeInMinutes fields are never populated in
ProcessInstanceWorkitem records for which equivalent ProcessInstanceStep records
were created before the Summer ’14 rollout.

For all other ProcessInstanceWorkitem records, these three fields are populated after the
approval process instance is next acted upon after the Summer ’14 rollout.

Note:  Because ProcessInstanceHistory combines fields from ProcessInstanceStep
and ProcessInstanceWorkitem, you may notice incorrect elapsed times of 0 in
ProcessInstanceHistory records because the elapsed time fields were never
populated in the related ProcessInstanceWorkitem record.

Chatter REST API
Use Chatter REST API to integrate mobile apps, intranet sites, and third party Web applications with Chatter.
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Note:  To create custom Chatter experiences in Salesforce, use Chatter in Apex (ConnectApi).

General Updates to Chatter REST API
New and Changed Resources
New and Changed Request Bodies
New and Changed Response Bodies

General Updates to Chatter REST API
Documentation indicates whether a resource requires Chatter

Each resource in the Chatter REST API Developer’s Guide has a section indicating whether or not the resource requires
the user making the request to have access to Chatter. To verify that the user has access, check the hasChatter property
of the User Details or the User Settings response bodies.

Resource-specific request parameters are ignored when a request includes a request body
When you make a request that includes resource-specific request parameters and a request body, the resource-specific
request parameters are ignored. For example, the originalFeedElementId parameter in this request is ignored and
the request body is processed:

POST /chatter/feed-elements?originalFeedElementId=0D5D0000000XZlc

{
"body" : {

"messageSegments" : [
{

"type" : "Text",
"text" : "When should we meet for release planning?"

},
{

"type" : "Mention",
"id" : "005D00000016Qxp"

}]
},

"feedElementType" : "FeedItem",
"subjectId" : "0F9D00000000oOd"

}

Request parameters that are not specific to a resource are processed along with the request body. Examples are parameters
in bearer token URLs and the _HttpMethod parameter.

New bearer token URLs for feed elements
The Feed response body returns bearer token URLs for these new properties:
• feedElementPostUrl

• feedElementsUrl

To return the Feed response body, make a request to these resources with the request header X-Connect-Bearer-Urls:
true:
• /chatter/feeds/feedType

• /chatter/feeds/feedType/subjectId

• /chatter/feeds/filter/subjectId/keyPrefix
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Note:  Use bearer token URLs as they are. Don’t add or remove parameters from a bearer token URL or you’ll
receive an error.

New and Changed Resources

Action Links (Pilot)

Note: Action links are available through a pilot program and only in the Salesforce1 mobile browser app. For
information on enabling action links in your organization, contact salesforce.com.

An action link is a URL on a feed item that targets an API, a Web page, or a file. An action link can also include an HTTP
method and OAuth information. Use action links to integrate Salesforce and third-party systems into the feed.

The highlighted buttons are action links:

For more examples of action links, see Add Action Links to Posts (Pilot) on page 80.

Create an action link group definition
An action link group is a collection of mutually exclusive action links with shared properties. For example, you can define
whether an action link group can be executed once, once per user, or an unlimited number of times per user.

To create an action link group definition, make a POST request to the new
/connect/action-link-group-definitions resource. Pass the new Action Link Group Definition Input request
body which includes Action Link Definition Input request bodies defining each action link.
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Post a feed item that is associated with one or more action link groups
To post a feed item that is associated with one or more action link groups, make a POST request to the new
/chatter/feed-elements resource. Pass a Feed Item Input request body and specify the action link group IDs in
the capabilities property.

POST /v31.0/chatter/feed-elements

{
"body": {
"messageSegments": [

{
"type": "Text",
"text": "Change your pictures"

}
]

},
"subjectId": "me",
"feedElementType": "feedItem",
"capabilities": {
"associatedActions": {
"actionLinkGroupIds": ["0AgRR0000004CIL0A2"
]

}
}
}

The action link group IDs are in the response to the POST request to the
/chatter/action-link-group-definitions resource.

Get or delete an action link group definition
To get or delete an action link group definition, use the new
/connect/action-link-group-definitions/actionLinkGroupId resource.

Deleting an action link group definition removes all references to it from feed items and their parents.

All action links must belong to a group. Action links in a group are mutually exclusive and share some properties. Define
stand-alone actions in their own action group. Because information in the action link group definition can be sensitive
to a third party (for example, OAuth bearer token headers), only requests made via the connected app that created the
action link group definition can read or modify the information.

Get information about a specific action link group
To get information about a specific action link group, use the new
/connect/action-link-groups/actionLinkGroupId resource.

Update the status of an action link or get information
To update the status of an action link, make a PATCH request to the new /connect/action-links/actionLinkId
resource. Possible status values are:
• Failed—The action link execution failed.
• Pending—The action link is executing. Choosing this value triggers the API call for Api and ApiAsync action

links.
• Successful—The action link executed successfully.

To get information, make a GET request.

Feed Elements

In API versions 30.0 and earlier, a feed contains feed items. As of API version 31.0, a feed contains feed elements.
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In API version 31.0, a feed element can be a feed item or a bundle. A bundle (or bundled post) contains feed elements and keeps
the feed clean and organized. In Summer ‘14, bundles are collections of feed tracked change feed items in record feeds only
and are supported in the Salesforce1 mobile browser app only. Bundled posts are available through a pilot program. For
information on enabling bundled posts for your organization, contact salesforce.com.

The feed element in this image is a bundle of feed tracked changes for the Acme Inc. account:

1. The header indicating that this bundle contains feed tracked changes for a record.
2. The auxiliary body indicating the changed field and the new and old values.

To see the individual feed tracked change feed items, click on the bundle.

To get bundles, request the new resource /chatter/feeds/record/recordId/feed-elements. When you request
feed items from a feed (for example, using the resource /chatter/feeds/news/me/feed-items), bundles are not returned.

In API versions 30.0 and earlier, every feed item supported comments, likes, topics, and so on. In versions 31.0 and later, every
feed item (and feed element) can have a unique set of capabilities. If a capability property exists on a feed element, that capability
is available, even if the capability property doesn’t have a value. For example, if the ChatterLikes capability property exists
on a feed element (with or without a value), the logged-in user can like that feed element. If the capability property doesn’t
exist, it isn’t possible to like that feed element. A capability can also contain associated data. For example, the Moderation
capability contains data about moderation flags.

The Feed Item response body and the Bundle response body have new capabilities properties, which contain the capabilities
of that feed element.

Tip:  The feed-items resources are still supported, but to future-proof your applications, use the new
feed-elements resources instead. For example, as of API version 31.0, the only feed element types are feed item
and bundle, but that could change in future releases.

Get a feed’s feed elements
Make GET requests to these new resources to get the feed elements for a feed. A feed element can be either a feed item
or a bundle, which is a container of other feed elements

• /chatter/feeds/bookmarks/me/feed-elements

• /chatter/feeds/company/feed-elements

• /chatter/feeds/favorites/me/favoriteId/feed-elements

• /chatter/feeds/files/me/feed-elements

• /chatter/feeds/filter/me/keyPrefix/feed-elements
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• /chatter/feeds/groups/me/feed-elements

• /connect/communities/communityId/chatter/feeds/moderation/feed-elements

• /chatter/feeds/news/me/feed-elements

• /chatter/feeds/people/me/feed-elements

• /chatter/feeds/record/recordId/feed-elements

• /chatter/feeds/to/me/feed-elements

• /chatter/feeds/topics/topicId/feed-elements

• /chatter/feeds/user-profile/userId/feed-elements

Get feed elements in a bundle
To get feed elements in a bundle, make a GET request to the
/chatter/feed-elements/feedElementId/capabilities/bundle/feed-elements resource.

Post a feed element and search all feed elements
To post a feed element make a POST request to the /chatter/feed-elements resource. Supply the subjectId
as a parameter. You don’t need to supply the feed type or the subject ID in the URL path like you did in earlier API
versions.

To search all the feed elements in an organization, make a GET request.

Get information about or delete a feed element
To get information about or delete a specific feed element, use the /chatter/feed-elements/feedElementId
resource, which supports GET and DELETE.

Get information about multiple feed elements in one request
To get information about multiple feed elements in one request, make a GET request to the
/chatter/feed-elements/batch/feedElementIds resource.

Get a feed element’s capability set
To get a feed element’s capability set, make a GET request to the
/chatter/feed-elements/feedElementId/capabilities resource. A capability set includes all the capabilities
of a feed element.

Get a specific capability
To get information about a specific capability, make a GET request to the
/chatter/feed-elements/feedElementId/capabilities/capabilityType resource.

Get information about the moderation capability, flag a feed element, or delete moderation flags from a feed element
Make a GET request to get information, a POST request to flag a feed element for moderation, or a DELETE request
to the
/connect/communities/communityId/chatter/feed-elements/feedElementId/capabilities/moderation
resource.

Salesforce Files Sync (Generally Available)

Chatter REST API for Salesforce Files Sync is generally available in version 31.0. To use Chatter REST API to work with
files and folders, use these resources.

Move a file to a different folder
Move a file to a different folder using /chatter/files/fileId. These request parameters for POST are no longer
reserved for pilot:
• isDataSync—The request is automatically generated by an automated client.
• isInMyFileSync—true if the file is included in the user’s Salesforce Files folder, and is synced between that

folder and Chatter; false otherwise.
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These request parameters for PATCH are no longer reserved for pilot:

• isInMyFileSync—true if the file is included in the user’s Salesforce Files folder, and is synced between that
folder and Chatter; false otherwise.

• parentFolderId—ID of the containing folder.

Get information about folder, modify, or delete a folder
To get information about a folder, modify or delete a folder, use /chatter/folders/folderId.

Get information about the contents of a folder and add items to a folder
To get information about the contents of a folder and add items to a folder, use /chatter/folders/folderId/items.

Work with users files
These POST parameters for the /chatter/users/me/files/ resource are no longer reserved for pilot:
• isDataSync—The request is automatically generated by an automated client.
• isInMyFileSync—true if the file is included in the user’s Salesforce Files folder, and is synced between that

folder and Chatter; false otherwise.

Other Changes to Chatter REST API Resources

Post a major or minor version of a file
To post a new major or minor version of a file, use either the /chatter/files/fileId resource or the
/chatter/users/userId/files resource, both of which support POST. Major versions can’t be replaced.

Get renditions of a file for preview
To create a rendition of a file for previewing the file’s content, use the /chatter/files/fileId/rendition resource,
which supports GET.

For shared files, renditions process asynchronously after upload. For private files, renditions process when the first file
preview is requested, and aren’t available immediately after the file is uploaded.

Post an announcement to a group
To post an announcement to a group, use the new /chatter/groups/groupId/announcements resource, which
supports GET and POST.

You can also use this resource to get information about all announcements in a group.

An announcement displays in a designated location in the Salesforce UI until 11:59 p.m. on its expiration date, unless
it’s deleted or replaced by another announcement.

Update, get, or delete a group’s announcement
To update an announcement, pass the expirationDate parameter in a PATCH request to the new
/chatter/announcements/announcementId resource.

To get an announcement, make a GET request. To delete an announcement, make a DELETE request.

Send push notifications
To send mobile push notifications, use the new /connect/notifications/push resource, which supports POST.

Send a mobile push notification to connected apps on users’ devices. This resource is only accessible when the session
is established with a connected app that is developed in the same organization or installed in the same package as the
recipient’s connected app.

Filter topic endorsements
Use the new endorseeId and endorserId parameters in GET requests to the Topics, Endorse People resource
(/connect/topics/topicId/endorsements) to filter topic endorsements for or from a specific user.
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Chatter Questions (Beta)

Note:  This release contains a beta version of Chatter Questions that is production quality but has known
limitations. For information on enabling this feature for your organization, contact salesforce.com.

To use Chatter REST API to work with Chatter Questions, use these resources.
• To post a question, make a POST request to the /chatter/feeds/news/userId/feed-items resource using

the Attachment Input: Question request body.
• To get the best answer of a question feed item, make a GET request to the new

/chatter/feed-items/feedItemId/question resource.
• To update the best answer for a question, make a PATCH request to

/chatter/feed-items/feedItemId/question and pass the bestAnswerId parameter or a Feed Question
Input request body.

• To search for question and answers suggestions, make a GET request to the new
/connect/question-and-answers/suggestions resource.

New and Changed Request Bodies
Action Link Definition Input

This new request body is the definition of an action link.

The request body has these properties:
• actionType—Defines the type of action link. One of these values:

◊ Api—The action link calls an API.
◊ ApiAsync—The action link calls an API.
◊ Download—The action link downloads a file.
◊ Ui—The action link takes the user to a user interface.

• actionUrl—The action link URL. For example, for a Ui action link, the URL may be a Web page. For an Api
or ApiAsync action link, the URL may be a REST resource. For a Download action link, the URL is a link to the
file to download. Links to Salesforce can be relative. All other links must be absolute and start with https://.

• excludedUserId—ID of a single user to exclude from performing the action.
• groupDefault—true if this action is the default or primary action link in the action link group; false otherwise.

There can be only one default action link per action link group.
• headers—The request headers for the Api and ApiAsync action link types.
• labelKey—Key for the set of labels to show in the user interface. A set includes labels for these states: new, pending,

success, failed. For example, if you use the Approve key, you get these labels: Approve, Pending, Approved, Failed.
• method—One of these HTTP methods:

◊ Delete—Return HTTP 204 on success. Response body is empty.
◊ Get—Return HTTP 200 on success.
◊ Head—Return HTTP 200 on success. Response body is empty.
◊ Patch—Return HTTP 200 on success or HTTP 204 if the response body is empty.
◊ Post—Return HTTP 201 on success or HTTP 204 if the response body is empty.
◊ Put—Return HTTP 200 on success or HTTP 204 if the response body is empty.

• requestBody—The request body for Api and ApiAsync action link types.
• requiresConfirmation—true if the action results in something that should be confirmed, such as a delete;

false otherwise.
• userId—The ID of the user who can execute the action. If not specified or null, any user can execute the action.
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Action Link Group Definition Input
This new request body is the definition of an action link group.

The request body has these properties:
• actionLinks—A collection of Action Link Definition Input request bodies which are the action links in the group.
• category—Indicates the priority and relative locations of action links. One of these values:

◊ Primary—The action link is displayed in the feed item’s auxiliary body.
◊ Unclassified—The action link is displayed in the drop-down menu at the top right corner of the feed item.

• executionsAllowed—Defines the number of times an action link can be executed. One of these values:

◊ Once—An action link can be executed only once across all users.
◊ OncePerUser—An action link can be executed only once for each user.
◊ Unlimited—An action link can be executed an unlimited number of times by each user. You can’t use this value

if the action link’s actionType is Api or ApiAsync.

• expirationDate—ISO 8601 date string, for example, 2011-02-25T18:24:31.000Z, that represents the date and
time this action group expires and can no longer be executed. The expirationDate must be within one year of
the creation date.

Action Link Input
This new request body describes an action link. It has one property, status, which is the execution status of the action.
One of these values:
• Failed—The action link execution failed.
• Pending—The action link is executing. Choosing this value triggers the API call for Api and ApiAsync action

links.
• Successful—The action link executed successfully.

Announcement Input
This new request body describes an announcement. An announcement displays in a designated location in the Salesforce
UI until 11:59 p.m. on its expiration date, unless it’s deleted or replaced by another announcement.

This request body has these properties:
• body—Text of the announcement.
• expirationDate—The Salesforce UI displays an announcement until 11:59 p.m. on this date unless another

announcement is posted first. The Salesforce UI ignores the time value in the expirationDate. However, you
can use the time value to create your own display logic in your own UI.

Associated Actions Capability Input
This new request body describes action links that can be created or updated on a feed element.

It has one property, actionLinkGroupIds, which is a collection of action link group IDs to associate with the feed
element.

Attachment Input: Question (Beta)
This request body describes a question attachment to a feed item.

It has these properties:
• attachmentType—The attachment type. Must contain the value Question.
• questionTitle—Title of the question.
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Feed Element Capabilities Input
This new request body is a container for capabilities that can be included with a feed element. Capabilities define how
a feed element behaves.

It has one property, associatedActions, which is an Associated Actions Capability Input request body.

Feed Item Input
Feed items are now a type of feed element.

This request body has these new properties:
• capabilities—A Feed Element Capabilities Input request body. The capabilities that define the behavior of the

feed element. In API versions 30.0 and earlier, every feed item supported comments, likes, topics, and so on. In
versions 31.0 and later, every feed item (and feed element) can have a unique set of capabilities. If a capability property
exists on a feed element, that capability is available, even if the capability property doesn’t have a value. For example,
if the ChatterLikes capability property exists on a feed element (with or without a value), the logged-in user can
like that feed element. If the capability property doesn’t exist, it isn’t possible to like that feed element. A capability
can also contain associated data. For example, the Moderation capability contains data about moderation flags.

• feedElementType—The type of feed element this input represents. The only possible value is FeedItem.
• originalFeedElementId—If this feed element is shared, this is the original feed element. Feed elements are the

top-level items that a feed contains. Feeds are feed element containers.
• subjectId—The ID of the parent this feed element is being posted to. This value can be the ID of a user, group,

or record, or the string me to indicate the logged-in user.

The attachment property of this request body supports the Attachment Input: Question request body.

Feed Question Input (Beta)
This new request body describes a feed question.

File Input
This request body has a new isMajorVersion property, which is true if the file is a major version; false if the file
is a minor version. Major versions can’t be replaced.

Group Input
This request body has a new announcement property, which is an announcement ID.

Push Notification Input
This new request body describes a push notification.

The request body has these properties:
• appName—The API name of the connected app that the push notification is sent to.
• namespace—The namespace of the connected app that the push notification is sent to.
• payload—The push notification payload in JSON format.
• userIds—The push notification recipient user ids.

New and Changed Response Bodies
Action Link

An action link instance with state information for the logged-in user.

This new response body has these properties:
• actionLinkGroup—A reference to the action link group containing this action link.
• actionUrl—The action link URL. For an Api or ApiAsync action link, this value is null. For a Ui action link,

the URL may be a Web page. For a Download action link, the URL is a link to the downloadable file.
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• confirmationMessage—If requiresConfirmation is true, this is the default localized confirmation message.
If requiresConfirmation is false, this is null.

• createdDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• diagnosticInfo—Diagnostic information, such as HTTP status codes and error messages, received from Api

and ApiAsync calls.
• executingUser—User who initiated execution of the action link.
• groupDefault—true if this action is the default or primary action link in the action link group; false otherwise.

There can be only one default action link per action link group.
• id—The ID of the action link. The 18-character ID of the action link definition.
• label—The localized label for the action link.
• modifiedDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• quickActionInfo—Reserved for future use
• requiresConfirmation—true if the action results in something that should be confirmed, such as a delete;

false otherwise.
• status—One of these values:

◊ Failed—The action link execution failed.
◊ New—The action link is ready to be executed.
◊ Pending—The action link is executing.
◊ Successful—The action link executed successfully.

• type—One of these values:

◊ Api—The action link calls an API.
◊ ApiAsync—The action link calls an API.
◊ Download—The action link downloads a file.
◊ Ui—The action link takes the user to a user interface.

• url—Chatter REST API URL for the Action Link.

Action Link Definition
This new response body is the definition of an action link. To access this information, request must use the same connected
app that was used to create the action link definition.

It has these properties:
• actionUrl—The action link URL. For example, for a Ui action link, the URL may be a Web page. For an Api

or ApiAsync action link, the URL may be a REST resource. For a Download action link, the URL is a link to the
file to download. Links to Salesforce can be relative. All other links must be absolute and start with https://.

• createdDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• excludedUserId—ID of a single user to exclude from performing the action.
• groupDefault—true if this action is the default or primary action link in the action link group; false otherwise.

There can be only one default action link per action link group.
• headers—The request headers for the Api and ApiAsync action link types.
• id—ID for the action link definition.
• labelKey—Key for the set of labels to show in the user interface. A set includes labels for these states: new, pending,

success, failed. For example, if you use the Approve key, you get these labels: Approve, Pending, Approved, Failed.
• method—One of these HTTP methods:

◊ Delete—Return HTTP 204 on success. Response body is empty.
◊ Get—Return HTTP 200 on success.
◊ Head—Return HTTP 200 on success. Response body is empty.
◊ Patch—Return HTTP 200 on success or HTTP 204 if the response body is empty.
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◊ Post—Return HTTP 201 on success or HTTP 204 if the response body is empty.
◊ Put—Return HTTP 200 on success or HTTP 204 if the response body is empty.

• modifiedDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• requestBody—The request body for Api and ApiAsync action link types.
• requiresConfirmation—true if the action results in something that should be confirmed, such as a delete;

false otherwise.
• type—Defines the type of action link.
• userId—The ID of the user who can execute the action. If not specified or null, any user can execute the action.

Action Link Group
This new response body represents an action link group instance with state appropriate for the logged-in user.

It has these properties:
• actionLinks—A collection of Action Link response bodies, which are the action link instances for this group.
• category—Indicates the priority and relative locations of action links.
• createdDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• executionsAllowed—Defines the number of times an action link can be executed.
• expirationDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z. After this date,

action links in the action link group can’t be executed. If this value is null, there isn’t an expiration date.
• id—ID for the action link group.
• modifiedDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• url—Chatter REST API URL for the Action Link Group.

Action Link Group Definition
The definition of an action link group. All action links must belong to a group. Action links in a group are mutually
exclusive and share some properties. Define stand-alone actions in their own action group. Because information in the
action link group definition can be sensitive to a third party (for example, OAuth bearer token headers), only requests
made via the connected app that created the action link group definition can read or modify the information.

This new response body has these properties:
• actionLinks—A collection of Action Link Definition response bodies that make up the action link group.
• category—Indicates the priority and relative locations of action links. One of these values:

◊ Primary—The action link is displayed in the feed item’s auxiliary body.
◊ Unclassified—The action link is displayed in the drop-down menu at the top right corner of the feed item.

• createdDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• executionsAllowed—One of these values:

◊ Once—An action link can be executed only once across all users.
◊ OncePerUser—An action link can be executed only once for each user.
◊ Unlimited—An action link can be executed an unlimited number of times by each user. You can’t use this value

if the action link’s actionType is Api or ApiAsync.

• expirationDate—ISO 8601 date string, for example, 2011-02-25T18:24:31.000Z, that represents the date and
time this action group expires and can no longer be executed. If the value is null, there isn’t an expiration date.

• id—18-character ID of the Action Link Group Definition.
• modifiedDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.
• url—Chatter REST API URL for the Action Link Group Definition.
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Announcement
This new response body is an announcement. An announcement displays in a designated location in the Salesforce UI
until 11:59 p.m. on its expiration date, unless it’s deleted or replaced by another announcement.

It has these properties:
• expirationDate—The Salesforce UI displays an announcement until 11:59 p.m. on this date unless another

announcement is posted first. The Salesforce UI ignores the time value in the expirationDate. However, you
can use the time value to create your own display logic in your own UI.

• feedElement—The feed element that contains the body of the announcement and its associated comments, likes,
and so on.

• id—18-character ID of the announcement.

Announcement Page
This new response body is a paged collection of Announcement response bodies.

It has these properties:
• announcements—A collection of announcements.
• currentPageUrl—Chatter REST API URL identifying the current page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• previousPageUrl—Chatter REST API URL identifying the previous page or null if there isn’t a previous page.

Article Item
This new response body is an article in question and answer search results. It has these properties:
• id—ID of the article.
• rating—Rating of the article.
• title—Title of the article.
• urlLink—Link URL of the article.
• viewCount—Number of votes given to the article.

Associated Actions Capability
This new response body is information about the action links that can be used on feed elements. It has one property:

• actionLinkGroups–A collection of action link groups associated with a feed element capability.

Banner Capability
If this feed element has this capability, it has a banner motif and style.

This new response body has these properties:
• motif—A Motif response body containing a banner motif.
• style—Decorates a feed item with a color and set of icons. The value is:

◊ Announcement—An announcement displays in a designated location in the Salesforce UI until 11:59 p.m. on
its expiration date, unless it’s deleted or replaced by another announcement.

Bookmarks Capability
If a feed element has this capability, the logged-in user can bookmark it.

This new response body doesn’t have any properties.

Bundle
Bundle is a new response body. A bundle is a feed element that is a container of feed elements.
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This response body contains these properties:
• body—Information about the bundle.
• capabilities—A container for all capabilities that can be included with a feed element.
• bundleType—Specifies the type of bundle. One of these values:

◊ GenericBundle—A bundle that contains no additional information and is just a collection of feed elements.
◊ TrackedChanges—A bundle that represents a collection of feed tracked changes. The bundle includes summary

information about the feed tracked changes that make up the bundle.

• createdDate—The date and time at which the bundle was created. An ISO 8601 format date string, for example,
2011-02-25T18:24:31.000Z.

• feedElementType—Bundles are a type of feed elements. The value of this property is Bundle.
• header—The header is the title of the post. This property contains renderable plain text for all the segments of the

message. If a client doesn’t know how to render a feed element type, it should render this text.
• id—The 18-character ID of the feed element.
• modifiedDate—The date and time at which the bundle was last modified. An ISO 8601 format date string, for

example, 2011-02-25T18:24:31.000Z.
• parent—The parent type. One of these values:

◊ File Summary
◊ Group
◊ Record Summary
◊ User Summary

• relativeCreatedDate—The created date formatted as a relative, localized string, for example, “17m ago” or
“Yesterday.”

• url—URL for this bundle.

Chatter Likes Capability
If a feed element has this capability, the logged-in user can like it and unlike it.

This new response body doesn’t have any properties.

Comments Capability
If a feed element has this capability, the logged-in user can add a comment.

This new response body doesn’t have any properties.

Community
This response body has these new properties:
• allowChatterAccessWithoutLogin—Specifies if guest users can access public groups in the community without

logging in.
• reputationEnabled—Specifies whether reputation is calculated and displayed for members of the community.

Features
This response body has a new communitiesEnabled property which specifies whether Salesforce Communities is
enabled.

Feed
This response body has these new properties:
• feedElementPostUrl—URL for posting feed elements to this subject. When returned by a request that includes

the HTTP header X-Connect-Bearer-Urls: true, the URL includes a bearer token. Use this bearer token
URL to make POST requests.

• feedElementsUrl—URL to a resource of feed elements.
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Feed Directory Item
This response body has a new feedElementsUrl property which is a URL to the resource for the feed elements for a
specific feed. For example, /chatter/feeds/files/me/feed-elements.

Feed Element Capabilities
A container for all capabilities that can be included with a feed element.

This new class has these properties:
• associatedActions—If a feed element has this capability, it has action links associated with it.
• banner—If this feed element has this capability, it has a banner motif and style.
• bookmarks—If a feed element has this capability, the logged-in user can bookmark it.
• bundle—If a feed element has this capability, the feed element may be a group of other feed elements condensed

into one.
• chatterLikes—If a feed element has this capability, the logged-in user can like it and unlike it.
• comments—If a feed element has this capability, the logged-in user can add a comment.
• moderation—If a feed element has this capability, users in the community can flag the feed element for moderation.

This response body also includes information about the flagged content.
• poll—If a feed element has this capability, the feed element can include a poll for voting.
• questionAndAnswers—If a feed element has this capability, users can provide answers instead of comments.
• topics—If a feed element has this capability, the logged-in user can add topics to the feed element.

Feed Element Page
Container of feed elements with paginated results.

This new response body has these properties:
• currentPageUrl—Chatter REST API URL identifying the current page.
• elements—Collection of feed elements. Feed elements are either bundles or feed items.
• isModifiedToken—An opaque polling token that describes when a news feed was last modified. Use this as the

value in the since request parameter of the /chatter/feeds/news/me/feed-elements/is-modified
resource.

• isModifiedUrl—A Chatter REST API URL with a since request parameter that contains an opaque token that
describes when the feed was last modified. Returns null if the feed isn’t a news feed. Use this URL to poll a news
feed for updates.

• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• updatesToken—Token to use in an updatedSince parameter, or null if not available. An opaque polling token

that describes when a news feed was last modified. Use this as the value in the updatedSince request parameter of
the /chatter/feeds/news/me/feed-elements resource.

• updatesUrl—A Chatter REST API feed resource containing the feed elements that have been updated since the
feed was refreshed. If the feed doesn’t support this feature, the value is null.

Feed Item
This class has these new properties:
• capabilities—In API versions 30.0 and earlier, every feed item supported comments, likes, topics, and so on.

In versions 31.0 and later, every feed item (and feed element) can have a unique set of capabilities. If a capability
property exists on a feed element, that capability is available, even if the capability property doesn’t have a value. For
example, if the ChatterLikes capability property exists on a feed element (with or without a value), the logged-in
user can like that feed element. If the capability property doesn’t exist, it isn’t possible to like that feed element. A
capability can also contain associated data. For example, the Moderation capability contains data about moderation
flags.
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• feedElementType—Feed elements are the top-level objects that a feed contains. The feed element type describes
the characteristics of that feed element. One of these values:

◊ Bundle—A container of feed elements. A bundle also has a body made up of message segments that can always
be gracefully degraded to text-only values.

◊ FeedItem—A feed item has a single parent and is scoped to one community or across all communities. Feed
items can have comments, likes, and topics. Depending on the feed item type, a feed item can have an attachment
of additional information (a poll, file, dashboard, and so on). Feed items have a body made up of message segments
that can always be gracefully degraded to text-only values.

• header—The header is the title of the post. This property contains renderable plain text for all the segments of the
message. If a client doesn’t know how to render a feed element type, it should render this text.

The moderationFlags property is not supported in API versions 31.0 and later. Access moderation flags in the
/capabilities/moderation property.

The preamble property is not supported in API versions 31.0 and later. Use the header property instead.

The attachment property has a new value, Question which is a Feed Item Attachment: Question response body.

The type property has these new values:
• AdvancedTextPost—A text post with advanced formatting, such as a group announcement.
• ProfileSkillPost—Feed item generated when a skill is added to a user’s profile.
• QuestionPost—Feed item generated when a question is asked.

Feed Item Attachment: Content
This class has one new property,contentUrl, which specifies the URL if the content is a link or a Google Doc;
otherwise, the value is null.

Feed Item Attachment: Question
This new response body describes a question attachment and has these properties:
• bestAnswer—The comment selected as the best answer for the question.
• bestAnswerSelectedBy—Indicates who selected the best answer for the question.
• canCurrentUserSelectOrRemoveBestAnswer—Indicates whether the current user can select or remove a best

answer.
• questionTitle—Title of the question.
• type—Question

File Detail
This class has one new property, isMajorVersion, which is true if the file is a major version; false if the file is a
minor version. Major versions can’t be replaced.

File Summary
This class has one new property, isMajorVersion, which is true if the file is a major version; false if the file is a
minor version. Major versions can’t be replaced.

Generic Bundle Capability
If a feed element has this capability, the feed element may be a group of other feed elements condensed into one.

This new class has these properties:
• bundleType—Specifies the type of bundle. The value is GenericBundle.
• feedElements—A collection of feed elements.
• totalElements—The total number of feed elements that this bundle aggregates.
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Group
This response body has these new properties:
• announcement—The current announcement for the group
• lastFeedElementPostDate—Date of the most recent feed element posted to the group

The lastFeedItemPostDate property is not supported in API versions 31.0 and later. Use lastFeed
ElementPostDate.

Group Detail
This response body has these new properties:
• announcement—The current announcement for the group
• lastFeedElementPostDate—Date of the most recent feed element posted to the group

The lastFeedItemPostDate property is not supported in API versions 31.0 and later. Use lastFeed
ElementPostDate.

Group Member
This response body has a new lastFeedAccessDate property, which is the date on which the group member last
accessed the group feed.

Moderation Capability
If a feed element has this capability, users in the community can flag the feed element for moderation. This response
body also includes information about the flagged content.

This new response body has one property:
• moderationFlags—A Moderation Flags response body with information about the flagged feed elements.

Poll Capability
If a feed element has this capability, the feed element can include a poll for voting.

This new response body doesn’t have any properties.

Question and Answers Capability
If a feed element has this capability, users can provide answers instead of comments.

This new response body doesn’t have any properties.

Question and Answers Suggestion Collection
This new response body is a question and answers search result and has these properties:
• articles—Collection of articles.
• questions—Collection of questions and answers.

Request Header
This new response body is an HTTP request header and value pair. It has these properties:
• name—The name of the request header.
• value—The value of the request header.

Topics Capability
If a feed element has this capability, the logged-in user can add topics to the feed element.

This new response body doesn’t have any properties.
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Tracked Change Bundle Capability
If a feed element has this capability, the feed element may be a group of feed elements condensed into one feed element
called a bundle. A tracked change bundle contains feed elements that describe tracked changes.

• bundleType—Specifies the type of bundle. The value is TrackedChanges.
• changes—A collection of Tracked Change Item response bodies containing information about the tracked changes.
• feedElements—A collection of feed elements.
• totalElements—The total number of feed elements that this bundle aggregates.

User Detail
This response body has one new property, hasChatter, which is true if the user has access to Chatter.

User Settings
This response body has one new property, hasChatter, which is true if the user has access to Chatter.

Data.com API
The Data.com APIs provide access to the most up-to-date Data.com records. You can search, match, and purchase company
and contact records.

Available in: Developer, Professional (add-on), Enterprise, and Performance Editions.

In this release the Data.com Search API has additional fields and enhancements in the DatacloudContact, DatacloudCompany,
and DatacloudDandBCompany objects.

Datacloud Objects
The Datacloud Objects are used with SOQL to search for Data.com contact and company records and enable you to purchase
Data.com records. The following Datacloud Objects have changes in this release.

More DatacloudCompany searchable fields

• DunsNumber:

A randomly generated nine-digit number that’s assigned by Dun & Bradstreet (D&B) to identify unique business
establishments.

More DatacloudDandBCompany searchable fields

• DunsNumber: The Data Universal Numbering System (D-U-N-S) number is a unique, nine-digit number assigned
to every business location in the D&B database that has a unique, separate, and distinct operation. D-U-N-S numbers
are used by industries and organizations around the world as a global standard for business identification and tracking.

• GlobalUltimateDunsNumber: The D-U-N-S Number of the Global Ultimate, which is the highest entity within
an organization’s corporate structure and may oversee branches and subsidiaries. Maximum size is 9 characters.
Information for all companies under the Global Ultimate DUNS Number is returned. A corporate structure can be
derived from this information.

DatacloudContact and DatacloudCompany enhancements
Count ()

You can see how many records a query can return by using Count() in the SELECT clause of a query. You can also use
Count() to determine the number of rows that are returned by a query.
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DatacloudContact read-only fields
UpdatedDate

The last date and time when the information for a contact was updated.

DatacloudCompany read-only fields

• ActiveContacts:

The number of active contacts that are associated with a company.

• UpdatedDate:

The last date and time when the information for this company was updated.

DatacloudCompany wildcard search enhancements

Operator DescriptionField

NaicsCode • = : an exact search on the value that was entered. The
NaicsCode is a string and must be enclosed in single
quotation marks.

WHERE NaicsCode = '813940'

• IN : searches on a string that must be enclosed in single
quotation marks nested in parentheses. You can search
on a comma separated list.

WHERE NaicsCode IN
('813940','453998','524128')

• LIKE : you can search one or more NaicsCodes with
or without a wildcard.

WHERE NaicsCode LIKE '813940,445110'

The following query finds NaicsCodes that starts with
81 and any value for the third and fifth digits.

WHERE NaicsCode LIKE '81%9%0'

This following query finds any NaicsCode that starts
with 445.

WHERE NaicsCode LIKE '445%'

Important:  A wildcard should not be used as
the first digit. If you use a wildcard as the first
digit, the response is empty.
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Operator DescriptionField

Sic • = : an exact match for a string of numbers. It must be
enclosed in single quotation marks. You can search on
only one string at a time.

• IN : and exact match for a string of numbers. It must
be enclosed in single quotation marks and nested in
parentheses. It can be a comma separated list.

WHERE City = 'Chicago' AND Sic IN
('6411','8651')

• LIKE : you can search one or more Sic numbers with
or without a wildcard.

WHERE Sic LIKE '7513,5411'

The following query finds numbers that start with 5,
the third digit must be 1, and the second and fourth
digits can be any digit.

WHERE Sic LIKE '5%1%'

The following query finds numbers that start with 7
and end with 1.

WHERE Sic LIKE '7%1'

Important:  Do not use a wildcard as the first
digit. If you use a wildcard as the first digit,
the response is empty.

Bulk API
Use Bulk API to work with large sets of records.

Bulk Query SOQL Limit Increased

The maximum length for the SOQL query string in a bulk query request has been increased from 10,000 characters to
20,000 characters.

Tooling API
Use Tooling API to build custom development tools for Salesforce applications.

In version 31.0, Tooling API includes:
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New FlexiPage Object

Represents a Flexible Page. A Flexible Page is the home page for an app that appears as a menu item in the Salesforce1
navigation menu. Includes access to the associated FlexiPage object in the Salesforce Metadata API.

Renamed HistoryRetentionJob Object

Renamed and updated version of the previous FieldHistoryRetentionJob object. Currently available through a pilot
program.

New DeployDetails Field on ContainerAsyncRequest

The DeployDetails field replaces the CompilerErrors field, and contains the line number, component name and
a short description for any compile errors reported in the asynchronous request defined by a ContainerAsyncRequest
object.

Added FullName Field to ContainerMember Objects

The FullName field was added to the following objects: ApexClassMember, ApexComponentMember,
ApexPageMember, ApexTriggerMember. This field is the full name of the associated object in the Metadata API, used
to avoid race conditions on create, before you have IDs.

Metadata API
Use the Metadata API to manage customization information, such as custom object definitions and page layouts, for your
organization.

Metadata API Calls

Metadata API calls were modified or added in version 31.0.

Metadata Types and Fields

Metadata types and fields were modified or added in version 31.0.

Metadata API Calls
Metadata API calls were modified or added in version 31.0.

New Metadata Calls

The following Metadata API call is new.

upsertMetadata()

Creates or updates one or more metadata components in your organization synchronously.

Use the upsertMetadata() call to create or update any component that extends Metadata. All components must be
of the same type in the same call. For more details, see Metadata Components and Types.

If the specified components already exist in your organization, the upsertMetadata() call updates them. Otherwise,
upsertMetadata() creates these components. Components are matched by the fullname field. This call executes
synchronously, which means that the call returns only after the operation is completed.

Updated Metadata Calls

The following Metadata API calls changed.
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Modified Process for retrieve()
In API version 31.0 and later, the process of making a retrieve() call has been simplified. You no longer have to call
checkStatus() after a retrieve() call to obtain the status of the retrieve operation. Instead, make calls to
checkRetrieveStatus() only. If the retrieve operation is in progress, call checkRetrieveStatus() again until
the retrieve operation is completed. The checkStatus() call is still supported in versions API version 30.0 or earlier,
but is not available in API version 31.0 and later. As part of this change, RetrieveResult has new fields that contain status
and error information about the retrieval. See RetrieveResult.

API Version in package.xml Used in retrieve() Calls
Starting in API version 31.0, retrieve() calls use the API version that’s specified in package.xml. The API version
in package.xml overrides the version that’s specified in the RetrieveRequest parameter. If the version is not specified
in package.xml, the version that’s specified in the apiVersion field of the RetrieveRequest parameter is used.

This change enables you to retrieve components in any API version by updating the version in your package.xml file.
You no longer need to change the endpoint in your API client or download a new version of the Force.com Migration
Tool to make a retrieval with a new API version.

Deprecated Metadata Calls

The following Metadata API calls have been removed and are no longer available as of API version 31.0. These Metadata
API calls are available only in earlier versions.

• create()

• update()

• delete()

• checkStatus()

Instead of create(), update(), and delete(), use these synchronous CRUD calls, which were introduced in API version
30.0: createMetadata(), updateMetadata(), renameMetadata(), and deleteMetadata().

For metadata retrieve calls, use checkRetrieveStatus() instead of checkStatus() to obtain status information about
the retrieval. See Modified Process for retrieve().

Metadata Types and Fields
Metadata types and fields were modified or added in version 31.0.

Standard Field Support

Standard fields are now supported in Metadata API. You can retrieve, deploy, and perform CRUD (create, read, update,
delete) operations on standard fields of standard objects. Standard field support enables you to work with customizations of
standard fields, such as help text, feed tracking, and Chatter feed tracking. Only standard fields that can have these customizations
are supported. Other standard fields, including system fields (for example, CreatedById or LastModifiedDate) and
autonumber fields, aren’t supported.

When you retrieve a standard object via the CustomObject type, all the object’s customizable standard fields are included in
the object definition. Alternatively, you can specify the fields to retrieve via the CustomField type by using the
objectName.field syntax in the manifest file. For example, the following example shows a section of the manifest
package.xml file that retrieves only the Phone account field definition.

<types>
<members>Account.Phone</members>
<name>CustomField</name>

</types>
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The following sample definition shows the Phone Account standard field with history tracking enabled.

<?xml version="1.0" encoding="UTF-8"?>
<CustomObject xmlns="http://soap.sforce.com/2006/04/metadata">

<fields>
<fullName>Phone</fullName>
<trackHistory>true</trackHistory>

</fields>
</CustomObject>

Standard Console App Support

Standard console apps are now supported through the CustomApplication type. You can retrieve, deploy, and perform CRUD
(create, read, update, delete) operations on standard console apps.

In API version 30.0, standard app support was added, but standard console apps were not included. They are supported now.

New Metadata Types

CustomPermission
Represents a permission that grants access to a custom feature. Custom permissions are currently available as a Developer
Preview.

NameSettings
Enables or disables middle name and suffix attributes for the following person objects: Contact, Lead, Person Account,
and User. In API version 31.0, NameSettings is a beta release type.

Updated Metadata Types and Fields

These metadata fields have been added or changed in API version 31.0.

AsyncResult
All fields, with the exception of the id field, have been deprecated. These fields still exist but are no longer in use.
• done

• message

• state

• statusCode

Because properties related to the status of metadata retrievals have been moved to RetrieveResult, and the asynchronous
create(), update(), and delete() calls have been removed, only the id field is needed in AsyncResult.

AuthProvider
The following value has been added to the providerType field:

MicrosoftACS

You can use Microsoft Access Control Service as an authentication provider. Authorization is typically done by a
Microsoft Office 365 service like SharePoint® Online.

ConnectedApp
The following field has been added to the ConnectedAppCanvasConfig subtype:

lifecycleClass

The name of the Canvas.CanvasLifecycleHandler Apex class, if you’ve implemented this class for custom
parameters.
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samlInitiationMethod

If you’re using SAML single sign-on (SSO), indicates which provider initiates the SSO flow. Valid values are:
• IdpInitiated—Identity provider initiated. Salesforce makes the initial request to start the SSO flow.
• SpInitiated—Service provider initiated. The canvas app starts the SSO flow after it’s invoked.
• None—The canvas app isn’t using SAML SSO.

The following fields have been updated:

canvasLocationOptions

The following enumeration values have been added:
• MobileNav—The canvas app can appear in a mobile card in the Salesforce1 app.
• PageLayout—The canvas app can appear on a page layout. When viewed in the Salesforce1 app, the canvas

app appears in the record detail page.

The following field has been added to the ConnectedAppIpRange subtype:

description

Use this field to identify the purpose of the range, such as which part of a network corresponds to this range.

The following value has been added to the ConnectedAppOauthAccessScope enumeration values. The value is used in
the scopes field of the ConnectedAppOauthConfig subtype:

CustomPermissions

Allows access to the custom permissions in an organization associated with the connected app, and shows whether
the current user has each permission enabled.

Note:  Custom permissions are currently available as a Developer Preview.

CustomField
An integrity constraint that prevented field data type conversions from being deployed if the field was referenced in Apex
has been relaxed. Now, as long as the deploy also includes any required Apex changes, it won’t fail on the initial validation.
This change eliminates a cumbersome workaround previously required to deploy field type changes. Apex code included
in the deployment is still subject to compilation checks and other validation.

CustomObject
The following fields have been added:

enableBulkApi

When enabled, the custom object is classified as an Enterprise Application object for usage tracking.

enableSharing

When enabled, the custom object is classified as an Enterprise Application object for usage tracking.

enableStreamingApi

When enabled, the custom object is classified as an Enterprise Application object for usage tracking.

externalSharingModel

Indicates the external organization-wide defaults for the custom object, which determines the access level for external
users, such as portal and community users. This field is supported for these objects:

• Accounts and their associated contracts and assets
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• Cases
• Contacts
• Opportunities
• Custom Objects
• Users

Depending on the object, valid values are:

• Private

• Read

• ReadWrite

• ReadWriteTransfer

• FullAccess

• ControlledByParent

For example, the User object supports Private and Read values. Accounts, opportunities, and custom objects
support Private, Read and ReadWrite values.

historyRetentionPolicy

Represents the policy for retaining field history data. By setting a policy, you can specify the number of months you
want to maintain field history in Salesforce, and the number of years you want to retain field history in the archive.

FlexiPage
The following field has been added:

description

The optional description text of the Flexible Page.

The following field has been updated:

componentName

This field is now required.

Flow
The following fields have been added:

actionCalls

An array of nodes that define calls to actions.

processType

The process type. Valid values are:
• AutoLaunchedFlow—a flow whose active version (or latest version, if there’s no active version) is trigger-ready
• Flow—a flow whose active version (or latest version, if there’s no active version) isn’t trigger-ready, because it

contains one or more restricted elements or resources
• Workflow—Reserved for future use

The following field has been added to the FlowFormula subtype:

dataType

The data type for the formula. Valid values are:
• Boolean

• Currency

• Date
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• DateTime

• Number

• String

The sObjectInputReference field name has been renamed to inputReference on these subtypes.
• FlowRecordCreate
• FlowRecordDelete
• FlowRecordUpdate

FeedLayout
The following fields have been added:

autocollapsePublisher

Specifies whether the publisher is automatically collapsed when it’s not in use (true) or not (false).

fullWidthFeed

Specifies whether the feed expands horizontally to take up all available space on the page (true) or not (false).

The following values were added to the FeedItemType enumeration that is used in the FeedLayoutFilter subtype:

AdvancedTextPost

Feed items with advanced text formatting, such as group announcements.

QuestionPost

Feed items with a required title and an optional body. One comment at a time can be selected as the best answer.

ProfileSkillPost

Feed items generated when a skill is added to a user’s Chatter profile.

HomePageComponent
The following fields have been added:

height

Required for Visualforce Area components. Indicates the height (in pixels) of the component.

page

This field is only available for Visualforce Area components and indicates the API name of the Visualforce page
that is associated with the component.

showLabel

This field is only available for Visualforce Area components and specifies whether the component displays with a
label (true) or not (false).

showScrollbars

This field is only available for Visualforce Area components and specifies whether the component displays with
scrollbars (true) or not (false).

The visualforcePage value has been added to the PageComponentType enumeration.

KnowledgeSettings
The following field has been added:

enableChatterQuestionKBDeflection

Indicates whether tracking for case deflection via Chatter is enabled (true) or not (false).
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Layout
The following field has been added to the ReportChartComponentLayoutItem subtype:

error

Error string; only populated if an error occurred in the underlying report.

The following field has been added to the LayoutItem subtype:

canvas

Reference to a canvas app.

The following fields have been added to the SidebarComponent subtype:

componentType

Specifies the type of sidebar component. Valid values are KnowledgeOne, Lookup, Milestones, RelatedList,
and Topics.

relatedlists

If the component is a related list, the name of the list.

The following field has been removed from the SidebarComponent subtype:

knowledgeOneEnable

This field has been replaced by the KnowledgeOne value on the componentType field.

LiveChatAgentConfig
The following fields have been added:

enableAgentFileTransfer

Indicates whether file transfer is enabled for agents (true) or not (false).

enableChatTransfer

Indicates whether chat transfer is enabled for agents (true) or not (false).

transferableButtons

Specifies the list of chat buttons that agents can transfer chats to.

transferableSkills

Specifies the list of skill groups that agents can transfer chats to.

Network
The following fields have been added:

enableGuestChatter

Specifies whether guest users can access public Chatter groups in the community without logging in.

enableReputation

Determines if reputation levels can be set up and displayed on community member’s profiles.

reputationLevels

The reputation levels assigned to members when they accrue points by performing certain actions.

reputationPointsRules

The points members accrue when they perform certain defined actions.
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PermissionSet
In Developer Edition only, the following field has been added.

customPermissions

Indicates which custom permissions are available to users assigned to this permission set.

Profile
In Developer Edition only, the following field has been added.

customPermissions

Indicates which custom permissions are available to users assigned to this profile.

The following field has been added to the ProfileLoginIpRange subtype:

description

Use this field to identify the purpose of the range, such as which part of a network corresponds to this range.

QuickAction
The following value has been added to the standardLabel (QuickActionLabel) and type (QuickActionType) fields:

SendEmail

A simplified version of the Case Feed Email action that is available on Salesforce1.

ReportType
The following value has been added to the category field (ReportTypeCategory enumeration).

territory2

Represents a report type category for Territory Management 2.0 (Beta).

RetrieveResult
The following fields have been added:

done

Required. Indicates whether the retrieve() call is completed (true) or not (false). This field is available in
API version 31.0 and later.

errorMessage

If an error occurs during the retrieve() call, this field contains a descriptive message about this error. This field
is available in API version 31.0 and later.

errorStatusCode

If an error occurs during the retrieve() call, this field contains the status code for this error. This field is available
in API version 31.0 and later.

For a description of each StatusCode value, see “StatusCode” in the SOAP API Developer's Guide.

status

The status of the retrieve() call. Valid values are:
• Pending

• InProgress

• Succeeded

• Failed

This field is available in API version 31.0 and later.
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success

Indicates whether the retrieve() call was successful (true) or not (false). This field is available in API version
31.0 and later.

SecuritySettings
The following fields have been updated in the PasswordPolicies subtype:

complexity

Two new options are available: UpperLowerCaseNumeric and UpperLowerCaseNumericSpecialCharacters
For more information, see Uppercase and Lowercase Password Complexity Option.

minPasswordLength

TwelveCharacters is now an option. For more information, see Longer Minimum Password Length Option.

historyRestriction

The maximum value for this field increased from 16 to 24. For more information, see Additional Password History
Options: Remember Up to 24 Passwords.

The following field has been added to the PasswordPolicies subtype:

minimumPasswordLifetime

Indicates whether a one-day minimum password lifetime is required (true) or not (false).  For more information,
see Minimum Password Lifetime Option.

The following fields have been added to the SessionSettings subtype:

enablePostForSessions

Indicates whether cross-domain session information is exchanged using a POST request instead of a GET request,
such as when a user is using a Visualforce page. In this context, POST requests are more secure than GET requests.
For more information, see the release note Cross-Domain Exchanges Switch to POST Requests.

forceLogoutOnSessionTimeout

Indicates that when sessions time out for inactive users, current sessions become invalid. Browsers are automatically
refreshed and return to the login page. To access the organization again when this occurs, users must log in again.
Enabled (true) or not (false).

Territory
The following field has been added:

accountAccessLevel

Specifies whether users in this territory can access accounts that are assigned to this territory and are otherwise
inaccessible. Valid values are:
• Read

• Edit

• All

Salesforce Console API (Integration Toolkit)
The toolkit includes new methods that let you customize a console’s navigation tab and interaction log programmatically.
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Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

For more information (English only) about the toolkit, see the Salesforce Console Integration Toolkit Developer's Guide.

The following methods are new or have changed in API version 31.0. They are organized for use with an interaction log,
navigation tab, or logout.

For use with an interaction log:

fireOnCallBegin()

Fires an event that notifies a call has begun. Use to get information or send information between an interaction log and
a custom console component. This method is only available in API version 31.0 or later.

fireOnCallEnd()

Fires an event that notifies a call has ended. Use to get information or send information between an interaction log and
a custom console component. This method is only available in API version 31.0 or later.

fireOnCallLogSaved()

Calls the eventHandler function registered with onCallLogSaved(). Use to get information or send information
between an interaction log and a custom console component.. This method is only available in API version 31.0 or later.

onCallLogSaved()

Registers a function that is fired when an interaction log saves a call log. Use to get information or send information
between an interaction log and a custom console component. This method is only available in API version 31.0 or later.

onSendCTIMessage()

Registers a function that is fired when a message is sent with the sendCTIMessage(). Use to get information or send
information between an interaction log and a custom console component. This method is only available in API version
31.0 or later.

setCallAttachedData()

Sets the call data associated with a call object ID. Use to get information or send information between an interaction
log and a custom console component.This method is only available in API version 31.0 or later.

setCallObjectIds()

Sets call object IDs, in ascending order of arrival. This method is only available in API version 31.0 or later.

For use with a navigation tab:

focusNavigationTab()

Focuses on the navigation tab. This method is only available in API version 31.0 or later.

getNavigationTabs()

Returns all of the objects in the navigation tab. This method is only available in API version 31.0 or later.

getSelectedNavigationTab()

Returns the selected object in the navigation tab. This method is only available in API version 31.0 or later.

refreshNavigationTab()

Refreshes the selected navigation tab. This method is only available in API version 31.0 or later.
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setSelectedNavigationTab()

Sets the navigation tab with a specific ID or URL. This method is only available in API version 31.0 or later.

For use with logout:

sforce.console.ConsoleEvent.CONSOLE_LOGOUT

Delays the execution of logging out of a console when a user clicks Logout. This standard event is only available in API
version 31.0 or later.

Open CTI API
Open CTI includes a new method that lets you retrieve phone numbers from a Salesforce call center’s directory.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

For more information (English only) about the toolkit, see the Open CTI Developer's Guide.

The following method is new in API version 31.0.

getDirectoryNumbers()

Returns the list of phone numbers from the call center’s directory.

Analytics Dashboards API
Use the Analytics Dashboards API to integrate Salesforce dashboard data into your applications programmatically.

For more information, see Analytics Dashboards API (Generally Available) in the release notes Analytics section.

ISVforce
Improvements include a new Partner Community for ISVs, a simplified package installer, packaging of mobile apps, usage
metrics tracking and visualization, as well as enhancements to package licensing and the Environment Hub.

New Partner Community

The new Partner Community, at https://partners.salesforce.com, is now the primary resource for all ISVs. Access the latest
ISV content, collaborate with other partners and salesforce.com using our Chatter community, and stay up to date on news
and events related to the AppExchange Partner Program.

Simplified Package Installer

The package installer has been redesigned for speed and simplicity. All configuration options appear on one screen, and users
can complete the installation with a single click. These improvements make installing a package as easy as installing an app
on a mobile phone.

Usage Metrics (Generally Available)

You can collect detailed usage metrics from each organization in which your managed package is installed. By analyzing this
information, you can gain valuable insights into the utilization and performance of your app across your entire customer base.
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Usage Metrics Visualization

The Usage Metrics Visualization package, available from Salesforce Labs on the AppExchange, enables you to visualize
trends in usage metrics data for your app. Use the package to generate charts showing changes in various app metrics, over
a specified duration, for one or more customer organizations.

License Management App (LMA) Supports Sandbox Installations

The LMA now generates licenses and leads for package installations in sandbox organizations, in addition to production
organizations. This enables you to track prospects who try your app in a sandbox before buying it, a common use case.

Assign Package Licenses Using the API

Administrators can use the API to assign or revoke licenses for any managed package installed in their organization. This
makes managing package licenses in a subscriber organization faster and easier, especially for large-scale deployments.

Create Partner Organizations in the Environment Hub

You can now create partner organizations directly from the Environment Hub, instead of having to visit the Partner Portal.
Partner organizations have higher limits and other advanced features, compared to standard development organizations, so
they’re well-suited for demos or to test your app with various license types.

Package Mobile Connected Apps (Generally Available)

Mobile packaging is now available to all customers for free. Mobile packaging solves the app distribution problem for
customers building mobile apps on the Salesforce platform, by providing an easy mechanism for distributing those apps to
employees or partners.

New Partner Community
The new Partner Community, at https://partners.salesforce.com, is now the primary resource for all ISVs. Access the latest
ISV content, collaborate with other partners and salesforce.com using our Chatter community, and stay up to date on news
and events related to the AppExchange Partner Program.

Use the Partner Portal, at https://salesforce.com/partnerportal, for creating test organizations and to log cases for support from
salesforce.com. Both the Partner Community and the Partner Portal are self-service—the first person to register your partnership
becomes your designated administrator and manages the creation of additional users for your company. You can change or
add administrators, as required.

Note:  In June 2014 we will be migrating the case functionality into the Partner Community, and you’ll no longer
need access to the Partner Portal.

Simplified Package Installer
The package installer has been redesigned for speed and simplicity. All configuration options appear on one screen, and users
can complete the installation with a single click. These improvements make installing a package as easy as installing an app
on a mobile phone.

Available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:
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All customization options in the previous installer are available as separate links outside the default installation path. This
ensures that administrators can still specify API access to objects, restrict access to users based on profiles, and so on. However,
those features don’t prevent users from installing with a single click if they accept the default settings, which is the most
common use case.

The new installer also gives developers the option of specifying external links to release notes and post-installation instructions
when uploading a package. The links are displayed during installation and on the Package Details page after installation. This
feature makes it easy to communicate important information, such as details of new features or post-installation configuration
steps, to customers when they’re most likely to need it. As a best practice, we recommend that both links point to external
URLs, so you can update the information independently of the package.

Figure 5: Package installation screen showing the different options.

The new installer always appears when installing an app from the AppExchange. However, when using an installation URL,
the old installer is displayed by default. You can customize the installation behavior by modifying the installation URL you
provide your customers.

• To access the new installer, append the text &newui=1 to the installation URL.

• To access the new installer with the "Install for All Users" option selected by default, append the text &newui=1&p1=full
to the installation URL.

Pre-Installation Steps
Default Installation
Custom Installation
Post-Installation Steps

Pre-Installation Steps
Follow these steps to start the installation process.
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1. In a browser, go to the installation URL provided by the package developer, or, if you’re installing a package from the
AppExchange, click Get It Now from the application information page.

Note:  If you’re installing into a sandbox, replace the www.salesforce.com portion of the installation link with
test.salesforce.com. The package is removed from your sandbox organization whenever you create a new sandbox
copy.

2. Enter your username and password for the Salesforce organization in which you want to install the package, and then click
the login button.

3. If the package is password-protected, enter the password you received from the publisher.
4. Optionally, if you’re installing an unmanaged package, select Rename conflicting components in package.

When you select this option, Salesforce changes the name of a component in the package if its name conflicts with an
existing component name.

Default Installation
Click Install. You’ll see a message that describes the progress and a confirmation message after the installation is complete.

Custom Installation
Follow these steps to install a package, if you need to modify the default settings, as an administrator.

1. Choose one or more of these options, as appropriate.

• Click View Components. You’ll see an overlay with a list of components in the package. For managed packages, the
screen also contains a list of connected apps (trusted applications that are granted access to a user's Salesforce data after
the user and the application are verified). Review the list to confirm that the components and any connected apps shown
are acceptable, and then close the overlay.

Note:  Some package items, such as validation rules, record types, or custom settings might not appear in the
Package Components list but are included in the package and installed with the other items. If there are no
items in the Package Components list, the package might contain only minor changes.

• If the package contains a remote site setting, you must approve access to websites outside of Salesforce. The dialog box
lists all the websites that the package communicates with. We recommend that a website uses SSL (secure sockets
layer) for transmitting data. After you verify that the websites are safe, select Yes, grant access to these third-party
websites and click Continue, or click Cancel to cancel the installation of the package.

Warning:  By installing remote site settings, you’re allowing the package to transmit data to and from a
third-party website. Before using the package, contact the publisher to understand what data is transmitted
and how it's used. If you have an internal security contact, ask the contact to review the application so that
you understand its impact before use.

• Click API Access. You’ll see an overlay with a list of the API access settings that package components have been
granted. Review the settings to verify they’re acceptable, and then close the overlay to return to the installer screen.

• In Enterprise, Performance, Unlimited, and Developer Editions, choose one of the following security options.

Note:  Depending on the type of installation, you might not see this option. For example, in Group and
Professional Editions, or if the package doesn’t contain a custom object, Salesforce skips this option, which
gives all users full access.
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Install for Admins Only

Specifies the following settings on the installing administrator’s profile and any profile with the "Customize
Application" permission.
◊ Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” enabled
◊ Field-level security—set to visible and editable for all fields
◊ Apex classes—enabled
◊ Visualforce pages—enabled
◊ App settings—enabled
◊ Tab settings—determined by the package creator
◊ Page layout settings—determined by the package creator
◊ Record Type settings—determined by the package creator

After installation, if you have Enterprise, Performance, Unlimited, or Developer Edition, set the appropriate user
and object permissions on custom profiles as needed.

Install for All Users

Specifies the following settings on all internal custom profiles.
◊ Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” enabled
◊ Field-level security—set to visible and editable for all fields
◊ Apex classes—enabled
◊ Visualforce pages—enabled
◊ App settings—enabled
◊ Tab settings—determined by the package creator
◊ Page layout settings—determined by the package creator
◊ Record Type settings—determined by the package creator

Note: The Customer Portal User, Customer Portal Manager, High Volume Customer Portal,
Authenticated Website, Partner User, and standard profiles receive no access.

Install for Specific Profiles...

Enables you to choose the usage access for all custom profiles in your organization. You can set each profile to
have full access or no access for the new package and all its components.
◊ Full Access—Specifies the following settings for each profile.

- Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” enabled
- Field-level security—set to visible and editable for all fields
- Apex classes—enabled
- Visualforce pages—enabled
- App settings—enabled
- Tab settings—determined by the package creator
- Page layout settings—determined by the package creator
- Record Type settings—determined by the package creator

◊ No Access—Specifies the same settings as Full Access, except all object permissions are disabled.

You might see other options if the publisher has included settings for custom profiles. You can incorporate the
settings of the publisher’s custom profiles into your profiles without affecting your settings. Choose the name of
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the profile settings in the drop-down list next to the profile that you need to apply them to. The current settings
in that profile remain intact.

Alternatively, click Set All next to an access level to give this setting to all user profiles.

2. Click Install. You’ll see a message that describes the progress and a confirmation message after the installation is complete.

Post-Installation Steps
If the package includes post-installation instructions, they’re displayed after the installation is completed. Review and follow
the instructions provided. In addition, before you deploy the package to your users, make any necessary changes for your
implementation. Depending on the contents of the package, you might need to perform some of the following customization
steps.

• If the package includes permission sets, assign the included permission sets to your users who need them. In managed
packages, you can't make changes to permission sets that are included in the package, but subsequent upgrades happen
automatically. If you clone a permission set that comes with a managed package or create your own, you can make changes
to the permission set, but subsequent upgrades won't affect it.

• If you’re re-installing a package and need to re-import the package data by using the export file that you received after
uninstalling, see “Importing Package Data” in the Salesforce Help.

• If you installed a managed package, click Manage Licenses to assign licenses to users.

• Configure components in the package as required. For more information, see “Configuring Installed Packages” in the
Salesforce Help.

Usage Metrics (Generally Available)
You can collect detailed usage metrics from each organization in which your managed package is installed. By analyzing this
information, you can gain valuable insights into the utilization and performance of your app across your entire customer base.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Tracking changes in your app’s usage over time can help you identify:

• The features most and least used — this can help you prioritize your development efforts when planning the next version
of your app.

• The customers using your app most intensively — these are your most valuable customers.

• The customers whose usage of your app is minimal or declining — these are the customers most at risk of attrition.

You can collect the following daily metrics on two types of components in a managed package.

• Custom objects — the total number of records existing per organization in each custom object. This enables you to track
how the usage of that custom object is growing with time in any subscriber organization, which is a reliable indicator of
how much it's being utilized

• Visualforce pages — the number of times per organization each Visualforce page was accessed, the number of unique
users who accessed it, and the average loading time (in milliseconds). By comparing the metrics for different Visualforce
pages, you can determine the relative popularity of different parts of your app in a specific customer organization, as well
as trends across all customers.

The custom objects data is a snapshot that reflects the state of the organization at the time the database was sampled, while
the Visualforce data covers usage over a 24-hour period.
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The usage metrics data for all production organizations in a given instance is merged and written into a text file, in a specified
format, once a day. Currently, no data is collected on packages installed in sandbox organizations or on managed beta packages.

This feature is intended for API access only. The usage data for a package is stored in MetricsDataFile records in your reporting
organization. You must write a custom process to collect the metrics data from the reporting organization, and export it to a
system of your choice for analysis. This gives you the maximum flexibility to monitor and analyze the usage trends most relevant
for your app.

Your customers’ consent is not required for usage data to be collected, and there’s no way for them to opt out. This ensures
you receive complete data for your entire customer base. Allowing some users to be excluded would skew the results, making
the data less useful.

Note:  If any of your customers have concerns about privacy, reassure them any data collected is limited to usage
statistics. No customer data is ever exposed to the ISV under any circumstances. This is consistent with salesforce.com’s
emphasis on trust as a core value.

Setting up Usage Metrics
Accessing Usage Metrics Data

Setting up Usage Metrics
To set up Usage Metrics for any package, two organizations have special importance.

• Release organization — the Development Edition organization used to upload the package.

• Reporting organization — the organization to which the usage data is delivered, on a daily basis.

The release organization and reporting organization must be members of the same Environment Hub. This is a security
feature, to ensure usage data is only delivered to an organization controlled by the developer of the package. We recommend
using the Environment Hub as your reporting organization.

Note:  For information on setting up and connecting organizations to the Environment Hub, see Environment Hub
in the online help.

To set up Usage Metrics for a package:

1. Set up Environment Hub, if you haven’t already done so.
2. Connect the release organization to the Environment Hub.
3. Connect the reporting organization to the Environment Hub (if they’re different).
4. Log a case in the Partner Portal to activate Usage Metrics. You’ll need to provide the package ID for your app.

Once the feature is activated, you’ll receive a confirmation email. From that point on, usage data will automatically be collected
from all organizations in which your package is installed, and delivered to the reporting organization on a daily basis. There
is no way to get usage data retroactively, that is, for any period prior to the activation of Usage Metrics.

Accessing Usage Metrics Data
The usage data for a package is stored in MetricsDataFile records in your reporting organization. Once you activate the
Usage Metrics feature, one new record is created for all custom objects and one for all Visualforce pages, per Salesforce instance
per day.

Note:  To see the number of Salesforce instances currently in use, visit trust.salesforce.com.
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The usage data for each day and instance is stored as a text file, encoded in Base 64, in the MetricsDataFile field of the
record. Other fields in the record identify these properties.

• Namespace prefix of the package

• Salesforce instance

• Start time and date of data collection

• End time and date of data collection

• Size of the data file in bytes

• Type of data, which is either CustomObject or Visualforce

The custom objects data is a snapshot that reflects the state of the organization at the time the database was sampled, while
the Visualforce data covers usage over a 24-hour period.

The custom object count is a snapshot captured once each day. Here’s a section of a sample data file for custom objects. It
shows there were 3500 and 1500 records in the Alpha and Beta custom objects, respectively, in the specified customer
organization on the specified day.

"00Dxx0000001gbk","org1","Enterprise Edition","TRIAL","Alpha", "3500"
"00Dxx0000001gbk","org1","Enterprise Edition","TRIAL","Beta", "1500"

In a record for Visualforce pages, each row of the text file contains usage data in the following order.

• Organization ID

• Organization name

• Organization edition

• Organization status

• Name of the Visualforce page

• Number of times the page was accessed

• Number of unique users who accessed the page

• Average loading time of the page, in milliseconds

The Visualforce counts for each organization measure the number of times the page was viewed in the duration between the
start and end times. Here’s a section of a sample data file for Visualforce pages.

"00Dxx0000001gbk","org1","Enterprise Edition","TRIAL","/apex/gm12__f1","1","1","66.0"
"00Dxx0000001gbk","org1","Enterprise Edition","TRIAL","/apex/gm12__f2","1","1","128.0"
"00Dxx0000001gbk","org1","Enterprise Edition","TRIAL","/apex/gm12__f3","1","1","107.0"
"00Dxx0000001gbf","org1","Enterprise Edition","TRIAL","/apex/gm12__f1","5","1","73.6"
"00Dxx0000001gbf","org1","Enterprise Edition","TRIAL","/apex/gm12__f2","1","1","72.0"
"00Dxx0000001gbf","org1","Enterprise Edition","TRIAL","/apex/gm12__f3","7","1","50.8"

You must write a custom process to query the reporting organization to collect the metrics data, and export it to a system of
your choice for analysis. This gives you the maximum flexibility to monitor and analyze the usage trends most relevant for
your app.

Usage Metrics Visualization
The Usage Metrics Visualization package, available from Salesforce Labs on the AppExchange, enables you to visualize trends
in usage metrics data for your app. Use the package to generate charts showing changes in various app metrics, over a specified
duration, for one or more customer organizations.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
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The app must be installed in your Usage Metrics reporting organization and requires Usage Metrics to be enabled in advance,
so some data is available for analysis. You can analyze data going back a maximum of 30 days. If Usage Metrics wasn’t enabled
for the entire time period that you specify, only partial data is plotted.

The app is intended as a reference implementation, for illustration purposes only. It’s distributed as an unmanaged package,
so you can review its components and extend or customize it to meet your requirements. If your visualization needs are more
complex, you can export the raw metrics data from the reporting organization and analyze it by using custom code or a
third-party tool .

To install the Usage Metrics Visualization app:

1. Go to the AppExchange and search for the Usage Metrics Visualization app.
2. Click Get It Now.
3. Enter the credentials for your reporting organization, and then click the login button.
4. Click Install.

You’ll see a message describing the progress and a confirmation message after the installation is complete.

Figure 6: The Usage Metrics Visualization app showing data for the top five Visualforce pages.

To visualize the usage metrics data:

1. Specify the app whose metrics you want to view by selecting it from the App menu.

Note:  You should have enabled Usage Metrics for your app at least a few days before, so some usage data is
available to analyze.

2. Specify the organization(s) that you want to view metrics for by choosing one of these options.

• For a single organization, enter its Organization ID in the Single Organization field.
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• For a group of organizations, select one of the following from the All Organizations menu.

◊ Any Status
◊ All Active: These are organizations used by paying customers.
◊ All Free: These are Developer Edition (DE) organizations.
◊ All Trial: These are trial organizations, which expire after a specified period.

3. Specify the type of metric that you want to visualize by selecting one of these values from the Show menu.

• Total Visualforce Page Views
• Top 5 Visualforce Pages
• Total Record Count
• Top 5 Objects by Record Count

4. Specify the time period to cover by selecting one of these values from the Date Range menu.

• Last 30 Days
• Last 7 Days
• Last 2 Days

Note:  If the volume of usage data is too large, you might get an error message. In that case, choose a smaller date
range and try again.

5. Click View Metrics.

The data you specified is displayed on the page as a chart and as a table. To visualize a different data set, change the parameters,
and then click View Metrics again.

License Management App (LMA) Supports Sandbox Installations
The LMA now generates licenses and leads for package installations in sandbox organizations, in addition to production
organizations. This enables you to track prospects who try your app in a sandbox before buying it, a common use case.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

System Administrator profileTo configure the LMA:

“Read”

AND

“Edit”

To edit licenses and packages:

“Read”To view licenses, packages, and package versions:

A sandbox license record and a lead are created in the LMA under these conditions.

• Your package is installed in a sandbox organization, from the AppExchange or via an installation URL.

• A sandbox is created from a production organization that has your package installed.
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The Sandbox field on the License Detail page in the LMA is automatically selected. The license status is free and set to never
expire.

Assign Package Licenses Using the API
Administrators can use the API to assign or revoke licenses for any managed package installed in their organization. This
makes managing package licenses in a subscriber organization faster and easier, especially for large-scale deployments.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Package Licenses”To manage licenses for an AppExchange app:

License information for a package is stored in two objects, PackageLicense and UserPackageLicense, which were previously
accessible only from the Manage Licenses page under Setup. These are now accessible as standard objects, so an administrator
can assign licenses to specific users via API calls.

For example, suppose an administrator installs an app for use by all 200 salespeople in the company. Assigning a license to
each salesperson from the UI is inefficient and time-consuming. Using the API, the administrator can assign licenses to all
salespeople, based on their profile, in one step.

Note:  This feature is for use by customers in their subscriber organization after they purchase a license for an app.
ISVs should continue using the License Management App to control customer licenses.

Here are some common licensing tasks that administrators can use the API to do.

• Determine the number of package licenses in use and available.

• Verify if a specific user has a license for the package.

• Get a list of all users who have a license for the package.

• Assign a package license to a user or group of users.

• Revoke a package license that was previously assigned to a user.

Create Partner Organizations in the Environment Hub
You can now create partner organizations directly from the Environment Hub, instead of having to visit the Partner Portal.
Partner organizations have higher limits and other advanced features, compared to standard development organizations, so
they’re well-suited for demos or to test your app with various license types.

Available in: Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:
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Note:  These organizations are strictly for internal use by partners and should not be shared with customers or
prospects.

To create a partner organization in the Environment Hub:

1. On the Environment Hub, click Create Organization.
2. On the page that appears, from the drop-down list, choose Partner (more features).
3. On the page that appears, specify the organization’s edition, name, and My Domain, and the admin user’s name, user

name, and email address.
4. Read and accept the Master Subscription Agreement.
5. Click Create.

After the organization is created, it appears in the Environment Hub, and you get an email confirmation.

Package Mobile Connected Apps (Generally Available)
Mobile packaging is now available to all customers for free. Mobile packaging solves the app distribution problem for customers
building mobile apps on the Salesforce platform, by providing an easy mechanism for distributing those apps to employees or
partners.

Connected Apps can be created in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Connected Apps can be installed in: All Editions

User Permissions Needed

“Customize Application”To read:

“Customize Application” AND either

“Modify All Data” OR “Manage Connected Apps”

To create, update, or delete:

“Customize Application”To update all fields except Profiles, Permission Sets, and
Service Provider SAML Attributes:

“Customize Application” AND “Modify All Data”To update Profiles, Permission Sets, and Service Provider
SAML Attributes:

“Download AppExchange Packages”To uninstall:

When creating a mobile connected app, you can specify a set of mobile packaging attributes, such as the platform, version,
form factor, and mobile app binary file. If you then include the mobile connected app as a component when creating a package,
these attributes are included in the package and migrated when a user moves a package from one organization to another. In
addition, after you create and package a mobile connected app, it’s instantly available for distribution via a listing in the Private
AppExchange.

Here are the steps for creating a mobile connected app.

1. From Setup, click Create > Apps.
2. In the Connected Apps section, click New.
3. Enter the relevant information in the Basic Information, API (Enable OAuth), and Web App Settings sections.
4. Enter the following information in the Mobile App Settings section.
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Select PIN Protect, if your app supports PIN protection. This gives an administrator the option of setting the session
timeout and PIN length for mobile applications after installing the connected app. PIN protection is automatically

a.

supported by the Salesforce Mobile SDK (http://developer.force.com/mobilesdk). You can also implement it manually
by reading the mobile_policy object from the user’s Identity URL.

b. Specify the App Platform by choosing iOS or Android from the drop-down list.
c. Specify the supported device form factor(s) for the mobile app from the Restrict to Device Type drop-down

list. The possible values are Phone, Tablet, or Mini-Tablet. If the app is universal (that is, supports all form factors),
don’t choose any value.

d. Enter the App Version number of the mobile app.
e. Enter the Minimum OS Version required for the app.
f. Select Private App to confirm this app is for internal (non-public) distribution only. This is required because Apple

doesn’t allow distribution of public mobile apps outside of its app store.
g. If the mobile app is private, specify the location of the Mobile App Binary file. This is an IPA file for iOS and an

APK file for Android.
h. For iOS apps only:

i. Specify the location of the Application Icon. This is the icon displayed during download and installation of the app
on an iOS device.

ii. Specify the iOS Bundle Identifier.

Note:  For iOS 7 and higher, you must specify the same bundle identifier that you used for developing the
app in XCode. Otherwise, the end user will see two app icons on app installation.

i. If the mobile connected app is a public app and you haven’t uploaded its binary file to Salesforce, enter the App Binary
URL here.

5. Click Save.

You can now publish your app, make further edits, or delete it.

Note:  If you remove mobile integration from a new version of an existing connected app, mobile integration is no
longer included in any version of the connected app. For example, imagine publishing a package containing version
1.0 of your connected app with mobile integration. Then remove mobile integration from the app, repackage it, and
publish it as version 1.1. If a customer installs the earlier package with version 1.0 at this point, the version 1.0
connected app will not contain mobile integration.

Your connected app can receive push notifications if:

• Your app is built with Salesforce Mobile SDK.

• Your app implements the Mobile SDK push notification protocol for your platform.

• You are a registered developer with the mobile platform provider (Apple or Google).

• Your app is registered with Apple Push Notification Service (APNS) for iOS push notifications or with Google Cloud
Messaging (GCM) for Android push notifications.

• You’ve implemented Apex handlers for push notifications.

Note:  A push-enabled connected app can support only one mobile platform. If you provide Android and iOS versions
of your mobile app and need to support push notifications on both versions, create a connected app for each platform.

To learn how to fulfill these requirements, see the Salesforce Mobile Push Notifications Implementation Guide.
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Other salesforce.com Products
desk.com
Desk.com is an all-in-one customer support app for small businesses and growing teams.

For information on new features, go to the Desk.com Product Updates Blog.

Heroku
Heroku is a cloud-based application platform for building and deploying web apps.

For information on new features, go to the Heroku Changelog.

Salesforce Marketing Cloud
Salesforce Marketing Cloud is a unified social marketing suite that allows companies to listen to and engage customers, publish
content, optimize social advertising, measure campaigns, and integrate social insights with customer data.

For information on new features, go to the Salesforce Marketing Cloud Facebook page.
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